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ORIGINALITY

This book draws many 
documents together into a 
single place. This includes the 
following documentation: 

 ▪ C3\Rock Band Network 
documentation

 ▪ CAT User manual and docs

 ▪ Venuegen User Manual

 ▪ Rock Band DIrected Cut 
Notation

 ▪ C3 Forum posts

 ▪ C3 Discord author 
discussions

The content reproduced from 
these sources has been edited 
or re-written for clarity. This is 
so that this book is easy to read 
and understand. This content 
makes up the majority of the 
text in this book. 

This means that the majority 
of the content in this book is 
not orginal. But extra content, 
graphics, and examples, have 
been added as needed. 

The result is a visually engaging 
and easy to read text for all 
Rock Band custom authors. 

Rock Band 3 © 2010 
Harmonix Music 
Systems. The Rock 
Band 3 Customs Book 
is not affiliated with 
Harmonix, MTV Games, 
Mad Catz, or EA.
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Thank you for picking up this 
book. I wrote it as a guide for two 
different types of people:

 ▪ Those who want to learn how to author Rock Band 3 songs 
from scratch

 ▪ Anyone else who wants a thoughtfully organized resource 
for authoring customs

To follow along you will need a Windows PC or laptop and 
software called REAPER. To play your finished songs you will 
need an Xbox 360 and Rock Band 3 instruments. 

REAPER is free to try for 30 days. After your trial ends REAPER 
will remind you to buy a license. Discounted licenses are 
available for personal use from reaper.fm.

The goal of this book is to take you 
from an .mp3 of your favorite song 
to a full band, full difficulty, Rock 
Band 3 custom.
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Focus pages have a dark background. They help 
you understand key topics.

Authoring pages explain the rules for authoring 
guitar, bass, drums, keys and vocals.

Summary pages are at the end of each chapter. 
They remind you of the key points in each chapter.

Reduction pages show Expert charts and 
reductions for Hard, Medium, and Easy. Some 
charts show reductions for one difficulty.

Basic Install and Configuration pages show step-
by-step instructions with screenshots.

Detailed Configuration pages explain longer 
processes one step at a time. 

5

Background pages explain the topics covered in 
each chapter.

Introduction pages are at the beginning of each 
chapter. They introduce you to the key topics that 
you will learn.

ABOUT THIS BOOK

This book has been written to help you learn. The 
text is easy to read and the graphics are colorful 
and simple to understand. 

Each page covers a single topic and individual 
topics are easy to find. Flip through the book or 
look in the index to find what you are looking for.

Yellow squares call out important 
information and actions to take.

Blue squares contain other useful 
information.
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If you are new to Rock Band, welcome! You will 
need a good understanding of the game before 
you start authoring.

SCORING
Rock Band 3 has a few different 
mechanics for scoring. These 
mechanics help to boost your 
game score:

 ▪ Overdrive phrases are 
individual sections of white 
gems. When played they 
increase the player’s energy 
meter. When the meter is 
at least half full you can 
activate Overdrive for score 
multipliers

 ▪ Unison phrases are sections 
of white gems that the 
whole band plays together. 
When played in unison they 
result in a band bonus

 ▪ Big Rock Endings (BRE) are 
at the end of some songs. 
The band rocks out in free-
form lanes to build up their 
bonus score. All players have 
to land the final note(s) to 
score the bonus

GUITAR & KEYS
Basic guitar and keys both use 
only five notes. The notes are 
Green, Red, Yellow, Blue, and 
Orange:  

 ▪ Low notes are on Green

 ▪ High notes are on Orange

 ▪ Chords are two or three 
notes played together at the 
same time

 ▪ Sustained notes are notes 
that you hold down for as 
long as you hear them. They 
appear as notes with a tail 
on the game track.

Basic guitar features HOPOs 
(Hammer-On and Pull-Offs). 
This is a guitar technique where 
you use one hand to play fast 
runs of notes. In Rock Band 
HOPOs are smaller gems for 
guitar and bass that you do not 
need to strum.

DRUMS 
There are basic and Pro drum 
kits available for Rock Band. The 
basic drums have four colored 
pads and a kick pedal: 

 ▪ The Snare is on Red

 ▪ Hi-hat and first rack tom are 
on Yellow

 ▪ Ride cymbal and second 
rack tom are on Blue

 ▪ Crash cymbal and floor tom 
are on the Green

 ▪ Kick is on the Orange bar

The Pro drums expand this 
basic layout to include 
dedicated hi-hat, ride, and 
crash cymbals. You play Pro 
cymbals on the Yellow, Blue and 
Green cymbal gems. 

The facing page shows a simple 
Pro drums layout. 

Hi-hat

Ride 

Crash

Rack toms

Snare

Floor tom
Kick

ROCK BAND BASICS
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Rock Band 3 is now over 10 
years old. So hopefully you 
already have the hardware 
needed to play Rock Band 
songs. If not, search the second-
hand market for used consoles, 
instruments, and adapters. 

Below is a list of everything that 
you will need to author songs 
and play them on your Xbox: 

PC or laptop: Your PC doesn’t 
need to be very powerful to 
author custom songs. For 
example, I use a mid-range PC 
from 2011 running Windows 10.   

Xbox 360: Look for refurbished 
and used Xbox 360s on Ebay or 
Amazon. You will need Operating 
System version 2.0.17349.0 or 
higher. The date of this version 
is 04/30/2015.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers. I recommend 
using wired headphones over 
bluetooth ones. 

Rock Band 3 instruments: 
You can find used plastic 
instruments on websites such 
as eBay. 

Replacement strum bars 
and fret switches for Rock 
Band guitars are available at  
bytearts.com.

Players interested in Pro drums 
can buy an electronic drum set 
(or e-kit). Make sure it has a 
MIDI out port. You will also need 
to buy a Rock Band 3 MIDI Pro 
Adapter. 

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For online play on Xbox 
Live you will need a 1Gb drive.

Software: We will cover all the  
software that you will need in 
the next few chapters.

PlayStation 3 and Wii: There are 
extra steps that you need to 
take to play customs on these 
platforms:

 ▪ You need to have a custom 
firmware (jailbroken) 
PlayStation

 ▪ You need to install a soft-
mod on your Wii

 ▪ You will have to convert 
customs to play them on the 
Wii or PlayStation

 ▪ Converting customs to the 
Wii is not a simple process.

So for this book, we will focus 
on producing customs for the 
Xbox 360.

WHAT DO YOU NEED? 

To author and play custom songs you need a 
Windows PC, a 7th generation console, and 
Rock Band 3 instruments. 

https://bytearts.com
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IS AUTHORING HARD TO 
LEARN? 

When I first started to chart 
customs I was intimidated by 
how much there was to learn.

There were a lot of forum posts 
to search through and read. 
There was a lot of software to 
install and configure. On top of 
that the official documentation 
was not very beginner friendly. 

The truth is that while customs 
may look complicated they don’t 
have to be hard to understand. 
And you don’t need to be a 
professional musician to make 
customs songs either.

This book breaks everything 
down into small parts. This lets 
you find and focus on the things 
that you need to learn. 

If you are new to authoring 
you don’t have to try and learn 
everything at once. You can 
gain experience working, or 
practising, on existing customs 
if you would like. 

For example, if you are a 
drummer you might want 
to add drums to a song that 
doesn’t have them. You might 
be surprised at how many guitar 
only customs there are.

If you play Rock Band casually 
with friends you might want to 
start with reductions. 

Reductions are the hard, 
medium, and easy charts for 
each instrument. There are 
plenty of custom songs that 
are expert only or do not have 
authored reductions.

In either case reach out to the 
original author for permission to 
work on their custom song. 

If you want to author your own 
custom from scratch then 
follow along with this book step 
by step. You will learn how to:

 ▪ Tempo map your song

 ▪ Chart each Rock Band 
instrument 

 ▪ Compile your custom song 
package for your Xbox 360

It is very important to learn how 
to tempo map. Tempo mapping 
makes sure that your notes are 
in time with the music.

There are a few tempo mapping 
methods detailed In this book.  
Try them out and find the one 
that you like best.

Finally, some advice to help you 
get started: 

 ▪ Choose a short simple song 
for your first custom

 ▪ Understand the basics 
before you try to tackle 
more difficult songs

 ▪ Focus on tempo mapping 
first, then chart the Rock 
Band instruments

 ▪ Start with the expert chart 
and then chart the other 
difficulties one at a time

 ▪ Follow the authoring 
rules for each Rock Band 
instrument and difficulty

You don’t need to be a professional musician 
to make songs for Rock Band. Any musical 
knowledge that you have will help.
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C3
The C3 community creates 
custom content for Rock Band. 
The community started in 
2013 when Harmonix stopped 
producing new content for 
Rock Band 3. Customs authors 
came together to create “one 
more week” of DLC for the 
community. That “one week” 
turned into a couple of years of 
weekly content (until Rock Band 
4 was released).  

Today the C3 community is still 
thriving. Many tools have been 
developed to help customs 
authors. Some tools are still in 
active development.

The annual Chart-A-Thon 
raises money for charity and 
brings many rhythm gaming 
communities together. This is a  
true testament to the passion 
of the community. 

The C3 community welcomes 
anyone who wants to author or 
play custom songs for the Rock 
Band games! 

RGW
Rhythm Gaming World (RGW)
is a global platform for rhythm 
gaming communities. Its 
mission is to:

 ▪ Host as many communities 
as possible

 ▪ Create custom content

 ▪ Provide information and 
tools to create custom 
content

 ▪ Disallow piracy and support 
the purchase of original 
content for any game

 ▪ Build a respectful 
community 

 ▪ Encourage freedom of 
thought and honest 
constructive dialogue

The C3 community posts 
updates on RGW!

Join Rhythm Gaming World at: 
rhythmgamingworld.com

RHYTHMVERSE
RhythmVerse is the platform 
where you can create and find 
content for rhythm games:

 ▪ Clone Hero

 ▪ YARG

 ▪ Rock Band 3, and many more!

The RhythmVerse platform 
offers many benefits to authors, 
players, and communities:

 ▪ Free external hosting

 ▪ The definitive archive for 
custom content

 ▪ For authors: automatic 
parsing of metadata, preview 
links, comments, and more

 ▪ For players: Extensive search 
and filter options. Like and 
follow your favorite creators!

Join RhythmVerse at: 
rhythmverse.co

Discord: https://discord.gg/
N6Mpv8p6F4

C3, RHYTHM GAMING WORLD, 
AND RHYTHMVERSE

Upgrade your rhythm gaming experience with 
Rhythm Gaming World and RhythmVerse!

13 INTRODUCTION

https://rhythmgamingworld.com/
https://rhythmverse.co/
https://discord.gg/N6Mpv8p6F4
https://discord.gg/N6Mpv8p6F4
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SOFTWARE 
INSTALL
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We use same software that Harmonix used to  
create songs for Rock Band.  

AUTHORING  
SOFTWAREIn this chapter we install the 

software and tools that you need to 
create custom songs.

On the facing page is a list of software needed to make 
customs. It looks like a lot, but many of these tools can be 
simply un-zipped and copied to a new directory. 

To help you with installation you can use the Cheat Sheets on 
pages 23 — 24. Or, if you prefer, you can find step-by-step 
instructions starting on page 25. On page 45 we will look 
at some extra tools that you might want to install. 

Prerequisites: Your computer needs to have version 4 of 
the .NET Framework. It is pre-installed on Windows 8 — 11. 
On Windows 7 it is installed by Windows Update. You will 
need Microsoft Visual C++ 2010 to use Nautilus. To convert 
customs to the PlayStation 3 you will need the Java Runtime 
Environment (JRE). 

Legacy or Modern authoring software: You can choose to use 
a legacy or modern software setup. The legacy setup uses 
32-bit software including Python 2. You can install it on 32 or 
64-bit versions of Windows. The modern software setup uses 
32 or 64-bit versions with Python 3. Do not mix 32 and 64 bit 
versions of REAPER and Python together. 

At the end of this chapter you will have a powerful suite of 
tools to help you author. These tools will save you a lot of time 
and effort, so let’s get installing!

REAPER
REAPER is a digital audio 
workstation developed by 
Cockos. We use it to create 
Rock Band MIDI files. 

This chapter includes guides for 
legacy and modern versions of 
REAPER. Version 4.22 from April 
2012 is the recommended legacy 
version. Follow the modern 
REAPER setup guide to use 
current REAPER features and 
Python (pages 41 - 44).

RBN TOOLS
Harmonix developed The Rock 
Band Network (RBN) Tools.  
They install REAPER actions, a 
preview window, color maps, 
and key maps. 

Actions customize REAPER. 
Color maps change the color of 
MIDI notes for Rock Band. Key 
maps change templates and 
fields in REAPER for Rock Band. 

CUSTOM TOOLS
Custom Tools is a collection 
of files used in REAPER. Files 
include the C3 Custom RB3 
Template, note name files, and 
audio samples for the song 
count-in. 

MAGMA C3
Magma combines Rock Band 
MIDI and audio files into 
customs for the Xbox 360. 
These files are known as CON 
files, or rb3con files. 

NAUTILUS
Nautilus is an open source set 
of tools for managing customs. 
These tools help you edit CON 
files, make packs, and convert 
customs to other platforms. 

Note: Nautilus was previously 
known as C3 Tools.

PYTHON 2.7
Python is a programming 
language. It is required for the 
C3 Automation Tools (CAT). 

CAT
The C3 Automation Tools 
(CAT) are a set of scripts that 
automate tasks in REAPER. 
These scripts simplify many 
repetitive tasks and will save 
you a lot of time. They are an 
essential tool to learn.

W1 LIMITER
The W1 Limiter is an audio 
plugin used to limit audio 
track volume. It ensures a 
more consistent volume level 
between songs.

17

Note: This book uses C:\ as the recommended install directory 
for some software. This is for ease of communication. You can 
install to other directories of your choice if you prefer.

https://github.com/trojannemo/Nautilus
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REAPER 
(v4.22 32-bit - Legacy) 
reaper.fm/download-
old.php?ver=4x

Modern install guide is 
on pages 41 - 44.

RBN Tools 
 
rhythmgamingworld.
com/c3-authoring-
tools/

Custom Tools 
 
rhythmgamingworld.
com/c3-authoring-
tools/

Magma  
 
nemosnautilus.com/
magma/

Nautilus 
 
nemosnautilus.com/
nautilus/

Python 2.7 
 
python.org/
downloads/release/
python-2718/

W1 Limiter 
 
yohng.com/software/
w1limit.html

Audio to MIDI Template 
 
rhythmgamingworld.
com/c3-authoring-
tools/

.NET Framework 
 
dotnet.microsoft.
com/en-us/download/
dotnet-framework

Visual C++ 2010 
 
learn.microsoft.
com/en-us/
cpp/?view=msvc-170

Java Runtime 
 
java.com/en/
download/windows_
manual.jsp

Onyx  
 
github.com/mtolly/
onyx

Tux Guitar 
 
sourceforge.net/
projects/tuxguitar/

cPlayer 
 
https://bit.ly/
nemoCPLAYER

Miniconda  
 
docs.conda.io/
projects/miniconda/
en/latest/w

Universal Vocal Remover 
 
https://ultimate 
vocalremover.com/

GH Demucs GUI 
 
github.com/IMF24/
gh-demucs-gui 
 
(No Longer Supported)

CAT 
 
github.com/
abefacciazzi/CAT/
releases/

CONVERSION AND 
PREVIEW TOOLS

AUDIO SEPARA-
TION SOFTWARE 

https://www.reaper.fm/download-old.php?ver=4x
https://www.reaper.fm/download-old.php?ver=4x
https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
http://nemosnautilus.com/magma/
http://nemosnautilus.com/magma/
http://nemosnautilus.com/nautilus/
http://nemosnautilus.com/nautilus/
https://www.python.org/downloads/release/python-2718/
https://www.python.org/downloads/release/python-2718/
https://www.python.org/downloads/release/python-2718/
http://www.yohng.com/software/w1limit.html
http://www.yohng.com/software/w1limit.html
https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
https://dotnet.microsoft.com/en-us/download/dotnet-framework
https://dotnet.microsoft.com/en-us/download/dotnet-framework
https://dotnet.microsoft.com/en-us/download/dotnet-framework
https://learn.microsoft.com/en-us/cpp/?view=msvc-170
https://learn.microsoft.com/en-us/cpp/?view=msvc-170
https://learn.microsoft.com/en-us/cpp/?view=msvc-170
https://www.java.com/en/download/windows_manual.jsp
https://www.java.com/en/download/windows_manual.jsp
https://www.java.com/en/download/windows_manual.jsp
https://github.com/mtolly/onyx
https://github.com/mtolly/onyx
https://sourceforge.net/projects/tuxguitar/
https://sourceforge.net/projects/tuxguitar/
https://bit.ly/nemoCPLAYER
https://bit.ly/nemoCPLAYER
https://docs.conda.io/projects/miniconda/en/latest/
https://docs.conda.io/projects/miniconda/en/latest/
https://docs.conda.io/projects/miniconda/en/latest/
https://ultimatevocalremover.com/
https://ultimatevocalremover.com/
https://github.com/IMF24/gh-demucs-gui
https://github.com/IMF24/gh-demucs-gui
https://github.com/abefacciazzi/CAT/releases/
https://github.com/abefacciazzi/CAT/releases/
https://github.com/abefacciazzi/CAT/releases/
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Nautilus requires Microsoft Visual C++ 2010 and 
the Java Runtime Environment.

OTHER  
DEPENDENCIES

The .NET Framework provides 
libraries and tools to build and 
run software on Windows. It 
is included in installations of 
Windows 8 — 11. On Windows 7 
you should run Windows Update 
to install .NET. 

Follow these steps to check if 
.NET is installed or to check the 
version number:

 ▪ Open File Explorer and 
browse to C:\Windows\
Microsoft.NET\Framework

 ▪ Open the folder that has the 
highest version number

 ▪ Right-click on any of the 
.dll files and then select 
Properties from the menu 

 ▪ Click the Details tab. The 
Product version value 
will show you your .NET 
Framework version

The .NET Framework 4 is required by Magma C3 
and Nautilus.

.NET 
FRAMEWORK  

Install .NET Framework 
4 if you need to.

VISUAL C++ 2010
The Visual C++ 2010 
Redistributable contains 
libraries for the C programming 
language. Nautilus depends on 
these libraries for functions. 

Download: Follow the Visual 
C++ 2010 link in the Download 
Directory (page 20).

 ▪ Click the Visual Studio 2010 
(VC++ 10.0) SP1 (no longer 
supported) link

 ▪ Click the vcredist_x86.exe 
link for the x86 architecture 
(version 10.0.402191.325)

Install Visual C++ 2010 to its 
default location.

JAVA RUNTIME
The Java Runtime Environment 
(JRE) contains libraries for the 
JAVA programming language. 
Nautilus use these libraries 
to convert customs for the 
PlayStation 3.

Download: Follow the Java 
Runtime Environment link found 
on page 20:

 ▪ Click the Windows Offline 
link for the latest Java 
Runtime version

 ▪ Install Java Runtime to its 
default location

Install Visual C++ 
2010 before you install 
Nautilus. 

The Java Runtime is 
only needed if you want 
to convert customs to 
the PlayStation 3.

Download: Follow the .NET 
Framework link on page 20.

Download and install the 
latest 4.x version of the .NET 
Framework.

Note: .NET 7 is required to 
decrypt YARG .yargsong files 
and Clone Hero .sng files.
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INSTALL 
CHEAT SHEET 

SOFTWARE INSTALL

Un-zip these tools and copy their contents to 
the recommended directories.

REAPER 4.22
Default install directory:  
C:\Program Files (x86)\
REAPER

Recommended install directory: 
C:\REAPER

 ▪ Check the Portable install 
checkbox during installation 

Note: A portable installation is 
suggested because you might 
also want to run a more up-
to-date version of REAPER. A 
portable version also makes it 
easy to back-up your REAPER 
install and configuration.

 ▪ Pin reaper.exe to the Start 
Menu, desktop or taskbar

PYTHON 2.x
Default install directory: 
C:\Python27\

The C3 Automation Tools (CAT) 
require Python 2.x.

RBN TOOLS
Default install directory:  
C:\Program Files (x86)\
REAPER

Recommended install directory: 
C:\REAPER

 ▪ Install the RBN Tools to the 
same directory as REAPER W1 LIMITER

Un-zip files to:   
C:\Downloads\W1 Limiter

 ▪ Copy George Yohng’s W1 
Limiter.dll to the Plugins\
FX directory in your REAPER 
install

NAUTILUS
Un-zip files to:  
C:\Nautilus

 ▪ Pin Nautilus.exe to the 
Start Menu, desktop or 
taskbar

CUSTOM TOOLS
Un-zip files to:  
C:\Custom Tools

 ▪ Copy the C3 Custom RB3 
Template.RRP file to C:\
REAPER\ProjectTemplates

Un-zip files to:   
C:\Magma

 ▪ Pin Magma.exe to the Start 
Menu, desktop or taskbar

MAGMA

Un-zip files to:  
C:\CAT

CAT

.ZIP FILES 
CHEAT SHEET 

Do not install Magma 
C3 in the C:\Program 
Files directory. If you 
do your customs will 
randomly crash when 
played on your Xbox.

Use the recommended 
directories to follow 
along with the rest of 
this book.

Install this software to the recommended directories.



INSTALL REAPER

Follow the download link for 
REAPER 4.22 on page 19:

 ▪ Open File Explorer

 ▪ Browse to your Downloads 
folder

 ▪ Double-click on reaper422-
install.exe 

The License Agreement will 
open.

 ▪ Click the I Agree button

 

1

2
The Choose Install Location 
dialogue will open:

 ▪ Check the Portable install 
checkbox * 
 
* This will let you install 
other versions of REAPER

 ▪ Change the default install 
folder to: C:\REAPER

 ▪ Click the Next button

Note: A portable install makes it 
easy to back-up REAPER.
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You will not be able to check 
the following checkboxes during 
a portable install:

 ▪ Desktop icon

 ▪ Start menu shortcuts

 ▪ Associate with RPP (Reaper 
Project) files

Click the Install button to 
continue.

3

4
Installation will complete:

 ▪ Click the Close button

A pop-up window will ask you if 
you want to run REAPER. 

 ▪ Click No

Pin reaper.exe to the Start 
Menu, desktop or taskbar.

INSTALL REAPER 2
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NETWORK TOOLS
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The Installation Complete 
dialogue will open:

 ▪ Click the Close button

A pop-up window will ask you if 
you want to run REAPER: 

 ▪ Click No to complete 
installation

The Choose Install Location 
dialogue will open:

 ▪ Choose your REAPER 
installation path. To follow 
along with this book use the 
path C:\Reaper

 ▪ Click the Install button

27 SOFTWARE INSTALL

2
The Choose Components 
dialogue will open:

 ▪ Check all the checkboxes 
in the Choose Components 
window

This will install the RBN preview 
window, templates, presets, and 
REAPER customizations. 

Download RBN Tools from: 
rhythmgamingworld.com

 ▪ Open File Explorer

 ▪ Browse to your Downloads 
folder

 ▪ Double-click on rbn2-install.
exe

The License Agreement will 
open: 

 ▪ Click the I Agree button

1 3

4

RBN TOOLS 2
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Installation will complete:

 ▪ Click the Finish button

You do not need to customize 
your Python install: 

 ▪ Click the Next button

The default installation folder is 
C:\Python27. 

 ▪ Click the Next button

2

Use the download link for 
Python on page 19:

 ▪ Open File Explorer

 ▪ Browse to your Downloads 
folder

 ▪ Double-click on the Python 
installer 

The Install for all users radio 
button is pre-selected: 

 ▪ Click the Next button

1

4

INSTALL PYTHON

3

INSTALL PYTHON 2
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A new File Explorer window 
will open to show the extracted 
files.

Pin Nautilus.exe to the Start 
Menu, desktop or taskbar.

Click the Close button and 
then click No to finish installing 
REAPER.

4

3

The Extract Compressed 
(Zipped) Folders window will 
open:

 ▪ Check the Show extracted 
files when complete 
checkbox 

 ▪ In the Select a Destination 
and Extract Files field type: 
C:\Nautilus

 ▪ Click the Extract button

Download Nautilus from: 
nemosnautilus.com/
nautilus/

Open File Explorer:

 ▪ Browse to your Downloads 
folder

 ▪ Right click on the nautilus 
.zip file

 ▪ Select Extract All from the 
context menu

1

2

Nautilus 2

https://nemosnautilus.com/nautilus/
https://nemosnautilus.com/nautilus/


Click the Close button and 
then click No to finish installing 
REAPER.

4
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A new File Explorer window 
will open to show the extracted 
files.

To configure CAT in REAPER see 
pages 91 — 94.

Use the download link for CAT 
on page 19:

Open File Explorer:

 ▪ Browse to your Downloads 
folder

 ▪ Right click on the CAT .zip 
file

 ▪ Select Extract All from the 
context menu

The Extract Compressed 
(Zipped) Folders window will 
open:

 ▪ Check the Show extracted 
files when complete 
checkbox 

 ▪ In the Select a Destination 
and Extract Files field type: 
C:\CAT

 ▪ Click the Extract button

3

2

1

INSTALL C3 AUTOMATION 
TOOLS (CAT)

INSTALL C3 AUTOMATION 
TOOLS (CAT) 2



In File Explorer:

 ▪ Browse to C:\REAPER\
ProjectTemplates

 ▪ Press Ctrl + V to paste the 
C3 Custom RB3 Template.
RRP file into the folder

The C3 Template is now in the 
correct REAPER folder.

4
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1
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The Extract Compressed 
(Zipped) Folders window will 
open:

 ▪ Check the Show extracted 
files when complete 
checkbox 

 ▪ In the Select a Destination 
and Extract Files field type: 
C:\Custom Tools

 ▪ Click the Extract button

2

A new File Explorer window 
will open to show the extracted 
files:

 ▪ Select the C3 Custom RB3 
Template.RRP file:

 ▪ Press Ctrl + C to copy the 
file 

3
Download Custom Tools from: 
rhythmgamingworld.com

Open File Explorer:

 ▪ Browse to your Downloads 
folder

 ▪ Right click on the Custom 
Tools .zip file

 ▪ Select Extract All from the 
context menu

INSTALL CUSTOM TOOLS

http://rhythmgamingworld.com
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Download Magma from: 
nemosnautilus.com/magma

Open File Explorer:

 ▪ Browse to your Downloads 
folder

 ▪ Right click on the Magma 
.zip file

 ▪ Select Extract All from the 
context menu

The Extract Compressed 
(Zipped) Folders window will 
open:

 ▪ Check the Show extracted 
files when complete 
checkbox 

 ▪ In the Select a Destination 
and Extract Files field type: 
C:\Magma

 ▪ Click the Extract button

 ▪ Open the Magma C3 folder. 

 ▪ Press Ctrl + V to paste files 
into the folder

Pin Magma C3 to the Taskbar:

 ▪ Right click on MagmaC3.exe

 ▪ Select Pin to Taskbar from 
the context menu.

4

A new File Explorer window 
will open to show the extracted 
files:

Pin Magma.exe to the Start 
Menu, desktop or taskbar.

1

INSTALL MAGMA

2

3

Do not install Magma in 
the C:\Program Files 
directory. If you do your 
customs will randomly 
crash when played on 
your Xbox.

https://nemosnautilus.com/magma
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Follow the download link for W1 
Limiter on page 19:

Open File Explorer:

 ▪ Browse to your Downloads 
folder

 ▪ Double-click: 
w1limiter-win.zip 

The .zip file will open:

 ▪ Select the George Yohng’s 
W1 Limiter.dll file

Do not select the x64 version of 
the W1 Limiter file.

 ▪ Press Ctrl + C to copy the 
file to the clipboard

In the C:\REAPER\Plugins\FX 
folder: 

 ▪ Press Ctrl + V to paste the 
file from the clipboard into 
the folder

Open a new File Explorer 
window:

 ▪ Browse to:  
C:\REAPER\Plugins\FX

4

31

2

INSTALL W1 LIMITER INSTALL W1 LIMITER 2
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Follow this guide to install a modern version of 
REAPER and Python 3. 

MODERN SETUP GUIDE FOR 
REAPER AND PYTHON 3 

INTRODUCTION
Reaper v4.22 was released 
in April 2012. It has been 
recommended for authoring for 
a very long time. Many authors 
have moved on to more modern 
versions of REAPER. This has 
several advantages:

 ▪ New REAPER features

 ▪ REAPER Extensions

 ▪ Python 3

Many thanks to Sean for sharing 
this guide and developing a fork 
of CAT for Python 3.  
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REAPER
Download the latest version of 
REAPER:

https://www.reaper.fm/
download.php

Install either the 32-bit or 64-
bit version of REAPER. Make a 
note of which one you install.

Note: During installation you 
can choose a Portable install. 
This will keep all of REAPER’s 
files together in a single folder. 
This makes it easy to backup 
REAPER or move it to a different 
location if you want to do that.

You can say no to opening 
REAPER or the RBN tools until 
we are ready.

RBN TOOLS
The Rock Band Network Tools 
are optional, but recommended.

Download the RBN Tools, then 
extract and install them to the 
same folder that you installed 
REAPER. For example: C:\
Reaper.

For 64-bit Reaper also install 
the 64-bit plugin.

Extract the rbprev_vst64_
beta.dll file and copy it to 
the Plugins\FX folder in your 
Reaper install. For example C:\
Reaper\Plugins\FX.

PYTHON 3
Download the latest version of 
the Python 3 installer:

https://www.python.org/
downloads/windows/

 ▪ Click the Latest Python 3 
Release - Python 3.xx link on 
the download page.

 ▪ Scroll down and select 
either the Windows installer 
(64-bit) or Windows installer 
(32-bit) option, matching the 
architecture (32 or 64-bit) of 
REAPER that you installed.

For the sake of this guide, we  
assume that we are only using 
this version of Python with 
REAPER, and we do not want it 
to interfere with anything else.  
 
Because of this, we need to 
make some changes to the 
install:

 ▪ Open the installer, and click 
Customize installation. 

 ▪ Under Optional Features, 
click Next.

 ▪ (Advanced, Optional) We only 
really need tk here. You can 
proceed with only tcl/tk and 
IDLE checked. It is very easy 
to re-run the installer to 
get anything else you might 
need later.

 ▪ Under Advanced Options, 
un-check every checkbox.

 ▪ Customize the install 
location. Put it somewhere 
you have access to and will 
not forget.  
 
I like to keep my Python 
install inside of REAPER’s 
install folder.  
 
For example, I put my 
Python in D:\REAPER\
Python3. Do not install it in 
the default Python folder 
(we don’t want to interfere 
with the system Python).

REAPER SETUP
Launch REAPER:

 ▪ On first launch, select an 
audio device. This will put 
us into the configuration 
window for future changes.

 ▪ If you installed an older 
version of REAPER and plan 
to stay there, un-check 
the Check for new versions 
box. Close the window 
that appears asking you to 
update.

 ▪ Click Options > Preferences.  
Then go to Plug-ins > 
ReaScript: 
 
REAPER 4: Check Enable at 
the top of the window. 
 
Modern REAPER: Under 
Python, check Enable 
Python for use with 
ReaScript.

Continued on the next page.

Do not mix 32 and 64-
bit versions of REAPER 
and Python. Only 
use 32 bit or 64-bit 
versions of REAPER and 
Python. 

https://www.reaper.fm/download.php
https://www.reaper.fm/download.php
https://rhythmgamingworld.com/wp-content/uploads/2024/05/rbn2-install.zip
https://rhythmgamingworld.com/wp-content/uploads/2024/05/rbprev_vst64_beta.zip
https://www.python.org/downloads/windows/
https://www.python.org/downloads/windows/
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Make sure that REAPER detects your Python 
location correctly. 

MODERN SETUP GUIDE FOR 
REAPER AND PYTHON 3 
(CONTINUED)

 
REAPER SETUP

 ▪ Under ReaScript, make 
sure both Clear ReaScript 
console options are enabled 
for the best experience with 
CARV and Joule.

 ▪ Under Custom path to 
(Python) dll, put your install 
location for Python.

 ▪ Under Force Python to use 
.dll: / Force ReaScript to 
use specific Python .dll:, you 
need to use the specific DLL 
for the version you installed. 
 
For example, if you installed 
Python 3.13, the DLL will be 
python313.dll. 
 
For other versions, you can 
check the DLL name by 
entering the folder. You do 
not want to use python3.dll, 
it will not work.

MODERN SETUP GUIDE END
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 ▪ After setting these options, 
you should see a message 
like python313.dll is 
installed. This is how you 
know that you have set the 
location correctly.

 ▪ You will get a message that 
REAPER may need to be 
restarted for Python to work. 
You may as well do this, just 
to be safe.

SCRIPTS
Download Scripts:

C3 Automation Tools (CAT):

https://github.com/
SuperRiderTH/CAT/archive/refs/
heads/python3-main.zip

My fork of CAT includes CARV 
and is designed to work with 
Python 3. It should work with 
every version of REAPER (v4.22 
and higher).  
 
Joule (Optional):

https://github.com/
SuperRiderTH/joule/archive/
refs/heads/main.zip

Joule a new validation tool that 
I have developed to get around 
some of the limitations that 
CARV had. It does not have a 
fancy web interface yet, but 
it can be run with or without 
REAPER and gives you an easy 
to read output file.

 
 

Joule includes all the checks 
that CARV has, and extra checks 
such as if notes will appear off 
the lane in Pro Keys.

If you run Joule in REAPER, the 
output.json file will be in the 
output folder next to joule.py. 
Unlike CARV, this will not open 
automatically because there is 
not a web page. 
 
Joule also behaves slightly 
different than CARV, and will 
ignore any muted tracks in 
REAPER, matching the behavior 
of a MIDI export. 

By default, Joule supports the 
Expert+ kick notes (95) found on 
Drums. If a “PART DRUMS_2X” 
track is not found or muted, it 
will automatically run checks on 
a new 2X track internally. This 
behavior can be disabled by 
setting IgnoreModNotes to True 
in joule_config.ini. 

See the GitHub page for 
additional configuration and 
usage options.

EXTRACT SCRIPTS
Inside the downloaded zip files 
you will find a folder like CAT-
python3-main or joule-main. 
Put these folders inside the 
REAPER Scripts folder.

To find this location:

 ▪ Select Options in the 
REAPER window.

 ▪ Click the Show REAPER 
resource path in explorer/
finder option in the menu.

 ▪ In Windows File explorer 
open the Scripts folder.

 ▪ Copy the required folders 
into the Scripts folder. 

SETUP SCRIPTS
 ▪ In REAPER, select Actions > 

Show action list

 ▪ REAPER 4: Select New/load 
next to ReaScript:

 ▪ Modern REAPER: Under 
New action, select Load 
ReaScript:

 ▪ CAT: Navigate to the CAT-
python3-main folder in 
Scripts, and select CAT.py.

 ▪ (Optional) CARV: Navigate 
to the CARV folder in CAT-
python3-main, and select 
RBNCheck.py.

 ▪ Joule (Optional): Navigate 
to the joule-main folder in 
Scripts, and select joule.py.

Once these are added, you can 
now either run them from the 
Actions window, or configure 
REAPER hotkeys if you want to. 
 
You can set a shortcut in the 
bottom-left of the Actions 
window, or customize REAPER 
and add new buttons to the 
interface.

You are now free to do whatever 
you want inside REAPER!

https://github.com/SuperRiderTH/CAT/archive/refs/heads/python3-main.zip
https://github.com/SuperRiderTH/CAT/archive/refs/heads/python3-main.zip
https://github.com/SuperRiderTH/CAT/archive/refs/heads/python3-main.zip
https://github.com/SuperRiderTH/joule/archive/refs/heads/main.zip
https://github.com/SuperRiderTH/joule/archive/refs/heads/main.zip
https://github.com/SuperRiderTH/joule/archive/refs/heads/main.zip
https://github.com/SuperRiderTH/joule
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These tools are optional extras. Onyx and  
cPlayer can preview unencrypted customs. Tux 
Guitar can create MIDI files from pro guitar tabs.

ADDITIONAL 
TOOLS 

 

ONYX
Onyx is a build tool for Rock 
Band/Guitar Hero type games. It 
can import from a wide variety 
of sources including:

 ▪ Rock Band 1, 2, and 3

 ▪ Frets on Fire, Phase Shift, 
and Clone Hero

 ▪ Guitar Hero, Guitar Hero 
II, and Guitar Hero Encore: 
Rock the 80s

It includes extra features 
such as CAT-like automatic 
reductions and lip-sync file 
generation.

Onyx can preview all Rock Band 
instruments and difficulties. 
It can even preview all 
the difficulties for a single 
instrument at the same time 
(see facing page).

Note: Onyx does not support 
previews for vocals or pro keys. 
Onyx might not work on older 
versions of Windows.

CPLAYER
cPlayer can play and preview 
custom songs. It has different 
viewing modes, such as audio 
spectrum, karaoke, and MIDI 
chart. MIDI chart mode previews 
expert charts and includes pro 
keys, vocals, and harmonies. 

A great feature of cPlayer is that 
it can display individual note 
names. Use this feature for pro 
keys, vocals and harmonies.

cPlayer does not preview the 
lower instrument difficulties 
(Hard, Medium, or Easy).

Note: cPlayer takes a little time 
to process customs before 
playing them.

TUX GUITAR
Tux Guitar is an open-source 
tablature (tabs) editor. It 
supports the following pro 
tablature files:

 ▪ gp3, gp4, and gp5

Below you can see that pro 
tab files are a form of musical 
notation. Like regular tablature 
they show strings and finger 
positions. You can listen to pro 
tabs online or in Tux Guitar to 
hear how accurate they are.

There are no special 
instructions for 
installing these apps.

Download links are on 
pages 19 — 20.
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Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Install pre-requisites before installing other software.

 ▪ Install REAPER version 4.22.

 ▪ Install the RBN Tools to the same directory as REAPER.

 ▪ Do not install Magma C3 to the C:\Program Files 
directory.

 ▪ Color maps and key maps are a part of the RBN Tools.

 ▪ The C3 Custom RB3 Template, note name files, and count-
in audio files are part of the C3 Custom Tools.

 ▪ Magma C3 converts Rock Band MIDI and audio files into 
custom song files. 

 ▪ Use Nautilus to open, edit, convert, and manage custom 
song files.

 ▪ CAT automates authoring tasks in REAPER.
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 ▪ C3 Custom RB3 Template
 ▪ REAPER preferences
 ▪ REAPER Actions

REAPER 
CONFIGURATION

2
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Download links available from: 
rhythmgamingworld.com/customsbook
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At this point we have our core software 
installed. Our next step is to configure 
REAPER for Rock Band. 

In this chapter we will cover a wide range of topics. Some of 
them are convenient settings that will save you time. Others are 
essential parts of authoring songs for Rock Band. 

In the first half of the chapter we will work through REAPER 
Settings and Preferences. Pay particular attention to the C3 
Template, Project TimeBase and Scrub Settings. 

In the second half of the chapter we look at actions in REAPER. 
Actions are shortcuts for simple or complex tasks. We review 
how to create actions and assign keyboard shortcuts. We 
will then create some key actions that you will use later. This 
includes custom actions for:

 ▪ Tempo mapping

 ▪ Unison phrases

 ▪ Importing Lyrics

In the final few pages of the chapter we configure REAPER to 
run the C3 Automation Tools (CAT).

By the end of this chapter REAPER will be fine-tuned for 
authoring Rock Band songs! 

52

Note: This chapter 
guides you through 
the legacy software 
setup. The major 
steps required for the 
modern REAPER setup 
can be found in the 
previous chapter.
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42

31

SELECT AUDIO DEVICE
When you first open REAPER it prompts you to select an audio device.

Click the Audio system drop 
down menu:

 ▪ Select your audio system

The REAPER manual 
recommends selecting ASIO if 
your sound card supports it.

I use the default WaveOut 
option on my PC and laptop  
without any issues.

Your options will depend on 
your hardware.

When you first open REAPER 
you will see the You have not 
yet selected an audio device 
prompt:

 ▪ Would you like to select 
your audio device driver now 
(recommended)?

 ▪ Click the Yes button

The Audio device settings 
section of the Preferences 
window will open.

Click the Input Device menu:

 ▪ Select your microphone if 
found in the menu

Note: The Microsoft Sound 
Mapper option uses your system 
default input audio device.

Your options will depend on 
your hardware.

Click the Output Device menu:

 ▪ If you have headphones 
select them as your output 
device

Note: The Microsoft Sound 
Mapper option uses your system 
default output audio devices.

 ▪ Click OK to finalize your 
settings

SELECT AUDIO DEVICE 2
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When you open REAPER it prompts you to download a newer version. Load the C3 Custom RB3 Template in REAPER.

NEW VERSION NOTIFICATION

55 REAPER CONFIGURATION

LOAD C3 TEMPLATE

56REAPER CONFIGURATION

The C3 community will 
try to help you with 
any REAPER 4.22 issues 
that you experience. 
Community experience 
with other REAPER 
versions is more 
limited.

REAPER 4.22 is the version 
that Harmonix used to produce 
songs for Rock Band 3. Updating 
to a newer version is not 
recommended. *

When prompted follow these 
steps to stop REAPER checking 
for updates: 

 ▪ Uncheck the Check for new 
versions checkbox

 ▪ Click the Close button.

The C3 Custom RB3 Template 
includes the tracks and 
templates you need to author 
custom songs.

Follow the steps below to load 
the template in REAPER:

 ▪ Click File > Project 
templates 

 ▪ Select the C3 Custom RB3 
Template

The C3 template is a 
part of the Custom 
Tools download. If 
you do not see the 
template in REAPER 
refer to pages 35 — 
36 for installation 
instructions.

* C3 Authors have 
reported issues when 
sharing projects 
between different 
REAPER versions. This 
includes MIDI notes not 
being visible in the MIDI 
track.



REPLACE MISSING FILE

The Choose replacement file 
dialogue box will open:

 ▪ Browse to C:\Custom Tools

 ▪ Select the hihat.wav file

 ▪ Click the Open button 

The Choose replacement file 
dialogue box will close.

In REAPER:

 ▪ Click the File menu 

 ▪ Click Save project as

Note: The C3 Template is our 
main project file. In the next 
step we will overwrite the 
existing template. The change 
that we made in the previous 
step will be saved permanently. 

You can use this process to 
make other permanent changes 
to the C3 Template.

When you load the C3 Custom 
RB3 Template the Replace 
missing file dialogue opens.

It tells you that it cannot find 
the file hihat.wav.

hihat.wav is the default audio 
file for the COUNTIN track in the 
C3 Template.

Let’s fix it so that we don’t see 
that window again:

 ▪ Click the Browse for file 
button

2

58

1
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The Save Project dialogue box 
will open:

 ▪ Browse to C:\REAPER\
ProjectTemplates

 ▪ Select the C3 Custom RB3 
Template.RPP file 

 ▪ Click the Save button

The Confirm Save As dialogue 
box will open:

 ▪ Click the Yes button

3

When you open the C3 Template it prompts you to look for a missing file.

4



Set the C3 Template as the default for new projects.

In the Project settings area:

 ▪ Click the Browse button

I only use REAPER for creating 
customs. So when I open a new 
project I like REAPER to open 
the C3 Template. 

If you would also like to do this 
follow these steps.

Open the Preferences dialogue 
in REAPER:

 ▪ Click Options > Preferences

Shortcut: Press Ctrl + P

Choose Project from the list: 

 ▪ In the left-hand pane select 
Project

The Choose project dialogue will 
open:

 ▪ Browse to C:\REAPER\
ProjectTemplates

 ▪ Select the C3 Custom RB3 
Template.RPP file

 ▪ Click the Open button

The Choose project dialogue will 
close.

Close the Preferences dialogue:

 ▪ Click the OK button

When you launch REAPER the 
C3 Template will now load 
automatically. 

60REAPER CONFIGURATION59 REAPER CONFIGURATION

SET A DEFAULT TEMPLATE

2

1 3

4



The Choose replacement file 
dialogue box will close.

 ▪ Click the File menu 

 ▪ Click Save project as

62REAPER CONFIGURATION

Set the backup directory:

 ▪ Click the Browse button 

The Browse dialogue box will 
open:

 ▪ Browse to C:\Reaper 
Backup 

 ▪ Click OK 

The Browse dialogue will close. 
In REAPER:

 ▪ Click the OK button

Tip: Always check your backup 
folder for recent saves if 
REAPER crashes.

4

3
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Open the Preferences dialogue 
in REAPER:

 ▪ Click Options > Preferences

Shortcut: Press Ctrl + P

Choose Project from the list: 

 ▪ In the Left hand pane select 
Project

I recommend that you automate 
your project backups. Create a 
backup folder and set REAPER 
to save every five minutes.

Open File explorer:

 ▪ Browse to C:\

Create a backup folder:

 ▪ Press Ctrl + Shift + N

 ▪ Name the folder: Reaper 
Backup

 ▪ Press Enter

1

Set regular backups to save you from losing work.

AUTOMATE PROJECT BACKUP

2

In the Project saving area check 
the following checkboxes: 

 ▪ Save project file references 
with relative pathnames

 ▪ When overwriting project 
file, rename old project to 
.rpp-bak

 ▪ Save to timestamped file in 
additional directory

Set the backup frequency:

 ▪ In the Every [  ] minutes field 
type the value 5 
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1

2

The Project Settings window 
contains the Project BPM and 
Time Signature settings.

You do not need to change 
these settings. I have included 
them so that you can see where 
to find them in REAPER. 

In REAPER open Project 
Settings:

 ▪ Click File > Project Settings 

Shortcut: Press Alt + Enter.

63 REAPER CONFIGURATION

In the Project Settings dialogue:

 ▪ Find the Timebase for items/
envelopes/markers setting

 ▪ Use the drop down menu 
and select Time

 ▪ Click the OK button.

2

The Timebase setting is very 
important. It controls how 
REAPER will behave when you 
tempo map a song.

For now make sure that your 
Timebase is set to Time.

In REAPER open Project 
Settings:

 ▪ Click File > Project Settings 

Shortcut: Press Alt + Enter.

Review Project BPM and Time Signature settings.

1

PROJECT SETTINGS SET PROJECT TIMEBASE
Set your Project Timebase to: Time

The default Project BPM is 
120. BPM stands for Beats Per 
Minute. It refers to the tempo of 
a song. 

The default Time Signature is 
4/4. This is the most common 
time signature in music.

Unless you change these 
settings all new projects will 
have a starting BPM of 120 and a 
4/4 time signature.
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Make audio srcubbing a default behavior in REAPER. 

In the Scrub/jog settings area 
copy these settings:

 ▪ Limit jog rate to 1.0x

 ▪ Limit jog rate when near 
cursor

 ▪ Limit scrub rate to 1.0x

 ▪ Engage scrub when playing 
(stopping playback)

 ▪ Looped segment mode: -30 
ms to 30 ms

 ▪ When moving edit cursor via 
action or control surface: 
Scrub

Scrub settings are important for 
tempo mapping and authoring 
vocals in REAPER.

We will talk more about 
scrubbing when we get to the 
chapter on tempo mapping. 

For now, let’s make sure that 
our settings are correct.

Open the REAPER Playback 
Preferences:

 ▪ Press Ctrl + P

 ▪ Select Playback in the left-
hand pane

In the Mouse modifiers Context 
menu:

 ▪ Set the Context to: Edit 
cursor handle

Click the Default action 
modifier:

 ▪ Set the Behavior to Jog 
audio (looped-segment 
mode)

Confirm that the settings are 
correct:

 ▪ Click the OK button

Next open the settings for 
Mouse Modifiers:

 ▪ In the left-hand pane, under 
Editing Behavior select 
Mouse Modifiers

3

4

1

2

SCRUB SETTINGS SCRUB SETTINGS 2



4

3
Save your settings:

 ▪ Click the Presets button

 ▪ Select All Settings 

 ▪ Click Save Preset

The Render Preset dialogue will 
open:

 ▪ In the New Name field type: 
Render Song Audio

 ▪ Click the OK button

The Render Preset dialogue will 
close.

The preset is now complete. To 
recall this setting in the future, 
follow these steps:

 ▪ Click File > Render ... 

Shortcut: Press the Ctrl + Alt + 
R keys.

 ▪ Click the Presets button

 ▪ Select All Settings 

 ▪ Click Render Song Audio

68REAPER CONFIGURATION67 REAPER CONFIGURATION

Render presets allow you to 
export audio from REAPER with 
specific settings. 

Use this preset to export song 
audio for Magma and music 
separation.

In REAPER open the Render to 
file window:

 ▪ Click File > Render ... 

Shortcut: Press the Ctrl + Alt + 
R keys.

In the Options and Output 
format areas copy these 
settings:

 ▪ Sample rate: 44100 Hz

 ▪ Channels: Stereo

 ▪ Resample mode: Better 
(192pt Sinc - Slow)

 ▪ Output format: WAV

 ▪ WAV bit depth: 16 bit PCM

 ▪ Allow large files to use 
Wave64

1

Create a preset to render song audio.

RENDER PRESET #1

2

RENDER PRESET #1-2



4

1

2
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Save your settings:

 ▪ Click the Presets button

 ▪ Select All Settings 

 ▪ Click Save Preset

The Render Preset dialogue will 
open:

 ▪ In the New Name field type: 
Render Dryvox for Magma

 ▪ Click the OK button

The Render Preset dialogue will 
close.

The preset is now complete. To 
recall this setting in the future, 
follow these steps:

 ▪ Click File > Render ... 

Shortcut: Press the Ctrl + Alt + 
R keys.

 ▪ Click the Presets button

 ▪ Select All Settings 

 ▪ Click Render Dryvox for 
Magma.

In the Options and Output 
format areas copy these 
settings:

 ▪ Sample rate: 16000 Hz

 ▪ Channels: Mono

 ▪ Resample mode: Better 
(192pt Sinc - Slow)

 ▪ Output format: WAV

 ▪ WAV bit depth: 16 bit PCM

 ▪ Allow large files to use 
Wave64

Use this preset to export dry-
vox audio for Magma. Magma 
will use this audio to create 
lip-sync animations for in-game 
characters.

In REAPER open the Render to 
file window:

 ▪ Click the File menu

 ▪ Select Render ... 

Shortcut: Press the Ctrl + Alt + 
R keys.

Create a preset to render dry-vox audio for Magma.

RENDER PRESET #2

3

RENDER PRESET #2 2
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Build a list of actions to perform repeat or 
complex tasks. 

ACTIONS OVERVIEW: 
CUSTOM ACTIONS

REAPER CONFIGURATIONREAPER CONFIGURATION

This section introduces you to 
actions in REAPER. Over the 
next few pages we will review 
how actions work. We will then 
make our own custom actions 
for REAPER.

First, open the Actions window:

 ▪ Click Actions > Show action 
list

Shortcut: Press Shift + ?

Note: You can view six different 
lists of actions in this window. 
Use the Section drop down 
menu to see the list of actions.   

ACTIONS OVERVIEW: 
THE ACTIONS LIST 

Actions are used to automate tasks in REAPER. 
You can create an action for any task.

The Filter field. Input 
keywords to search for 
specific actions. 

1

2

2

1

The Section drop down 
menu. Select from the list 
of Action groups:

3 4

The New button. Create 
new custom actions.

The shortcut Add button. 
Assign keyboard shortcuts 
to actions.

5

3

4

Use the Filter field to 
search for actions. 

Double-click an action in 
the left pane to copy it to 
your custom actions list in 
the right pane.

1 This area shows your list 
of custom actions. 

To re-order the list select 
individual actions and 
drag them up or down.

To delete actions, first 
select them then click the 
Remove selected button.

3

Type a name for your 
custom action.

4

Click the New button in the 
Actions window to open the 
Create Custom Action window.

Use this window to chain a list 
of actions together. 

2

3 4

Click the OK button 
when your actions list is 
complete. 

5

5

5

List of actions and 
keyboard shortcuts.

1

2
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You can view and edit your 
custom actions in REAPER. 

Click the Edit button in the 
Actions window to open the 
Edit Custom Action window.

Use this window to view or edit 
custom actions if you need to.

View or edit custom actions.

Click the Add button in the 
Actions windows to open the 
Keyboard/MISC/OSC Input 
dialogue box.

Use this dialogue to assign 
keyboard shortcuts to actions:

 ▪ You can use single or 
multiple keys for action 
shortcuts 

 ▪ You can use special keys 
such as the Tab key 

 ▪ You can use the Shift and 
Ctrl keys in combination 
with other keystrokes

Note: You can use the same 
keyboard shortcut once in each 
section. Choose sections in the 
Actions window:

Assign a keyboard shortcut to a selected action.

ACTIONS OVERVIEW: 
EDIT ACTIONS 

ACTIONS OVERVIEW: 
KEYBOARD SHORTCUTS  

Select an action in the 
Actions window.

1

Click the Add button. 

This will open the 
Keyboard/MISC/OSC Input 
dialogue box.

In the Shortcut field type 
the shortcut key(s) that 
you want to assign.

2

3

Click the OK button.

The Keyboard/MISC/OSC 
Input dialogue box will 
close.

4

1

2

3

4

Select an action in the 
Actions window.

1

Click the Edit button. 

This will open the Edit 
Custom Action window.

View or edit actions here.

2

3

Click the OK button.

The Edit Custom Action 
window will close.

4

1

2

3

4

REAPER will warn you if a 
shortcut is already assigned to 
another action.

Turn the page to create 
custom actions for 
Rock Band!
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1 2 3
ABOUT THIS 
SHORTCUT

ACTION NAME

In the Create Custom Action 
field type:

 ▪ Set tempo by bar

Close the Create Custom Action 
dialogue:

 ▪ Click the OK button

4
In the Create Custom Action 
dialogue select these actions:

 ▪ Time selection: Set end 
point

 ▪ Move edit cursor back one 
beat

 ▪ Move edit cursor to start of 
current measure

 ▪ Time selection: Set start 
point

 ▪ Markers: Create measure 
from time selection (detect 
tempo)

SELECT ACTIONS

Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select Main:

Create a new custom action: 

 ▪ Click the New button

NEW CUSTOM 
ACTION

SHORTCUT 
INSTALL

The Q shortcut tempo maps a 
single measure based on the 
current time signature.

You can find this shortcut in the 
Main section of the Actions list. 
It is installed by the RBN Tools 
software package.

Q is the default shortcut for tempo mapping. 

TEMPO MAPPING  
SHORTCUT: Q 

If you cannot find the shortcut 
try reinstalling the RBN Tools 
software again.

Installation instructions are on 
pages 27 — 28.

If for some reason you still 
cannot find the shortcut, 
continue to step 2.

5
KEYBOARD 
SHORTCUT
In the Actions window: 

 ▪ Select the Custom: Set 
tempo by bar shortcut

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: Q

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close. 

In the Actions window:

 ▪ Click the Close button

Make sure that the Q 
shortcut exists.

You will need this 
shortcut when you 
start to tempo map 
your first song.
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1 2 3
ABOUT THIS 
SHORTCUT
The T shortcut tempo maps a 
single measure and changes the 
time signature.

You can find this shortcut in the 
Main section of the Actions list. 
It is installed by the RBN Tools 
software package.

If you cannot find the shortcut 
try reinstalling the RBN Tools 
software again. 

Installation instructions are on 
pages 27 — 28.

If for some reason you still 
cannot find the shortcut, 
continue to step 2.

Open the Actions window:

 ▪ Click the Actions > Show 
action list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select Main:

Create a new custom action: 

 ▪ Click the New button

In the Create Custom Action 
dialogue select these actions:

 ▪ Time selection: Set end 
point

 ▪ Move edit cursor back one 
beat

 ▪ Move edit cursor to start of 
current measure

 ▪ Time selection: Set start 
point

 ▪ Markers: Create measure 
from time selection (new 
time signature)

In the Create Custom Action 
field type:

 ▪ Set tempo by bar (new time 
signature)

Close the Create Custom Action 
dialogue:

 ▪ Click the OK button

4
ACTION NAMESELECT ACTIONSCREATE A NEW 

CUSTOM ACTION
SHORTCUT 
INSTALL

T is the default shortcut for changing time signature.

TEMPO MAPPING  
SHORTCUT: T  

5
KEYBOARD 
SHORTCUT
In the Actions window: 

 ▪ Select the Custom: Set 
tempo by bar (new time 
signature) shortcut

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: T

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close.

In the Actions window:

 ▪ Click the Close button

Make sure that the T 
shortcut exists.

You will need this 
shortcut when you 
start to tempo map 
your first song.
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ADVANCED TEMPO MAPPING 
2

Shift + Q is the C3 shortcut to tempo map between project markers.

ADVANCED TEMPO MAPPING 
SHORTCUT: SHIFT + Q 

The Shift + Q shortcut is a 
custom C3 Action. Authors use 
this shortcut so that they can  
tempo map between beats or 
measures.

This shortcut is great for:

 ▪ Simple or complex songs

 ▪ Songs that slow down or 
speed up

 ▪ Songs that don’t have a 
downbeat at the start of a 
measure

To create the Shift + Q action 
follow these steps.

1 2 3
Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select Main:

Create a new custom action: 

 ▪ Click the New button

CREATE NEW 
CUSTOM ACTION

ABOUT THIS 
SHORTCUT

SELECT ACTIONS ACTION NAME

In the Create Custom Action 
dialogue select these actions:

 ▪ Time selection: Set start 
point

 ▪ Markers: Go to next marker/
project end

 ▪ Time selection: Set end 
point

 ▪ Markers: Create measure 
from time selection (new 
time signature)

In the Create Custom Action 
field type:

 ▪ Advanced Tempo Mapping

Close the Create Custom Action 
dialogue:

 ▪ Click the OK button

4
KEYBOARD 
SHORTCUT
In the Actions window: 

 ▪ Select the Advanced Tempo 
Mapping shortcut

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: Shift + Q

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close. 

In the Actions window:

 ▪ Click the Close button

We review advanced 
tempo mapping in 
chapter 7.
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1 2 3
ABOUT THIS 
SHORTCUT

KEYBOARD 
SHORTCUT
In the Actions window: 

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Click the Special key (Enter, 
Tab, etc) button

 ▪ Press: Shift + Tab

 ▪ Click the OK button

Close the Keyboard/MIDI/OSC 
Input dialogue. 

In the Actions window:

 ▪ Click the Close button

In the search Filter type:

 ▪ forward

In the filtered results select:

 ▪ Move edit cursor forward 
one measure

FIND ACTION

Open the Actions window:

 ▪ Click the Actions > Show 
action list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select Main:

OPEN THE 
ACTIONS LIST

You can use this 
shortcut for regular 
or advanced tempo 
mapping.

The Shift + Tab shortcut moves 
the play cursor forward one 
measure. If the song tempo is 
even this action can quickly 
move the play cursor to the 
next downbeat.

Shift + Tab is an optional shortcut to advance the 
play cursor one measure at a time. 

MOVE PLAY CURSOR 
FORWARD ONE MEASURE 
SHORTCUT: SHIFT + TAB

TAB SHORTCUT 2
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SCROLL TEMPO MAPPING 
SHORTCUT: ALT + Q 2

Alt + Q is a C3 shortcut to scroll tempo map with project markers.

SCROLL TEMPO MAPPING 
SHORTCUT: ALT + Q 

The Alt + Q shortcut is a 
custom C3 action. It is used 
with the scroll tempo mapping 
method to tempo map between 
a marker and the play cursor. 

Note: Use separated drum 
tracks if you are using this 
method to tempo map.

Use this shortcut for:

 ▪ Simple or complex songs

 ▪ Songs that slow down or 
speed up

 ▪ Songs that doesn’t have a 
downbeat at the start of a 
measure

To create the Alt + Q action 
follow these steps.

1 2 3
Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

In the Section drop down menu 
choose Main:

Create a new custom action: 

 ▪ Click the New button

CREATE NEW 
CUSTOM ACTION

ABOUT THIS 
SHORTCUT

CREATE LIST OF 
CUSTOM ACTIONS

NAME THE 
CUSTOM ACTION

In the Create Custom Action 
dialogue select these Actions:

 ▪ Markers: Insert marker at 
current position

 ▪ Markers: Go to previous 
marker/project start

 ▪ Time selection: Set start 
point

 ▪ Markers: Goto next marker/
project end

 ▪ Time selection: Set end 
point

 ▪ Markers: Create measure 
from time selection (new 
time signature)

 ▪ Time selection: Remove time 
selection and loop point 
selection

Type a name for the custom 
action:

 ▪ In the Custom action name 
field type: Scroll Tempo 
Mapping

Close the Create Custom Action 
dialogue:

 ▪ Click the OK button

4
KEYBOARD 
SHORTCUT
In the Actions window: 

 ▪ Select the Scroll Tempo 
Mapping shortcut

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

Press the keys: Alt + Q

Close the Keyboard/MIDI/OSC 
Input dialogue:

Click the OK button

In the Actions window:

Click the Close button

You can learn more 
about Scroll Tempo 
Mapping at the end of 
chapter 6.
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1 2
ABOUT THIS 
SHORTCUT

3
CREATE NEW 
CUSTOM ACTION

SELECT ACTIONS NAME THE 
CUSTOM ACTION
Type a name for the custom 
action:

 ▪ In the Custom action name 
field type: Unison Phrase 
Burn

Close the Create Custom Action 
dialogue:

 ▪ Click the OK button

 ▪ Cycle to next secondary MIDI 
item

 ▪ Edit: Paste

 ▪ Navigate: Move edit cursor to 
start of selection

 ▪ Cycle to next secondary MIDI 
item

In the Create Custom Action 
dialogue select the following 
actions:

 ▪ Edit: Copy

 ▪ Navigate: Move edit cursor to 
start of selection

 ▪ Cycle to next secondary MIDI 
item

 ▪ Edit: Paste

 ▪ Navigate: Move edit cursor to 
start of selection

 ▪ Cycle to next secondary MIDI 
item

 ▪ Edit: Paste

 ▪ Navigate: Move edit cursor to 
start of selection

Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select MIDI Editor:

Create a new custom action: 

 ▪ Click the New button

The U shortcut copies the 
selected Overdrive phrase to 
other MIDI tracks. This allows 
a single Overdrive phrase to 
become a Unison phrase. 

The U shortcut turns an Overdrive phrase into a Unison phrase.

UNISON PHRASE  
SHORTCUT: U 
(LEGACY SETUP)

KEYBOARD 
SHORTCUT

4
In the Actions window: 

 ▪ Select the Unison Phrase 
Burn shortcut

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: U

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close.

In the Actions window:

 ▪ Click the Close button

You will learn more 
about this shortcut 
when we discuss 
Overdrive and Unison 
phrases in Chapter 17.

UNISON PHRASE SHORTCUT: 
U 2

Follow these steps for 
REAPER version 4.22.
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1 2
ABOUT THIS 
SHORTCUT

3
CREATE NEW 
CUSTOM ACTION

SELECT ACTIONS NAME THE 
CUSTOM ACTION
Type a name for the custom 
action:

 ▪ In the Custom action name 
field type: Unison Phrase 
Burn

Close the Create Custom Action 
dialogue:

 ▪ Click the OK button

 ▪ Edit: Paste events into the 
active MIDI media item 
regardless of source MIDI 
media item

 ▪ Navigate: Move edit cursor to 
start of selected events

 ▪ Activate next visible MIDI 
item

 ▪ Edit: Paste events into the 
active MIDI media item 
regardless of source MIDI 
media item

 ▪ Navigate: Move edit cursor to 
start of selected events

 ▪ Activate next visible MIDI 
item

In the Create Custom Action 
dialogue select the following 
actions:

 ▪ Edit: Copy

 ▪ Navigate: Move edit cursor to 
start of selected events

 ▪ Activate next visible MIDI 
item

 ▪ Edit: Paste events into the 
active MIDI media item 
regardless of source MIDI 
media item

 ▪ Navigate: Move edit cursor to 
start of selected events

 ▪ Activate next visible MIDI 
item 

Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select MIDI Editor:

Create a new custom action: 

 ▪ Click the New button

The U shortcut copies the 
selected Overdrive phrase to 
other MIDI tracks. This allows 
a single Overdrive phrase to 
become a Unison phrase. 

Thanks to Sean for providing 
this REAPER action. 

The U shortcut turns an Overdrive phrase into a Unison phrase.

UNISON PHRASE  
SHORTCUT: U 
(MODERN SETUP)

KEYBOARD 
SHORTCUT

4
In the Actions window: 

 ▪ Select the Unison Phrase 
Burn shortcut

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: U

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close.

In the Actions window:

 ▪ Click the Close button

You will learn more 
about this shortcut 
when we discuss 
Overdrive and Unison 
phrases in Chapter 17.

UNISON PHRASE SHORTCUT: 
U 2

Follow these steps for 
modern versions of 
REAPER.
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1 2 3
ABOUT THIS 
SHORTCUT
The Shift + L shortcut imports 
lyrics from a text (.txt) file. 
Lyrics are added to the selected 
MIDI notes in the vocal track.

You can use Notepad or another 
text editor to create .txt files for 
import into REAPER. 

The use of this shortcut 
is discussed on pages 
561 — 562.

In the Actions window: 

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: Shift + L

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close. 

In the Actions window:

 ▪ Click the Close button

KEYBOARD 
SHORTCUT

In the Actions window:

 ▪ In the Filter field type: lyrics

In the filtered results:

 ▪ Select: Import lyrics for 
selected notes from file

FILTER THE 
ACTIONS LIST

Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select MIDI Editor:

OPEN THE 
ACTIONS LIST

The Shift + L shortcut imports lyrics from a text file.

IMPORT LYRICS 
SHORTCUT: SHIFT + L 
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REAPER CONFIGURATION

If Python is not detected try 
restarting REAPER. Otherwise 
make sure you have the correct 
Python version installed (see 
pages 29 — 30).

4

In the ReaScript area of the 
window:

 ▪ Check the Enable checkbox

REAPER should show that 
Python is installed:

 ▪ Check for the following 
confirmation (highlighted in 
the screenshot):   
 
python27.dll is installed

 ▪ Click the OK button

The Preferences window will 
open:

 ▪ In the left hand pane scroll 
to the bottom of the list

 ▪ Under Plugins select 
ReaScript

3
The C3 Automation Tools (CAT) 
are a core utility for custom 
authors. Let’s work through a 
few steps to get CAT working in 
REAPER. 

Open the REAPER Preferences:

 ▪ Click the Options > Select 
Preferences

 ▪ Shortcut: Press Ctrl + P

1

ReaScript must be enabled for C3 Automation Tools (CAT) to work.

ENABLE REASCRIPT

2

Turn the page to 
assign the F9 keyboard 
shortcut to CAT.

ENABLE REASCRIPT 2
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1 3
ABOUT THIS 
SHORTCUT

4
KEYBOARD 
SHORTCUT

2
OPEN THE 
ACTIONS WINDOW

In the Actions window: 

 ▪ Select the Custom: CAT.py 
shortcut

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: F9

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close.

In the Actions window:

 ▪ Click the Close button

In the Load Script window:

 ▪ Browse to C:\CAT

 ▪ Select the CAT.py file

 ▪ Click the Open button

The Load Script window will 
close.

LOCATE THE 
SCRIPT FOR CAT

In the Actions window load the 
script for CAT:

 ▪ Click the ReaScript New/
load button

The Load Script window will 
open.

LOAD NEW 
REASCRIPT

Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

Make sure that the Section drop 
down menu is set to Main:

You will learn how to 
use CAT in chapter 21.

The F9 shortcut is used to open 
the C3 Automation Tools (CAT). 

CAT contains many useful 
scripts that automate authoring 
tasks in REAPER. For example, 
CAT can help you reduce your 
MIDI charts from expert to easy.

CAT has close to 50 functions 
in total.

The F9 shortcut opens the C3 Automation Tools.

C3 AUTOMATION TOOLS (CAT)
SHORTCUT: F9 

For CAT to work 
ReaScript must be 
enabled and Python 
must be detected by 
REAPER. See pages 
91 — 92 for details.

C3 AUTOMATION TOOLS (CAT) 
SHORTCUT: F9 2
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This C3 shortcut is optional. It converts a 
sustained note into many single MIDI notes.

SUSTAIN TO SINGLE NOTES 
SHORTCUT: CTRL + ALT + S 

You can add this shortcut to 
your workflow to save time.

Let’s say, for example, that you 
need to author a long run of 
sixteenth notes. You can:

 ▪ Author each note, one at a 
time, or

 ▪ Author a single sustained 
note and then divide it into 
single 1/16 notes

This shortcut divides selected 
sustain notes into single notes. 

Note: Sustain notes divide 
according to your MIDI grid size. 
A 16th note MIDI grid will result 
in 16th notes. Check your grid 
size before using this shortcut.

1 2 3
ABOUT THIS 
SHORTCUT

4
In the Actions window: 

 ▪ Click the Add button

The Keyboard/MIDI/OSC Input 
dialogue will open:

 ▪ Press: Ctrl + Alt + S

 ▪ Click the OK button

The Keyboard/MIDI/OSC Input 
dialogue will close. 

In the Actions window:

 ▪ Click the Close button.

KEYBOARD 
SHORTCUT

In the Actions window:

 ▪ In the Filter field type: split

In the filtered results:

 ▪ Select: Split notes on grid

FILTER THE 
ACTIONS LIST

Open the Actions window:

 ▪ Click Actions > Show action 
list 

Shortcut: Press Shift + ?

In the Section drop down menu 
select MIDI Editor:

OPEN THE 
ACTIONS LIST

In the MIDI Editor:

 ▪ Draw a sustain note

 ▪ Select the sustain note 

 ▪ Press Ctrl + Alt + S to split 
the sustain note:

The sustain note is split 
according to the size of the MIDI 
Editor grid.

HOW TO USE THE 
SHORTCUT
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TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ The C3 Template is the default template for authoring Rock 
Band customs.

 ▪ Automate project backups so that you don’t lose work if 
REAPER crashes.

 ▪ The project timebase is an important setting. It directly 
impacts tempo mapping in REAPER.

 ▪ Scrub and mouse behavior settings are needed for tempo 
mapping and vocal authoring.

 ▪ Use audio render presets to export audio from REAPER.

 ▪ REAPER Actions let you repeat simple or complex tasks with 
the press of a button.

 ▪ The C3 Automation Tools (CAT) need ReaScript and Python 
to function. 

REAPER CONFIGURATION



 ▪ REAPER user interface
 ▪ Rock Band note colors
 ▪ How to scrub audio

INTRODUCTION 
TO REAPER

3
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Download links available from: 
rhythmgamingworld.com/customsbook

INTRODUCTION TO REAPER INTRODUCTION TO REAPER101

Harmonix used REAPER to create 
songs for Rock Band.

In this section we introduce REAPER and the C3 Template. The 
topics that we cover include:

 ▪ The layout of the MIDI Editor and the C3 Template

 ▪ The Play cursor and how to scrub audio *

 ▪ The Transport bar and media controls

 ▪ Resizing elements in REAPER

 ▪ Track controls

 ▪ Docking and undocking the MIDI Editor

 ▪ Customize MIDI note colors to match Rock Band colors *

 ▪ Text Events and Text Event lists *

 ▪ Draw and select notes in the MIDI Editor

 ▪ Copy and paste notes in the MIDI Editor

 ▪ REAPER view modes *

 ▪ New Project tabs and Ctrl + Z REAPER bug *

* Some of these features are not intuitive. For example, how to 
scrub audio, or find the MIDI Editor hidden context menu. If you 
are already familiar with REAPER I recommend you focus on the 
topics marked with an asterisk. 

102

Note: This chapter was 
written for the legacy 
software setup. For the 
most part it should 
still apply to modern 
versions of REAPER.



103 104INTRODUCTION TO REAPER

The Toolbar contains buttons 
for frequently used functions:

INTRODUCTION TO REAPER

REAPER USER INTERFACE 

Menu Bar TimelineToolbar

Arrange AreaTrack Panel Transport Bar

The menu bar groups 
commands together. These 
commands help you load and 
save files, insert audio files, 
create actions, and so on. 

MENU BAR

PLAY CURSOR

New Project (Ctrl + N) Open Project (Ctrl + O) Save Project (Ctrl + S)

Project Settings  
(Alt + Enter)

Undo (Ctrl + Z) Redo (Ctrl + Shift + Z)

Metronome  
Toggle On/Off

Grid lines (Alt + G) 
Toggle On/Off

Snap to Grid (Alt + S) 
Toggle On/Off

Tip: Use the Metronome to 
check your tempo maps.

TOOLBAR

The play cursor selects your 
position in the timeline. It is 
also used to scrub through 
audio (for tempo mapping and 
vocal authoring).

The timeline helps you navigate 
your project. By default it shows 
measures/beats and minutes/
seconds. 

Tip: Turn Snap to Grid off to 
position audio files in REAPER.

The Track Panel controls your 
audio and MIDI tracks. You will 
see all your tracks when you 
load the C3 Template.

TRACK PANEL

TIMELINE

The arrange area shows your 
audio and MIDI tracks and lets 
you interact with them.

ARRANGE AREA

The Transport Bar controls 
playback and recording. It also 
shows the position of the play 
cursor. The slider controls the 
playback speed.

TRANSPORT BAR

Play cursor
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THE C3 TEMPLATE 

The C3 Template contains 
everything you need to make a 
custom song in REAPER. 

The Track Panel includes:

 ▪ Master track

 ▪ Song Audio track

 ▪ Count-in track

 ▪ Basic and pro instrument 
MIDI tracks

 ▪ Events track

 ▪ Venue track

 ▪ Beat track

You will use the Master, Song 
Audio, and Count-in tracks for 
tempo mapping. 

The remaining tracks are all 
MIDI tracks. You will author your 
charts in the instrument MIDI 
tracks. The Events, Venue, and 
Beat track all contain additional 
game information.

The Master track controls audio 
for the whole project. The blue 
line in the Master track shows 
your project tempo map. 

MASTER TRACK

SONG AUDIO

OVERVIEW

The song audio track is where 
you put your song audio file. You 
can use .wav or .mp3 files. I use 
a high quality .flac file from a 
CD whenever possible.

The count-in track contains 
six samples of the hi-hat.
wav audio file. We arrange 
these samples to count-in the 
song for the player. The default 
count-in is: One, two, one, two, 
three, four.

COUNT-IN TRACK

MIDI tracks contain the MIDI 
notes for each Rock Band 
instrument and difficulty. 

Other game information charted  
in MIDI tracks includes:

 ▪ Solo markers 

 ▪ Overdrive markers

 ▪ Character animations 

 ▪ Vocal phrases and lyrics

 ▪ Lane markers

 ▪ Drum fills and Big Rock 
Endings

HI-HAT.WAV

Master Track

Count-In Track
Song Audio Track

MIDI Tracks

hi-hat.wav

hi-hat.wav is the default audio 
sample for the count-in track. 
You can find this sample in the 
Custom Tools download. An 
alternative drum stick sample 
called stick.wav is also part of 
the Custom Tools. You can use 
other count-in samples instead 
if you want to.

MIDI TRACKS

Track Panel

Load the C3 Template:

 ▪ Click File > Project 
templates

 ▪ Select the C3 
Custom RB3 
Template
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MIDI EDITOR 

MIDI Editor Template

MIDI Editor GridTrack Tab Grid Controls Text Events

The MIDI Editor is where you 
chart the MIDI notes for each 
Rock Band instrument. The 
Editor includes:

 ▪ The Editor template and 
MIDI grid

 ▪ Playback controls

 ▪ Track tab

 ▪ Grid controls

 ▪ Text events panel 

The MIDI Editor Template shows 
the structure of each MIDI track. 
Each Rock Band instrument has 
a different template to follow. 
We will discuss these templates 
in the authoring chapters later 
in this book. 

EDITOR TEMPLATE EDITOR TOOLBAR

MIDI EDITOR OVERVIEW

The Snap to Grid button in this 
toolbar controls snapping in the 
MIDI Editor. Leave this button 
enabled for authoring in the 
MIDI Editor.

Track Tabs let you switch 
between open MIDI tracks. 

Tip: Each MIDI Editor Tab has 
a hidden context menu. Right 
click a MIDI Editor Tab to view 
the context menu. 

TRACK TAB

Grid Controls let you adjust the 
divisions in the MIDI Editor grid.  
You can choose different note 
sizes, for example 16th, or 32nd 
notes. You can also choose 
different grid types, such as 
straight notes or triplets. 

GRID CONTROLS

In the screenshot to the left you 
can see the PART DRUMS track 
open in the MIDI Editor. 

The template lists the note 
names for the drum track. This 
includes note rows for Expert. 
Hard, Medium, and Easy drums.

Beneath the MIDI grid is a 
horizontal panel for text events.  
Text events have various 
functions depending on the 
MIDI track / instrument.

Text Events are displayed 
directly under the grid. They 
are moveable pointers with 
associated text. They provide 
additional game data. 

Tip: Lyric Events look the same 
as text events. They are found 
only in vocal tracks.

TEXT EVENTS
The MIDI Editor Grid is where 
you will spend most of your 
time in REAPER. MIDI notes, 
markers, and Overdrive are all 
authored here. 

In the MIDI grid your mouse icon 
will change to a pencil icon.

EDITOR GRID

MIDI Editor Toolbar 

Double-click on a MIDI 
track to open it in the 
MIDI Editor.
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Move your mouse cursor over 
the play cursor and it will 
change to a hand icon:

With the hand icon on the play 
cursor click and drag the mouse 
slowly left and right.

The hand icon will disappear as 
you drag the play cursor. 

Use this action to scrub through 
your project audio. You can 
scrub through your audio to 
find kicks and snares when you 
tempo map. When you author 
vocals scrub to find vowel 
sounds in the vocal track audio.

Use the play cursor to scrub through audio. 
Scrubbing is used to tempo map and author  
vocal charts.

Playback begins from the 
current play cursor position.

The timeline shows the play 
cursor position in:

 ▪ Measures, beats, and 
fractions of a beat

 ▪ Minutes, seconds, and 
milliseconds

 

HOW TO SCRUB AUDIO

To the right you can see the play 
cursor in both the timeline and 
the MIDI Editor.

The play cursor is the small 
red triangle with a thin red line 
beneath it.

The red line runs vertically 
through the timeline, MIDI 
tracks, and MIDI Editor. This 
makes the position of the play 
cursor easier to see.

Click in the MIDI Editor or 
Timeline to re-position the play 
cursor.

INTRODUCTION TO REAPERINTRODUCTION TO REAPER

The play cursor is used to select a point in the  
timeline / MIDI Editor. 

THE PLAY CURSOR 

PLAY CURSOR POSITION PLAYBACK
The MIDI Editor shows the play 
cursor position in measures, 
beats, and fractions of a beat.

You can also see the play cursor 
position in the Transport Bar 
(see page 115).

JOG VS SCRUB
See pages 65 — 66 
to set scrubbing as 
a default behavior in 
REAPER.

Jogging and scrubbing are used 
for different purposes. It is 
important not to mix them up: 

 ▪ Jogging is when you quickly 
drag the play cursor to a 
new position in the timeline 

 ▪ Scrubbing is when you 
slowly drag the play cursor 
to hear sounds in the audio

Make sure that you use the 
correct settings so that you can 
scrub audio in REAPER. 

TimelineMIDI Editor
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RESIZING ELEMENTS 

Resize elements to access track controls, view 
waveforms, and author long songs. 

There are a few elements that 
you might want to resize in 
REAPER. These include:

 ▪ The height of your tracks in 
the track panel

 ▪ The width of your track 
panel

 ▪ The height of the MIDI Editor, 
and

 ▪ The length of your MIDI 
tracks

Resizing your track height will 
do two things. It will reveal 
track controls or let you see the 
waveform in your audio track(s).

Adjust the  track panel width 
according to your preference. 

Adjusting the MIDI Editor height 
will let you see more, or less, of 
your charts.

Adjusting MIDI track length will 
let you author longer songs. 

TRACK HEIGHT
To adjust track height follow 
these steps.

In the track panel:

 ▪ Move your mouse to the 
bottom of a track

The cursor will change  
to a resize arrow:

 ▪ Click and drag the resize 
arrow down to adjust the 
track height

This will reveal the track control 
panel:

At the top of the MIDI Editor is a 
horizontal grey dividing line:

 ▪ Position your mouse 
anywhere on the dividing 
line

The cursor will change  
to a resize arrow:

 ▪ Click and drag the resize 
arrow up or down to adjust 
the height of the MIDI Editor

Increase the track size to see 
the waveform of audio files in 
more detail:

TRACK PANEL WIDTH
Adjust the track panel width as 
follows:

In the track panel:

 ▪ Move your mouse to the 
right edge of the track panel:

The cursor will change  
to a resize arrow:

 ▪ Click and drag the resize 
arrow left or right to change 
the panel width

MIDI EDITOR HEIGHT
In the C3 Template the track 
length is set to 95 measures. 

If your song is longer than this 
you will need to extend the 
length of your MIDI tracks.

 ▪ Press the End key to scroll 
to the end of your project

 ▪ Press Ctrl + A to select all 
tracks

 ▪ Position the mouse at the 
end of a selected track

The cursor will change to a 
resize indicator:

 ▪ Click and drag your tracks 
so that they are longer than 
your audio track

 

Use these hot keys to adjust 
track height:

 ▪ Expand selected ! 
tracks

 ▪ Minimize track  @ 

MIDI TRACK LENGTHOVERVIEW
When the text events area is 
small text events can often 
overlap. This makes them very 
difficult to read: 

 

To fix this, resize the text events 
area to make it larger:

 ▪ Rest the mouse over the 
grab-bar at the top-left of 
the text events area

The cursor will change to a 
resize arrow:

 ▪ Click and drag the grab-bar 
up to resize the area

The text events will become 
easier to read the more space 
that you give them:

HOT KEYS

TEXT EVENTS

In modern REAPER 
the MIDI Editor resize 
grabber is not visible. 
Position your mouse 
cursor under the Media 
Controls and above the 
MIDI Editor Toolbar to 
locate it. 
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To the left you can see media 
controls for playback and 
recording.

The Home and End buttons take 
you to the start and end of your 
project in a single click. You 
can also use the Home and End 
keys if you prefer.

Use the Spacebar to start and 
stop playback.

The left side of the Transport Bar contains  
media controls.

MEDIA CONTROLS

INTRODUCTION TO REAPERINTRODUCTION TO REAPER

FX button. View the RBN 
Preview window. Add 
effects to the track. 

The power button toggles 
all effects on and off for 
the track. 

Record enable button. 
Record input(s) to the 
track.

6

5

Solo button. Listen to  
individual track(s) only.

Volume Slider. Increase or 
decrease track volume.

4

3

Meter to view track 
volume.

Mute button. Mute 
individual tracks. 

2

1

To the right is the track control 
panel for the Master track and 
the PART DRUMS track. 

Below is a summary of the track 
controls that you will use the 
most often.

The Track Control Panel contains essential track 
controls.

TRACK CONTROL PANEL 

21 3

4 5

6

7

Track Name. Do not 
change the C3 Template 
track names.

7 6

5

4

3

2

1

7

1 2 3 4 5 6 7Home Play End

Home button. Takes you to the 
start of the project.

Repeat

Play button. Plays media. Press 
the Spacebar to start playback.

Pause button. Pauses playback. 

Stop

End button. Takes to you the 
end of the project. 

Record enable button. Records 
input(s) to the selected track.

Pause Record

Repeat button. Toggles repeat 
playback on and off.

Stop button. Halts playback.  
You can also use the Spacebar 
to stop playback.
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To the left you can see the 
current Beats Per Minute, time 
signature, and playback rate in 
the Transport Bar.

The Transport Bar shows the 
position of the play cursor in 
two ways. First, by measure and 
then by time.

The right hand section of the Transport Bar 
shows tempo map information. The slider lets 
you adjust playback speed.

The middle section of the Transport Bar shows 
the position of the play cursor in your project.

BPM, TIME SIGNATURE  
& RATE

PLAY CURSOR POSITION 

Measure BPM Rate

The measure counter shows  
cursor position in measures, 
beats, and fractions of beats. 

The first number in the counter 
is the measure number. The 
default starting measure is 1.

The second number shows 
the beat within the measure. 
The number of beats depends 
on the time signature for that 
measure.

For example, a measure of 
4/4 will have four beats in the 
measure (beats one, two three, 
and four).

MEASURE
The time counter shows the 
cursor position in minutes, 
seconds, and milliseconds. 

The millisecond part of the 
counter can be useful when 
tempo mapping. (You will be 
able to measure how close 
beats are to the MIDI grid).

We can use the millisecond 
counter to check if we need 
extra tempo markers. 

TIME
The start of a measure always 
begins on the first beat. For 
example, the start of measure 
three is 3.1.00.

The last two digits show 
fractions of a beat. 

For example, 3.1.50 would be 
halfway between beats one and 
two, in measure three.

The Transport Bar shows the 
current Beats Per Minute (BPM).

The current BPM depends on 
the position of the play cursor 
in your project.

The default project BPM is 120.

BEATS PER MINUTE TIME SIGNATURE
The rate slider shows the 
current playback speed. 

The default rate is 1.0 (for 
normal playback).

Follow these steps to return the 
playback rate to normal (if you 
accidentally change it):

 ▪ Right click the Rate control

 ▪ Select Set to 1.0 from the 
context menu

RATE
The Transport Bar shows the 
current time signature.

The time signature shown 
depends on the position of the 
pay cursor in your project.

The default time signature is 4/4.

Time Time Signature
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Navigate the Track Panel and MIDI Editor in 
REAPER using the mouse and keyboard.

SCROLL, ZOOM, AND  
NAVIGATE IN REAPER 

To scroll up and down through 
your track list:

 ▪ Use the mouse wheel, or

 ▪ Use Alt + Up and Down 
arrow keys

SCROLL UP AND 
DOWN

To scroll left and right through 
the timeline:

 ▪ Use Shift + mouse wheel, or

 ▪ Use Alt + Left and Right 
arrow keys

SCROLL LEFT AND 
RIGHT

HORIZONTAL ZOOM 
IN AND OUT
To zoom in and out on the play 
cursor / timeilne:

 ▪ Use Alt + mouse wheel, or

 ▪ Use the Plus (+) and Minus 
(-) keys

POSITION THE PLAY 
CURSOR
To position the play cursor in 
the Timeline / MIDI Editor:

 ▪ Click in the timeline / MIDI 
Editor

VERTICAL ZOOM IN 
AND OUT
To zoom in and out on all tracks 
or the MIDI Editor Template:

 ▪ Use Ctrl + mouse wheel, or

 ▪ Press the Page Up and Page 
Down keys

MAXIMIZE SELECTED 
TRACK(S) HEIGHT
To maximize the height of 
selected track(s):

 ▪ Press the Shift + 1 keys

Press Shift + 1 again to return 
tracks to their previous size.

VIEW WHOLE 
PROJECT
To zoom out and view your 
whole project:

 ▪ Press Ctrl + Page Down

To make a selection in the 
timeline:

 ▪ Click and drag the cursor in 
the timeline

TIMELINE SELECTION

MOVE PLAY CURSOR 
TO START / END
To move the play cursor to the 
start / end of the timeline:

 ▪ Press Home and End keys

Navigation in REAPER depends 
on your cursor position.  

If your cursor is in the MIDI 
Editor then your scroll and 
zoom actions will apply to the 
MIDI Editor. 

If your cursor is in the MIDI 
tracks area then your scroll and 
zoom actions will apply to the 
MIDI tracks.

For most navigation you can 
choose to use either the 
keyboard or the mouse. 

Tip: To scroll up and down you 
can use the scrollbars at the 
edges of the REAPER window.

At the ends of the scroll-bars 
are small round buttons with 
plus (+) and minus (-) signs. You 
can use these buttons to zoom 
in and out. 

CANCEL TIMELINE 
SELECTION
To cancel a selection in the 
timeline:

 ▪ Press Esc

NAVIGATION 
OVERVIEW

To minimize the height of all 
tracks:

 ▪ Press Shift + 2

MINIMIZE ALL 
TRACKS

Click and drag to make a 
selection in the timeline, then:

 ▪ Press Shift + Page Up

ZOOM TO TIMELINE 
SELECTION

SYNC PROJECT 
SCROLLING
With certain settings your 
timeline and MIDI track scrolling 
will not be synchronized. Follow 
these steps to fix the issue:

 ▪ Open a MIDI track

 ▪ Right-click the track tab

 ▪ In menu click View > Piano 
roll timebase > Project 
synced

Your project timeline and MIDI 
will now scroll in sync. When 
you scrub audio your play cursor 
is now synced in the MIDI Editor.

Note: These steps assume that 
your MIDI Editor is docked.

Incorrect sync settings 
make it very difficult to 
scrub audio and author 
vocal and instrument 
MIDI tracks.
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DOCKING AND UN-DOCKING 
THE MIDI EDITOR 2

MIDI Editor Toolbar MIDI Editor Toolbar 

When undocked the MIDI Editor 
Menu is no longer hidden.

The MIDI Editor Menu is visible 
in the menu bar at the top left 
of the MIDI Editor window.

To dock the MIDI Editor, click 
the Dock Editor button in the 
MIDI Editor toolbar:

DOCK EDITOREDITOR MENU
When you undock the MIDI 
Editor it changes to a floating 
window that you can re-size.

This is useful if you have more 
than one computer monitor to 
work with.

EDITOR UN-DOCKEDUN-DOCK EDITOR
To undock the MIDI Editor click 
the Dock Editor button in the 
MIDI Editor toolbar:

DOCKING AND UN-DOCKING 
THE MIDI EDITOR 

In the screenshot above the 
MIDI Editor is docked. It is 
a part of the main REAPER 
window and can be re-sized up 
and down.

EDITOR DOCKED EDITOR MENU
When docked the MIDI Editor 
Menu is hidden.

To access the Editor menu right 
click on the MIDI Editor Tab at 
the bottom left of the screen.

MIDI Editor Toolbar 

MIDI Editor Tab

MIDI Editor Menu MIDI Editor Toolbar

MIDI EDITOR DOCKED MIDI EDITOR UN-DOCKED
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The Load MIDI color map from 
file window will open:

 ▪ Browse to: C:\REAPER\
Data\color_maps

Select the appropriate color 
map for your MIDI track:

 ▪ rockband_drums.png for 
the PART DRUMS track

 ▪ rockband_guitarbass.png 
for the PART GUITAR or PART 
BASS tracks

 ▪ rockband_vox-other.png 
for the PART KEYS and other 
MIDI tracks

In the Load MIDI color map from 
file window:

 ▪ Click the Open button

The Load MIDI color map from 
file window will close.

Your MIDI notes are now 
displayed in Rock Band colors.  
These colors match the note 
names in the C3 Template. 

INTRODUCTION TO REAPER121

1

2
If the MIDI Editor is undocked 
(see page 120):

 ▪ Click File > Customize note 
colors > Load color map 
from file

MIDI tracks do not show Rock 
Band colors by default. 

To customize the note colors:

 ▪ Double-click a MIDI track to 
open it

If the MIDI Editor is docked (see 
page 119):

 ▪ Right click the MIDI Editor 
Tab

The MIDI Editor tab context 
menu will open. Click:

 ▪ File > Customize note colors 
> Load color map from file

CUSTOMIZE NOTE COLORS 
(LEGACY REAPER)

MIDI EDITOR DOCKED

MIDI EDITOR UN-DOCKED

CUSTOMIZE NOTE COLORS 2We do not want to customize 
note colors for every custom 
song project. 

The solution is to customize an 
empty C3 Template and then 

save a new modified template. 
When you have modified the 
note colors for the template:

 ▪ Click File, Save project as

 ▪ Save the file to C:\Reaper\
ProjectTemplates

Your note colors are now saved 
to your project template. 
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The Load MIDI color map from 
file window will open:

 ▪ Browse to: C:\REAPER\
Data\color_maps

Select the appropriate color 
map for your MIDI track:

 ▪ rockband_drums.png for 
the PART DRUMS track

 ▪ rockband_guitarbass.png 
for the PART GUITAR or PART 
BASS tracks

 ▪ rockband_vox-other.png 
for the PART KEYS and other 
MIDI tracks

In the Load MIDI color map from 
file window:

 ▪ Click the Open button

The Load MIDI color map from 
file window will close.

Your MIDI notes now match the 
note names in the C3 Template. 
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 ▪ In the filter field type color 

map

 ▪ In the list of results select 
View: Load note color map 
from file

 ▪ Click the Run button

In modern REAPER we use an 
Action to load color maps: 

 ▪ Double-click a MIDI track to 
open it

 ▪ In the REAPER menu click 
Actions > Show action list 

Shortcut: Press Shift + ?

The Actions window will open:

 ▪ Click the Section drop down 
menu and select MIDI Editor 
from the list

CUSTOMIZE NOTE COLORS 2CUSTOMIZE NOTE COLORS 
(MODERN REAPER)

We do not want to customize 
note colors for every custom 
song project. 

The solution is to customize an 
empty C3 Template and then 

save a new modified template. 
When you have modified the 
note colors for the template:

 ▪ Click File, Save project as

 ▪ Save the file to C:\Reaper\
ProjectTemplates

Your note colors are now saved 
to your project template. 
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Select text events from the 
imported list using the Text 
drop down menu.

Tip: Always use imported text 
events to reduce the potential 
for errors.

Note: Text events are not always 
created exactly where you need 
them. To reposition text events:

 ▪ Click and hold the green 
stem of the text event

 ▪ Drag the mouse left or right 
to move the text event

Click the Load button in the Add 
Text Events window. 

Browse to: C:\REAPER\Data\
Text_Strings

The .txt files in this folder 
contain lists of text events for:

 ▪ Events 

 ▪ Instruments 

 ▪ Venues

Load the text events that you 
need for the track that you are 
working on.
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In Rock Band we use text events 
for many things. This includes:

 ▪ Animation

 ▪ Practise sections

 ▪ Venues

 ▪ Lyrics

Create a text event as follows:

 ▪ Double-click in the text 
events panel (highlighted in 
green)

1

125

3

2
The Edit Text Event window will 
open.

In the Type drop down menu 
you can see a list of types of 
text event. The important ones 
for authoring are:

 ▪ Text Event: For all text 
events that are not Track 
Names or Lyrics

 ▪ Track Name: For the Track 
Name text events at the 
start of each track. For 
example, PART GUITAR

 ▪ Lyrics: For lyrics in vocal 
tracks

4

TEXT EVENTS AND TEXT 
STRINGS 2
LOAD TEXT EVENTS INTO 
REAPER 2

TEXT EVENTS AND TEXT 
EVENTS LISTS
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MIDI Editor Toolbar MIDI Editor Toolbar 

SELECT NOTES IN THE  
MIDI EDITOR

DRAW AND MOVE NOTES IN 
THE MIDI EDITOR 

MOVE NOTES
Click and drag notes to move 
them around the MIDI Editor.

Tip: You can also select notes 
and use the arrows keys to 
move them in the MIDI Editor.

Sustained notes are the long 
notes in the screenshot.

Click and drag to the right 
in the MIDI Editor to draw a 
sustained note. 

Tip: You can also drag the edge 
of a single note to turn it into a 
sustained note. 

SUSTAINED NOTESSINGLE NOTES
To draw single notes double- 
click in the MIDI Editor grid.

The size of the notes drawn will 
depend on the size of the MIDI 
Editor grid. 

In the screenshot above the 
individual notes are 1/32 notes.

SELECT A SINGLE 
NOTE

Click on a note to select it.

BOX SELECT NOTES

Right click and draw a box to 
select a group of notes.

ADD OR REMOVE 
NOTE TO SELECTION 

Press Ctrl + click to add or 
remove notes from the current 
selection.

SELECT MULTIPLE 
NOTES IN A ROW

Select a single note, then press 
Shift + click on another note in 
the same row.

SELECT MULTIPLE 
NOTES IN A COLUMN

Select a single note, then press 
Shift + click on another note in 
the same column.

SELECT ALL NOTES 
IN MIDI TRACK 

Press Ctrl + A to select all notes 
in the MIDI track.

SELECT ALL NOTES 
IN A ROW

Right click the row name to 
select all notes in that row.

CLEAR THE CURRENT 
SELECTION

Press the Escape key to clear 
the current selection.

EXPERT Blue
EXPERT Orange

EXPERT Yellow
EXPERT Red
EXPERT Green
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The C3 Template shows instrument difficulties 
from Expert to Easy. Each difficulty has five main 
notes: Green, Red, Yellow, Blue, and Orange.

COPY AND PASTE NOTES IN 
THE MIDI EDITOR

BASIC INSTRUMENT 
DIFFICULTIES 

Select notes in the MIDI Editor and then use 
Ctrl + C and Ctrl + V to copy and paste.

X

H

M

E

EXPERT Blue
EXPERT Orange

EXPERT Yellow
EXPERT Red
EXPERT Green

HARD Blue
HARD Orange

HARD Yellow
HARD Red
HARD Green

MEDIUM Blue
MEDIUM Orange

MEDIUM Yellow
MEDIUM Red
MEDIUM Green

EASY Blue
EASY Orange

EASY Yellow
EASY Red
EASY Green

The C3 Template (above) shows 
difficulties and note colors. 
This layout applies to the PART 
GUITAR, PART BASS, PART 
DRUMS, and PART KEYS tracks.

This book uses visual shortcuts 
for each instrument difficulty: 
X for Expert, H for Hard, M for 
Medium, and E for Easy. 

Note: Some parts of template 
have been removed to simplify 
this graphic.

EXPERT Blue
EXPERT Orange

EXPERT Yellow
EXPERT Red
EXPERT Green

EXPERT Blue
EXPERT Orange

EXPERT Yellow
EXPERT Red
EXPERT Green

EXPERT Blue
EXPERT Orange

EXPERT Yellow
EXPERT Red
EXPERT Green

Select and copy notes:

 ▪ Right click and draw a box to 
select notes

 ▪ Press Ctrl + C to copy the 
selected notes

Paste notes: 

 ▪ Press Ctrl + V 

Note: You cannot copy and 
paste between different 
instrument difficulties.

Re-position the play cursor:

 ▪ With snap enabled click to 
position the play cursor

1 2 3

1

2

3

X

X

X
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REAPER has three different view modes. Press 
Alt + 2 to return to the default view.

INTRODUCTION TO REAPERINTRODUCTION TO REAPER

Select notes and then press and hold the Ctrl 
key. Drag the selected notes to copy them to 
another difficulty. 

REAPER VIEW MODESDRAG NOTES BETWEEN  
DIFFICULTIES 

EXPERT Blue
EXPERT Orange

EXPERT Yellow
EXPERT Red
EXPERT Green

EXPERT Blue
EXPERT Orange

EXPERT Yellow
EXPERT Red
EXPERT Green

HARD Blue
HARD Orange

HARD Yellow
HARD Red
HARD Green

Select the notes you want to  
copy to another difficulty:

 ▪ Right click and draw a box 
to select notes

Move the mouse over one of the 
selected notes, and then: 

 ▪ Click and drag the selection 
to another difficulty

The selected notes will be 
highlighted:

 ▪ Press and hold the Ctrl key

1 2 3

1

2

3

Use these hotkeys to switch 
between REAPER views:

 ▪ Alt + 1 (Piano Roll)

 ▪ Alt + 2 (Named Notes)

 ▪ Alt + 3 (Events List)

Named notes is the default view 
in the C3 Template.

Note: The Events List view can 
be used to troubleshoot some 
Magma errors. Right click in 
Events View to bring up the 
context menu. 

X

H

ALT + 1 ALT + 2

ALT + 3

PIANO ROLL NAMED NOTES

EVENT LIST
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Make count-in audio samples adjust to song 
BPM changes.

If you work with more than one project tab and 
then use undo (Ctrl + Z) REAPER 4.22 will crash.

NEW PROJECT TABS AND 
UNDO (CRTL + Z)

133 INTRODUCTION TO REAPER 134

To open more than one project 
tab in REAPER click:

 ▪ File > New project tab

You will now see tabs for each 
project under the menu bar.

REAPER can crash if you use the 
undo function when more than 
one project tab is open. 

When this happens you will lose 
all unsaved work.

Do not use the undo 
function (Ctrl + Z) after 
opening new project 
tabs in REAPER 4.22.

The C3 Template includes audio 
samples in the COUNTIN track. 
The position of the samples 
is set according to the default 
BPM, which is 120. 

When the BPM for the count-
in changes the samples stay in 
their original position. 

In this case the audio samples 
must be manually repositioned 
according to the new BPM. 

To avoid this behavior we 
change the item timebase for 
each audio sample as follows:

 ▪ Press and hold the Ctrl key

 ▪ Click on each audio sample 
in the COUNTIN track to 
select them. Release the 
Ctrl key

 ▪ Press the F2 key

The Media Items Propeties 
window will open. Make sure 
that the window caption says 6 
items selected. 

 ▪ Change the Item timebase to 
Beats (position only)

 ▪ Click the OK button

Your count-in audio samples 
will now adjust to BPM changes 
in the first two measures. 

C3 TEMPLATE: COUNT-IN 
AUDIO TIMEBASE

Make this change in a 
new (un-used) project. 
Overwrite the existing 
C3 Template to make 
the change permanent:

File > Project templates 
> Save project as 
template
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Resize tracks to access REAPER FX.

 ▪ Resize MIDI tracks horizontally so that they match the 
length of your song audio.

 ▪ Un-dock the MIDI Editor to work across multiple displays.

 ▪ Load color profiles to show the Rock Band colors for each 
instrument.

 ▪ Load text event lists into the appropriate MIDI tracks. This 
will save you from having to type text events by hand.

 ▪ REAPER will crash if you use the undo function with 
multiple project tabs open. 

INTRODUCTION TO REAPER



 ▪ 4/4 Time signature 
 ▪ Notes and measures
 ▪ Basic rock beats

MUSIC 
THEORY

4
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Download links available from: 
rhythmgamingworld.com/customsbook
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Some understanding of music is needed 
to begin authoring custom songs.

In this chapter we will focus on three topics:

 ▪ Time signatures: Time signatures tell you how to count the 
beats in a measure of music. We start the chapter with the 
4/4 time signature. This is the most common time signature 
in music. You will learn what the downbeat is and how to 
count a measure of 4/4. At end of the chapter we look at 
other common time signatures.

 ▪ Measures and notes. Measures divide songs into small parts. 
Notes are divisions of measures into smaller units. We will 
look at common notes, dotted notes, rests, triplets, trills, 
and tremolo notes. 

 ▪ The basic rock beat is very common in rock music. 
Understanding this simple beat will help you tempo map 
many basic rock songs.

This chapter does not teach you everything that you need to 
know about music. But it does prepare you for the next two 
chapters: 

 ▪ A basic understanding of the first two topics will help you 
understand the MIDI Editor grid. 

 ▪ Understanding time signatures and counting beats will help 
with tempo mapping. 
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4 
4

A time signature tells you how to count the 
rhythm, or beats, of a song. 4/4 is the most 
common time signature in music.

THE 4/4 TIME SIGNATURE 

Beats per measure

Type of beat note

Time signatures are written with 
one number above the other.

The upper number tells you 
how many beats there are in a 
measure. 

The lower number tells you 
what type of notes the beat 
notes are.

The 4/4 time signature has four 
beats per measure.

The type of beat note is a 
quarter note. 

This means that there are 
four quarter notes beats in a 
measure of 4/4.

Measures are small sections of a song. The 
number of beats per measure depends on the 
time signature.

MEASURES 

Measure 1 Measure 2

Common Beat Note 
Types:

2: Half Note 
4: Quarter Note 
8: Eighth Note 

TIME SIGNATURE
Every song starts with a time 
signature (see measure 1 above).

It is common for many rock and 
popular songs to only have one 
time signature. This is typically 
the 4/4 time signature.

A new time signature is added 
only when the time signature 
changes (see measure 2). 

Measure 3

BAR LINES
Each measure starts and ends 
with bar lines.

There are several different types 
of bar lines in music:

Bar Lines

 
Double bar lines mark the 
start and ends of sections
 
End bar lines mark the end 
of a song
 
Start repeat lines mark the 
start of a repeated section

:

 
Single bar lines mark the 
start and end of measures

 
End repeat lines mark the 
end of a repeated section

:

 

BEATS
In the three measures above 
there are ten quarter note beats 
in total.

The measure of 4/4 has four 
beats. The two 3/4 measures 
have three beats each.

4 
4

3 
4



143 144MUSIC THEORYMUSIC THEORY

Individual notes are divisions or multiples of 
measures. The most common notes range from 
whole notes to sixteenth notes. 

NOTE LENGTHS AND MUSIC 
NOTATION 

Whole Note

Double Whole Note

Half Note

Quarter Note

Eighth Note

Sixteenth Note

Thirty-second Note

Sixty-fourth Note

One Hundred Twenty-eighth Note

Each note is half the 
size of the note above.

For example, two 
quarter notes make a 
half note.

Measure 1 Measure 2

NOTE REST

q

BEATS

Q

h H

w W

e E

s S

4

2

1

1/2

1/4

The notation for the most 
common notes and rests is to 
the left. 

A rest is silent. It is a note that 
is not played.

The beats column shows the 
number of 4/4 beats for each of 
the most common notes. 

4 
4

1/8
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Dotted notes are notes with a dot next to them. 
The dot makes the note longer by adding half of 
its value. 

COMMON DOTTED 
NOTES  

NOTE VALUE BEATS NAME

w. w+ h Dotted Whole Note4 + 2 = 6

d h+ q Dotted Half Note2 + 1 = 3

j q+ e Dotted Quarter Note1 + ½ = 1 ½

i e+ s Dotted Eighth Note½ + ⅛ = ⅜

OVERVIEW

Notes and rests can both be 
dotted. 

A dotted note adds half of its 
value to itself. 

Above you can see a table with 
some common dotted notes. 
The table shows dotted notes, 
their musical values, and the 
number of beats they take.

BAR LINES

A dotted note must stay within 
the measure.

Dotted notes cannot cross bar 
lines. 

DOUBLE AND TRIPLE 
DOTTED NOTES
Double-dotted notes have two 
small dots after the note.

Double-dotted notes add 
three quarters of their value to 
themselves.

Triple dotted notes are not 
very common. They add seven 
eighths of their value to 
themselves. 

Emphasis on different beats is an important 
part of the feel of a song.

COUNTING QUARTER 
NOTE BEATS

1 2 3 4

To the left is a measure of 4/4. 
It has four quarter notes beats.

Follow the dots and count:

 ▪ One, Two, Three, Four 

The speed at which you count 
depends on the tempo.

TEMPO
Tempo is measured in beats per 
minute or BPM. 

Below is a list of tempos and 
their approximate bpm:

 ▪ Slow (66 — 76 bpm)

 ▪ Walking pace (76 — 108 
bpm)

 ▪ Moderate (98 — 112 bpm)

 ▪ Fast (120 — 156 bpm)

 ▪ Very fast (156 — 176 bpm)

 ▪ Very, very fast (168 —200 
bpm)

 ▪ Extremely fast (200 + bpm)

EXAMPLE
A great example is the intro 
to “New Kid in School” by The 
Donnas. Torry Castellano plays 
quarter note kicks (with a few 
8th note toms). 

Emphasis on different beats 
changes the feel of music:

EMPHASIS

Strong Beat
Medium Beat
Weak Beat

In 4/4 the first beat of the 
measure is the downbeat (the 
strongest beat in the measure).

The third beat often has an 
emphasis too, but not as strong 
as the downbeat. 

This leaves the weakest beats of 
the measure on two and four.

Count the measure with this 
emphasis:

 ▪ One, Two, Three, Four

Downbeat

The key to tempo 
mapping is to identify 
the downbeat at the 
start of the measure.

q q q q

4/4 Measure
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A sixteenth note rock beat features sixteenth 
notes with emphasis on beats two and four.

MUSIC THEORYMUSIC THEORY

COUNTING SIXTEENTH 
NOTE ROCK BEATS 

A basic 4/4 rock beat features eighth notes with 
emphasis on beats two and four.

COUNTING EIGHTH NOTE 
ROCK BEATS 

& & & &e a e a e a e a

SIXTEENTH NOTE ROCK BEAT

Hi-hat

Snare

Kick

& & & &e a e a e a e a

The measure to the left shows 
the emphasis in a sixteenth 
note rock beat. 

Count the measure like this:

 ▪ One e and a, Two e and a, 
Three e and a, Four e and a

EMPHASIS
This beat is the same as the 
eighth note rock beat except for 
the sixteenth note hi-hats.

It rocks from beats one to two, 
and then three to four, just like 
the eighth note beat. 

The 16th note hi-hats provide a 
faster pulse to the rhythm.

EXAMPLE
The first verse of “Crazy Train” 
by Ozzy Osbourne is a good 
example of this beat. 

4/4 Measure

BASIC ROCK BEAT

& & & &

& & & &

Hi-hat

Snare

Kick

To the right is a measure of 
eighth notes. It shows the 
emphasis in a basic rock beat.

Count the measure like this:

 ▪ One and two and three and 
four and

EMPHASIS
In a basic rock beat the 
emphasis is on the snare and 
hi-hat (beats two and four).

There is less emphasis on the 
one and three (kick and hi-hat). 

This beat produces a rocking 
rhythm. It rocks from beats one 
to two, and then three to four.

The eighth note hi-hats help to 
drive this rhythm.

EXAMPLE
A classic example of this beat in 
Rock Band is “Back in Black” by 
AC/DC. 

q q q q q q q q qq qq qq qq qq qq qq qq

4/4 Measure

1 2 3 4

1 2 3 4

1 2 3 4

1 2 3 4
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Eighth note triplets are very common. They 
divide two eighth notes into three.

EIGHTH NOTE TRIPLETS

MUSIC THEORYMUSIC THEORY

Triplets divide two regular beats into three  
equal parts.

To the right you can see two 
measures of 2/4.

There are two quarter notes 
beats to each measure. 

Quarter note triplets divide two 
quarter note beats into three 
evenly spaced notes.

TRIPLETS 

q

1 2 1

q

NOTATION
All triplets have a number “3” 
next to them. Triplets can be 
written in a few different ways:

 ▪ With a slur (or arc) above or 
below

 ▪ With beamed notes and the 
number 3

 ▪ With brackets

3

3

q  q  q q  q  q

q
3

3
q  q  q q  q  q

3

q

COUNTING
When you count triplets choose 
the method that works best for 
you. For example:

 ▪ Trip - ah - let

 ▪ One - Trip - Let, Two - Trip 
- Let 

 ▪ One - ta - ta, Two - ta - ta

 ▪ Ta - ki -ta, Ta - ki -ta

The first two options will help 
reinforce the idea that you are 
counting triplets. 

Consider the last two options, 
or something similar, if you are 
counting fast triplets. “Trip - ah 
let” is not that easy to say fast. 

ADVANCED TRIPLETS
Triplets can have rests in them. 
Triplets can also have more 
than three notes.

In either case the total value of 
the notes and rests will be the 
same as a basic triplet.

In the example above, 
grey shades show how 
to divide the measures.

To the left you can see two 
eighth note triplets on beats 
three and four. q

2/4 Measure 4/4 Measure

&& Trip Let

q q q q qq q qq
33

COUNTING 
Start by counting half a 
measure of 8th notes and then 
add in the eighth note triplets. 

Refer to the grey shading to 
help you visualize the rhythms. 

Notice how each note is evenly 
spaced. None of the rhythms 
should feel rushed. 

EXAMPLE
Check out “Far Beyond the Sun” 
by Yngwie Malmsteen. The intro 
features fast eighth note triplets 
that really grab your attention!

All the examples above show 
triplet notes.

A full measure of 8th 
note triplets is twelve 
notes in total:

One - Trip - let  
Two - Trip - let 
Three - Trip - let 
Four - Trip - let

An eighth note triplet is three 
notes played in the space of 
two eighth notes. 

Or, to put it another way, an 
eighth note triplet is a quarter 
note divided evenly into three.

Use the count track above the 
notes as a guide for counting.

Trip LetTrip Let &1 2 3 4

q q
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THE 12/8 TIME SIGNATURE

12/8 is a popular time signature with a three 
note per beat “shuffle” feel.

MUSIC THEORYMUSIC THEORY

3/4 is a very common time 
signature. It has three beats per 
measure with emphasis on the 
downbeat. 

This gives 3/4 a “waltz” feel:

 ▪ One - Two - Three, One - 
Two - Three

A measure of 3/4 can fit in a measure of 6/8. So 
how are these two time signatures different?

THE 3/4 AND 6/8 TIME 
SIGNATURES

1 2 3 4

Downbeat

q q q

1 2 3 4

6/8
6/8 has six 8th notes per 
measure. With the 8th notes 
grouped in sets of three this 
gives us two beats per measure.

This gives a “pendulum” feel:

 ▪ One - Two - Three, Four - 
Five - Six

3/4 Measure

1 4 4

Downbeat

q q

6/8 Measure

q q q q

3/4

3/4 is a simple time signature. 
The beats divide by two. 

Group 8th notes in 3/4 like this:

 ▪ One - &, Two - &, Three - &

3/4 SIMPLE TIME
6/8 is a type of compound time 
signature. This means that the  
beats divide into three (instead 
of two):

 ▪ One - Two -Three, Four - 
Five - Six

6/8 COMPOUND TIME
Check out “Lucy in the Sky with 
Diamonds” by The Beatles as an 
example of 3/4 time.

For an example in 6/8 listen to 
“House of the Rising Sun” by 
The Animals.

EXAMPLES

n n n

q q q q q q q q q q q q

2 3 5 6

2 3 2 3 2 3 2 3

12/8 is another example of a 
compound time signature.

With eighth notes grouped in 
sets of three, there are four 
beats per measure. 

It has a “shuffle” feel with 
emphasis on each beat.

12/8 

You can write 12/8 as eighth 
note triplets in a 4/4, but this is 
not recommended. 

If you author 12/8 this way you 
will find that your grid lines will 
not look right in-game.

4/4 TRIPLETS

q q q q q q q q q q q q
3 3 3 3

Emphasis on every 8th note 
really brings out the shuffle 
sound of 12/8 time.

For Example “Lost In Yesterday” 
by Tame Impala.

“SHUFFLE” SOUND
At slower tempos 12/8 can feel 
like two measures of 6/8.

For example, you could notate 
“Perfect Day” by Lou Reed in 
12/8 or 6/8.

TEMPO
Listen to “The Way You Make Me 
Feel” by Michael Jackson for an 
example of 12/8 time.

Other examples include “Bury 
A Friend” by Billie Eilish, 
“Everybody Wants To Rule The 
World” by Tears for Fears, and 
“Dazed And Confused” by Led 
Zeppelin.

EXAMPLES

12/8 Measure

4/4 Measure

T T
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The 7/4 time signature has seven quarter notes 
per measure. 

THE 7/4 TIME SIGNATURE

The 7/8 time signature has seven 8th notes. It 
typically has three main beats. 

THE 7/8 TIME SIGNATURE 

1 1 12 2 3

7/8 Measure

q q q q q q q

2

1 1 12 3

7/8 Measure

q q q qq q q

2 2

7/8 is a complex time signature.  
The number of beats does not 
divide equally into groups of two  
or three.

For example, the first 7/8 
measure here is 2 + 2 + 3 beats. 

You can count this in a couple 
of different ways:

 ▪ One - Two, Three - Four, 
Five - Six -Seven 

 ▪ One - Two, One - Two, One - 
Two - Three

Use whichever feels more 
natural to you.

7/8

The emphasis in 7/8 depends on 
how your group the eighth notes 
together.

You can use any combination of 
2 + 2 + 3 notes. For example:

3 + 2 + 2 
2 + 3 + 2 
2 + 2 + 3

EMPHASIS
The 3 + 2 + 2 pattern is above. 

Notice how it feels different to 
count from the first pattern:

 ▪ One - Two - Three,  Four - 
Five,  Six -Seven

 ▪ One - Two - Three , One - 
Two, One - Two

Listen to “Natural Science” part 
II: “Hyperspace” by Rush.

Count the 7/8 section as 
follows:

 ▪ One - Two, One - Two, One - 
Two - Three

EXAMPLE
7/4 has an uneven feel. It feels 
like two measures of 4/4 but 
with one beat missing at the 
end of the measure.

7/4 FEEL 4/4 + 3/4
Check out the verses of “Money” 
by Pink Floyd for a great 
example of 7/4 time.

“Solsbury Hill” by Peter Gabriel 
is another example. The intro 
features a 3 + 4 pattern that 
switches to a 4 + 3 pattern. 

EXAMPLES

7/4, like 7/8 is a complex time 
signature. But, with seven 
quarter notes per measure, the 
beat feels more even.

7/4 will often have quarter notes 
groups of three and four:

One - Two - Three - Four,  Five 
- Six -Seven 

One - Two - Three, Four - Five - 
Six -Seven

7/4
1 3 5

7/4 Measure

2

q q q q q q q

1

7/4 Measure

q q q qq q q

4 6 7

1 3 52 4 6 7

If you wanted to you could write 
7/4 as alternating measures of 
4/4 and 3/4. Or 3/4 and 4/4.

Note: This means more for you 
to keep track of in REAPER.

Also 4/4 + 3/4 or 4/4 + 3/4 will 
look different in game than a 
single measure of 7/4. 
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A trill is two notes that alternate quickly.

TRILLS 

Tremolo is the very fast repetition of notes or 
chords.

TREMOLO NOTES

155 MUSIC THEORY 156

Trills are common in music. 
They are fast alternating notes 
that are usually a half-tone, or 
tone apart.

On guitar and bass a trill is two 
alternate notes played quickly 
on the same string. 

Guitar and bass players use 
a hammer-on and pull-off 
technique to play trills.

Keyboard players use either 
hand to play trills.  

In Rock Band you will find trills 
played on guitar, bass, and keys.

TAPPED TRILLS
Tapped trills are a special 
technique played on the guitar. 
The guitarist fingers the lower 
notes with their left hand. The 
right hand then hits the edge 
of the pick against the string 
to play the higher notes. The 
left and right hands can move 
away from each other with this 

technique. This allows for a 
greater interval range between 
trilled notes. 

Tapped trills are usually played 
very fast. The use of the edge 
of the pick gives tapped trills a 
unique sound. 

X

16th NOTE TRILL

Check out “Crazy Train” by Ozzy 
Osbourne. Trills start about half 
way through the guitar solo. 

For tapped trills listen to 
“Surfing with the Alien” by Joe 
Satriani. Almost half of the first 
guitar solo is tapped trills.

EXAMPLES

Tremolo is common in music. 
It is the very fast repetition of 
notes or chords. Tremolo is 
usually notated as 32nd notes.

Guitar and bass players use 
their fingers or a pick to play 
tremolo notes. When using a 
pick this is commonly referred 
to as “tremolo picking”. 

Keyboard players and pianists 
play two notes an octave apart 
for a tremolo effect. 

X

Unmeasured tremolo, or trem., 
is played as fast as possible. 

Measured tremolo matches a 
precise rhythm. 

Musical notation should say 
which kind of tremolo to play.

UNMEASURED
Trill markers are used 
in Rock Band for guitar, 
bass and keys.

Tremolo markers are  
used for guitar and 
bass only.

A Tremolo note has three 
strokes through the note stem. 
When a note has no stem the 
strokes are above the note.

NOTATION

OVERVIEW OVERVIEW

qq qq qq qq qq q

32nd NOTE TREMOLO
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1

157 INTRODUCTION 158

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ 4/4 is the most common time signature. It has four quarter 
note beats with emphasis on beats one and three.

 ▪ Identifying the downbeat at the start of each measure is key 
to tempo mapping.

 ▪ Eighth and sixteenth note rock beats put emphasis on beats 
two and four.

 ▪ Triplets divide two regular beats into three equal parts.

 ▪ 3/4 has three quarter note beats. The emphasis is on the 
downbeat. 

 ▪ 6/8 has six eighth notes. The emphasis is on beats one and 
four.

 ▪ 12/8 has twelve eighth notes, grouped in sets of three. The 
emphasis is usually on beats one, two, three, and four.

 ▪ 7/8 has seven eighth notes. There are three beats to the 
measure with groups of two and three notes.

 ▪ 7/4 has seven quarter notes. They are often grouped into 
sets of three and four notes.

MUSIC THEORY



 ▪ Straight notes
 ▪ Triplets and swing notes
 ▪ Note pitch and velocity

5
THE MIDI 
EDITOR GRID



Download links available from: 
rhythmgamingworld.com/customsbook

Use the MIDI Editor grid to author straight, 
triplet, and swing notes in your custom 
song charts. 

In this chapter we focus on the main features of the MIDI Editor 
grid. You will learn about:

 ▪ Grid types: the different grid types that you can use to 
author notes and rhythms

 ▪ Grid size: the different sizes of grids you can use, and the 
best size for most situations

 ▪ Note size: the different note sizes available, and when to 
use a size other than the grid size

 ▪ Note color: the color of MIDI notes and other information 
associated with MIDI notes. We will focus on note velocity 
and how to use it for trill and tremolo markers.

At the end of this chapter, you will know how to use the MIDI 
Editor grid to draw common musical notes.

161 THE MIDI EDITOR GRID 162THE MIDI EDITOR GRID
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On the right, you can see a 
single measure of 4/4.

The measure is divided into four 
quarters. 

Each quarter has eight notes. 

This gives us a total of 32 notes 
per measure.

At the top of the grid is the MIDI 
Editor timeline.

At the bottom of the MIDI grid 
are some drop down menus:

 ▪ Grid size

 ▪ Grid type

 ▪ Note size

 ▪ Color

The menus are enlarged to 
better show their values.

The default time signature in the C3 Template is  
4/4. The default grid size is thirty-second notes.

INTRODUCTION TO THE 
MIDI GRID 

Measure

Grid TypeGrid Size

The grid size drop down menu 
lets you change the size of the 
MIDI Editor grid. The default size 
is 32nd notes. 

This is a good grid size to work 
with most of the time. With this 
grid size you can work with 16th 
notes and have a gap between 
each note. This gap makes MIDI 
charts easier to read. Blue notes 
in particular are hard to tell 
apart when they are drawn next 
to each other. You can work 
with smaller or larger grid sizes 
as needed. 

Tip: You can type note values 
into the grid size drop down 
menu. For example, type 1/20 
for quintuplet notes. 

GRID SIZE
The grid type menu lets you 
choose different MIDI grids.

The default grid is straight 
notes. This is for normal, 
regularly spaced notes. It is the 
grid type that you will likely use 
most of the time.

The second grid is the triplet 
grid. Switch to this grid when 
you are charting triplet notes.

The dotted grid gives you a grid 
of dotted note values. It is not 
a grid that is commonly, if ever, 
used to make customs.

The last grid type is the swing 
grid. Use this grid to chart a 
swing rhythm - a rhythm that is 
not completely straight. 

GRID TYPE
The note size drop down lets 
you choose a note size to draw.

For single (unsustained) notes 
do not choose a note size larger 
than a 16th note. 

The default setting is grid. This 
setting draws notes that relate 
to the grid size. 

Below you can see a 16th note 
drum pattern on the default 
32nd note grid. If the grid size 
was 16th notes then these notes 
would be touching each other. 
This would make the chart 
harder to read.

 
For drums, guitar, and bass start 
with a 1/32 grid with the note 
size set to Grid.  

NOTE SIZE

Note Size

MIDI Editor Timeline

TIMELINE
The timeline displays measures, 
beats, and fractions of a beat. 
For example, 3.4 is measure 
three, beat four.

COLOR
This menu lets you view 
MIDI notes by their different 
properties. The default setting 
is pitch which displays note 
colors. You will only rarely need 
to change this setting.

Color

OVERVIEW
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Use the 32nd note grid to author most notes.

  
Beat Four 

 
Beat Three

  
Beat Two 

Measure 3  
Beat One 

THE MIDI EDITOR GRID

32nd notes are drawn 
an 8th of a beat apart. 
Use 64th notes with a 
64th note gap.

A quarter note takes 
up a whole beat. (A 
1/16th note gap is added 
before the next note).

8th notes are drawn 
half a beat apart.

16th notes are drawn a 
quarter beat apart 

The MIDI Editor timeline shows 
measures, beats, and fractions 
of a beat.

As you zoom in and out the 
MIDI Editor timeline and grid 
will expand and shrink. 

To see the 32nd note grid, 
zoom in until you can see half 
note beats in the timeline. For 
example, 3.1.50 is a half note 
beat. It is halfway between 
beats 3.1 and 3.2.

To the right you can see how to 
draw some common notes in 
relation to the timeline.

Use the MIDI Editor timeline 
to help you position notes 
correctly. 

Note: The white cut out notes 
show the gap(s) between notes.

Tip: Remember this is a 32nd 
note grid. Two 32nd notes make 
a 16th note gap. 

3.43.33.23.1

THE 32ND NOTE GRID AND 
TIMELINE

3.1.50 3.2.50 3.3.50 3.4.50

165 166

q Quarter note

e Eighth notes

s Sixteenth notes

Thirty-second notes

 
Half Beat

 
Half Beat

 
Half Beat

 
Half Beat
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Whole notes

To the right are some common 
notes on a straight 4/4 grid.

Notes up to 16th notes are on 
the 32nd note grid. 32nd notes 
are on the 64th note grid.

The whole, half, and quarter 
notes here are sustained 
notes. There is a 16th note gap 
between the end of the sustain 
and the start of the next note. 

Eighth notes have three 32nd 
notes between them.

Sixteenth notes have one 32nd 
note between them.

The 32nd notes are 64th notes 
with a gap of one 64th note 
between them.

Note: The white cut out notes 
show the gaps between notes.

Tip: Two 32nd notes make a 
16th note gap.

The straight grid is the grid that you will use 
most of the time. 

THE STRAIGHT GRID

3.1 3.2 3.3 3.4

w

h

q

Half notes

Quarter notes

Notice that MIDI notes do not 
need to be drawn the same size 
as their note name. 

Unless a note is sustained it 
should never be drawn larger 
than a 16th note.

Space between notes in the 
same row makes them easier 
to read.

e Eighth notes

s Sixteenth notes

Thirty-second notes

Measure 3  
Beat One 

 
Beat Two 

 
Beat Three

 
Beat Four 

3.1.50 3.2.50 3.3.50 3.4.50
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The measure to the right shows 
8th and 16th note triplets in a 
single 4/4 measure.

8th note triplets have three 
notes per beat.

You can use a 16th or 32nd note 
triplet grid to draw 8th note 
triplets. Use the one that makes 
the most sense to you.

Do not use an 8th note triplet 
grid. This will make all your 
notes sustained notes.

16th note triplets have six notes 
per beat.

A 32nd note triplet grid works 
best for 16th note triplets.

Note: The white cut out notes 
show the gaps between notes.

Use the triplet grid to author triplet notes. 
Eighth and sixteenth note triplets are the 
most common.

THE TRIPLET GRID

8th note triplets with 16th note 
triplet grid

Measure 3  
Beat One 

 
Beat Two 

 
Beat Three

 
Beat Four 

3.1 3.2 3.3 3.4

8th note triplets with 32nd note 
triplet grid

16th note triplets with 32nd 
note triplet grid

169
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The straight and triplet grids are 
fixed grids. You cannot move or 
change the gridlines. 

This is not the case with the 
swing grid.

With the swing grid you can 
move offbeat notes out of their 
straight positions.

To do this you use the strength 
slider at the bottom of the MIDI 
Editor window:

You can see this in the example 
to the right.

In the bottom half of the 
graphic the strength slider has 
been set to 50%. 

This has swung the off beat grid 
half way to the right.

You use the slider so that the 
swing grid matches the swing 
rhythm in your audio track.

Use the swing grid to author songs that have a 
swing beat.

THE SWING GRID

Kick When you select the swing grid 
the strength slider appears at 
the bottom of the MIDI Editor.

Measure 3  
Beat One 

 
Beat Two 

 
Beat Three

 
Beat Four 

3.1.00 3.2.00 3.3.00 3.4.00

Strength: 50 %
Hi-hat

SWING GRID: NO SWING

SWING GRID: 50% SWING
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THE SWING GRID: IN DEPTH 2

If you have many notes that you 
want to move with the swing 
grid use this option.

To the left, the swing grid has 
been set to 50%. 

Notice that only some of the off 
beat notes have been moved 
with the swing grid. 

To move notes with the swing 
grid first select them. Then  
click the Quantize button in the 
MIDI Editor toolbar.

In the Quantize Events window 
use the following settings:

 ▪ Settings: Use grid

 ▪ Quantize: Selected notes 
and Position

 ▪ Strength: 100%

Do not close the Quantize 
Events window. Now use the 
Strength slider to change the 
position of the selected notes.  

To move all notes (instead of 
selected notes) set Quantize to 
All notes.

Set the swing grid to author swing notes. Use 
the quantize button to move selected notes 
with the swing grid.

THE SWING GRID: IN DEPTH 

SWING STRENGTH

The slider moves the swing grid 
lines to the left and right.

This allows you to swing notes 
out of their straight rhythms. 

 

The dark grey arrows show the 
range of movement for swing 
notes in the MIDI Editor.

By default the swing grid does 
not move any notes on the grid.

Strength: 0 %

Move the strength slider to 
adjust the swing grid to the left 
and right.

Tip: You can also enter values in 
the text box between -100 and 
100%. A value of zero resets the 
swing grid to a straight grid.

You can find 8th note swing 
beats in traditional jazz. 

In other genres of music the 
swing is mostly applied to 16th 
note rhythms.

To author swing notes move the 
swing grid to match the swing 
notes in your song.

Turn on Snap in the MIDI Editor 
and draw swing notes on the 
swing grid to match the music.

3 3.2 3.3 3.4

SWING BEATS

Strength: 50 %

3 3.2 3.3 3.4

AUTHORING 

MOVE WITH GRID 
On the right is an 8th note beat 
with an 8th note swing grid.

At the moment the rhythm is 
straight. The time between 
beats and notes is the same. 

Notice that the swing grid looks 
a little different than a regular 
straight grid:

 ▪ The swing grid has grey  
ball markers on the  
offbeat notes:

 ▪ At the bottom of the MIDI 
Editor there is a swing 
strength slider:

Quantize

8th Note Swing Grid Swing Grid Movement
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The graphic to the left shows 
the same trill viewed by Velocity. 

The trill notes have a velocity of 
96. But, as you can see, the trill 
marker has a different velocity.

The velocity of the trill marker is 
set to 50 so that it works on the 
Expert and Hard difficulties. 

To set the trill marker to only 
work on Expert change the 
velocity back to 96.

The color drop down menu has 
six options:

 ▪ Velocity

 ▪ Channel

 ▪ Pitch

 ▪ Source

 ▪ Track

 ▪ Media Item

We will look at the Pitch and 
Velocity options.

To the right you can see a trill 
and trill marker viewed by Pitch.

The color drop down menu provides MIDI 
note information using color. 

Velocity is used on trill and tremolo markers. 

THE COLOR DROP DOWN 
MENU: VELOCITY 

THE COLOR DROP DOWN 
MENU: PITCH

PITCH
Pitch is the default option in the 
color drop down menu. It shows 
the note colors for instruments 
in the MIDI editor. 

This is the setting that you will 
use most of the time.

All notes in the MIDI Editor have 
a velocity assigned to them. The 
default value is 96.

When you view notes by their 
velocity, their color will change. 

Note: You only need to change 
note velocity in special 
situations.

VELOCITY

X

H

COLOR: PITCH

X

H

COLOR: VELOCITY

Follow these two steps to 
change the velocity of note(s):

 ▪ Select note(s) and then right 
click them

 ▪ Navigate through the Note 
velocity context menu to set 
a new value

CHANGE VELOCITY
 

Do not use a note 
velocity of 40 or lower.

If you do Magma will 
report a note spacing 
error when you compile 
your project.

Trill and tremolo markers need 
a velocity between 41 - 50 to 
work on Expert and Hard.

Expert only trill and tremolo 
markers have a velocity of 96.

NOTE VELOCITY
Velocity 50

Velocity 96



 ▪ How to tempo map
 ▪ The Q and T method
 ▪ The Scroll and Timeline methods

6
TEMPO 
MAPPING
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Always tempo map to the drum track 
if there is one. 

Your tempo map keeps your MIDI notes in 
time with the song audio.

In this chapter you will learn: 

 ▪ The differences between different tempo mapping methods

 ▪ The elements that make up a tempo map

 ▪ Tempo map and beat track limitations

 ▪ How to import audio

 ▪ How to scrub audio and use a separated drum waveform

 ▪ How to tempo map the count-in and first song measure

 ▪ How to render your song for audio separation

 ▪ How to change the time signature

We start with the Q and T method found in the official RBN/
C3 documentation. We end the chapter with a brief look at the 
Scroll and Timeline tempo mapping methods.

To make tempo mapping easier I recommend that you use 
separated drum tracks. It is not difficult to do, and this chapter 
includes the first steps!

TEMPO MAPPINGTEMPO MAPPING 180
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An accurate tempo map is the most important 
part of your custom song.

In the last few chapters we’ve 
covered a lot of ground. We 
talked about time signatures 
and counted musical time. We 
also talked about the MIDI grid 
and common note values. In the 
next few chapters we build on 
this knowledge to learn how to 
tempo map.

Tempo mapping is a repetitive 
process that marks the rhythm 
of a song. Its purpose is make 
sure that your MIDI grid lines up 
with the beats in your song. 

I recommend that you start 
with a song that has a simple 
drumbeat. This is because you 
will likely have a downbeat at 
the start of each measure. This 
has a few advantages: 

 ▪ The downbeat will be regular 
and predictable

 ▪ You will most likely be 
tempo mapping kicks *

 ▪ You can place one tempo 
marker per measure
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If you follow this advice you 
should find that your first song 
is not too hard to tempo map.

Having said that you should 
be aware that some genres of 
music can be harder to tempo 
map than others. 

Electronically produced songs, 
for example, should be easy 
to tempo map. They typically 
have a consistent tempo and a 
downbeat at the start of each 
measure. 

Other songs will need more 
work to create an accurate 
tempo map. This applies to 
bands that record with, and 
without, a click track.

Take punk rock for example. 
Part of its character is simple 
beats with a more chaotic 
performance. The resulting 
variations in tempo can make it 
harder to tempo map.

Compare this to progressive 
rock. Here you can expect 
tighter time-keeping but that 
does not mean a perfect 
performance. The tempo may 
still vary from measure to 
measure. On top of that you 
may have to deal with complex 
rhythms, tempo changes, and 
odd time signatures. You may 
not have a downbeat at the 
start of each measure either. 

There are many things that can 
make tempo mapping more (or 
less) challenging. So pick your 
first song accordingly!

AUDIO QUALITY

INTRODUCTION TO TEMPO 
MAPPING 

You should use the highest 
quality audio that you can for 
your custom songs.  

For most people this means 
ripping music from a CD or 
using an .mp3 file. 

To rip music from CD you can 
use Windows Media Player. It 
outputs audio to the .flac and 
.wav file formats.

I use .flac files because they 
are good quality and take up far 
less space than .wav files.

If .mp3 is your only option make 
sure that you use the highest 
quality that you can:

 ▪ 320 kbps - highest quality 

 ▪ 256 kbps - high quality

 ▪ 128 kps - low quality

Do not use music from 
potentially low quality sources 
such as YouTube music videos. 

Separated audio is highly 
recommended for tempo 
mapping. It will give you clear 
transients to work with.

Transients are short bursts of 
energy that you hear at the start 
of a sound. You can see this 
burst in the example waveform 
on this page.

Clear transients like this are 
easier to tempo map:

 ▪ Place a tempo marker at the 
start of the transient, or

 ▪ Adjust the MIDI grid so that 
it lines up with the start of 
the transient, and place a 
tempo marker

Common transients that you will 
encounter include:

 ▪ Kick drum

 ▪ Snare hit

 ▪ Pick attack on guitar strings 

OVERVIEW

* Downbeats in simple 
drum patterns are 
usually kicks or hi-hats.

SEPARATED AUDIO AND TRANSIENTS

Note: You should always focus 
on the drums when tempo 
mapping. If you do not have a 
drum track to tempo map you 
can use transients from other 
prominent instruments.

In the next topic we will discuss 
different tempo mapping 
methods. You will see that there 
are several methods that you 
can use to tempo map.

KICK TRANSIENT
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There are several tempo mapping methods to 
choose from. 

TEMPO MAPPING METHODS

This is the method outlined in 
the Rock Band Network (RBN) 
documentation. It is the main 
focus of this chapter:

 ▪ Q is used to tempo map 
measures

 ▪ T is used to tempo map a 
measure and change time 
signature

Pros and Cons:

 ▪ Good for songs with a steady 
downbeat at the start of 
each measure

 ▪ Difficult to fix mistakes

 ▪ Not compatible with the 
timeline method
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With this method you place 
project markers and tempo map 
between them:

 ▪ Press M to place markers

 ▪ Press Shift + Q to tempo 
map between markers

Pros and Cons:

 ▪ Tempo maps beats or 
downbeats

 ▪ Good for songs that slow 
down or speed up

 ▪ Easy to fix mistakes

 ▪ Good for simple or complex 
songs

 ▪ A custom action is required

This is a flexible method. Beats 
can be tempo mapped with a 
temporary time signature such 
as 1/4 or even 1/8. 

With scroll tempo mapping you 
stretch or shrink the grid to 
match the audio waveform:

 ▪ Use the mouse wheel to 
stretch or shrink the grid

 ▪ Place tempo markers with Q 
and T or place Markers and 
tempo map with Alt + Q

Pros and Cons:

 ▪ Quick visual method

 ▪ Can map between a marker 
and the play cursor 

 ▪ A custom action is required

 ▪ Separated audio is required

This is a flexible and intuitive 
method. It maps in a forward 
direction so that you can see 
where tempo markers need to 
be placed (pages 221 — 222).

This method uses the tempo 
envelope to stretch and shrink 
the grid to match the audio:

 ▪ Adjust the tempo envelope 
to stretch or shrink the grid

 ▪ Shift click in the timeline to 
create a tempo marker

Pros and Cons:

 ▪ Quick visual method

 ▪ Erases Q and T method 
tempo maps

 ▪ Restricted to one time 
signature

 ▪ Separated audio required

The downside of this method 
is that the vertical size of the 
Master track needs to be very 
large. This allows for fine control 
over the size of the MIDI grid 
when adjusting the timeline. 
See pages 223 — 224.

There are two ways of finding 
beats and downbeats in your 
audio track(s):

 ▪ Tempo mapping the audio 
waveform, or 

 ▪ Scrubbing the audio

Tempo map transients in one of 
the following ways:

 ▪ Tab to transient 
(recommended)

 ▪ Click to position the play 
cursor on the transient

 ▪ Use the scroll method to 
align the MIDI grid with 
transient(s)

 ▪ Use the timeline method 
to align the MIDI grid with 
transient(s)

To scrub, drag the play cursor 
slowly back and forth through 
the audio. Listen for beats or 
downbeats.

THE Q AND T 
METHOD

ADVANCED TEMPO 
MAPPING

THE SCROLL TEMPO 
MAP METHOD

THE TIMELINE 
METHOD

FINDING BEATS AND 
DOWNBEATS

This can take a bit of practise 
until you gain confidence. Refer 
to the How To Scrub Audio 
focus page if you need to. See 
pages 195 — 196.

Tempo mapping to the 
waveform requires stems or 
separated audio. This gives you 
a clean waveform to work with 
and transients to tempo map.

Scrub audio

Map waveform

Grid to waveform

Timeline & grid to 
waveform

AUTHOR RECOMMENDED
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Tempo markers can be deleted 
from the timeline if needed:

 ▪ Press and hold the Alt key

 ▪ Click the tempo marker

The tempo marker will be 
removed.

To the right you can see the 
first few measures of a typical 
tempo map. 

At the bottom of the graphic 
you can see the count-in track. 
It is two measures long and has 
samples to count-in the song.

Notice that the count-in and 
the first song measure have the 
same BPM. This ensures that 
the player is counted into the 
song at the right tempo.

In the audio track you can see 
that the song starts at measure 
three. Notice how the peaks in 
the audio waveform line up with 
the grid in the timeline.

The master track shows a blue 
line called the tempo envelope. 
This line shows the tempo map 
of the song. 

In the timeline there are tempo 
markers. They show the time 
signature and song BPM.

TEMPO MAP OVERVIEW 

The first two measure are set 
aside for the count-in.

Tempo Markers: Set the time 
signature and BPM for the 
following measure(s).

Tempo Envelope Points: Show 
the position of tempo markers 
in the tempo envelope.

Tempo Envelope: The blue line 
on the Master Track. It visually 
represents the project tempo.

Project Timeline: Shows 
measures and beats, minutes 
and seconds.

The song audio starts at 
measure three.

Hi-hat audio samples are the  
default song count-in.

Always save or make 
a backup before trying 
to fix a mistake in a 
tempo map.

152.831T152.831, 4/4
1.1.00
0:00.000

1.3.00 2.1.00 2.3.00 3.1.00 3.3.00 4.1.00 4.3.00 5.1.00
0:01.000 0:02.000 0:03.000 0:04.000 0:05.000 0:06.000 0:07.000 0:01.000

T 152.831T 153.215T

3.1.00

T 152.831, 4/4 1.1.00
0:00.000

153.215T

MASTER TRACK

COUNT-IN TRACK

AUDIO TRACK
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A solution for very short 
measures is to merge them with 
another measure.

For example, the 3/8 measure 
here could be merged with 
the 2/4 measure. These two 
measures would become a 
single measure of 7/8.

When tempo mapping there are 
some limits that you need to be 
aware of.

The first limit is the BPM range:

 ▪ The lowest BPM is 40 

 ▪ The highest BPM is 300

Any BPM outside of this range 
will cause an error in Magma. 
You will not be able to compile 
your song to play it. 

Compile errors are also caused 
by very short measures. All 
measures must have at least 
one downbeat and upbeat for 
in-game animations. 

You can see downbeats and 
upbeats for each measure in the 
BEAT track.

Notice that the 1/4 and 3/8 
measures do not have an 
upbeat. This will cause a 
compile error in Magma. 

TEMPO MAP LIMITS 

40 BPM: is the lowest BPM. Short Time Signatures: such as 
1/4 or 3/8 cause issues. This 
is because they do not have 

300 BPM: is the highest BPM. an upbeat in the beat track. 
Magma expects at least one 
upbeat between downbeats.

The beat track shows 
downbeats and upbeats. 

Note: The beat track 
is not updated as you 
tempo map. 

Use CAT to create the 
beat track after you 
finish tempo mapping. 

See page 751.

300, 2/4T40, 1/4
3.1.00
0:04.000

3.1.50 4.1.00 6.1.00 8.1.00 9.1.00 10.1.00
0:04.750 0:02.000 0:06.300 0:07.100 0:08.100 0:08.850

T 120, 2/4T 120, 3/8T

T 40

120, 4/8T

MASTER TRACK

T 300 T 1/4 T 3/8

BEAT TRACK

 Downbeat  Upbeat
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TEMPO MAPPING STEPS

1 4
Make sure that the count-in 
samples are in their correct 
positions:

 ▪ Turn Snap on

 ▪ Move samples to measures 
1.1, 1.3, 2.1, 2.2, 2.3, and 2.4

Tempo map the count-in 
measures:

 ▪ Place tempo markers at 
measures 2.1 and 3.1 

Tempo map the first song 
measure:

 ▪ Scrub through the audio to 
find the next downbeat and 
place a tempo marker

Compare the first song measure 
BPM to the count-in BPM. If the 
BPMs do not match:

 ▪ Change the project Timebase 
to Beats (position only)

 ▪ Copy the BPM from measure 
3.1 to the tempo markers at 
measures 1.1 and 2.1

 ▪ Reposition the song audio so 
that the first downbeat is at 
measure 3.1

Import your song audio into the 
SONG AUDIO track. Then fine 
tune the position of your audio:

 ▪ Scrub the start of the song 
to find the downbeat

 ▪ Turn Snap off 

 ▪ Reposition the song audio 
so that the downbeat is at 
measure 3.1 *

The first step is to use an online 
BPM finder to find the general 
BPM for your song. For example:

 ▪ https://songbpm.com

Edit the first tempo marker (at 
the start of your project) and 
set the BPM for your song.

Follow these steps to set up 
your tempo map.

Your goals are:

 ▪ A count-in for players 

 ▪ A matching tempo for the 
count-in and first song 
measure

 ▪ Regular tempo markers (so 
that the MIDI and audio are 
in sync)

TEMPO MAP 
OVERVIEW

FIX THE COUNT-IN 
SAMPLES

TEMPO MAP THE 
STARTING MEASURES

IMPORT & POSITION 
SONG AUDIO

SET YOUR SONG BPM 

You can complete a tempo map in five steps.

5
Reset the Project Timebase to 
continue tempo mapping:

 ▪ Change the project Timebase 
back to Time

Tempo map the rest of the 
song: 

 ▪ Place a new tempo marker 
on the downbeat at the start 
of each new measure

In most cases one tempo 
marker per measure is enough.

TEMPO MAP THE 
REST OF THE SONG

Set Project Timebase  
to Time:

 ▪ Press Alt + Enter

 ▪ Set Timebase to 
Time

 ▪ Click OK 

* High tempo songs 
may require a three or 
four measure count-in.

This will delay your 
audio and count-in by 
a measure or two (see 
page 202, step 4).

2 3

To make count-in audio 
samples automatically 
adjust to song BMP 
changes see page 133.  
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Resize the SONG AUDIO track to 
see the waveform of your song:

 ▪ Position your mouse at the 
bottom of the SONG AUDIO 
track

 ▪ Click and drag the resize 
arrow down to adjust the 
track height

Drag and drop your audio file 
into REAPER:

 ▪ Open Windows Explorer

 ▪ Browse to your audio file

 ▪ Drag and drop your audio file 
into the SONG AUDIO track

Make sure that the start of the 
audio file is at measure 3.1.

Move the play cursor to the 
start of the timeline:

 ▪ Click in the timeline

 ▪ Press the Home key

Half of the play cursor will 
be visible at the start of the 
timeline.

Follow these steps to import 
your custom song audio.

Load the C3 Template:

 ▪ Click File > Project 
Templates > C3 Custom RB3 
Template 

 ▪ Click the SONG AUDIO track

The SONG AUDIO track will be 
highlighted in white.

IMPORT AUDIO



Find the downbeat and 
reposition your song audio:

 ▪ Click and drag the play 
cursor to scrub the song 
audio

 ▪ Find the first downbeat at 
the start of the song

 ▪ Click and drag your song 
audio so that the first 
downbeat is at measure 3.1

Review the next two topics 
before you start to tempo 
map. You will learn how to 
scrub audio and tempo map a 
separated audio waveform.

Move your song audio:

 ▪ Turn off snap in the main 
toolbar

 ▪ Click and drag your audio 
track 

 ▪ Move your song audio to the 
start of measure 3.1

The Edit Time Signature Marker 
window will open:

 ▪ Type your song BPM into the 
BPM field

 ▪ Click OK

[The default BPM is 120].

Note: The default Time 
Signature is 4/4. If you need to 
set a different time signature:

 ▪ Check the Set Time 
Signature checkbox

 ▪ Adjust the Set Time 
Signature text boxes values
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4

31

2

Find the BPM for your song at a 
site like: https://songbpm.com.

 ▪ Search for your song and 
find the BPM

In REAPER edit the time 
signature marker at measure 1.1: 

 ▪ Double click the time 
signature marker

Tip: The time signature marker 
is the white box with the letter 
T inside it.

SET BPM AND POSITION 
AUDIO



Focus 1.
Introduction to the page - max of three lines of 
text.
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You can scrub through your audio to find the 
downbeat. Use this method if you do not have 
AI generated stems. 

 

When you scrub audio you hear 
a very short loop of sound. The 
sound lasts 0.06 of a second 
before it repeats.

The loop starts 30 ms before 
the position of the play cursor. 
It ends 30 ms after the position 
of the play cursor. This is shown 
in the graphic with blue shading 
either side of the play cursor. 

To scrub through audio click 
and drag the play cursor. 

Your mouse cursor will change 
to a hand icon. Slowly move the 
play cursor left and right.

Search for the downbeat at the 
start of the measure. 

When you tempo map, always 
give priority to drums. Search 
for the moment where the kick 
pedal hits the kick drum. Or 
when the drum stick hits the 
snare or hi-hat:

 ▪ The kick drum hit has a 
rapid beating sound with a 
low pitch

See pages 65 — 66 
to configure scrub 
settings in REAPER.

Kicks

-30 ms +30 ms

Play cursor

 ▪ The snare has a higher 
pitched, precise hit

 ▪ Hi-hats can be more difficult 
to pick out (depending on 
the mix)

 ▪ Crash cymbals are often 
paired with kicks.

Most of the time you may be 
able to tempo map using just 
kicks. Sometimes you may need 
to tempo map snares.

For example, the song on the 
right starts with quarter note 
kicks. The orange dotted lines 
show the downbeats.

HOW TO SCRUB AUDIO 2HOW TO SCRUB AUDIO 
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TAB TO TRANSIENT VS WAVE-
FORM PEAKS VS SCRUB 

What is the best way to tempo map your song 
when using AI generated stems?

TRANSIENT DELAY 2Y 2

This topic assumes that you are 
using AI drum stems. With that 
out of the way, our general rule 
of thumb is to tempo map the 
downbeats. This means that we 
place one tempo marker at the 
start of each measure. (We can 
always add extra tempo markers 
later if we need to). 

Most often we are going to be 
tempo mapping kicks on each 
downbeat, and there are a few 
ways to do this. 

If you read the RBN Docs, they 
will tell you to use the tab to 
transient function in REAPER. 
This function moves the 
playhead from one transient 
to the next. When you get to 
the downbeat you create a new 
tempo marker. 

Our goal here is to tempo map 
the attack of the beat. This is 
that moment when the drum 
beater, or stick, hits the drum. 

Note: There is a difference 
between when the drum is 
hit and when the hit is at its 
loudest. The loudest part of 
the waveform is the peak (the 
tallest part). We do not want 
to tempo map the peak of the 
waveform.

In this topic we compare the 
tab to transient method against 
a couple of other options: 

 ▪ scrub the downbeat audo to 
find the hit

 ▪ tempo map the peak 
(loudest part of the 
waveform)

We will see which option is 
the most consistent for tempo 
mapping the attack of the beat.

Note: The zoomed in screen-
shots are not zoomed to the 
same level.

“YYZ” (Sept 2008): 

Kick is tempo mapped colse to 
first transient peak.  

 
 
Zoomed in view. The tab to 
transient and scrub are all the 
within 4ms of the DLC tempo 
marker. The peak is +16ms.

“I Don’t Know” (May 2011)

 
Kick is tempo mapped close to 
the peak of the transient. 

 
 
Zoomed in view. The tab to 
transient and DLC tempo 
marker are the same. My audio 
scrub is +3 ms. My peak tempo 
marker is + 8ms.

“Walk Like an Egyptian” (Nov 
2009)

Kick is tempo mapped close to 
first transient peak. 
 

 
Zoomed in view. The scrub 
marker is +5ms and the peak 
is +14ms. The tab to transient 
marker is +6ms after the DLC 
tempo marker.

As you can see, the peak tempo 
mapping method is always 
late. (It takes time for the hit 
to reach its loudest volume.)  
The degree to which it is late 
depends on the waveform.

My audio scrubbing was closer 
to the mark, but still variable, 
compared to the hit of the beat. 

The Tab to transient markers 
are in the ideal spot in each of 
these examples. I recommend 
that you use the tab to transient 
function with AI drum stems to 
tempo map. 

For consistent and 
accurate results use the 
tab to transient tempo 
mapping method.
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TEMPO MAPPING FLAMS 

Use tab to transient to tempo map beats or 
downbeats with AI drum stems.

The tab to transient method is not always the 
right choice when tempo mapping flams.

A flam is a combination of two 
strokes with the sticks:

 ▪ A grace note followed by a 
main note.

 ▪ The drums sticks should not 
hit at the same time.

 ▪ The two hits must be close 
enough that they almost 
sound like a single hit.

Below is an example waveform 
for a snare flam:

 

Flams can be tempo mapped as 
follows:

 ▪ On the first hit, or the main 
hit

 ▪ Between the two hits

How you tempo map a flam 
depends on which note the 
drummer intends to be the 
main beat. 

Tab to transient is a default 
action in REAPER.

To use tab to transient:

 ▪ Click your drum stem audio 
track *

* Make sure that you click the 
audio track and not the track 
control panel on the left. (If you 
do not select the audio track, 
the action will not work).

 ▪ Position the playhead in the 
silence at the start of the 
audio waveform.

 ▪ Press the Tab key.

The playhead will move to 
the first transient. (We will 
assume that it is a kick for this 
example).

 ▪ Place a tempo marker. 

 ▪ Keep pressing the Tab key 
until you reach the next 
downbeat. 

 ▪ Place the next tempo 
marker.

Note: The vertical red line 
represents the play head. The 
vertical orange lines represent 
tempo markers. 

You can use this method with 
the Q and T tempo map method 
or the advanced tempo mapping 
method. I recommend the later.

If the drum track is simple, you 
can tab to the next downbeat 
transient quite quickly. 

If the drum part is more 
complicated it can be tedious 
to press tab many times to get 
to the next downbeat. In this 
case you can click ahead in the 
audio track and then press tab 
to reach the downbeat. 

For example, flam [1] is a hit at 
the end of a roll. The first hit 
lines up with the rest of the hits 
in the roll. 

Flam [2] shows a bar line 
between hits. This flam is 
between tempo markers at the 
start and end of the measure. 

Flam [3] shows a flam mapped 
on the main hit.

Main noteGrace note Tempo marker 
(Grace note)

Bar line

Tempo marker 
(Main note)

1

2

3

HOW TO USE THE TAB TO 
TRANSIENT METHOD
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In game it takes three seconds 
to show and remove a player’s 
gamertag. This means that 
faster songs need a longer 
count-in:

 ▪ > 160 BPM - use three 
measures for the count-in

 ▪ > 210 BPM - may need a four 
measure count-in

Note: There should never be any 
notes earlier than 2.5 seconds 
in any song.

The screenshot to the left 
shows examples of 120, 160, and 
210 BPM count-ins.

Some songs may include a 
partial count-in of their own.

For example, if the drummer 
plays a short one beat fill before 
the song starts. In this case the 
count-in would be:

 ▪ One ... , Two ... , One, Two, 
Three

The “Four” would be the fill 
leading into the song.

To the left is a full count-in 
with a half beat fill. Choose the 
count-in that works best for 
your situation.

The count-in tempo should 
match the tempo of the first 
song measure.

This helps players know when 
to expect the first hit of the 
song in the game track.

Notice that in this screenshot 
the count-in and first song 
measure have the same tempo.

When a song does not have a 
count-in, you need to add one.

A standard count-in is two 
measures long.

It is counted in the typical style: 

 ▪ One ... , Two ... , One, Two, 
Three, Four

The hi-hat samples included 
with the C3 Template are 
commonly used for the count-
in. You can use other samples if 
you would like.

COUNT-IN OVERVIEW

3

42

1

1 32 41 2

COUNT-IN OVERVIEW 2

160 BPM

120 BPM

210 BPM
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Tempo map measure three:

 ▪ Turn Snap off

 ▪ Scrub through your song 
audio and locate the first 
downbeat

 ▪ Press the Q key

Check the first song measure 
with the metronome:

 ▪ Enable the metronome

 ▪ Press the Spacebar to start 
and stop playback

The clicks of the metronome 
should match the beats of the 
first song measure.

TEMPO MAP THE FIRST 
THREE MEASURES

The next step is to tempo map 
the count-in measures and the 
first song measure.

First, tempo map measure one:

 ▪ Enable Snap

 ▪ Click at measure 2.1 in the 
timeline to position the play 
cursor

 ▪ Press the Q key

Next, tempo map measure two:

 ▪ Click at measure 3.1 in the 
timeline to position the play 
cursor

 ▪ Press the Q key

 ▪ Press the Esc key to 
deselect measure two.

1

2 4

3



4

1

2

TEMPO MAPPING205 206TEMPO MAPPING

Set the Project Timebase to 
Beats (position only):

 ▪ Press Alt + Enter

The Project Settings window will 
open. 

In the Timebase for items/
envelopes/markers drop down:

 ▪ Select Beats (position only)

 ▪ Click OK

Edit the count-in tempo 
markers:

 ▪ Double click the measure 2.1 
tempo marker

 ▪ Select the BPM

 ▪ Press Ctrl + V

 ▪ Click OK

 ▪ Repeat the above actions 
for the measure 1.1 time 
signature marker also

Your first three tempo markers 
now have the same BPM.

Copy the BPM from the first 
song measure:

 ▪ Double click the tempo 
marker at measure 3.1

The Edit Time Signature Marker 
window will open:

 ▪ Select the BPM 

 ▪ Press Ctrl + C

Close the Edit Time Signature 
Marker window:

 ▪ Click OK

Compare the BPM at measure 
3.1 to the count-in:

 ▪ Count-in - 160 BPM

 ▪ Measure 3.1 - 152.831 BPM

Let’s fix it so that they both 
have the same tempo.

Note: You can get away with 
small differences in BPM. Just 
make sure that the difference 
between the two BPMs is not 
noticable.

CHECK COUNT-IN VS FIRST 
MEASURE BPM

3
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Click and drag the audio 
samples to the following points 
on the timeline:

 ▪ 1.1

 ▪ 1.3

 ▪ 2.1

 ▪ 2.2

 ▪ 2.3

 ▪ 2.4

Your count-in and first song 
measure should now be 
perfectly in sync!

Fine tune the position of your 
song audio again:

 ▪ Click and drag the play 
cursor to find the first 
downbeat

 ▪ Click and drag your song 
audio so that the first 
downbeat is at measure 3.1

Turn Snap on and change the 
project timebase back to Time:

 ▪ Press Alt + Enter

The Project Settings window will 
open. 

In the Timebase for items/
envelopes/markers drop down:

 ▪ Select Time

 ▪ Click OK

207 TEMPO MAPPING

SONG AUDIO / COUNT-IN 
SAMPLES 

1

2

TEMPO MAPPING

You can now render 
your audio track for 
music separation. 

This will allow you 
to tempo map to a 
separated drum track.

REPOSITION SONG AUDIO / 
COUNT-IN SAMPLE 2
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To render audio that is the 
correct length:

 ▪ Make a selection in the 
timeline from the start to 
the [end] event

To fix this issue:

 ▪ Make sure that all your 
tracks all end together 
promptly after the [end] 
event

The rendered audio is now 2 
minutes and 36 seconds long.

Note: It is always good practice 
to end your tracks correctly.

210

In REAPER we “render” audio to 
export it. In the Render options 
you can choose to render the:

 ▪ Entire Project, or a 

 ▪ Time Selection

If you render your entire project, 
you can end up with exported 
audio that is too long. 

For example, here the PART 
DRUMS track is extended to 2 
minutes and 52 seconds. 

This means that our rendered 
audio file will be 2 minutes and 
52 seconds long.

1

209

PREPARE TO RENDER AUDIO 
(OPTIONAL)

3

2
The problem is that the song 
ends at 2 minutes and 32 
seconds. Our rendered audio 
will be twenty seconds too long. 

The song length displayed in-
game will be very different than 
the actual song length. 

Note: To review the [music_
end] and [end] text events see 
pages 637 — 638.

4

Turn the page to render 
your song audio. Render  
Time Selection instead 
of Entire Project:

[music_end] [end]
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RENDER AUDIO FOR AUDIO 
SEPARATION (OPTIONAL)

TEMPO MAPPING

The Render window will open 
and process your audio:

 ▪ Click the Close button

Confirm your save settings and 
render your audio file: *

 ▪ * To render a selection: Click 
the Render bounds drop 
down menu and select Time 
Selection

 ▪ Set the output directory

 ▪ Set the file name

 ▪ Click the Render 1 file button

Open the Render to file window:

 ▪ Click File > Render

Shortcut: Ctrl + Alt + R

The Render to file window will 
open.

Choose the Render Song Audio 
Preset:

 ▪ Click the Presets button

In the pop-up menu click:

 ▪ All Settings > Render Song 
Audio

Note: To create this preset, see 
pages 67  — 68.

3

42

1
Do not render audio 
until you have tempo 
mapped the count-in 
and first song measure.

This ensures that 
your separated audio 
files line up with your 
custom song audio.

Turn to chapter 8 to 
learn how to separate 
tracks from your 
rendered audio file.
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Move the play cursor to the 
start of the timeline:

 ▪ Click in the timeline

 ▪ Press the Home key

Half of the play cursor will 
be visible at the start of the 
timeline.

Create new tracks for your 
separated audio. (New tracks 
appear under the currently 
selected track):

 ▪ Select your SONG AUDIO 
track

Create new tracks:

 ▪ Press Ctrl + T

Repeat the last step until you 
have a new track for each 
separated audio track.

Drag and drop your separated 
audio files into REAPER:

 ▪ Open Windows Explorer

 ▪ Browse to your separated 
audio files [C:\Demucs]

 ▪ Drag and drop your audio 
files one at a time into the 
empty tracks

Make sure that the start of each 
audio file is at measure 1.1.

Your separated audio tracks now 
line up perfectly with the start 
of your SONG AUDIO track.

IMPORT SEPARATED TRACKS 
INTO REAPER (OPTIONAL)

1

42

3

Your separated drum 
track is now ready for 
tempo mapping!

IMPORT SEPARATED TRACKS 
2



You should be able to see 
the rhythm of the song in the 
separated drum track.

For example, to the right you 
can see an enlarged section of 
the waveform:

 ▪ Kick, snare, kick

You should be able to identify 
kicks and snares in your own 
separated drum waveform.

If you are using separated audio, 
organize your tracks:

 ▪ Resize your SONG AUDIO 
track to make it smaller

Solo your separated drum track:

 ▪ Click the yellow S button in 
the track controls

Make the drum audio track 
larger:

 ▪ Resize your separated drum 
track so that you can clearly 
see the waveform

Set a comfortable zoom level 
for tempo mapping. About three 
or four full measures on screen 
works well.

 ▪ Press the Tab key to advance 
the play cursor one measure 
at a time

 ▪ Tempo map one measure at 
a time

Note: Check that waveform 
transients between tempo 
markers are in sync. Add 
additional tempo markers if 
they are needed.

A few things to note:

 ▪ For non-electronic music 
expect some tempo 
variation between measures

 ▪ Some songs may have faster 
and slower sections

 ▪ Drum fills are often a little 
faster than the rest of the 
song. (See the blue measure 
on the left)

Turn the page to review the 
tempo mapping process.

216TEMPO MAPPINGTEMPO MAPPING215
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SOLO THE DRUM TRACK
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1
To advance the play cursor 
towards the next downbeat:

 ▪ Press the Shift + Tab key 
two times

The play cursor will advance 
to the next measure on the 
grid. Note: The distance moved 
depends on the tempo of the 
previous tempo marker:

 ▪ Tempo map one measure at 
a time 

 ▪ Regularly check your tempo 
map with the metronome

Tempo map the measure:

 ▪ Press the Q key

The measure is highlighted and 
there is a new tempo marker at 
the end of the measure

The play cursor returns to the 
start of the tempo mapped 
measure.

Choose one method below:

A). Scrub through your audio to 
find the downbeat at the start 
of each measure:

 ▪ Click and drag the play 
cursor through your audio

 ▪ Position the play cursor on 
the downbeat

B). Tab to transient method: *

 ▪ Click Tab until the playhead 
reaches the next downbeat 

* Requires separated audio or 
stems. 

Tempo mapping is a repetitive 
process. You repeat a few 
actions over and over, until your 
tempo map is complete:

 ▪ Find the downbeat 

 ▪ Press the Q key

 ▪ Repeat the above steps

Let’s break each step down.

TEMPO MAP THE REST OF 
THE SONG
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Create a new tempo marker:

 ▪ Press the T key

The Edit Time Signature 
dialogue will open:

 ▪ Change the time signature 
to 3/4

 ▪ Make sure that Bars is set 
to 1

 ▪ Click the OK button

Follow these steps if you need 
to change time signature.

In this example we will change 
the time signature to 3/4:

 ▪ Find the downbeat

In the example on the right the 
tempo is constant. There are 
three quarter note divisions 
between the last tempo marker 
and the play cursor. 

The tempo marker at the start 
of the 3/4 measure shows the 
new time signature.

Move the play cursor to look for 
the next downbeat:

 ▪ Press Shift + Tab key two 
times

Notice that the play cursor has 
advanced three beats (one 3/4 
measure). This depends on the 
BPM of the previous tempo 
marker, and the previous time 
signature in the timeline.

220TEMPO MAPPING
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CHANGE TIME SIGNATURE
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You can use the advanced 
tempo map method with the 
scroll method. But this requires 
a custom action. Instructions 
are on pages 83 — 84.

We cover advanced tempo 
mapping in the next chapter. 

Move the scroll wheel and align 
the MIDI grid to the transients 
in your audio.

Tempo map according to your 
time signature:

 ▪ Use the Q or T shortcuts 
to tempo map measure by 
measure

It should be clear when the 
MIDI grid and transients no 
longer match. 

222

The scroll tempo map method 
works forward from the last 
tempo marker. You use the 
scroll wheel on your mouse to 
make the MIDI grid larger or 
smaller. To begin:

 ▪ Double-click on a MIDI track 
to open it

 ▪ Make your audio track larger 
so that you have a good view 
of the waveform

In this example the PART 
DRUMS track is open. The audio 
is a separated drum track.

1

221

THE SCROLL TEMPO MAP 
METHOD

3

2
Position your mouse pointer:

 ▪ Put your mouse pointer in 
the BPM box area in the 
Transport Bar

To adjust the MIDI grid in large 
increments:

 ▪ Press and hold the Alt key

 ▪ Roll your mouse scroll wheel 
back and forth

For smaller adjustments:

 ▪ Press and hold the Ctrl key 
instead

4

THE SCROLL TEMPO MAP 
METHOD 2
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Adjust the timeline for the next 
tempo marker.

The benefit of this method is 
that you are not constrained to 
one tempo marker per measure. 

You can place as many, or as 
few, tempo markers in the 
envelope as you need.

 ▪ Regularly check your tempo 
map with the metronome.

Turn Snap on:

In the waveform to the left the 
first four beats (after the tempo 
marker) line up with the grid.

The fifth beat in the waveform 
is a little early.

In this situation you would 
create a new tempo marker in 
the envelope at beat four:

 ▪ Press and hold the Shift 
key and click the timeline 
envelope

A new tempo marker is created.

Start from an existing tempo 
marker. 

This can be the tempo marker 
you placed at measure 3.1 or a 
later tempo marker.

 ▪ Click and drag the timeline 
envelope to move it up and 
down

The timeline grid will move left 
and right.

 ▪ Move the timeline envelope 
so that the grid matches 
the peaks in your audio 
waveform

This tempo map method is a bit 
of an all-or-nothing process.

You cannot go back to the Q 
and T method if you start using 
this method. 

This is because using Q or T 
erases tempo markers that you 
have placed in the envelope. 

 ▪ Resize your Master track

Make it as big as you can but 
leave room for your audio track.

THE TIMELINE METHOD TEMPO ENVELOPE 2
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text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Always tempo map the drum part (if it exists).

 ▪ Scrub mixed audio to find beats and downbeats.

 ▪ Use stems or separated drum tracks to tempo map by 
waveform.

 ▪ Timeline tempo markers show the BPM and time signature. 

 ▪ The lowest BPM in Rock Band is 40. The highest BPM is 300.

 ▪ Do not author very short time signatures such as 1/4 or 3/8.

 ▪ Leave enough time for the count-in. It takes three seconds 
to show and remove the player’s gamertag in-game.

 ▪ There should never be any notes earlier than 2.5 seconds.

 ▪ Make sure that the BPM for the count-in and first song 
measure match.

 ▪ Always tempo map according to the time signature. 

 ▪ Use CAT to create the beat track when you finish tempo 
mapping.

TEMPO MAPPING



 ▪ Temporary time signatures
 ▪ Project markers and tempo markers
 ▪ Tempo mapping by beat

7
ADVANCED 
TEMPO MAPPING
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Download links available from: 
rhythmgamingworld.com/customsbook

The advanced tempo mapping method 
lets you tempo map by beat. You can also 
easily fix mistakes if you need to.

This chapter builds on the previous chapter. We assume that 
you already know how to tempo map the count-in and first 
song measure. 

This method is flexible and can be used for simple or complex 
songs. If you set up the REAPER actions on pages 79 — 82 
then you are already good to go!

In this chapter you will learn:

 ▪ How to use a temporary (working) time signature

 ▪ The difference between project markers and tempo markers

 ▪ How to place project markers

 ▪ How to tempo map between project markers

 ▪ When to place more, or less, project markers

 ▪ How to replace or add tempo markers

 ▪ How to remove project markers

At the end of this chapter you will have the knowledge that you 
need to tempo map any song!

ADVANCED TEMPO MAPPINGADVANCED TEMPO MAPPING

Always tempo map to the drum track 
if there is one. 
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ADVANCED TEMPO MAPPING 
OVERVIEW 

This method uses project 
markers to mark the position of 
beats and downbeats. With this 
method you place markers and 
then tempo map between them.

You can place project markers 
and tempo map them one pair 
at a time if you like. Or you can 
place many markers and then 
tempo map the group.

This method lets you use a 
temporary time signature to 
tempo map beats instead of 
measures. For example, the 
temporary time signature at 
measure 3.1 is 1/4.

You can use this method for any 
song, but it is especially helpful 
in these situations:

 ▪ When there are no notes on 
the downbeat 

 ▪ When the band does not 
play to a click track

 ▪ When the song speeds up or 
slows down

 

 

 Kick  Snare  Hi-hat  Ride

125.105T123.54 1/4
5.1.00
0:07.742

T 127.801T 123.215T
32 4 5

The time signature has been 
changed to 1/4 (the working 
time signature for this project).

Project markers are numbered 
in the order that you place them.

Project markers: Are used to 
mark the position of beats and 
downbeats in the timeline.

Project markers have a vertical 
red line that is visible in your 
project audio and midi tracks.

2123.54 1/4T

If you look at measure 4.1, 
you can see that there is no 
downbeat. The snare and hi-hat 
on either side have been tempo 
mapped instead. 

Note: Take care when using 
this method. You will need to 
verify the time signature and 
bar values as you tempo map 
between project markers:

For example, to tempo map 
between measures 3.1 and 3.3 
you would use these values:

 ▪ Time Signature: 1/4

 ▪ Bars: 2

If you make a mistake, you 
can delete tempo markers and 
project markers and map those 
measures again.

To complete the tempo map:

 ▪ Replace temporary time 
signature(s) with the correct 
time signature(s)

4

3.1.00 4.1.00
0:03.875 0:05.815

3.3.00
0:04.845

4.3.00
0:06.780
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You can place project markers 
one at a time and tempo map 
between them if you would like. 

To work faster you can place 
many markers. Then “spam” 
through the Edit Time Signature 
dialogue step:

 ▪ Press the Shift + Q Keys

 ▪ Press the Enter key

You can repeat these two 
actions very quickly. 

Note: Do not spam this action 
without care. If the tempo map 
suddenly goes out of sync you 
will need to tempo map some 
measure(s) again. 

WORK FASTER WITH 
MANY MARKERS

When you have placed two or 
more project markers tempo 
map between them.

Turn Snap on and click on your 
first marker:

Press the Shift + Q keys

The Edit Time Signature 
dialogue will open:

 ▪ Change the time signature to 
your working time signature

 ▪ Count how many beats there 
are in the timeline selection

 ▪ Change the number of bars 
to the number of beats in 
the selection

 ▪ Click OK

Pay attention to your 
tempo envelope as you 
tempo map. 

Sudden changes may 
indicate that something 
has gone wrong..

Work through your audio and 
place project markers on beats 
/ downbeats:

 ▪ Position the play cursor on 
downbeats and / or beats *

 ▪ Press the M key

 ▪ Repeat these steps measure 
by measure

* Use the tab to transient 
method with AI drum stems (p. 
200) or scrub your audio for 
the downbeat (p. 195).

Edit the tempo marker at the 
start of your song and set your 
working time signature:

 ▪ Double click on the first 
song tempo marker

 ▪ Change the time signature 
to 1/4

 ▪ Click OK

TEMPO MAP 
BETWEEN MARKERS

PLACE MARKERS 
USING THE M KEY

In the previous chapter we 
setup our tempo map with the 
Q and T method. We tempo 
mapped:

 ▪ The count-in, and

 ▪ First song measure

You can use the advanced 
tempo map method to do this 
if you prefer. To do this place 
markers, and tempo map 
between them.

Once you have the count-in, 
and first song measure set up, 
follow these steps.

SET YOUR WORKING 
TIME SIGNATURE

ADVANCED TEMPO 
MAP SETUP

Place project markers on downbeats or beats. 
Use Shift + Q to tempo map between markers. 

ADVANCED TEMPO MAPPING 
STEPS

You may need to also change 
your working time signature if 
the time signature changes. For 
example, if your time signature 
changes from 4/4 to 7/8. 

These steps assume a 
4/4 time signature for 
your song. 

Adjust your working 
time signature if you 
need to.
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Notice that the timeline now 
shows each beat as being equal 
to one measure.

The Edit Time Signature 
dialogue will open.

 ▪ Change the time signature 
to 1/4

 ▪ Check the Set time signature 
checkbox

 ▪ Click OK

Note: If your time signature is 
based on eighth notes change 
the time signature to 1/8.

Change the time signature at 
the start of your song:

 ▪ Double click first song 
tempo marker

1

2 4

3

SET A TEMPORARY WORKING 
TIME SIGNATURE
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Place as many (or as few project 
markers) as you need to tempo 
map your song accurately.

Here one marker every four 
beats works well.

In this final example there are 
two working time signature 
changes:

 ▪ 1/8, followed by

 ▪ 1/4

This allowed the snares in this 
section to be tempo mapped.

As you can see, with advanced 
tempo mapping you can place 
tempo markers exactly where 
you need them to be.

In this example tempo markers 
were needed on each quarter 
note beat. This is because the 
song slows down during this 
measure.

Place project markers for your 
tempo map:

 ▪ Use tab to transient method 
or Scrub audio for beats / 
downbeats

 ▪ Press M to place a marker

 ▪ Use Shift + Tab to move the 
play cursor to the next beat 
if you are scrubbing audio. 
 
Otherwise press Tab to 
advance the playhead to 
the next downbeat (tab to 
transient method). 

 

PLACE PROJECT MARKERS

Regularly check your 
tempo map with the 
metronome.

Add more markers if 
your tempo map looks 
or sounds out of sync.

Do not place more than 
one marker per beat. It 
is wasted effort on your 
part if you do.
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For example, here you can see a 
problem area later in the song.

REAPER does not know if the 
current selection should be one 
or two beats. 

Notice that the tempo in the 
Edit Time Signature dialogue is 
much lower than it should be. 

To fix the issue change the time 
signature / bars values: 

In this example the bars value 
should be set to 2

Tempo map between the 
remaining project markers.

There are no time signature 
changes and no significant 
tempo changes. This means that 
it is safe to spam the Shift + Q 
action through these markers:

 ▪ Press Shift + Q

 ▪ Press Enter

Tempo and time signature 
changes cause problem areas 
if you spam Shift + Q through 
them. When this happens 
the tempo and timeline will 
suddenly look wrong. 

Tempo map between markers:

 ▪ Press Shift + Q

The Edit Time Signature 
dialogue will open:

Adjust the time signature and 
bars values:

 ▪ Set the time signature to 1/4

 ▪ Set the bars value

Set the bars value to the 
number of 1/4 note beats in your 
selection. Here the value is  4

 ▪ Click OK

With your project markers 
placed, the next step is to 
tempo map between them:

 ▪ Turn Snap on:

 ▪ Click on the first tempo 
marker in the timeline.

Make sure you have at least one 
project marker to the right of 
the play cursor.

3
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1

TEMPO MAP BETWEEN 
PROJECT MARKERS

4
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Reset the working time 
signature so that the measure 
has the correct time signature:

 ▪ Double click the tempo 
marker at the start of the 
measure

The Edit Time Signature Marker 
dialogue will open:

 ▪ Set the correct time 
signature

 ▪ Click OK

In this case the correct time 
signature is 7/8.

To fix the tempo map add a new 
project marker and then tempo 
map the measure:

 ▪ Scrub the audio for the beat

 ▪ Press M to place a marker

Turn Snap on:

 ▪ Tempo map both sections of 
the measure using Shift + Q 

 ▪ Enter the correct time 
signature and bars values

Sometimes you may need to 
fix a misplaced tempo marker. 
In this example we will fix an 
incorrect tempo marker in a 
measure of 7/8. 

Here the misplaced tempo 
marker is placed on the wrong 
kick. Let’s fix it.

Remove the misplaced markers:

 ▪ Press and hold the Alt key: 

 ▪ Click the tempo marker and  
project marker to remove 
them both

Set a temporary working time 
signature at the start of the 
measure:

 ▪ Double click the tempo 
marker at the start of the 
measure

The Edit Time Signature Marker 
dialogue will open:

 ▪ Set the working time 
signature for the measure

 ▪ Check the Set time signature 
checkbox

 ▪ Click OK

2

1 3

4

REPLACE OR ADD A TEMPO 
MARKER

Four 1/8 bars Three 1/8 bars
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Search through your project for 
working time signature markers:

 ▪ Double click each working 
time signature tempo 
marker

In the Edit Time Signature 
dialogue:

 ▪ Uncheck the Set Time 
Signature checkbox

It is easy to miss a working 
time signature marker. This can 
happen if:

 ▪ Tempo markers are close 
together, and

 ▪ The zoom level on the 
Timeline makes tempo 
markers overlap

In the screenshot you can see 
how working time signature 
marker is hidden. 

You would have to zoom 
in more to reveal the time 
signature information in the 
Timeline.

It is easy to miss a working 
time signature marker. This can 
happen if:

 ▪ Tempo markers are close 
together, and

 ▪ The zoom level on the 
Timeline makes tempo 
markers overlap

In the screenshot you can see 
how a working time signature 
marker is hidden. 

Zoom in more to reveal time 
signature information hidden in 
the Timeline.

4

3

2

1
When you have completed your 
tempo map you will have one or 
more working time signatures.

They need to be edited so that 
you can add the correct time 
signature(s) back into your 
project.

REMOVE WORKING TIME 
SIGNATURES

Turn the page to 
add the correct time 
signature(s) to your 
project.
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You can see that the start of 
measure 4.1 is now at measure 
3.3. The second half of the first 
measure has disappeared.

If you look closely you can see 
this corruption in the MIDI 
chart. You can see how squished 
together the measure numbers 
and MIDI notes are. In fact all 
the notes after measure 3.3 are 
half a measure out of sync with 
the song audio.

Mistakes like this can be hard 
to spot and will ruin your chart 
until you correct them.

You must always make time 
signature changes at the start of 
a new measure. Time signature 
changes made anywhere else 
will break your charts. 

For example, to the left you can 
see a song that starts with a 4/4 
time signature at measure 3.1.

In the next step we are going to 
add a new time signature in the 
middle of the first 4/4 measure.

Pay attention to what happens 
to the second half of the first 
measure of the song.

246

After you remove your 
temporary time signatures your 
project will revert to 4/4. 

This is because 4/4 is the 
default time signature.

If your whole song is in 4/4 you 
do not need to add any other 
time signatures to the project.

1

245

ADD TIME SIGNATURES

3

2
Add time signature changes to 
songs that have time signatures 
other than 4/4.

In this example the 2/4 and 
7/8 time signatures have been 
added. To do this:

 ▪ Double click each tempo 
marker where the time 
signature changes

In the Edit Time Signature 
dialogue:

 ▪ Check the Set time signature 
checkbox

 ▪ Enter the correct time 
signature

4



4

3

247 ADVANCED TEMPO MAPPING 248ADVANCED TEMPO MAPPING

Select the project markers that 
you want to remove:

 ▪ Press Ctrl + A to select all 
markers

To make a custom selection:

 ▪ Click the first marker to 
remove

 ▪ Press and hold the Shift key

 ▪ Click the last marker to 
remove

To remove selected markers:

 ▪ Press the Delete key

The selected markers will be 
removed from your project. This 
makes your project nicer to 
work with.

Note: If you later need to 
correct parts of the tempo 
map you can add markers to a 
section and tempo map it again.

To remove markers first open 
the Region Manager:

 ▪ Press Ctrl + Shift + Alt + R

 ▪ Check the Markers checkbox

You will see the list of project 
markers for your project.

When you finish your tempo 
map you will have a lot of red 
project markers in your project.

They can be visually distracting 
and make your project feel a 
little cluttered.

You can safely remove these 
markers when your tempo map 
is complete.

3
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REMOVE PROJECT 
MARKERS (OPTIONAL)
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ADVANCED TEMPO MAPPING 
EXAMPLE 

In this example we are going to 
tempo map the kicks in three 
measures of 3/4.

The first and last kicks are both 
on the downbeat. Kicks two and 
three are not on the downbeat.

The kick pattern is numbered in 
the waveform below. As you can 
see kick number one has been 
tempo mapped. None of the 
other kicks line up on the MIDI 
Editor grid.
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The first thing we need to do is 
set the working time signature. 

The current time signature is 
3/4. To tempo map this section 
we need to edit the time 
signature and change it to 1/4:

 ▪ Double-click the time 
signature marker

The Edit Time Signature window 
opens:

 ▪ Check the Set time signature 
checkbox and change the 
time signature to 1/4

 ▪ Click the OK button

The time signature is set to 1/4:

 
Notice that each measure is 
now a quarter beat long:

Now we are ready to tempo 
map the second kick:

 ▪ Press Tab to advance the 
playhead to the next beat

 ▪ Press M to place a marker

Tempo map between the two 
markers. With snap enabled:

 ▪ Click at the start of measure 
17 (where the first marker is) 

 ▪ Press Shift + Q

REAPER highlights the area 
between the two project 
markers. The Edit Time 
Signature window opens. (See 
main image below):  

 ▪ Check that the Time 
signature and bars are 
correct

In this case the time signature 
is 1/4 for 2 bars:

 ▪ Click the OK button

1 2 43 1 2

KICK TWOKICK ONEOVERVIEW

PART DRUMS PART DRUMS

This example uses 
the tab to transient 
method. You can scrub 
you audio for the 
downbeat if you do not 
have AI drum stems. 
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ADVANED TEMPO MAPPING 
EXAMPLE (CONTINUED)

Repeat the process for kick 
number three:

 ▪ Press Tab until you find the 
start of the third kick

 ▪ Press M to place a marker

Tempo map between the two 
project markers:

 ▪ Click at the start of measure 
19 (the second red marker) 

 ▪ Press Shift + Q
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REAPER highlights the area 
between the two markers. 

The Edit Time Signature window 
opens. 

REAPER picks up the time 
signature from the previous 
measures. It also calculates 
that we need 3 (quarter note) 
bars between our two markers. 
This is based on the BPM of the 
last tempo marker:

 

These settings are correct:

 ▪ Click the OK button

Repeat the process again for 
kick number four:

 ▪ Press Tab until you find the 
start of the fourth kick

 ▪ Press M to place a marker

Tempo map between the two 
project markers:

 ▪ Click at the start of measure 
22 (the third red marker) 

 ▪ Press Shift + Q

REAPER highlights the area 
between the two markers. 

The Edit Time Signature window 
opens. 

This time REAPER calculates 
that we need 4 measures of 1/4:

 ▪ Click the OK button

To finish this example let’s 
remove the working time 
signature:

 ▪ Double-click on the tempo 
marker at measure 17

 ▪ Change the time signature 
from 1/4 to 3/4

 ▪ Click the OK button

We can now clearly see that 
kicks one and four are on the 
downbeat: 

Kicks two and three are on the 
three beat:

42 3 3
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Set a working time signature to tempo map beats instead of 
measures. 

 ▪ Scrub your audio to find beats or downbeats. In separated 
audio or stems place markers at the start of transients. 

 ▪ Use the M key to place project markers. Place project 
markers on beats or downbeats.

 ▪ Press Shift + Q to tempo map between project markers.

 ▪ When your tempo map is complete remove working time 
signatures. 

 ▪ Add time signatures back into your tempo map as needed.

 ▪ Only make time signature changes at the start of a measure.

 ▪ Wrongly placed time signature changes will ruin your tempo 
map and instrument charts.

 ▪ You can remove the red project markers when your tempo 
map is complete.

ADVANCED TEMPO MAPPING



 ▪ Pros and cons of separated audio
 ▪ Software install
 ▪ Audio separation

AUDIO 
SEPARATION

8



Download links available from: 
rhythmgamingworld.com/customsbook

Download links available from: 
rhythmgamingworld.com/customsbook
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AUDIO SEPARATION

AUDIO SEPARATION

Audio separation software divides a 
song into separate tracks. 

Audio separation tools single out instruments and vocals from 
an audio file. Some tools produce tracks for guitar, bass, drums, 
vocals and keys. 

The results that you get from these tools is variable. A lot 
depends on the mix of the song and the tool that you use. In 
this chapter you will learn:

 ▪ The differences between mixed audio, stems, and  
separated audio

 ▪ How separated drum tracks help you tempo map

 ▪ The pros and cons of separated audio

 ▪ How to install and use separation tools

The tools covered in this chapter include:

 ▪ Universal Vocals Remover GUI

 ▪ Guitar Hero GUI for Demucs

 ▪ Demucs (command line with Miniconda)

 ▪ Spleeter (command line with Miniconda)

Drums.wav Other.wav 
(Guitar)

Bass.wav Vocals.wav Piano.wav * 
 

* Not all tools 
or models.

1

2

3

A rendered audio file from 
REAPER.

1

Audio separation software or 
web-service.

2

Separated audio files. Most 
separation models produce 
drums, bass, vocals and other 
tracks. Some models can also 
produce piano and guitar.

3
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Stems are used in music production to create 
the final song mix. Separated audio is a bridge 
between mixed audio and stems.

MIXED AND SEPARATED 
AUDIO VS STEMS 

The songs you listen to on 
streaming services, CDs, or the 
radio are mixed audio. 

They start out as individual 
recordings called multi-tracks. 
The number of tracks needed 
depends on the song. There can 
be 20 to 100 (or more) tracks in 
total. These tracks are used for 
recording, editing and mixing. 

Stems are mixes of many 
individual tracks. For example, 
a drum stem might be a mix of 
all the individual drum tracks. 
Stems often include extra 
effects such as equalization, 
compression or reverb. The 
number of stems typically 
ranges from 4 to 20. 

Stems are often used to create 
the final mix of a song. This mix 
is then mastered to prepare a 
song for distribution.

There are many tools available for audio sepa-
ration. You can use a Graphical User Interface, 
the command line, or a web service.

AUDIO SEPARATION 
SOFTWARE
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Stems are what Harmonix uses
to author songs for Rock Band.
They are the best audio source
to author from because each
instrument is isolated.
If you have stems to author
from there are a few caveats:

 ▪ Stems must contain all the 
audio from the final mix

 ▪ Stems should sound exactly 
like the final mix of the song

Custom songs are mostly 
authored from mixed audio 
sources. This makes authoring
more challenging.

It takes practice to focus on 
individual instruments when you
can hear the rest of the band. 
It is also difficult to author an 
instrument that you cannot 
always clearly hear.

Audio separation can help
address some of these issues
with mixed audio, but it is not
perfect yet.

You may experience bleed 
between tracks or tracks 
that lack detail. (Bleed is 
when sounds from different 
instruments blend together).

As music separation matures 
these issues become less and 
less obvious. Many authors now
make use of separated audio 
when they author custom songs.

Demucs is currently the best 
model for audio separation. 
It offers very good separation 
into four tracks (vocals, drums, 
bass, and other). Demucs also 
promises a six instrument 
model. This model adds guitar 
and piano but still needs some 
improvement. 

Ultimate Vocal Recorder is my 
current software of choice. 
It includes demucs and can 
download other models. It runs 
very well on my M1 Mac.   

UVR also offers Ensemble Mode. 
This mode uses many models 
at once and averages out the 
results to give you the best 
from each model. 

Download UVR from: 
ultimatevocalremover.com  
 
Note: Processing times will  
be long if you do not have a 
compatible video card for GPU 
processing.

Stemroller is another 
popular option. I have seen 
it recommended regularly in 
the Clone Hero community. I 
have not personally tested this 
software though. 

You can download Stemroller 
from: www.stemroller.com

GH Hero Demucs was previously 
recommended in this book. 
It offered individual drum 
separation with Demucs. It no 
longer supported and has been 
removed from this chapter. 

Spleeter was previously 
included in this chapter and has 
also been removed. Spleeter 
has been very slow to update. 
As a result the community has 
moved onto Demucs. 

At the time of writing mvsep.
com offers the best range of 
models online. This includes:

 ▪ Demucs4 HT

 ▪ DrumSep (4–6 drum tracks: 
kick , snare, cymbals, toms, 
ride, and crash)

 ▪ MVSep Bass (BS Roformer) 
This model can help with 
hard to hear bass tracks

Mvsep has unregistered, 
registered, and premium plans. 

MUSIC PRODUCTION 
OVERVIEW

STEMS VS MIXED 
AUDIO

SEPARATED AUDIO 
TRACKS

CHOICES FOR AUDIO SEPARATION ONLINE WEB 
SERVICES

Visit rhythmgaming 
world.com for more 
info about stems:

Click Tools & Docs > 
C3/RBN Authoring Docs

Then click the Audio 
Setup link.

Web service users 
should note that many 
sites prohibit uploading 
copyrighted audio.

http://ultimatevocalremover.com
http://www.stemroller.com
https://mvsep.com/en
https://mvsep.com/en
https://rhythmgamingworld.com/
https://rhythmgamingworld.com/
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The results that you get from 
music separation software 
depend on the mix of the song 
and the tools that you use. 

Bleed between tracks and 
lack of detail can be an issue. 
You may even experience 
hallucinated notes. These issues 
can lead to you under or over- 
charting parts: 

 ▪ Kick drum bleed into the 
bass track might cause you 
to over-chart the bass

 ▪ Poor detail in the bass track 
may lead under-charting

 ▪ Lack of detail in vocal notes 
may cause you to under-
chart note lengths

Despite these potential issues 
there are some real benefits:  

 ▪ A clean waveform to tempo 
map from (drums)

 ▪ A vocal track for lip-sync 
animation *

 ▪ Buried sounds may be heard 
more easily

 ▪ Authoring is simpler with 
separated audio

My current recommendations 
are as follows:

Start off using demucs. It does 
a great job, especially if you only 
need drums, bass, vocals and 
other tracks. For demucs you 
can use:

 ▪ Ultimate Vocal Remover

 ▪ Demucs command line (via 
Miniconda)

The results that you get from music separation 
software can be variable. 

AUDIO SEPARATION 
PROS AND CONS 

If you need individual drum 
tracks, use mvsep.

If you need better isolated 
vocals use UVR.

I try not to rely solely on 
separated audio for charting. 
Bleed from other tracks and 
lack of detail can still be an 
issue. But, as the technology 
improves there are less reasons 
to be wary of it.

* You will need to check lip sync 
animations in game. Perfect 
results are not guaranteed.

If you chart from 
separated audio you 
should always check 
your charts against the 
full audio mix.

If you do not want to 
use separated audio 
you do have other 
options. In the next 
chapter you will learn 
how to use REAPER FX 
to help pick out details 
from mixed audio.

BLEED POOR DETAIL OR 
EXTRA NOTES

Kicks can bleed into  
the bass track.

Vocals and guitar can 
bleed into each other.

Bass tracks can lack detail.

Guitar and drum bleed 
can occassionally create 
hallucinated bass notes.

Spleeter / demucs can work 
well for piano.

Keys are less likely to 
be separated well.

VOCAL NOTE TIMING

Kicks and snares can interfere 
with note timing in vocal tracks
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Mixed audio waveforms can be very busy to 
look at. Separated drum tracks reveal a  
waveform that is much easier to work with. 

Above you can see two 
waveforms. The first is the full 
mix audio from a song. Below 
it is the separated drum track. 
The dotted orange lines show 
the start of each measure.  

The mixed audio is busy to look 
at and it is hard to see where 
individual measures begin and 
end. In contrast the separated 
drum track clearly reveals the 
rhythm of the song.  

Notice that the distance 
between measures is mostly 
the same. This means that the 
tempo is fairly constant. The 
longer measure is where the 
tempo slows down.

MIXED AUDIO

SEPARATED  
DRUMS

With a little practise it is 
possible to identify kicks and 
snare hits in the waveform. 
This is very helpful when tempo 
mapping a song.

I highly recommend using 
separated drum tracks for 
tempo mapping. They are easier 
to navigate and use than mixed 
audio tracks. 
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The UVR Setup window will open:

 ▪ Click the I accept the 
agreement radio button

 ▪ Click the Next button

 ▪ Set the install location 
to C:\Ultimate Vocal 
Remover

 ▪ Click the Next button

 ▪ Click the Next button

 ▪ Click the Install button

 ▪ Click the Finish button

Open File Explorer: 

 ▪ Browse to your Downloads 
folder and double-click on 
UVR setup.exe

If Windows blocks the UVR 
installer from running:

 ▪ Click the More info link

The window will update:

 ▪ Click the Run anyway button

266

Universal Vocal remover (UVR) 
has an installer for Windows.

Note: The installer works on 
Windows 10 or higher:

 ▪ UVR is not guaranteed to run 
on Windows 7 or lower

 ▪ UVR may not run on Intel 
Pentium or Celeron CPUs

 ▪ You must install UVR to the 
C:\ drive. Installation on a 
secondary drive will cause 
application instability.

1

265

INSTALL UNIVERSAL VOCAL 
REMOVER

3

2
Download UVR from: 
github.com/Anjok07/
ultimatevocalrecmovergui 
Click on the Main Download 
Link or mirror.

The installer is 1.57GB. It 
includes the UVR GUI, Python, 
PyTorch, and other required 
dependencies.

Note: Your browser may try to 
prevent you from downloading 
UVR. In this case you need to 
confirm that you want to keep 
the downloaded file. 

4

https://github.com/Anjok07/ultimatevocalremovergui
https://github.com/Anjok07/ultimatevocalremovergui
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Ultimate Vocal Remover is not only used for 
vocal separation. It can separate up to six dif-
ferent instruments, including vocals. 

UNIVERSAL VOCAL REMOVER 
USER INTERFACE

The UVR user interface changes 
when you make certain choices. 
For example, the highlighted 
areas can change when you 
choose a process method. The 
user interface is not static.

This means that it can take a 
little longer to understand how 
to use UVR.

On top of this UVR has some 
advanced features. One 
such feature is the ability to 
download extra models for 
audio separation. 

If you download these models 
you will see that your drop 
down menu choices also change. 

With all that said, UVR is not 
difficult to use once you get 
used to it.

Download new separation models and review 
basic UVR functions.

UNIVERSAL VOCAL REMOVER  
STEP BY STEP
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THE UVR USER 
INTERFACE

Select an output:

 ▪ Click the Select Outut 
button

 ▪ Browse to your output folder 

 ▪ Click the Select Folder 
button

SELECT INPUT 
AUDIO

SELECT AN  
OUTPUT PATH

2

Select an output file format. 
Click one of the following radio 
buttons:

 ▪ WAV

 ▪ FLAC

 ▪ MP3

I recommend .FLAC.

SELECT OUTPUT  
FILE TYPE

If your PC has an Nvidia graphics 
card then check the GPU 
Conversion checkbox. This will 
greatly improve processing time.

Expect much slower results 
without GPU conversion.

Turn the page to continue.

GPU CONVERSION 
CHECKBOX

4

1 3UVR DOWNLOAD 
CENTER

Click the wrench icon in UVR to 
open the Settings window:

Next click the Download Center 
button (top right). 

You will see a list of different 
frameworks. To download a 
model first select a framework. 
Click a framework radio button. 
Next, click the drop-down menu 
for that framework.

Select a model and then click 
the download icon:

Note 1: Workflow diagrams 
highlight the recommended 
models to use on pages 271 
— 272.

Note 2: Recommended models 
will change over time. Review 
pages 273 - 274 to learn how 
to track new models.

Select an audio source:

 ▪ Click the Select Input button

 ▪ Browse to your source audio 

 ▪ Select your audio file

 ▪ Click the Open button
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Select a process method, the number of stems, 
and output quality.

UNIVERSAL VOCAL REMOVER 
STEP BY STEP (CONTINUED) 

Use Ensemble mode to produce high quality 
vocal tracks.
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Ensemble Mode will list many 
models to choose from. The list 
that you see will depend on:

 ▪ The choices that you made 
in the previous steps

 ▪ The models that you have 
already downloaded

To select model(s):

 ▪ Click the model (the model 
will become highlighted)

You can find the current 
recommended models and 
workflows on the next page. 

Note: Methods and models 
are regularly updated and 
developed. Use the mvsep 
quality checker to keep 
up with the most recent 
recommendations (see pages 
273 - 274). 

Sample Mode will let you 
produce a 30 second sample. I 
recommended this for:

 ▪ Long songs

 ▪ Users without a GPU

Use this mode to preview the 
results for various methods and 
models. To use this mode:

 ▪ Check the Sample Mode 
(30s) checkbox

SELECT PROCESS 
/ METHOD

Choose a method:

 ▪ VR Architecture

 ▪ MDX-Net

 ▪ Demucs

 ▪ Ensemble Mode 

 ▪ Audio Tools

When you select a method 
other parts of the user interface 
will change. Refer to option 5A 
for Demucs. See options 5B, C, 
and D for Ensemble Mode.

Note: Demucs often provides 
good separation for drums, 
bass, vocals and other tracks. 
If a demucs track does not 
separate well, try using 
Ensemble Mode.

5 DEMUCS CHOOSE 
STEMS

A

If you chose Demucs in step 5 
then you can choose from the 
following options:

 ▪ All Stems

 ▪ Vocals

 ▪ Other

 ▪ Bass

 ▪ Drums 

 ▪ Guitar *

 ▪ Piano *

* Install the 6 Stem demucs 
model for these options.

All Stems is my default choice.

Choose from the following if 
you selected Ensemble Mode in 
step 5:

 ▪ Vocals / Instrumental

 ▪ Other / No Other

 ▪ Drums / No Drums

 ▪ Bass / No Bass

 ▪ 4 Stem Ensemble

Stem pairs produce two audio 
tracks. For example, Vocals/
Instrumental generates a vocal 
track and an instrumental track. 
If you want a vocals only track:

 ▪ Click the Vocals Only 
checbox

For vocals, bass, drums and 
other audio tracks use the 4 
Stem Ensemble option.

ENSEMBLE MODE 
STEM PAIRS

B

The Ensemble Mode Algorithm 
lets you specify output quality. 

For stem pairs the default is:

 ▪ Max Spec / Min Spec

If you chose Vocals/
Instrumental in step 5B this will 
give you:

 ▪ High quality vocal track

 ▪ Low quality instrumental 
track

If you want both stem pairs to 
be high qaulity choose:

 ▪ Max Spec / Max Spec

If you are using the 4 Stem 
Ensemble option choose:

 ▪ Max Step

This will give you the best result.

ENSEMBLE MODE 
ALGORITHM

C ENSEMBLE MODE 
MODELS

D UVR TIPS AND 
TRICKS

6

When you are done 
click the Start 
Processing button to 
separate your audio!

To import your audio 
tracks into REAPER see 
pages 213 — 214.
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Workflows are laid out to mimic the position of 
elements in UVR. Download models from the 
UVR download center.

UNIVERSAL VOCAL REMOVER 
WORKFLOWS 

Process Method:

 ▪ Demucs

Choose Demucs Model:

 ▪ V4 | htdemucs

UVIVERSAL VOCAL REMOVER 
WORKFLOWS 2
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Choose Stems:

 ▪ All Stems

Checkboxes:

 ▪ GPU Conversion

 ▪ Primary Stem Only

Segment:

 ▪ Default

DEMUCS DRUM, BASS, VOCALS, AND OTHER WORKFLOW

Process Method:

 ▪ Demucs

Choose Demucs Model:

 ▪ V4 | htdemucs_S6

Choose Stems:

 ▪ All Stems

Checkboxes:

 ▪ GPU Conversion

 ▪ Primary Stem Only

Segment:

 ▪ Default

DEMUCS 6 STEM WORKFLOW (INCLUDES PIANO AND GUITAR)

Process Method:

 ▪ Ensemble Mode

Main Stem Pair:

 ▪ Vocals / Instrumental

Checkboxes:

 ▪ GPU Conversion

 ▪ Vocals Only

Segment:

 ▪ Max Spec / Min Spec

Available Models:

 ▪ VR Arc: 7_HP2-UVR

 ▪ MDX-Net: UVR-MEX-NET Inst 3

 ▪ MDX-Net: UVR-MDX-NET Inst HQ1

 ▪ V4 | htdemucs

EMSEMBLE MODE VOCAL TRACK WORKFLOW

ENSEMBLE MODE DRUM, BASS, VOCALS, AND OTHER WORKFLOW

Process Method:

 ▪ Ensemble Mode

Main Stem Pair:

 ▪ 4 Stem Ensemble

Checkboxes:

 ▪ GPU Conversion

Segment:

 ▪ Max Spec

Available Models:

 ▪ V4 | htdemucs

 ▪ V4 | htdemucs_6s
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The mvsep quality checker tracks how well 
different models split tracks into stems.

WHAT ARE THE BEST 
MODELS TO USE?  

The mvsep quality checker is 
a tool that assesses how well 
different models create stems.

Users can test models against 
two different datasets:

 ▪ Synthetic dataset 
(Vocals / Instrument)

 ▪ Multisong dataset 
(Songs from different genres 
to test vocals, bass, drums 
and other stems)

MVSEP calculates the average 
SDR for uploaded test results:

 ▪ SDR stands for Signal-to-
Distortion Ration

The higher the SDR score is, 
the better the output from the 
audio separation model.

For details visit: mvsep.com/en/
quality_checker

WHAT ARE THE BEST MODEL 
TO USE 2
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At the bottom of the mvsep 
quality checker page are a 
couple of links:

 ▪ Algorithm comparison 
mvsep.com/quality

 ▪ Algorithms 
mvsep.com/algorithms

The comparison page has 
general recommendations for:

 ▪ Vocals / Instrumental

 ▪ Bass / drums

It also lists popular models with 
their SDR scores for:

 ▪ Bass

 ▪ Drums

 ▪ Other

 ▪ Vocals

The algorithms page is a great 
resource for looking into how 
various models perform. 

Note: Mvsep premium ensemble 
models are not available in UVR. 

Mvsep leaderboards rank 
models for the Synthetic and 
Multi-song datasets.

The Synththetic leaderboard has 
three options:

 ▪ Full List

 ▪ Single Models

 ▪ Ensemble Models

The Multi-song leaderboard has 
the following options:

 ▪ Bass

 ▪ Drums

 ▪ Other

 ▪ Vocals

 ▪ Instrumental

To view the models used for 
each ranked entry:

 ▪ Hover your mouse over the 
question mark in the Info 
column 

Follow these two leaderboards 
to keep track of the latest and 
best models.

MVSEP QUALITY 
CHECKER

MVSEP RECOMMENDED MODELS

MVSEP QUALITY COMPARISON

MVSEP LEADERBOARDS

MVSEP LEADERBOARD

https://mvsep.com/en/quality_checker
https://mvsep.com/en/quality_checker
https://mvsep.com/en/quality
https://mvsep.com/en/algorithms
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Miniconda requires Windows 8 
(64 bit) or newer.

4

3

2

1
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Confirm Advanced Installation 
Options:

The default option is Register 
Miniconda3 as my default 
Python 3.9.

 ▪ Click the Install button

Installation will complete:

Uncheck the Anaconda 
Individual Edition Tutorial and 
Getting Started with Anaconda 
checkboxes

 ▪ Click the Next button

The Thank you for installing 
Anaconda Individual Edition 
page will appear:

 ▪ Click the Finish button

Select the installation type:

Just Me (recommended) is the 
default install.

 ▪ Click the Next button

Choose an install location:

The default install location is 
C:\Users\[your username]\
miniconda3

 ▪ Click the Next button

A download link for Miniconda is 
on page 20:

 ▪ Open File Explorer

 ▪ Browse to your Downloads 
folder

 ▪ Double-click on 
Miniconda3-latest-
Windows-x86_64.exe 

The Installer will appear.

 ▪ Click the Next button

 ▪ Click I Agree to accept the 
Licence Agreement

INSTALL MINICONDA INSTALL MINICONDA 2
Install Miniconda to use Demucs 
from the command line. 
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Open Miniconda:

 ▪ Click Start

 ▪ Type miniconda into the 
search box

In the search results:

 ▪ Click Anaconda Prompt 
(miniconda3)

The Anaconda Prompt will open. 
Type the following command at 
the prompt to install ffmpeg:

conda install -c conda-
forge ffmpeg

 ▪ Press the Enter key

When prompted confirm the 
installation:

 ▪ Press the Y key

 ▪ Press the Enter key

Create a new folder for 
separated audio files:

 ▪ Open File Explorer

 ▪ Browse to your C:\ drive

 ▪ Press Ctrl + Shift + N to 
create a new folder

 ▪ Type Demucs as the folder 
name

 ▪ Press the Enter Key

Install demucs and PySoundFile 
with this command:

python.exe -m pip 
install -U demucs 
PySoundFile

 ▪ Press the Enter key

Demucs will install.

Note: If you need to upgrade 
demucs in the future run the 
following command:

python.exe -m pip 
install -U demucs

Install Demucs in the Miniconda 
environment.

INSTALL DEMUCS 
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For GPU acceleration type:

demucs 

 ▪ Do not press Enter

Drag and drop your rendered 
audio file to generate the 
filename and path:

 ▪ Open File Explorer

 ▪ Drag and drop your rendered 
audio file(s) into the 
miniconda window

 ▪ Click back inside the 
miniconda window

 ▪ Press the Enter Key

Browse to your separated audio:

 ▪ Open File Explorer

 ▪ Browse to the following 
directory:

C:\Demucs\separated\mdx_
extra_q\[song name]

 ▪ Move your separated audio 
folder(s) to C:\Demucs.

Import your separated audio 
tracks into your REAPER project 
(see pages 213 — 214).

Demucs will process and 
separate your audio file(s).

Without GPU acceleration this 
may take some time. It can take 
up to four times the duration 
of the song (depending on your 
computer hardware).

AUDIO SEPARATION WITH 
DEMUCS (COMMAND LINE)

Open Miniconda and change the 
working directory:

 ▪ Click Start

 ▪ Type miniconda into the 
search box

 ▪ Click Anaconda Prompt 
(miniconda3) 

At the Miniconda prompt type:

cd c:\demucs

 ▪ Press the Enter key

1

4

3

2

AUDIO SEPARATION WITH DE-
MUCS 2

FOR CPU TYPE: demucs -d cpu 
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY
AUDIO SEPARATION

 ▪ Tempo map the start of your song before you render audio 
for music separation. This ensures that your separated 
audio is in sync with the song audio.

 ▪ Separated drum tracks have a clear, readable waveform. 
This helps to make tempo mapping easier. 

 ▪ Separated audio can suffer from bleed and lack of detail.

 ▪ Take care not to over or under-chart when using separated 
audio files.

 ▪ Always check your charts against the full song mix when you 
author from separated audio. 

 ▪ Separated vocals can be used for in-game lip sync 
animations. Check your lip sync animations in-game. 
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 ▪ RBN Preview
 ▪ REAPER FX
 ▪ W1 Limiter

REAPER PLUGINS 
AND FX
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Add and remove plugins in the FX window. 

THE FX WINDOW
Plugins and FX are an essential part of 
authoring. 

In chapter 1 we installed the C3 Template and the RBN Preview.  
This means that many useful plugins and FX are setup and 
ready to go! 

For example, the RBN Preview is setup for your drum, guitar, 
bass, and keys tracks. There are also plugins in your vocal 
tracks that let you hear the MIDI notes that you author. 

We will look at all these plugins, so that you know why they 
are there, and what they do. We will also look at some REAPER 
plugins that can help you author songs.

The list of plugins discussed is:

 ▪ RBN Preview

 ▪ Bassmanager

 ▪ ReaPitch

 ▪ Center Canceller

 ▪ ReaEQ

 ▪ ReaSynth and JS: IX/MIDI Tool II

 ▪ W1 Limiter

To open the FX window:

 ▪ Expand the track to show 
the track controls

 ▪ Click the FX button

 
The left hand panel shows 
plugins for the selected track.   

The right hand panel shows the 
configuration options for the 
selected plugin. 

Use the checkboxes to turn 
plugins on or off. 

To add plugins click the Add 
button. Select plugins from the 
Add FX window and then click 
the OK button. 

To remove plugins select them 
and then click the Remove 
button.

Note: The order of plugins in the 
SONG AUDIO track is important. 
These plugins (when enabled) 
operate in sequence (from top 
to bottom). Drag plugins up and 
down to change their order.

Tip: In the track controls, click 
the FX button power icon to 

disable all plugins for that track:

Download links available from: 
rhythmgamingworld.com/customsbook
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Use the Rock Band Network (RBN) Preview 
window to preview instrument charts.

RBN PREVIEW WINDOW 

Use the Time Offset value to make sure that 
your preview is in sync.
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The Rock Band Network (RBN) 
Preview window lets you review 
the following charts in REAPER:

 ▪ Guitar

 ▪ Bass

 ▪ Basic and Pro drums

 ▪ Keys

Note: The instrument MIDI 
track must be open for the RBN 
preview to work.

The RBN preview does not 
highlight:

 ▪ Solos

 ▪ Trill markers

 ▪ Strum markers

Click the current skill to cycle 
between all skills:

 ▪ Expert

 ▪ Hard 

 ▪ Medium

 ▪ Easy

Click the current instrument 
(mode) to toggle between 
instruments:

 ▪ Guitar / Bass

 ▪ Pro Drums

 ▪ STD Drums

 ▪ Keys

Skill HOPO Threshold Time Offset Mode
RBN PREVIEW 
OVERVIEW

PREVIEW SKILL 
LEVEL

INSTRUMENT /  
MODE

Use the Time Offset to sync the 
audio and visual elements in the 
preview window.

The offset should match the 
value found at the top right of 
your REAPER window:

For example, my Time Offset 
value is -43. 

The HOPO Threshold alters 
when HOPOs are shown in 
your preview window. It is not 
something that you typically 
need to change. The default 
value is 170.

To change the Time Offset or 
HOPO Threshold:

 ▪ Click and hold the mouse on 
the current value

 ▪ Drag the mouse up or down 
to raise or lower the value

TIME OFFSET & 
HOPO THRESHOLD
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Bassmanager is an audio plugin that is used to 
boost bass levels.

JS: LITEON/BASSMANAGER 

This plugin was popular before 
music separation software 
became available.

Add the Bassmanager plugin 
to your mixed audio track. It 
boosts the bass level to make 
bass authoring easier.

Use the following settings:

 ▪ Frequency (Hz)  90.0

 ▪ Boost (dB)  9.46

 ▪ Drive (%)  0.0

 ▪ Muffle (%)  15.8

 ▪ Output (dB)  0.0

This plugin is still useful when 
a separated bass track has very 
low detail. (See also ReaPitch 
on the following page).

ReaPitch alters the pitch of audio tracks. With 
mixed audio tracks this plugin is often used 
with Bassmanager.

REAPITCH
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If it is hard to distinguish bass 
pitches with Bassmanager add 
the ReaPitch plugin. Then, shift 
the audio up one or two octaves 
in ReaPitch.

This will make the movement 
between bass pitches easier to 
assess. 

Tip: Use ReaPitch by itself to 
help bring the kick drum out of 
the mix.

BASSMANAGER REAPITCH
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ReaEQ lets you focus in on a smaller range of 
audio frequencies. 

REAEQ 

Center/Canceler lets you focus on different 
parts of the stereo field. 

CENTER/CANCELER
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ReaEQ is a flexible plugin 
for mixed audio. ReaEQ can 
boost or cut a range of audio 
frequencies. 

You can manually adjust 
frequencies by dragging nodes 
up, down, left, and right:

Presets are also available in the 
Type drop down menu:

 ▪ Low Shelf

 ▪ High Shelf

 ▪ Band

 ▪ Low Pass

 ▪ High Pass

 ▪ All Pass

 ▪ Notch

 ▪ Band Pass

 ▪ Band (alt)

 ▪ Band (alt 2)

Use the Low Pass preset to 
isolate bass frequencies. The 
Band Pass preset can be good 
for the kick drum.

Experiment adjusting the 
frequency nodes to get the 
results that you are looking for.

To reset your settings click the 
Reset defaults button.

Center/Canceler is another  
plugin for mixed audio. 

Move the slider from left to 
right as you listen to your audio. 
You will notice that the audio 
focus will change as you do this. 

Experiment with the slider to 
bring different parts of the song 
into focus. 

REAEQ CENTER CANCELER
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ReaSynth adds audio cues or note pitches to 
your MIDI notes.

REASYNTH 

ReaSynth is a very useful tool 
for authoring. It adds audio cues 
to your MIDI notes. This allows 
you to listen to note movement 
and timing as you listen to your 
song audio.

In instrument tracks, ReaSynth 
can give each gem color a single 
pitch, or sound. This gives you 
a five tone representation of 
your chart. When used with the 
Preview window this lets you:

 ▪ View your chart and hear 
MIDI note cues together

I find this a very useful way 
to review my charts. I listen 
for note timing and missed or 
over-charted notes. I also check 
that ReaSynth notes mirror the 
movement of pitch in the song.  

ReaSynth has four presets:

 ▪ Guitar / bass pitched

 ▪ Short percussion high

 ▪ Short percussion

 ▪ Vocal synth

Vocal MIDI tracks use JS: IX/MIDI Tool II  
to restrict the range of MIDI notes played.
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For instrument MIDI tracks I 
recommend using the short 
percussion preset: 

 ▪ It blends well with the song 
audio 

 ▪ Sustained MIDI notes have a 
short duration 

 ▪ The pitch range is easy to 
pick out  

The guitar / bass pitched 
preset lacks subtlety. It is a bit 
overwhelming. 

The short percussion high 
preset is too high in the mix for 
me. It does not blend well with 
the song audio.

Tip: Use the volume slider to 
adjust the volume of ReaSynth 
notes to your preference.

Vocal MIDI tracks have two 
plugins enabled by default:

 ▪ ReaSynth

 ▪ JS: IX/MIDI_Tool II

In ReaSynth choose the vocal 
synth preset. This lets you hear 
the musical pitch of each MIDI 
note authored. 

Listen to your vocal MIDI notes. 
Make sure that they match the 
original vocal performance. 

Note: There are notes in the 
vocal chart that you do not 
want to hear: 

 ▪ Overdrive

 ▪ Phrase Marker

 ▪ Not Displayed Percussion

 ▪ Displayed Percussion

 ▪ Lyric Shift

 ▪ Range Shift

 

Hearing any of these notes on 
top of your vocal MIDI notes is 
not good. This is especially true 
of longer notes like Overdrive or 
Phrase Markers.

This is where JS: IX/MIDI_Tool 
II comes in. This plugin has 
settings that exclude MIDI notes 
outside of the 5 octave vocal 
note range.

The default settings are below:

 ▪ Note Min 85

 ▪ Note Max 127

 ▪ Velocity Scaling(%) 100

 ▪ Output Velocity Max 127

 ▪ Pitch Reset Yes

REASYNTH
JS: IX/MIDI_TOOL II

REASYNTH AND 
JS: IX/MIDI_TOOL II
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Enable ReaSynth to listen back to your instrument 
and vocal MIDI notes. 
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To enable ReaSynth follow the 
steps below:

 ▪ Expand your MIDI instrument 
or vocal track if needed

 ▪ Click the track FX button

The FX track window will open:

 ▪ Check the VSTI: ReaSynth 
(Cockos) checkbox

 ▪

For MIDI instrument tracks:

 ▪ Select short percussion from 
the drop down menu

For vocal MIDI tracks:

 ▪ Select vocal synth from the 
drop down menu

ReaSynth is now enabled and 
active (assuming that you do 
not have any tracks soloed).

ReaSynth can be disabled and 
enabled in a number of ways.

 ▪ Un-check the VSTI: 
ReaSynth (Cockos) checkbox 
to disable ReaSynth

 ▪ Click the power button next 
to the FX button to disable 
all FX for a track:

If you have an audio track 
soloed this adds another layer 
to manage:

 ▪ Solo the ReaSynth track to 
hear it if one or more audio 
tracks are soloed

 ▪ Turn off the Solo feature to 
mute FX / ReaSynth 

You have to manage these three 
functions in concert with each 
other to control ReaSynth. 

Use the W1 Limiter to control the loudness of 
your custom. The limiter will also even out loud 
and quiet parts in your custom song. 

W1 LIMITER 

The C3 Template adds the W1 
Limiter to the SONG AUDIO 
track. The Limiter has two main 
purposes for Rock Band:

 ▪ Match the loudness of your 
custom to the average 
loudness of the Rock Band 3 
on-disc songs

 ▪ Hear the quiet parts of the 
song above the in-game 
crowd noise

A limiter works as follows. 
It reduces audio peaks that 
cross a defined threshold. This 
reduces the difference between 
the loudest and quietest 
sounds. Gain is then added to 
bring the track volume back up. 
Typical settings for Rock Band 
customs are:

 ▪ Ceiling -0.0

 ▪ Threshold  -3.7 to -8.9 *

* The average volume of the 
final mix should be around 
-6.4dBFS.

The Ceiling sets the maximum 
volume for the track. 

Experiment with the Threshold 
slider to find a good balance 
between loud and quiet parts. 

A quieter song will need a 
higher threshold value. With 
experience you may be able to 
look at the audio waveform and 
gauge the Threshold needed.

Note: A Threshold setting of 
more than -7 may add too much 
gain to the audio. In this case 
use volume controls to increase 
the volume first. 

The Release slider controls how 
quickly the limiter lets go of the 
audio. Keep the default setting if 
you are not experienced in using 
a limiter.

This method works for single 
track audio or mulitracks. 

To install the W1 Limiter see 
pages 39 — 40.

For an alternative method for 
single track audio only see 
pages 773 — 774.

W1 LIMITER

ENABLE AND DISABLE 
REASYNTH

REASYNTH
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Use the RBN Preview window to preview your charts in 
REAPER. Adjust the Time Offset to sync your preview.

 ▪ Use BassManager, ReaPitch, ReaEQ, and Center/Canceler 
with mixed audio. These plugins can help bring out parts of 
the song that are hard to hear.

 ▪ Use ReaSynth to hear the pitch and rhythm of your 
instrument and vocal MIDI notes.

 ▪ Use the W1 Limiter to match the loudness of the Rock Band 
3 on disc songs. 

 ▪ Use the W1 Limiter to balance loud and quiet parts of your 
custom song.

REAPER PLUGINS AND FX



 ▪ Rocksmith conversions
 ▪ Guitar Pro MIDI
 ▪ Fix a long or short count-in

IMPORTED MIDI
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Rocksmith customs can give you a good 
foundation for guitar and bass charts.  

ROCKSMITH
An imported MIDI can save you a lot of 
time and effort.

Charting a Rock Band song by ear can be a difficult and time 
consuming process. Fortunately there are often other resources 
that we can refer to, and make use of. 

In this chapter we focus on Rocksmith Customs and Guitar Pro 
files. Both can be excellent resources and references. 

You may find that a Rocksmith conversion is easier to work 
with. This is because it provides a 5-lane guitar part to work 
from. This part will typically need some work to make it 
consistent and playable.

Guitar Pro MIDI files require you to translate MIDI notes to 
5-lane Rock Band parts yourself. This may take some extra work 
on your part, but the structure of the parts should be clear.

In either case the most important consideration is the accuracy 
of the MIDI. You can preview Rocksmith customs in Onyx. Guitar 
Pro previews are available on the websites that host them.

In the final section of the chapter we look at importing the MIDI 
from an existing custom into REAPER.

https://customsforge.com/

 ▪ Create a Customs Forge 
account

 ▪ Click the Ignition4 Search 
link:

https://ignition4.
customsforge.com/

Note: For PC you should 
download Rocksmith files with 
the p.psarc file extension. 
m.psarc files are for Mac.

Rocksmith songs are like Rock 
Band 3 Pro guitar and bass 
parts. They chart the strings and 
notes played for guitar and bass 
and include a tempo map. 

Before converting Rocksmith 
customs for Rock Band, be 
aware of the following:

 ▪ A Rocksmith custom might 
be one instrument only

 ▪ Some notes and sections 
might be missing

 ▪ You will need to check the 
tempo map for accuracy 
(and fix it if needed)

 ▪ The chart may be inaccurate

Note: The Rocksmith to Rock 
Band conversion is from 
tablature to 5-lane chart(s). A 
perfect Rocksmith chart and 
tempo map will not produce a 
perfect Rock Band chart. You 
will need to check that the 

converted charts meet the Rock 
Band authoring standards:

 ▪ Does the chart feel right to 
play?

 ▪ Is the tempo map accurate?

 ▪ Is the chord motion correct?

 ▪ Is the note motion correct?

 ▪ Is the most prominent part 
charted?

 ▪ Are notes quantized to the 
MIDI grid?

This is not a complete list of 
things to check. The amount 
of work needed to meet Rock 
Band standards will vary. A 
good Rocksmith conversion 
will provide you with a solid 
foundation to build from.

301

Download links available from: 
rhythmgamingworld.com/customsbook

DOWNLOADING 
CUSTOMS

ROCK BAND 3 AND ROCKSMITH CUSTOM 
CONVERSIONS

Turn the page to 
see how to convert 
Rocksmith customs 
into 5-lane charts.  

https://ignition4.customsforge.com/
https://ignition4.customsforge.com/
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Import the Rocksmith MIDI into 
REAPER:

 ▪ Click in the project Timeline

 ▪ Press the Home button

 ▪ Drag the MIDI file into the 
first empty track that you 
created 

The MIDI file import options 
window will open:

 ▪ Click the OK button

We can now start to organize 
our Rocksmith MIDI tracks and 
check for any issues.

 ▪ Open REAPER

 ▪ Launch Windows Explorer 
and then open the folder 
created by Onyx

 ▪ Drag the MIDI file into the 
C3 Template

 ▪ Note the number of source 
tracks shown in the MIDI file 
import options window. Click 
the Cancel button

 ▪ Select the COUNTIN track

 ▪ Press Ctrl + T to create 
enough empty tracks for the 
MIDI file

304

Download a Rocksmith 
custom with the .p.psarc file 
extension. Next, use Onyx to 
convert the Rocksmith custom:

 ▪ Open Onyx

 ▪ Click the Load a song button

 ▪ Browse to your Downloads 
folder and select a 
Rocksmith custom file

 ▪ Click the Open button

The song will open in Onyx.

1

303

CONVERT AND IMPORT 
ROCKSMITH CUSTOMS

3

2
To preview the Rocksmith chart 
click the Preview tab. To view 
5-lane chart previews:

 ▪ Click the Select Tracks 
drop-down menu

 ▪ Select the Autochart 
instrument options

 ▪ Click the Play button

To convert the chart:

 ▪ Click the CH/PS tab

 ▪ Click the Create CH/PS song 
folder button

4

CONVERT AND IMPORT ROCK-
SMITH 2
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Make sure that your RockSmith conversion 
meets Rock Band standards.

WORKING WITH ROCKSMITH 
CUSTOM MIDI TRACKS 

In the previous topic we 
imported our 5-lane Rocksmith 
guitar tracks. This gives us:

 ▪ A tempo map

 ▪ The song audio

 ▪ One or more 5-lane guitar 
parts *

* You may have more imported 
tracks than you need. There 
may also be some tracks that 
you can delete. To organize your 
tracks see pages 311 — 312.

With your project workspace 
organized we can move on to 
the following topics:

 ▪ Tempo map review

 ▪ Count-in

 ▪ 5-lane conversion review

305 IMPORTED MIDI 306

Review the tempo map and 
count-in:

 ▪ Check that the song BPM is 
correct

You may find that the BPM is 
not correct. For example, the 
BPM might be double what 
it should be. This will impact 
character animations and the 
reductions produced by CAT. In 
this case you have the following 
options:

 ▪ Adjust the BEAT track so 
that it reflects the correct 
song BPM

 ▪ Create a new tempo map at 
the correct BPM

The choice that you make may 
depend on how good the tempo 
map is:

 ▪ Turn on the metronome and 
listen to the song

The metronome and beats of 
the song should be in sync. 
If you are not sure you can 
visually inspect the tempo map:

 ▪ Use demucs to separate the 
song audio into individual 
tracks (see chapter 8) 

 ▪ Import the separated drum 
track into REAPER (pages 
213 — 214)

 ▪ Make sure that the peaks in 
the drum track line up with 
the MIDI grid. A gap of <20 
ms is tolerable. 30 ms is a 
significant gap.

I recommend using the 
advanced tempo map method 
to fix tempo maps. By placing 
markers and tempo mapping 
between them you can leave the 
rest of the tempo map intact.

It is unlikely that the count-
in will match the Rock Band 
standard (pages 201 — 202).

You may need to change the 
count-in tempo and adjust the 
length of the count-in. We will 
cover how to do this in the next 
topic (pages 307 — 308).

The Onyx conversion often does 
a good job of mapping pro guitar 
notes to 5-lane gems. 

The conversion is not always 
perfect though. In my limited 
experience I have noticed the 
following:

 ▪ Repeated riffs are not 
always charted the same

 ▪ Chords are not always 
charted to the same gems

 ▪ Chords are not always 
consistent relative to their 
pitch

 ▪ Single note runs of gems are 
often well placed

Simple songs will experience 
these issues less than more 
complex ones. In either case an 
Onyx conversion can still save 
you a lot of time and effort.

ROCKSMITH MIDI 
OVERVIEW

TEMPO MAP 
REVIEW

ROCK BAND 
COUNT-IN

This example tempo map needs to be fixed. 
The peaks in the demucs drum audio do not 
like up with the MIDI grid.

The largest gap in this section is 49 
milliseconds. This will certainly impact 
gameplay in Rock Band.

49 ms gap

DRUM WAVEFORM WITH GRID LINES

5-LANE 
CONVERSION

!
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Tempo map the count-in:

 ▪ Create markers at measures 
1.1.00 and 5.1.00 with the M 
key. Press the Home key

 ▪ Press Shift + Q to tempo 
map measures 1 to 4

If the count-in and first song 
measure BPM do not match 
review pages 205 — 208.

Turn the page to continue. 

Add new measures for the 
count-in:

 ▪ Press the Home key to make 
sure that the Play cursor is 
at the start of the project

 ▪ At the start of the Timeline 
select the number of 
measures you want to insert 
for the count-in. For this 
BPM select 4 measures

 ▪ Right click in the Timeline 
and select Insert empty 
space in selection from the 
context menu

308

There are a couple of ways to 
fix a long or short count-in. A 
simple method is below. 

In this example the count-in is 
one measure at 60 BPM. The 
first song measure is 280 BPM.

Let’s fix this issue:

 ▪ Double click the tempo 
marker at measure 3.1

 ▪ Select the BPM

 ▪ Press Ctrl + C

 ▪ Click OK

1

307

FIX A LONG OR SHORT 
COUNT-IN

3

2
Delete the count-in measures:

 ▪ Enable the Grid and 
Snapping:

 ▪ Click and drag in the 
timeline and select the 
count-in measures

 ▪ Right click in the Timeline. 
Select Remove contents 
of selection (moving items 
later) from the context menu

4

FIX A LONG OR SHORT 
COUNT-IN 2
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Extend your song audio track if 
you need to.

Removing the original count-in 
changes the visual start point of 
the song audio:

 ▪ Drag the start of the song 
audio track to the start of 
the project to reveal the 
whole waveform

310

Extend MIDI tracks back to the 
start of the project:

 ▪ Select your MIDI tracks

 ▪ Position the mouse cursor at 
the start of the MIDI tracks

The mouse cursor will turn into 
a resize arrow:

 ▪ Click and drag to extend the 
MIDI tracks back to the start 
of the project

7

309

FIX A LONG OR SHORT 
COUNT-IN (CONTINUED)

9

8
Reposition track names for all 
MIDI tracks:

 ▪ Open each track

 ▪ Move track name text events 
back to measure 1.1

Make sure that you position 
track names correctly. 
Otherwise you will get Magma 
errors when you compile your 
custom song.

4
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Paste the converted MIDI into 
the correct instrument track in 
the C3 Template:

 ▪ Press Ctrl + V to paste the 
MIDI notes *

 ▪ * Make sure that the play 
cursor is in the correct 
position before you paste 
your notes

When you have completed your 
custom you can delete the 
imported MIDI tracks.

Copy the converted MIDI notes:

 ▪ Select the whole MIDI or a 
selection as needed

 ▪ Press Ctrl + A to select the 
whole MIDI

 ▪ Press Ctrl + C to copy your 
selection

312

In this example there are many 
converted MIDI tracks in our 
project. Keep the following 
imported tracks:

 ▪ PART GUITAR - notes

 ▪ PART BASS - notes

 ▪ PART RHYTHM - notes

1

311

ORGANIZE CONVERTED 
ROCKSMITH MIDI TRACKS

3

2
Delete the following imported 
MIDI tracks:

 ▪ PART VOCALS - notes

 ▪ PART REAL GUITAR - notes

 ▪ PART REAL BASS - notes

 ▪ EVENTS - notes *

 ▪ BEAT - notes *

* We will use the EVENTS and 
BEAT tracks that are already 
included in the C3 Template.

4

ORGANIZE CONVERTED MIDI 
TRACKS 2
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Guitar Pro files can be helpful when charting 
guitar and bass.

GUITAR PRO FILES

Guitar Pro files typically 
contain Pro guitar and bass 
parts. You can download 
them from websites such as 
ultimateguitar.com and 
gprotab.net.

Note 1: On Ultimate Guitar the 
download button is at the very 
bottom of Guitar Pro tab pages. 

Note 2: You cannot download 
official Pro tabs from Ultimate 
Guitar unless you are a member.

313 IMPORTED MIDI 314

Open Guitar Pro downloads in 
TuxGuitar:

 ▪ Click File and then select 
Open

 ▪ Browse to your Downloads 
folder and select your Guitar 
Pro file. Click Open

Make a note of the number of 
Guitar Pro tracks. For example, 
In the example below there are 
six tracks.  

 ▪ Click File and then select 
Export

 ▪ Select Export Midi from the 
context menu

 ▪ In the Options window click 
the OK button

 ▪ Click the Save button to 
save your MIDI file in your 
Downloads folder

Earlier in the chapter we 
imported a Rocksmith MIDI 
file into REAPER. The steps to 
import a MIDI from Tux Guitar 
are much the same. 

In Reaper create the number 
of empty tracks that you need 
for the exported MIDI file. Then 
drag and drop the MIDI at the 
start of the first empty track.

For detailed instructions refer to 
page 304. You will only need to 
modify those steps a little.

DOWNLOAD 
GUITAR PRO FILES

CONVERT GUITAR PRO FILES TO MIDI 
WITH TUXGUITAR

Preview guitar pro files 
to make sure that they 
are accurate before you 
use them.  

TUXGUITAR TRACK LIST

IMPORT TUX GUITAR MIDI FILES INTO REAPER

Create empty tracks in 
REAPER for MIDI import.

Drag and drop MIDI file 
into empty tracks.

Organize your imported 
MIDI tracks.1 2 3

https://www.ultimate-guitar.com/
https://gprotab.net/
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Guitar Pro MIDI files contain pitched MIDI notes.  
They are not the same as a Rocksmith 5-lane 
conversion.

WORKING WITH GUITAR PRO 
MIDI FILES 

Guitar Pro MIDI tracks are 
different from Rocksmith 
conversions in a couple of ways:

 ▪ The tempo map might be set 
to a single BPM

 ▪ You need to translate notes 
into 5-lanes for Rock Band

It is unlikely that the MIDI BPM 
will perfectly match the song 
BPM. You may need to tempo 
map the whole song from start 
to finish. 

If the MIDI is accurate you will 
be able to see the relationships 
between the notes. This will 
help you plan out chords or 
different sections of the song. 

Tip: Open the Guitar Pro MIDI 
on your second monitor (if you 
have one). You can then work on 
the PART GUITAR track on your 
main monitor.
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Above, you can see a MIDI that 
has been tempo mapped. The 
pitch and rythm of the notes 
match the song audio. Below, is 
the authored 5-lane part. 

Tip: Enable ReaSynth in your 
Guitar Pro MIDI track to hear the 
imported MIDI notes. See page 
293 to configure ReaSynth.

The MIDI (above) is for an 
acoustic guitar part. The broken 
chord arpeggios are hard to 
read. This is because all the 
notes ring in to each other. The 
blending of these notes makes 
it a challenge to author the 
rhythm of this part.

In this case you have a couple 
of options:

 ▪ Refer to the MIDI only for 
note pitches 

 ▪ Scrub the audio for the 
rhythm

 ▪ Refer to the Guitar Pro tab 
for the rhythm 

Select the combination that 
works best for you.

GUITAR PRO MIDI 
IN REAPER

WORKING WITH GUITAR PRO MIDI

GUITAR PRO MIDI

5-LANE PART GUITAR

REASYNTH PLUGIN

GUITAR PRO MIDI BROKEN CHORDS

GUITAR PRO BROKEN CHORDS (ARPEGGIO)
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Guitar Pro MIDI files often contain repeated 
sections. This means that later sections will not 
line up with the song audio. 

REPEAT MIDI SECTIONS 

When a Guitar Pro MIDI has 
repeat section(s) it will be 
shorter in length than the song 
audio. This means that most of 
the imported MIDI can be out of 
sync with the audio. 

What to do when the MIDI BPM is double or half 
the song BPM?

MIDI NOTE LENGTH AND BPM
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In the graphic below you can 
see that the song Intro is twice 
as long as the Guitar Pro Intro.

To work around this issue, 
identify and move sections of 
notes to their correct position in 
the song.

Tip: Repeat section bar lines 
are only displayed in Guitar Pro 
previews (not in the MIDI).

When you tempo map an 
imported MIDI you may find that 
it is double or half of the song 
BPM. For example:

 ▪ Eighth notes become quarter 
notes when you reduce the 
BPM by half

This change happens as you 
tempo map. 

To fix this you can alter the 
note position properties for the 
imported MIDI notes:

 ▪ Press Ctrl + A to select all 
the imported MIDI notes 

 ▪ Press Ctrl + F2 to open the 
Multiple Note Properties 
window

Enter one of the following in the 
Position and Length fields:

 ▪ *2 
Eighth notes will become 
quarter notes

 ▪ /2 
Eighth notes will become 
sixteenth notes

Click the OK button to complete 
the operation.

The note length and position 
of your MIDI notes is either  
doubled or halved.

This change includes the 
starting position of your notes. 
For example if you had a 
standard count-in and your 
notes started at measure 3.1:

 ▪ *2 
Your notes now start at 
measure 4.1

 ▪ /2 
your notes now start at 
measure 2.1

In either case you need to move 
your notes back to measure 3.1:

 ▪ Press Ctrl + A to select all 
the MIDI notes

 ▪ Click and drag the notes 
back to measure 3.1

This process is an easy fix for 
imported MIDI files with the 
wrong BPM. 

: :

INTRO VERSE CHORUS SOLO

VERSEINTRO CHORUS

SONG STRUCTURE

Note: These bar lines 
show repeat sections:

: :

240 BPM

120 BPM

MIDI STRUCTURE
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Open REAPER and delete MIDI 
items:

 ▪ Right-click and draw a 
selection around all MIDI 
items in the C3 Template

 ▪ Press the Delete key

This will remove all MIDI items, 
but leave the MIDI tracks intact. 
This ensures that there will not 
be any duplicate MIDI items in 
your REAPER project.

Turn the page to continue to the 
next step.

Export the song audio* and MIDI 
file:

 ▪ Click the Contents tab

Expand the listed song folders:

 ▪ Click songs > [custom song 
name]

The lower panel lists the .mid 
and .mogg files:

 ▪ Select both files

 ▪ Right-cilck the selected files 
and choose Extract selected 
files from the menu

 ▪ Click the Save button

320

Follow these steps to import 
the MIDI file from an existing 
custom:

 ▪ Download a Rock Band 3 
custom from https://
rhythmverse.co

 ▪ Open File Explorer

 ▪ Browse to your Downloads 
folder

1

319

IMPORT MIDI FROM 
CUSTOM SONG

3

2
Open the custom song with 
Nautilus: 

 ▪ Open Nautilus

 ▪ Drag and drop your 
downloaded custom from 
File Explorer into the 
Nautilus window

A new window for your custom 
song will open. 

4

https://rhythmverse.co/
https://rhythmverse.co/
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For a full band custom you will 
have the following MIDI items:

 ▪ PART DRUMS

 ▪ PART BASS

 ▪ PART GUITAR

 ▪ PART VOCALS

 ▪ VENUE

 ▪ EVENTS

 ▪ BEAT

Make sure that each item is in 
the correct MIDI track!

Your custom song MIDI import 
is complete, but some of your 
MIDI items are in the wrong 
MIDI tracks.

Start at the bottom and open 
MIDI items one at a time. Look 
at the MIDI item name in the 
MIDI item tab: 

 ▪ Move each MIDI item to the 
correct track

 ▪ Make sure each MIDI item 
starts at measure 1.1.00

322

Import custom MIDI items into 
REAPER:

 ▪ Drag and drop the .mid file 
into the PART DRUMS track 
at measure 1.1.00

The MIDI file import options 
window will open:

 ▪ Confirm that the tempo map 
merge is at measure 1.1.00

 ▪ Click OK to confirm

5

321

IMPORT MIDI FROM CUSTOM 
SONG (CONTINUED)

7

6
Import custom song audio into 
REAPER:

 ▪ Drag and drop the .mogg file 
into the SONG AUDIO track 
at measure 1.1.00 *

Mono audio tracks are added to 
your project:

 ▪ Zoom in to view the audio 
waveform

 ▪ Select and delete all  
the empty audio tracks 
(highlighted in yellow)

* Note: Encrypted .mogg audio 
files will not play in REAPER.

8
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Use Rocksmith customs and Guitar Pro files to help you 
author guitar and bass charts.

 ▪ Use Onyx to convert Rocksmith files to 5-lane MIDI tracks.

 ▪ Use TuxGuitar to convert Guitar Pro files to MIDI.

 ▪ Make sure that imported MIDI tempo maps are accurate.

 ▪ Adjust the count-in to Rock Band standards if needed.

 ▪ Author guitar and bass parts one section at a time.

 ▪ Make sure that you author your guitar and bass parts to 
Rock Band standards.

 ▪ Import existing custom song .mid files to the start of 
measure one. 

 ▪ Import existing custom song .mogg files to the start of 
measure one.

 ▪ Organize imported custom song MIDI items so that they are 
in the correct MIDI tracks.

 ▪ Encrypted .mogg files will not play in REAPER. In this case 
provide your own song audio.

IMPORTED MIDI



 ▪ Expert, Hard, Medium, and Easy
 ▪ Drum animations
 ▪ Common authoring mistakes

DRUM 
AUTHORING

11
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In this chapter, we will look at how to 
author drums for Rock Band.

This includes some broad concepts, as well as some specific 
rules for drums:

 ▪ Use specific gems for particular parts of the kit

 ▪ Maintain note consistency

 ▪ How to author toms, flams, hi-hats, crashes, and kicks

 ▪ How to author single and double kick songs

 ▪ How to author “disco beats” and drum rolls

 ▪ Authoring rules for each difficulty

 ▪ Drum animations

 ▪ Player character animations

 ▪ Drum mix events

 ▪ Common authoring mistakes

 ▪ Drum fills and Overdrive
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Drum fills and Overdrive are covered 
in chapter 17 along with other 
instrument markers (see page 589). 
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Listen to your drum audio and review the drum 
template before you start. 

GETTING STARTED WITH 
EXPERT DRUMS 
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The gem layout for basic drums 
is as follows:

BASIC DRUMS 
LAYOUT

Ride / Rack Tom 2 / 
Percussion

Hi-hat / Rack Tom 1

Snare

Crash / Floor Tom

Kick

Drums are authored on the 
PART DRUMS track. Use MIDI 
notes 96 (C6) to 100 (E6) for 
Expert gems. 

These notes are shown in the 
graphic to the right. 

To author drum parts, follow 
these steps:

 ▪ Start with Expert and chart 
the rhythms of the actual 
drum performance

 ▪ Adjust the gems to match 
the Rock Band kit

Note: Adjusting the gems to fit 
the stock kit is important. You 
can find guidance and examples 
on how to do this throughout 
this chapter.

EXPERT DRUMS 
OVERVIEW

EXPERT DRUMS 
TEMPLATE 

 
 
Roll Marker 2-Lane 
Roll Marker 1-Lane 
--- 
Drum Fill 
Drum Fill 
Drum Fill 
Drum Fill 
Drum Fill 
--- 
Overdrive 
 
Pro Green Tom 
Pro Blue Tom 
Pro Yellow Tom 
 
Solo Marker 
 
Expert Green 
Expert Blue 
Expert Yellow 
Expert Red 
Expert Kick 
 

PART DRUMS

To change the PART 
DRUMS template to 
Rock Band colors see 
pages 121 — 122.  

There are a couple of ways to 
approach drum authoring:

 ▪ Author the full kit measure 
by measure

 ▪ Author parts of the kit one 
at a time:

 ▪ Kicks

 ▪ Snare

 ▪ Hi-hat and cymbals

 ▪ Toms

Many authors prefer authoring 
parts of the kit separately.

If you have drum stems, listen 
to them before you start 
authoring. This will help you 
become familiar with how 
different parts of the kit sound: 

 ▪ Solo and listen to each track

Then listen to how things sound 
together. For example:

 ▪ How does the kick sound 
with the cymbals?

 ▪ How does the floor tom 
differ from the kick?

Getting familiar with how things 
sound will help you to author 
more efficiently.

AUDIO SOURCES AND AUTHORINGLEFT AND RIGHT 
HAND STICKING
Sticking refers to the hand 
that the drummer is using. We 
assume that the drummer is 
right-handed.

We use these abbreviations for 
sticking:

 ▪ L (left hand) 

 ▪ R (right hand)

REAPER FX: 
REASYNTH 
ReaSynth is a plugin that lets 
you hear short percussion 
sounds for your MIDI charts. 

You can use these sounds to 
verify your MIDI notes against 
the song audio. 

See page 293 for more details. 
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Pro drums have additional features to author. 

PRO DRUMS 

How to author 2x kick parts for Pro drums.

PRO DRUMS: DOUBLE BASS
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Pro drums added cymbals to 
the basic drums layout:

 

PRO CYMBALS 
ADD-ON

Hi-hat

Ride

Crash

Pro drums also support an extra 
kick pedal. You can use it for:

 ▪ Double bass (kick) parts 

 ▪ Hi-hat cymbal pedal

We will look at how to author 
double bass parts as we work 
through this chapter.

Double bass parts are referred 
to as (2x) drum parts.

DOUBLE BASS 
PEDAL

You can play these cymbals 
on the cymbal attachments 
for the Rock Band kit or on a 
compatible e-kit. 

On PART DRUMS, Yellow, Blue, 
and Green gems appear as 
cymbals in the game track.

You use special markers to 
change these notes into tom 
gems (see page 337).

There are a couple of different 
ways to reduce kicks:

 ▪ Choose what the right foot is 
doing as the playable part, or

 ▪ Find a pattern that just the 
right foot can play

You can use the Reduce 2x bass 
pedal function in CAT to help 
you get started.

Be aware that a real kick pedal 
has mechanisms that allow for 
a fast, constant stream of hits. 
The stock Rock Band kit does 
not have these mechanisms.

This means that too many kicks 
in a row can lead to fatigue on 
the stock kit. Take this, and the 
tempo of the song into account 
as you author.

A step-by-step guide to create 
the PART DRUMS_2X track is on 
the next page.

Note: If you release a 
(2x) kick pedal version 
you should also release 
a single kick version.

In the C3 Template you can 
author two drum tracks: 

 ▪ PART DRUMS: for drums 
with a single kick pedal

 ▪ PART DRUMS_2X: for Pro 
drums with a double bass 
(2x) pedal

The differences between the 
completed tracks is small:

 ▪ PART DRUMS_2X: 
Double kicks in the Expert 
chart only

 ▪ PART DRUMS: 
Single pedal kicks in the 
Expert chart

Hard, Medium, and Easy are the 
same in both tracks and are 
single kick only. 

DOUBLE BASS 
OVERVIEW

The 2x authoring process is 
straight-forward. Start with the 
PART DRUMS track: 

 ▪ Author the Expert part, but 
include the double bass

 ▪ Reduce each difficulty, but 
for a single kick pedal

When the PART DRUMS track is 
complete, duplicate it:

 ▪ Rename the duplicate track 
PART DRUMS_2X

 ▪ Change the text event at the 
start of the duplicate track 
from PART DRUMS to PART 
DRUMS_2X

In the PART DRUMS track:

 ▪ Reduce the kicks so that 
they can be played with one 
foot on the stock kit

Pro Drums: Yellow, Blue, and 
Green Cymbals

Pro Drums: Yellow, Blue, and 
Green Toms

2X AUTHORING 
PROCESS
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In the PART DRUMS track 
reduce the Expert kicks:

 ▪ Press F9 to open CAT

 ▪ Click the Reduce 2x bass 
pedal button

This window will open:

 ▪ Click the Reduce all button

 ▪ Review the Expert chart for 
playability with one foot

Rename the duplicate track to 
PART DRUMS_2X:

 ▪ Click the name field in the 
duplicated drum track

 ▪ Rename the track PART 
DRUMS_2X

 ▪ Press the Enter key

334

Complete your PART DRUMS 
chart. This includes:

 ▪ Expert (with double bass 
parts authored)

 ▪ Hard, Medium, and Easy 
(with kicks authored for only 
one foot)

Duplicate the PART DRUMS 
track as follows:

 ▪ Right-click the PART DRUMS 
track in the Track Panel

 ▪ Select Duplicate tracks from 
the menu 

1

333

PART DRUMS_2X TRACK

3

2

Change the track name in the 
text event at the start of the 
MIDI track. 

Open the duplicate track:

 ▪ Double-click the PART 
DRUMS_2X MIDI track

 ▪ Double-click the PART 
DRUMS text event and 
change the track name to 
PART DRUMS_2X

 ▪ Click the OK button

4

PART DRUMS_2X TRACK 2
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Adjust the MIDI grid to match the part that you 
are authoring.

MIDI GRID 

It is not always best to force note consistency.

NOTE CONSISTENCY
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When we author drums we 
translate the pads and cymbals 
played to the Rock Band kit.

With some songs this can be 
a direct translation. But this is 
not always the case. You should 
take care not to force things too 
much. It doesn’t always make 
for a playable song.

For example, imagine a song 
that has a ride cymbal section 
followed by a drum fill on 
the second rack tom. (See 
screenshot below).

As you can see, there is no 
visual difference between the 
ride and the toms. (Both these 
notes are usually mapped to 
Blue gems).

In this case you should consider 
putting the toms on Yellow. This 
is so that they feel different to 
play than the ride cymbal. (See 
screenshot below).

Note: Hi-hats and cymbals have 
a more distinctive sound and 
more important role in most 

beats. This means that their 
gems should be consistent if 
possible.

An exception to this rule is 
when a tom fill uses Yellow, 
Blue, and Green gems. 

In this case the last Green tom 
is normally followed by a crash 
on the Green gem. This prevents 
the player from having to cross 
hands to hit a cymbal on the 
Blue gem.

Basic Drums: Ride and Kick 
into Blue Tom Fill

Basic Drums: Ride and Kick 
into Yellow Tom Fill

Basic Drums: Yellow, Blue, 
Green Fill into Green Crash

USING THE SWING 
GRID
Some songs (usually the funkier 
ones) have a slight swing to the 
groove. To compensate for this:

 ▪ Try using a 50% or 66% 16th 
note swing grid

This will visually encourage the 
player to mimic the swing.

Note: Too much swing can make 
the gem pattern harder to read.

See also pages 171 — 174.

A 16th or 32nd note grid is 
usually a good choice for 
authoring drums. 

Turn Snap on in the MIDI Editor 
for quantized authoring.

Switch to a triplet grid as 
needed by the song.

GRID SIZE FOR 
DRUMS

Strength: 50 %

OVERVIEW AND 
GUIDELINES
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AUTHORING TOMS TOM FILLS AND STICKING
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When you author Yellow, Blue, 
and Green expert gems they 
default to cymbals:

 ▪ Hi-hat

 ▪ Ride

 ▪ Crash

If you want an Expert gem to be 
a tom you have to pair it with a 
Pro tom gem of the same color.

X

Pro Green Tom

Pro Blue Tom

Pro Yellow Tom

---
Solo Marker

---

Expert Green

Expert Blue

Expert Yellow

Expert Red

Expert Orange

---

Hard Green

Hard Blue

Hard Yellow

Hard Red

Hard Orange

H

For example, an Expert Yellow 
note and a Yellow Pro Tom note 
together make a Yellow tom.

You can author these two notes 
individually. Or you can copy 
Yellow, Blue, and Green Expert 
gems up to the Pro tom rows.

Note: If your Expert gems and 
Pro Tom notes are not aligned 
your Expert gems will still 
appear as cymbals.

X

Pro Drums: Toms

To fix out of sync notes:

 ▪ Select the Expert and Pro 
Tom notes

 ▪ Press the Q key

 ▪ Press the OK button

To the left you can see a drum 
chart with Yellow, Blue, and 
Green Pro Tom notes. The chart 
preview is above.

Notice that the first Green gem 
in the chart does not have a 
Green tom marker. It appears as 
a crash in the preview. 

Similarly, the notes paired with 
tom markers all appear as toms.

Pro Tom notes apply to Yellow, 
Blue, and Green gems authored 
in each difficulty.

Sometimes you need to make 
changes to drum charts so that 
they are satisfying to play on 
the Rock Band kit.

A good example of this is when 
the player has to cross their 
hands to play a part. 

This can be difficult to do, even 
if you are going from Green to 
Blue, or from Blue to Yellow.

Now, imagine you are playing a 

song where the drummer plays 
a roll on a kit with six toms.

You have to make changes to 
play this on the stock kit that 
only has three toms. We have to 
wrap the gems around the kit to 
play the fill. 

In this case it helps to start the 
wrap with the left hand, so that 
players’ hands do not cross. You 
can see this in the “Wrapping 
Tom Fill Gems” graphic below.

The downside here is that the 
gems are briefly out of sync 
with the tom pitches. 

Note: Making changes to toms 
like this is less noticeable at 
higher tempos. At lower tempos 
you will notice these changes 
more, but you can also cross 
hands more easily. So, at lower 
tempos you can author the 
section exactly as it is played.

X

LR LR

LR LR

LR LR

LR LR

LR LR

LR LR

LR LR R

L LR

Tom 1

Tom 2

Tom 3

Tom 4

Tom 5

Tom 6

Crash

Kick

Wrap starts with left hand

WRAPPING TOM FILL GEMS

Extra Green tom gem

Crash

R

LR LR

LR LR LR LR

LR LR R

Kick
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A flam is two single strokes played slightly 
apart on the same drum. 

FLAMS 

Drummers play flams to thicken 
the sound of a note. Flams are 
made up of two strokes:

 ▪ A grace note, and

 ▪ A primary note

The grace note is a softer note, 
while the primary note is louder.

Flip disco beat notes to play them on the stock 
Rock Band kit.

DISCO BEATS, OR 
THE “16 BEAT”
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A disco beat features 16th 
notes on the hi-hat. “Run to the 
Hills” by Iron Maiden is a good 
example. The drummer plays:

 ▪ 16th note hi-hats with 
alternate sticking (RLRL)

 ▪ Snare with the right hand 
(on beats two and four)

 ▪ Kick on the downbeat

This pattern and sticking is not 
a problem on Pro drums: 

 ▪ The hi-hat is higher than the 
snare and to the left

 ▪ The right hand can hit the 
snare without crossing 
hands

This is not the case on the 
stock Rock Band kit.

On the stock kit the disco beat 
pattern is difficult to play:

 ▪ The hi-hat (Yellow) is on the 
right, and

 ▪ The right hand can only hit 
the snare (Red) by crossing 
hands

This pad placement makes the 
beat much harder to play on the 
stock kit.

The solution is to “flip” the 
gems on the Rock Band kit:

 ▪ Play the hi-hats on Red and 
the snares on Yellow 

We control this flip with drum 
mix text events.

Note: Always listen carefully to 
see if the drummer is hitting 
a hi-hat with the snare. In 
some cases, the drummer can 
play 16th notes without using 
alternate hands. In this case do 
not flip the disco beat notes.

SNARE FLAM: “YOU REALLY GOT ME” BY THE KINKS

Pro Green Tom

Pro Blue Tom

Pro Yellow Tom

---
Solo Marker

---

Expert Green

Expert Blue

Expert Yellow

Expert Red

Expert Orange

---

The drummer holds the stick 
of the primary note higher than 
the stick of the grace note.

The primary note hits the drum 
just after the grace note.

In Rock Band we play flams as 
a single unison hit with both 
hands. For example, we author 

a snare flam as a hit on the Red 
and Yellow gems. This shows 
the player that they must use 
both hands at the same time.

Note: The Yellow gem does 
not mute or unmute the snare 
stream if you are using stems as 
your audio source. 
 

To the left you can see the 
opening notes of “You Really Got 
Me” by The Kinks.

The iconic opening snare flam 
is on the Red and Yellow gems, 
with a Yellow Pro tom marker.

 
We author tom flams as a two 
stick unison hit on tom gems:

 ▪ Yellow and Blue toms, or

 ▪ Blue and Green toms

Pro Drums: “Run to the Hills” 
Disco Beat

Basic Drums: “Run to the 
Hills” Flipped Disco Beat 

THE STOCK ROCK 
BAND KIT

“DISCO FLIP” 
OVERVIEW

WHAT IS A DISCO 
BEAT?

TOM FLAMS
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Customs without multitracks use two text 
events to flip disco beat hi-hats and snares.

HOW TO AUTHOR DISCO 
BEATS  

To the right you can see a disco 
beat on Pro and Basic drums.

The hi-hat and snare gems have 
the sticking included inside 
each note.

The Pro drums chart is flipped 
to Basic drums using these two  
text events:

 ▪ [mix 3 drums0d] 
Turns disco flip on

 ▪ [mix 3 drums0] 
Turns disco flip off

Place these text events before, 
and after, the gems you want to 
flip. Then, use CAT to flip the 
disco beat gems:

 ▪ Press F9 to open CAT

 ▪ Click the Flip disco beats 
button

[Continued on facing page].

HOW TO AUTHOR DISCO 
BEATS 2
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 Kick  Snare  Hi-hat 

[mix 3 drums0][mix 3 drums0d]

PRO DRUMS (NOT FLIPPED)

BASIC DRUMS (FLIPPED)

LR LR L

R

LR LR LR LRL

R

LR LR L

R

LR LR LR LRL

R

Text event to turn disco flip on Text event to turn disco flip off

The Flip disco beat sections 
window will open:

 ▪ Select the notes to flip in 
your MIDI track

 ▪ Click the Flip selected button

Your disco beat notes are now 
flipped. The beat will now play 
correctly on Pro and Basic drums. 

For more details about disco flip 
text events and multitracks see 
pages 373  — 375.

Author your chart for Pro drums. 
When complete, reduce the 
chart for each difficulty.

Add the disco flip text events 
to Expert. Run CAT and flip the 
Expert hi-hats and snares.

Expert Pro drums can now play 
unflipped flipped gems. Basic 
drums will play the flipped gems.

Step 1 Step 2 Step 3

Note: Make sure that 
the snare falls on the 
beat with the right- 
hand. If the snare falls 
on the up-beat and/or 
left-hand then do not 
flip the gems. 
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How does Rock Band resolve scoring and note 
weighting for disco flipped notes? 

DISCO BEAT NOTE 
WEIGHTING
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 Kick  Snare  Hi-hat 

[mix 3 drums0d]

PRO DRUMS WEIGHTING

BASIC DRUMS WEIGHTING

11 11 1

2

11 11 11 111

2

11 11 1

2

11 11 11 11

2

Text event to turn disco flip on

As you can see, the snare on 
Basic drums gets the same note 
weighting as the hi-hat on Pro 
drums. 

The same logic applies to the hi-
hat on Basic drums and the snare 
on the Pro drums.

For drums, some gems carry 
more weight than others when 
it comes to scoring: 

Note: Kicks (3) have a higher 
weighting than snares (2) and 
cymbals (1).

Missing higher tier notes will fail 
the player faster than missing 
lower tier notes.

In the graphic you can see note 
weighting for a disco flip on Pro 
and Basic drums.

This weighting is handled by the 
[mix 3 drums0d] event.

Hi-hat / Rack Tom 1

Ride / Rack Tom 2

Kick

Crash / Floor Tom

Snare

3

2

1

1

1

Note: For other disco-
like beats refer to the 
Pro drums “Noflip” 
topic. See page 376.

[mix 3 drums0]

Text event to turn disco flip off

1
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There are some common exceptions for hi-hat 
and crash authoring.

HI-HAT AND CRASH 
CYMBALS 
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Open hi-hats can be authored 
on Blue when: 

 ▪ There is a clear distinction 
between the open and 
closed hats, and

 ▪ There aren’t other Blue 
toms or cymbal gems in the 
section 

This works great for bands like 
Rush whose drumming is very 
tight and methodical. It does 

OPEN HI-HATS ON 
BLUE

not work so well for drummers 
who gradually open and close 
the hi-hat during a section of 
the song:

 ▪ Do not chart open hi-hats 
on Blue in this case

This is especially true if other 
Blue toms or cymbals are being 
played. In this case keep all hi-
hats, open or closed, on Yellow.

Authoring hi-hats on Blue or 
Green is not a very common 
occurrence. You can however 
author hi-hats on Green if:

 ▪ The right-hand rides on the 
hi-hat, and

 ▪ The left-hand is playing at 
least two different toms or 
percussion gems 

You can see this in “Don’t Stop 
Believin’” by Journey. Putting the 
hi-hat on Green frees the left 
hand to play the left three pads. 

Similarly, you can author the 
ride on Green if you need to free 
up the other pads for the left 
hand to play. 

Finally, hi-hat on Blue is also 
an option, if you need to free 
up other pads for the left hand. 
For example, “Feeling This” by 
Blink-182.

HI-HATS ON BLUE 
/ GREEN

Closed Hi-Hat Open Hi-Hat

 OPEN HI-HATS ON BLUE: “SUBDIVISIONS” BY RUSH

You can author crash cymbals 
on Green, Blue, or Yellow, 
depending on the situation.

For example, a drummer might: 

 ▪ Ride the crash cymbal during 
a chorus, and

 ▪ Hit another cymbal to accent 
the start of each measure

In this case, we can author 
a series of Green gems, with 
the accent crash on Blue. (See 
screenshot below):

CRASH CYMBAL 
AUTHORING

Ride on Green Crash with 
Blue Accent Cymbal

Open Hi-Hat Percussion  
Yellow Cymbal

HI-HATS ON BLUE: “FEELING THIS’” BY BLINK-182

Hi-Hat

Green Hi-Hat Yellow Tom

HI-HATS ON GREEN: “DON’T STOP BELIEVIN’” BY JOURNEY

Blue Tom
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Alternating Yellow and Blue gems for closed and 
open hi-hats is not always the best choice.

HI-HAT AND CRASH 
CYMBALS (CONTINUED)

Author double crashes on Yellow and Green.
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Drummers often open and close 
the hi-hat pedal to accent the 
hi-hat. For example, a drummer 
might accent eighth note hi-
hats as follows:

 ▪ Closing the hi-hat on the 
downbeat, and

 ▪ Opening the hi-hat on the 
upbeat

This sounds great and gives the 
beat a syncopated feel. This feel 
is difficult to reproduce because 
Rock Band does not have a hi-
hat pedal.

OPEN HI-HATS ON 
UPBEATS

Closed Hi-Hat Open Hi-Hat

 “HEART OF GLASS” BY BLONDIE

“CENTERFOLD” BY THE J. GELIS BANDInterpreting this rule is a 
judgement call. For example, in 
“Centerfold” Harmonix authored 
alternating Yellow and Blue gems. 

You can also find this same 
choice in slower songs like 
“Feeling That Way” by Journey. 

“Heart of Glass” by Blondie 
provides a good contrast. This 
part does not have any hi-hats 
on the downbeat. But it does 
have closed and open hi-hats 
on the upbeats. This gives the 
song a great syncopated feel. 

Use the method that feels best 
for your song.

DOUBLE CRASH 
HITS
Drummers often hit two 
cymbals at once for extra 
emphasis. To mirror this on the 
Rock Band kit:

 ▪ Author a double crash on 
Yellow and Green

Double Crash (with Kick) on 
Yellow and Green Cymbals

We could author this rhythm as 
follows:

 ▪  Alternating Yellow and Blue 
gems, or 

 ▪ Straight 8th notes, all on 
Yellow

Note: These two options 
may leave the player feeling 
detached from the rhythm.

A better way to author this kind 
of beat is with:

 ▪ Yellow or Blue gems only on 
the upbeats
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Left foot hi-hat pedal hits are not usually charted.

HI-HAT AND CRASH CYMBALS 
(CONTINUED)

Rock Band drum kits do not 
have a pedal for the hi-hat. For 
this reason we usually do not 
chart left foot hi-hat pedal hits. 
Playing these hits with the right 
hand feels un-natural. The only 
exception is when:

 ▪ The drummer keeps time 
with their left foot and does 
not play anything else

You can see two examples from 
custom songs to the right:

 ▪ Ghost “See No Evil” 
 
Left foot hi-hat pedal is not 
charted

 ▪ Led Zeppelin “Whole Lotta 
Love” (Post chorus) 
 
Left foot hi-hat pedal is 
charted

Note: Author the left foot hi-hat 
animation in either case.

Do not author parts that are not audible in the 
full audio mix.

AUTHOR TO THE 
FULL MIX
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UN-ACCENTED 
DRUM HITS
Solo drum tracks may often 
have details that are not heard 
in the full band mix. 

You should take care when 
authoring these details:

 ▪ They may not translate well 
when played with the rest of 
the band

A common example of this is 
when the drummer plays:

 ▪ Quiet off-beat eighth note 
cymbals, with

 ▪ More heavily emphasized 
downbeats

Playing these extra eighth notes 
in-game can:

 ▪ Detract from an intended 
quarter note groove

Similarly you may hear accents 
and details in the kick or snare 
tracks that are not heard in the 
full mix. In this case, author the 
groove as heard in the full mix:

 ▪ The player should not 
feel as if they are playing 
unnecessary notes / gems

LEFT FOOT HI-
HAT PEDAL

 “WHOLE LOTTA LOVE” BY LED ZEPPELIN

“SEE NO EVIL” BY GHOST

X

X

L
L L L L L L L L
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There are two kinds of drum rolls in Rock Band, 
the standard roll and the special roll.

DRUM ROLLS 
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A drum roll is a series of 
rapid beats used to produce a 
sustained sound on the kit.

The most common rolls are:

 ▪ Single stroke rolls: RLRL

 ▪ Double stroke rolls: RRLL

 ▪ Buzz roll: RLRL

Single stroke rolls use fast 
alternate sticking.

Double stroke rolls use stick 
rebound to produce fast rolls.

Buzz rolls use single strokes 
with control of the rebound to 
produce the “buzz” sound.

Drum roll lanes help players 
play very fast parts on the Rock 
Band kit. There are two kinds of 
roll lanes:

Standard rolls use the marker 
on note 126 (F#8):

 ▪ Roll Marker 1-Lane

Special (two lane) rolls use the 
marker on note 127 (G8):

 ▪ Roll Marker 2-Lane

Special rolls are for cymbal 
swells (for rolls played between 
two pads).

A roll marker is a single MIDI 
note that covers the whole roll 
(except for the last note). *  
Make sure that:

 ▪ The roll marker starts on the 
first note of the roll

 ▪ The roll marker does not 
overlap the last roll note 

* Many authors use a different 
method for roll markers. See 
pages 353 — 354. 

Rolls work on both Pro and 
Basic drums.

Use roll markers on single toms, 
snares, and cymbals when:

 ▪ The part is too fast for the 
stock Rock Band kit

When authoring rolls, follow 
these rules:

 ▪ Use drum roll markers when 
rolls / swells are too hard to 
play on the stock kit

 ▪ Do not author a fill over a 
drum roll

 ▪ For extremely fast parts 
author 32nd notes inside a 
roll lane

 ▪ Try to avoid authoring long 
rolls that span many pads * 
 
* For example, a quick 
descending tom roll. This 
does not look good in-game

Roll markers are best used on 
very fast or out of time rolls.

Some examples of songs with 
drum rolls are:

 ▪ “Subdivisions” by Rush: 
Drum roll and cymbal swell 

 ▪ “Beast and the Harlot” by 
Avenged Sevenfold: 
Cymbal swell

 ▪ “Train Kept a Rollin’” by 
Aerosmith: Should use a 
cymbal swell

 ▪ “Innuendo” by Queen:  
Buzz roll 

 ▪

By default roll markers only 
work on Expert.

To make them work on both 
Expert and Hard, you need to 
change their note velocity to a 
number between 41 and 50.

To change the velocity of a MIDI 
note see pages 175  — 176.

Remember: The default velocity 
of MIDI notes in REAPER is 96.

DRUM ROLL 
BASICS

ROLL LANES AND 
MARKERS

AUTHORING 
RULES 

EXAMPLE ROLLS 
AND SWELLS

HARD DIFFICULTY 
ROLLS

Many people find that 
two note rolls are 
too strict and hard 
to combo. Consider 
authoring swells to a 
single lane (usually on 
the Green cymbal).

Basic Drums: Roll on SnarePro Drums: Cymbal Swell on 
Yellow and Green 

Pro Drums: Roll / Swell on 
Green Cymbal Only
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Official method: Chart drum roll markers that 
do not cover the last note of the roll.

AUTHORING DRUM ROLLS 

Unofficial method: Chart roll markers that reach 
just beyond the last roll note. Many custom 
song authors use this method.

DRUM ROLLS 2
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31.33130.330.2 30.4 31.2 31.4

16TH NOTE TRIPLET SNARE ROLL

Roll Marker 2-Lane

Roll Marker 1-Lane

----

Drum Fill

Drum Fill

Drum Fill

Drum Fill

Drum Fill (Use all 5)

----

Expert Green

Expert Blue

Expert Yellow

Expert Red

Expert Orange

Take a look at the roll marker in 
the image to the right.

You can see that the roll marker 
and first roll note both start 
together. 

The roll marker ends where the 
last roll note begins. 

This is the official way to chart a 
roll marker - so that the marker 
does not cover the last note of 
the roll.

The drawback with this method 
is that the last note of the roll 
is scored more strictly. And 
this makes the roll harder to 
complete. If you would like 
to avoid this issue, use the 
unofficial method, detailed on 
the facing page. 

ROLL          MARKER

The unofficial method covers 
the whole roll with the roll 
marker. This makes the scoring 
for the whole roll less strict. 

Extend the roll marker a little 
beyond the last roll note to give 
the player a little extra leeway.

Follow these steps:

 ▪ End the roll marker at the 
end of the last roll note

 ▪ Select the roll marker and 
press Ctrl + F2 to open the 
Note Properties window

 ▪ In the Length field adjust 
the length of the roll  
marker *

 ▪ Click OK to close the Note 
Properties window

* You can extend the roll marker 
fractions of a 32nd note beyond 
the last roll note. If you extend 
it a whole 32nd note you will 
get an error in Magma when you 
compile your song.

 Roll marker  Added unofficial roll marker length
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Hard difficulty introduces the skills needed to 
become an expert player.

HARD DIFFICULTY 

Hard gems are authored on 
notes 84 (C5) to 88 (E5):

 
The Hard difficulty introduces 
Expert skills, but with many of 
the details removed.

Reduce your Expert chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction drums button

 ▪ Uncheck Medium and Easy

 ▪ Click the Reduce button
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Some gems carry more weight, 
scoring wise, than others:

 
Missing a series of kicks will fail 
you out sooner than missing a 
series of snares. 

Cymbal and tom gems are 
weighted the least. You can 
miss more of these gems before 
you fall to the bottom of the 
crowd meter.

Keep this in mind when you 
reduce drum charts of any 
difficulty.

When the right hand plays a 
constant rhythm:

 ▪ Kicks and snares can 
fall between right hand 
timekeeping gems

For example, the right hand is 
playing a constant rhythm on 
the hi-hat:

The left hand and right foot can 
play snares and kicks between 
the hi-hats:

Hard introduces players to 16th 
note rolls:

 ▪ Played on one, or multiple 
pads

 ▪ With alternating hands

Note: Only author sections like 
this if they last a beat or two.

Hard players are not expected 
to immediately perfect these 
rolls. So, the player should not 
fail while learning to play them.

Note: Avoid authoring 16th note 
rolls when the song tempo is 
140 BPM or more.

Hard should not have as many 
kicks as Expert. So, continue to 
reinforce the idea of a quarter 
note grid.  

Hard should often have off-beat 
crashes that are not paired with 
a kick:

Try removing the kicks marked 
with an “X”, as shown in the 
example above.

Hard players need to develop 
the techniques to play a fast 
rock beat.

The upper limit for playing 
constant 8th notes on Hard is 
about 170 BPM.

HARD DRUMS 
OVERVIEW

NOTE WEIGHTING 
AND REDUCTIONS

COMPLETE LIMB 
INDEPENDENCE

16TH NOTE 
ROLLS: RLRL

KICKS AND OFF-
BEAT CRASHES

FASTER R HAND 
TIMEKEEPING

 
 
Hard Green 
Hard Blue 
Hard Yellow 
Hard Red 
Hard Orange

PART DRUMS

H

LR LR

< 140 BPM

X X

< 170 BPM

LR LR

Hi-hat / Rack Tom 1

Ride / Rack Tom 2

Kick

Crash / Floor Tom

Snare

3

2

1

1

1
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Remove Expert nuances so that Hard is more 
playable.

HARD DIFFICULTY 
(CONTINUED) 
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THIN OUT THE 
KICKS

REMOVE SNARE 
ACCENTS

EVEN NUMBER OF 
ROLL HITS

REMOVE KICKS 
FROM FILLS

KEEP FAST ROLLS 
ON GRID

LESS HAND 
MOTION

Remove all kicks from drum fills 
on Hard difficulty.

For fast drum rolls you can: 

 ▪ Start rolls on 8th or quarter 
note grid lines

 ▪ Trim a note or two from the 
start of a fast roll

Require less hand motion. For 
example, if a crash happens 
right after a snare flam:

 ▪ Make the flam a one handed 
snare hit

This preserves the rhythm and 
feeling of connection to the 
sound. It also gives the right 
hand more time to move to the 
crash, with less hand motion.

If there are 100 Kicks in Expert 
and 50 in Medium, there should 
be about 75 in Hard.

Try removing kicks from 
adjacent 8th or 16th notes. 

In a section filled with little 
snare accents:

 ▪ Remove about half of them

Do this in a consistent way 
throughout the whole song. 

Advanced reading is needed for 
16th note rolls with an uneven 
number of hits:

 ▪ Even out the number of hits 
for Hard difficulty

REDUCE MULTIPLE 
CRASHES

DISCO BEAT TO  
“8 BEAT”

REMOVE GEMS 
CONSISTENTLY

MAKE SPACE FOR 
DOUBLE CRASHES
Don’t author double crashes 
unless there is space for the 
player to prepare for them.

Expert crashes can be authored 
on many pads. Try putting them 
all on Green in Hard. This is one 
less thing for the player to keep 
track of.

On Hard you play disco beats 
as a regular “8 beat”. To chart 
this, unflip the disco beat and 
reduce it as follows:

 ▪ Put hi-hats back on Yellow

 ▪ Put snares back on Red

 ▪ Remove the 16th notes

 ▪ Add a Yellow hi-hat above 
the snare gem

This will leave you with a regular 
rock “8 beat”. 

When you remove gems on Hard 
be as consistent as you can 
from measure to measure.

This will make the song feel 
much more cohesive.

X

X XX X X

X

X
X

X XX X

X

NO QUICK HAND 
CROSSES
Remove notes that require the 
player to cross hands quickly.

R L R L

R L R X

HARD DIFFICULTY 
CONTINUED 2
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Medium difficulty introduces the basics of rock 
drumming. The player learns how to use their 
hands and feet at the same time.

MEDIUM DRUMS 
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Medium gems are authored on 
notes 72 (C4) to 76 (E4):

 
Medium difficulty removes the 
details for a skeleton drum part.

Reduce your Hard chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction drums button

 ▪ Uncheck Hard and Easy

 ▪ Click the Reduce button

MEDIUM DRUMS 
OVERVIEW

 
 
Medium Green 
Medium Blue 
Medium Yellow 
Medium Red 
Medium Orange

PART DRUMS

M

LIMITED LIMB 
INDEPENDENCE

TIMEKEEPING 8TH 
NOTES < 140 BPM

> 170 BPM 1 KICK 
PER MEASURE
One kick per measure for songs 
at 170 BPM or more.

Do not author kicks and snares 
between hi-hat / ride gems.

No timekeeping 8th notes (right 
hand) at 140 BPM or more. 

Reduce to quarter notes at 140 
BPM or more. Note: This will 
also mean less places for kicks.

ONE HAND ROLLS 
AND FILLS
Assume that the player will 
hit a stream of gems on a 
single color with one hand. For 
example, a roll or fill on the 
Yellow tom.

Medium players are not 
expected to play 16th notes with 
alternating hands. So, reduce 
fills and rolls to 8th notes (or 
less for faster songs).

REDUCING 
TRIPLETS
It is usually best to reduce 
triplets to quarter notes.

This is often preferable to 
removing every other gem from 
the triplet pattern.

Note: Either approach can 
radically change the feel of a 
passage.

X

X
X

> 170 BPM

R L R L

H

R L R L

R R

M

R R

KICKS AND 
CRASHES
Medium difficulty introduces 
players to the following 
concept:

 ▪ Crashes are usually 
emphasized with a kick

Author downbeat crashes with a 
kick. Do not pair syncopated, or 
off-beat crashes with a kick.

X

X X X

X XX

OFF-BEAT CRASHESQUARTER NOTES

EVERY OTHER NOTE

QUARTER NOTE 
KICKS 100+ BPM
For songs above 100 — 110 BPM, 
consider only authoring kicks on 
quarter notes.

> 100 — 110 BPM

< 140 BPM
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MEDIUM DRUMS 
(CONTINUED)

There are no three limb hits in Easy. No gems 
should be paired with a kick.

EASY DRUMS

361 DRUM AUTHORING 362

EXTRA TIPS FOR MEDIUM
Medium players tend to get into 
the groove quite easily when:

 ▪ The beat is predictable and 
does not vary

When this is not the case:

 ▪ Focus on the intended feel 
of the passage

For example, when syncopation 
or polyrhythms complicate the 

RESET AFTER 
CRASH
At faster tempos, remove gems 
that come immediately after a 
crash. This gives the player time 
to reset their hand position.

X

OPEN / CLOSED 
HI-HATS
Contrasting open and closed 
hi-hats works well for some 
Medium songs. It does not work 
well for all songs though. Tempo 
is often the deciding factor.

feel of the beat:

 ▪ Pick out the main hits of the 
passage, and

 ▪ Thin out the gems around 
those hits

Some fills have an accented 
pattern. For example, the 
drummer may:

 ▪ Accent every third 16th note, 
or

 ▪ Hit a few different toms 
during a long snare fill

Instead of reducing the fill to 
8th notes:

 ▪ Try to find the intended 
rhythm of the fill. Simplify 
the pattern in a way that 
retains that nuance.

Author Easy gems on notes 60 
(C3) to 64 (E3):

 
 
Reduce your Medium chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction drums button

 ▪ Uncheck Hard and Medium

 ▪ Click the Reduce button

EASY DRUMS 
OVERVIEW

 
 
Easy Green 
Easy Blue 
Easy Yellow 
Easy Red 
Easy Orange

PART DRUMS

E

There are two main beats 
authored for Easy:

 ▪ A two hand beat (no kick)

 ▪ A beat with kick and snare

A general guideline to follow is:

 ▪ Less intense sections should 
be a kick / snare beat:

 ▪ More intense sections 
should be a 2-hand beat:

Note: Sometimes it may make 
sense to reduce a section to:

 ▪ Kicks and toms/cymbals

BEATS FOR EASY 
DRUMS

REDUCTION 
GUIDELINES

 ▪ No kicks under crashes

 ▪ For kick / crash sections, 
or important crash accents, 
author crashes instead of 
kicks

 ▪ At higher tempos you may 
want to reduce 8th note fills 
to quarter notes

 ▪ One kick per measure for 
songs at 170 BPM or more

 ▪ In sparse kick / snare 
sections it’s OK to author 
an extra kick per measure. 
The extra kick must be on a 
quarter or eighth note grid

 ▪ Reduce gems around 
important off-beat accents 
and complex rhythms

 ▪ Sections without hi-hat 
gems can have Yellow Tom 
gems during a fill. This is a 
little easier for the player 
to read and play, without 
having to reach as far.

NO THREE LIMB 
HITS
No kick, snare and crash at the 
same time.

X X
X X

X
X

X
X
X
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Avoid these mistakes to improve your drum charts!

COMMON AUTHORING 
MISTAKES 

 ▪ Only author one drum part 
at a time. The player cannot 
play a mix of studio and 
electronic drums at the 
same time

 ▪ Avoid crossovers except in 
highly technical songs *  
 
* Examples include technical 
speed, death, thrash, math, 
prog, and metal songs

 ▪ There are conventions for 
authoring certain parts of 
the kit to certain gems. You 
should follow them

 ▪ Different toms should be 
different gems, if at all 
possible

 ▪ Remember to author drum 
fills and Overdrive phrases 

 ▪ Overdrive phrases and drum 
fills cannot overlap

363 DRUM AUTHORING 364

 ▪ Do not author drum fills in 
drum solo sections

 ▪ The crash cymbal should 
almost always be on a Green 
gem

 ▪ Only author ghost notes 
when they are clearly heard 
in-game

 ▪ Remember to use the disco 
flip event when needed 
(even at slow tempos to 
avoid crossovers).

 ▪ It is best to author strongly 
accented open hi-hats on a 
Blue gem * 
 
* Assuming that there are 
few other sounds in the 
section that already have 
Blue gems.

 ▪ Thin out fast drum fills and 
remove the kicks from the 
fill * 
 
* Kicks can be kept if they 
are especially important to 
the fill.

 ▪ Three limb hits are not 
allowed

 ▪ Kick drums are not allowed 
on the off-beats

 ▪ Remove the kicks from all 
drum fills

 ▪ Try to maintain the feel of 
the song. * 
 
* If an off-beat rhythm is 
important, then make room 
around the off-beat gems.

 ▪ The snare and the crash 
cymbal are always more 
important than the kick.  
Author your charts 
accordingly

 ▪ Quieter sections and verses 
tend to be authored with the 
kick and snare

 ▪ Louder sections and 
choruses are best authored 
for hands only * 
 
* For example, hi-hat and 
snare.

 ▪ Do not pair any other gems 
with a kick

 
EXPERT

  
HARD

 
MEDIUM

 
EASY
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This kit layout for drum animation 
matches the in-game gem colors.

KIT LAYOUT FOR DRUM 
ANIMATIONS 

The C3 Template contains many note rows 
for in-game drum animation. 

ANIMATIONS LIST

365 DRUM AUTHORING 366

51 D#2 
Floor tom hit with right hand

50 D2 
Floor tom hit with left hand

49 C#2 
Tom 2 hit with right hand

48 C2 
Tom 2 hit with left hand

47 B1 
Tom 1 hit with right hand

46 A#1 
Tom 1 hit with left hand

42 F#1 
Ride cymbal with right hand

41 F1 
Crash 2 choke 
Right hand hit, choke with left

40 E1 
Crash 1 choke 
Right hand hit, choke with left

39 D#1 
Crash 2 soft hit with right hand

38 D1 
Crash 2 hard hit with right hand

37 C#1 
Crash 1 soft hit with right hand

36 C1 
Crash 1 hard hit with right hand

35 B0 
Crash 1 soft hit with left hand

34 A#0 
Crash 1 hard hit with left hand

033 A0 
Percussion with left hand 
Note: This animation does not 
work in RB3. Use percussion 
with right hand instead

32 G#0 
Percussion with right hand

31 G0 
Hi-hat hit with right hand

30 F#0 
Hi-hat hit with left hand

27 D#0 
Snare hit with right hand

26 D0 
Snare hit with left hand

25 C#0 
Hi-hat pedal up (hat open) with 
left foot. The hat stays open for 
the duration of the note.  
Note: The default is pedal down 
(hat closed)

24 C0 
Kick hit with right foot

28 (E0) 
Snare soft hit with left hand

29 (F0) 
Snare soft hit with the right 
hand

43 (G1) 
Ride hit with left hand

44 (G#1) 
Crash 2 hit with left hand

45 (A1) 
Crash 2 soft hit with left hand

Hi-hat

Crash 1

Ride

Tom 1

Snare

Floor tom

Kick

Crash 2

Tom 2

Percussion

The graphic is color coded to 
the gems played in-game.

Percussion is mounted above 
the kick.

The percussion on the in-game 
kit is typically a cowbell.
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For the best drum animations use CAT.

DRUM ANIMATIONS 

When your drum chart is 
complete there are a few ways 
to approach drum animation:

 ▪ Use CAT

 ▪ Use Magma

 ▪ Manually create animations 
from the Expert drum chart

Using CAT is the recommended 
method. It produces the best 
animations with only a little 
amount of work required.

Magma will create drum 
animations if no gems are 
authored for animation. These 
animations are not as good as 
the ones produced by CAT.
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Manual animations need 
the most work and are not 
recommended. The manual 
process involves dragging a copy 
of the Expert drum chart down 
to the animation rows below. 
From there you manually adjust 
notes to their correct positions.

SELECT 
INSTRUMENT
Select a drum track from the 
drop down menu:

 ▪ Drums

 ▪ 2x Drums

The default hit animation is a 
hard hit. To change the default 
to soft hits:

 ▪ Check the Soft as default for 
snare / crash checkbox

SELECT GRID

Choose the grid that best fits 
your PART DRUMS MIDI:

 ▪ 1/16th notes

 ▪ 1/32nd notes

CRASH1 AS 
DEFAULT
Crash2 is the default crash for 
animation. This is the crash on 
the drummer’s right. If you want 
to change the animation to the 
crash on the drummer’s left:

 ▪ Check the Crash 1 as default 
crash checkbox.

SOFT SNARE / 
CRASH

This setting controls two-
handed cymbal animation. The 
default setting is 4. This means 
that after 4 cymbal hits in a row 
a two-handed animation will 
happen.  

MINIMUM CYMBAL 
HITS

A flam is the default animation 
for a snare and yellow tom. 
There is usually no need to 
change this setting.

SNARE / YELLOW 
TOM FLAMS

Click the Create drums 
animations button to create 
drum animations. 

Review the tips on the 
next page to improve drum 
animations.

CREATE 
ANIMATIONS

Note: Complete your 
animations in PART 
DRUMS_2X if you 
are using that track. 
Then copy your drum 
animations to the PART 
DRUMS track.

To use CAT for drum animations:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic drum 
animations button

CAT animation options are 
discussed on the facing page.

DRUM ANIMATIONS 2
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Follow these tips to increase the realism of your 
drum animations. 

DRUM ANIMATION TIPS CHARACTER ANIMATIONS
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USE A RANGE OF 
CRASHES

UNCROSSED 
HANDS

 ▪ Crashes should be as varied 
as the original performance

ANIMATE DOUBLE 
CRASHES

 ▪ Animate double crashes 
found in the original audio

This applies even if the double 
crashes are not authored as 
playable gems. 

ADD REALISM TO 
FLAMS
To make flams look more 
realistic: 

 ▪ Make the left hand fall 
slightly after the right hand

HARD AND SOFT 
CRASH RIDES

 ▪ Alternate between soft and 
hard hits on crash rides

This makes the animation look 
less robotic.

SNARE AND TOM 
ROLL ACCENTS
Snare and tom rolls can’t be 
accented like cymbals can. To 
make the drummer look like 
they are accenting a hit:

 ▪ Try removing the note before 
the accent (for that hand) 

This gives the animation time 
to lift the hand higher before 
the hit. You can also experiment 
with paradiddles and double 
strokes and give the accented 
stroke hit more time to lift:

 ▪ Paradiddle: RLRR LRLL

 ▪ Double Stroke: RLRLRR 
LRLRLL

Experiment with uncrossed 
hands: 

 ▪ Try the left hand on the hi-
hat (or crash 1) with the right 
hand on the snare 

This works best with broken 
rhythms more than a regular 
rock beat.

HI-HAT PEDAL 
ANIMATION
The note that controls the hi-
hat (C#0) opens the hi-hat for 
the duration of the note.

Try making the drummer tap 
their left foot to the beat when 
hi-hats are not being played.

This technique can add extra 
realism to your animations.

Do not use this technique if 
the drum part is sparse and 
the player can hear that the 
drummer is not using the pedal.

Text events are placed to set 
the character animation state:

Use CAT to create play, idle, and 
idle realtime text events: 

 ▪ Press F9 to open CAT

 ▪ Press the Automatic 
animations button

Manually add the other 
animation text events from the 
table as needed.

[idle_realtime] The character does not move to the beat 
of the music. The character is waiting for 
their cue. This is useful in slower songs, 
or slow parts in a song.

[idle]

[play] The character is playing.

[mellow] The character is playing in mellow 
manner. They might hit softer.

[intense] The character is playing in an intense 
manner. For example, aggressive metal.

[ride_side_true] Drummer uses Max Weinberg’s side swipe 
when slowly hitting the ride cymbal.

[ride_side_false] Drummer hits the ride normally.

[play]

ANIMATION 
MARKERS

TEXT 
EVENTS

CHARACTER  
ANIMATION

Character animations change the actions and 
attitude of in-game characters.

The character will bop and wave to the 
beat of the music. Use [idle] before the 
song starts, after the song finishes, or 
during downtime. Downtime is at least 
two measures of rest.

[idle_intense] Character is idling in an intense manner.
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CHARACTER ANIMATIONS 
(CONTINUED) 

Character animations should not be added 
during the count-in.

DRUMMER ANIMATION 
 EXAMPLE
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Use the instrument text event list for 
character animation text events.

Try to avoid typing text events 
by hand. Load text events into 
REAPER as follows:

 ▪ Double-click in the text 
event area of the MIDI track

The Add Text Event window will  
open:

 ▪ Click the Load button

 ▪ Browse to C:\Reaper\Data\
Text_strings\

 ▪ Select Text Events List - 
Instruments.txt 

 ▪ Click Open

The Text drop down menu now 
shows Hand Maps and other 
animation text events. Use this 
list instead of typing text events 
in manually.

Note: You can find a complete 
guide for loading text events on 
pages 125 — 126.

ANIMATION  
EVENT LIST

1 3

Count-in: No character 
animations.

After count-in: Guitar is 
playing but drummer is not. 
Drummer is moving to the 
beat: Use [idle].

Drummer starts to play: Use 
[play], [mellow], or [intense].

Drummer starts to play: Use 
[play], [mellow], or [intense]. 
At end of song use: [idle_
realtime]

[idle] [play]

[mellow] [intense]

If you use CAT to generate 
character animations you may 
need to:

 ▪ Add character animation 
text events

 ▪ Modify text events

 ▪ Change the position of text 
events

In the example above you can 
see song sections and character 
animation text events.

Note: Some of the text events 
begin an eighth note early or an 

eighth note late. This is so that 
the animation does not start or 
end abruptly with the music. 

With proper spacing like this, 
your animations will flow with 
the music.

COUNT-IN NO DRUMS DRUMS

DRUMSDRUMS SHORT PAUSE

[idle_realtime]

For a short puase you 
can use: [mellow]. 
For more than two 
measures use [idle].

Drummer plays solo: Use 
[play_solo]. When the solo 
ends use the [play] marker.

[play_solo] [play]
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Use additional drum mix text events for multi-
track songs. You do not need to add mix events 
for regular stereo audio files.

DRUM MIX EVENTS 

Earlier in the chapter we used 
drum mix events to control 
disco flips. 

Here we discuss using them to 
mute and unmute multitrack 
audio streams.

We need to do this because 
artists record and mix drum kits 
in many different ways.

A drum multitrack can, for 
example, contain a mix of 
various mono and stereo tracks.

We need drum mix events 
to tell the game which audio 
stream to unmute for each 
drum pad.

There are five audio stream 
configurations (numbered from 
zero to four):

0 = Drum Mix 0 
1 = Drum Mix 1 
2 = Drum Mix 2 
3 = Drum Mix 3 
4 = Drum Mix 4
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There are also four difficulty 
configurations (numbered from 
zero to three):

0 = Easy 
1 = Medium 
2 = Hard 
3 = Expert

Drum mix events are formatted 
as follows:

[mix X drumsY]

The X and Y variables are:

 ▪ X = difficulty

 ▪ Y = audio configuration

For example, [mix 3 drums0] 
means, Expert difficulty and 
Drum Mix 0. This is the default 
drum mix for Expert drums. 

Note: [mix 3 drums0d] is a 
variant of drums0 that turns 
on disco flip for Expert.

In the graphic on the facing 
page, you can see the drum mix 
events included in the PART 
DRUMS C3 template:

 ▪ [mix 0 drums0]

 ▪ [mix 1 drums0]

 ▪ [mix 2 drums0]

 ▪ [mix 3 drums0]

These events enable Drum Mix 
0 for each difficulty. This means 
that the C3 template is set up 
for a single audio stream. 

drums0 is the default 
configuration in the drums 
template. It supports:

 ▪ A single stereo stream for 
the whole kit

Hitting any pad or pedal will 
unmute the audio stream.

drums0d is the disco flip variant 
of drums0:  

 ▪ Yellow = snare

 ▪ Red = Else *

drums1 supports:

 ▪ Mono kick, mono snare, and 
stereo kit (Else)

drums1d is the disco flip variant 
of drums1:

 ▪ Yellow = snare stream

 ▪ Red = Else *

The following mix events are no 
longer supported in RB2 or 3:

 ▪ drums1easy:drums1  
for sections with no Else 
gems to unmute in Easy

 ▪ drums1easynokick:drums1 
for sections with no kick 
gems to unmute in Easy

drums2 supports:

 ▪ Mono kick, stereo snare, and 
stereo kit (Else)

drums2d is the disco flip variant 
of drums2:

 ▪ Yellow = snare stream

 ▪ Red = Else *

The following mix events are no 
longer supported in RB2 or 3:

 ▪ drums2easy:drums2  
for sections with no Else 
gems to unmute in Easy

 ▪ drums2easynokick:drums2 
for sections with no kick 
gems to unmute in Easy

MIX EVENTS 
OVERVIEW

 
DRUM MIX 0

Easy Drum Mix 0 Medium Drum Mix 0 Hard Drum Mix 0 Expert Drum Mix 0

PART DRUMS [mix 0 drums0] [mix 1 drums0] [mix 2 drums0] [mix 3 drums0]

1 1.1.25 1.1.50 1.1.75 1.2

* Note: On the facing 
page Else refers to the 
stream that contains 
cymbals, toms, room 
mics, and percussion.

 
DRUM MIX 1

 
DRUM MIX 2

* In drumsYd the Red 
pad is assigned to Else 
for disco flip scoring. 

This is so that the 
yellow snare is 
weighted more heavily 
than the red hi-hats.
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DRUM MIX EVENTS 
(CONTINUED) 

The “noflip” event is for disco-like beats.

PRO DRUMS “NOFLIP”
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Earlier in the chapter we saw 
how to flip disco beats with the 
drums0d mix event.

The noflip event is used for 
similar, but less common, 
disco-like beats. For example:

 ▪ Alternating 16th notes on a 
regular drum pad, with

 ▪ Accented hit on the yellow 
cymbal / tom

In this case you would use the 
“noflip” mix event:

 ▪ [mix 3 drums0dnoflip]

This event flips the note 
weighting (just like a regular 
disco beat). But it does not flip 
the gems between the Basic 
and Pro drum modes.

You can see the flipped note 
tiers at the end of each chart.

Remember, missing higher tier 
notes [3] will fail the player 
faster than lower tier notes [1].

drums3 supports:

 ▪ Stereo kick, stereo snare, 
and stereo kit (Else) 

drums3d is the disco flip variant 
of drums3:

 ▪ Yellow = snare stream

 ▪ Red = Else *

The following mix events are no 
longer supported in RB2 or 3:

 ▪ drums3easy:drums3  
For sections with no Else 
gems to unmute in Easy

 ▪ drums3easynokick:drums3 
For sections with no kick 
gems to unmute in Easy

drums4 supports:

 ▪ Mono kick and stereo kit 
(Else and snare mixed into 
one stereo stream) 

drums4d is the disco flip variant 
of drums4:

 ▪ Yellow = snare stream

 ▪ Red = Else *

The following mix events are no 
longer supported in RB2 or 3:

 ▪ drums4easy:drums4  
For sections with no Else 
gems to unmute in Easy

 ▪ drums4easynokick:drums4 
For sections with no kick 
gems to unmute in Easy

If you use multitracks you can 
edit the existing drum mix 
events at the start of the PART 
DRUMS track.

For example, if you have a drum 
audio stream that consists of:

 ▪ Mono kick

 ▪ Stereo snare

 ▪ Stereo Else

Edit the default drum mix 
events as follows:

 ▪ [mix 0 drums2]

 ▪ [mix 1 drums2]

 ▪ [mix 2 drums2]

 ▪ [mix 3 drums2]

DRUM MIX 3 DRUM MIX 4 USING MIX 
EVENTS

DISCO-LIKE 
BEATS 

NOFLIP: “BAT COUNTRY” BY AVENGED SEVENFOLD

[mix 3 drum0dnoflip]

3

1

1

2

1

Kick3 Snare2 Hi-hat / Rack Tom 11

Crash / Floor Tom1Ride / Rack Tom 21

NOFLIP: “GOT SOME” BY PEARL JAM

3

1

1

2

1

[mix 3 drum0dnoflip]

NOTE TIERS

[intro]

[bridge]
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EXAMPLE REDUCTION:  
“CRAZY TRAIN” 

Hard has less hand 
motion on the crashes. A 

In Medium the 8th note 
tom pairs have been 

In Easy the toms are 
reduced to single half H M E

16th note snare is removed from 
the start of the fill to keep it on 
grid (end of measure 19).   

reduced to single toms. Three 
limb hits are reduced. The kicks 
have also been reduced. 

notes. * You could make the 
case to keep the half note kick, 
but Harmonix chose not to. 

18 19
[intro]

E

M

H

X

Hard reduces the fill to 
8th notes. The disco beat 

Medium reduces the fill 
to quarter notes. The “8 

Easy keeps the quarter 
note fill from Medium. The 

188 BPM CHALLENGING TIER 

H M E

is charted as an “8 beat”. For 
details see the “Disco Beat to ‘8 
Beat’” topic on page 358.

beat” is reduced to quarter 
notes. Quarter note kicks are 
further reduced.

8 beat is reduced to a snare and 
kick beat. Note: The chorus (not 
shown) has a two-handed beat.

20 21
[verse_1]

134+ BPM

0
0 0

00 0 0 0 0 0 0 0 0 0 0

 Hi-hat0  Crash0  Crash0

0

0 0 0

00 0 0 0 00 0

0 0

0 00 0

0 0

*
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Author the rhythms of the actual drum performance.

 ▪ Adjust the gems to best fit the Rock Band kit.

 ▪ It is not always best to force note consistency.

 ▪ Pay attention to left and right hand sticking so that the 
player’s hands do not cross.

 ▪ Author flams as a single hit on two pads.

 ▪ Use drum mix events and CAT to flip ‘disco beats’.

 ▪ Consider authoring cymbal swells to a single lane (usually 
Green).

 ▪ Use drum roll lanes for rolls that are too fast for the stock 
Rock Band kit.

 ▪ Use CAT for drum animations.

DRUM AUTHORING



 ▪ Note consistency
 ▪ Lane consistency
 ▪ Motion

12
INTRO TO GUITAR, 
BASS, AND KEYS
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There are a few rules and concepts that 
guitar, bass, and keys share.

In this chapter we discuss some broad concepts and shared 
rules. They includes:

 ▪ Using gem colors for particular note pitches

 ▪ Preserving the flow and motion of gems 

 ▪ The gem focus for each difficulty

 ▪ Why you should quantize your authoring

 ▪ How to wrap gems for each difficulty

 ▪ The basic chord types for Rock Band

 ▪ How to author sustained notes and HOPOs

When there are differences between instruments you will see 
these icons:

 

383

Download links available from: 
rhythmgamingworld.com/customsbook

INTRO TO GUITAR, BASS, AND KEYSINTRO TO GUITAR, BASS, AND KEYS

Guitar, bass, and keys charts start 
with the expert difficulty:

 ▪ Author the precise rhythms of the 
guitar, bass, or keys performance 

 ▪ Adjust the notes to best fit each 
instrument

Simplify the Expert chart for each 
difficulty, one at a time.G

B

K

Guitar

Bass

Keys
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Notes should keep the same gem color 
where possible. 

NOTE AND CHORD 
CONSISTENCY 

PRESERVE MOTION
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Try to be consistent with notes 
and gem color. For example, if 
you use a red gem for an A note, 
try to use red gems for that A 
throughout the whole song.

You can see this in the Note 
Consistency graphic. The A note 
is repeated on the red gems. 

Make sure that your chart feels right to play. 

Here the author would try to 
keep that A note paired with a 
red gem for the rest of the song.

The same logic applies to 
chords. If you use Green and 
Yellow notes for an E chord, it 
should be used for that chord 
for the whole song.

Perfect consistency is not 
always possible, though. Most 
songs have more than the five 
notes and seven basic chords 
found in Rock Band. Try to be as 
consistent as you can.

CHORD CONSISTENCY

The motion and flow of gems 
that you author should make 
your song feel right to play.

You should preserve this flow 
of motion even if it means 
breaking note consistency.

For example, if our red A note 
is part of an ascending melodic 
line it is OK to move it to 
another gem color.

This will preserve the flow of 
the melody and capture the 
feeling of playing a higher note.

For chords you should make 
sure that the motion is correct. 
For example:

 ▪ A Red Blue chord is higher 
than a Green Yellow one

 ▪ A Yellow Orange chord is 
higher than a Red Blue one

NOTE CONSISTENCY

A A A A

PRESERVE MOTION

A
A

CHORD MOTION

E

E E

E

E

E
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Each gem color found in expert must be used 
at least once in the other difficulties. 

LANE CONSISTENCY AND 
GEM FOCUS FOR GUITAR 
AND BASS

To the right you can see the 
gem focus for guitar and bass:

 ▪ Expert and Hard focus 
equally on all five gem colors

 ▪ Medium focuses on four 
notes at a time (Green, Red, 
Yellow, and Blue)

 ▪ Easy focuses on three notes 
at a time (Green, Red, and 
Yellow)

If your song uses all five gem 
colors in Expert you should:

 ▪ Include at least one Orange 
gem in Medium, and

 ▪ Include at least one Orange 
and Blue gem in Easy

It is up to you where you add 
these notes.

Notice that playing these notes 
in Medium and Easy requires a 
hand position (gem focus) shift.

Note: Any gem color missing 
from Expert should not appear 
in any other difficulty.

Our game is very precise, but rock and roll is not.

QUANTIZED MIDI 
NOTES

387 INTRO TO GUITAR, BASS, AND KEYS 388

Musical performances are full of 
imperfections. 

We tend to notice the really 
obvious ones, like a guitar string 
breaking, or a wrong note.

But we don’t really notice the 
smaller imperfections. They are 
part of the performance and are 
often very intentional. 

There are plenty of songs where 
the point is to be chaotic, 
imprecise, and noisy. 

This is certainly the case with 
rock and roll music. 

So, how do we handle this in 
Rock Band?

The short answer is that we 
quantize MIDI notes to the grid.

GEM FOCUS FOR GUITAR AND BASS

X

H

M

E

Dotted lines indicate 
a hand position shift.

See page 511 for lane 
consistency for keys. 

This means that in our charts 
we remove imperfections from 
the performance. 

We do this for the sake of 
gameplay.

Sight-reading a Rock Band chart 
is a bit like reading sheet music. 

Both use a short-hand form of 
notation to communicate which 
notes to play, and when.

In Rock Band this is tied to a 
scrolling note highway with 
downbeats, beats, and eighth 
note divisions.

The actual performance will 
likely vary to some degree 
from these exact and precise 
divisions. 

Charting any imprecision found 
in the actual performance 
would not look good in-game. 

Charts would be much harder 
to sight-read and much less 
intuitive and enjoyable to play. 

So, it is preferable to chart even 
a chaotic part to the grid (for 
the sake of gameplay).

To quantize your MIDI leave the 
Snap to Grid feature on when 
drawing notes in REAPER:

Finally, choose an appropriate 
grid size to author to. 

Usually this is a 16th or 32nd 
note grid. Sometimes you may 
also need a triplet grid.

K
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When melodic lines have more than five notes 
we wrap gems into simple patterns. 

WRAPPING NOTES 

We often have more notes 
than we can fit in our range 
of five colored gems. And, on 
lower difficulties, this problem 
increases because we have 
fewer gems to work with.

Wrapping gems helps to solve 
this issue. 

The most common pattern that 
we use for wrapping is groups of 
three gems. You can see this in 
the Expert chart:

 ▪ Orange, Blue, Yellow

 ▪ Blue, Yellow, Red

 ▪ Yellow, Red, Green

If it fits with the audio you can 
use other patterns. For example 
a four note pattern:

 ▪ Orange, Blue, Yellow, Red

 ▪ Blue, Yellow, Red, Green

You can see examples of 
both options on the Hard and 
Medium difficulties. Choose the 
one that works the best.
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On Hard the gem-focus does 
not change. Instead, the 
wrapping has been adjusted to 
a lower 8th note density.

On Medium the gem-focus is 
four notes. The wrapping has 
been adjusted to quarter notes.

On Easy the gem-focus is three 
gems with half notes.

In conclusion, wrap your notes 
for each difficulty according to 
what feels best for each one. 

E

Best practice is to 
use CAT for an initial 
difficulty reduction.

Then manually adjust 
the note density 
and note wrapping 
according to the song.

X M

H
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There are five basic types of chords in Rock 
Band. Each chord type has its own feel.

391 INTRO TO GUITAR, BASS, AND KEYS 392

Three note chords are usually 
used for non-standard or “big” 
sounding chords:

 ▪ Augmented chords

 ▪ Seventh chords

 ▪ Diminished chords

You can also use them for 
normal chords with a second 
guitar playing a higher or 
dissonant note.

1 2 chords are commonly used 
to convey motion in long chord 
sequences. 

You can find example chords for 
guitar on the next page.

1 2 CHORDS

1 3 CHORDS 1 5 CHORDS

1 2 chords feel good for bar 
chords and power chords. They 
also work well for:

 ▪ Two note chords (dyads)

 ▪ Thirds

 ▪ Fourths

 ▪ Small sounding chords

1 3 chords make up the majority 
of “normal” chords used in  
Rock Band. They usually feel like 
power chords and bar chords. 

1 4 chords feel good for 
octaves. They also work well for 
suspended chords.

1 5 chords also feel good for 
octaves, but are expert only 
chords. Use them as sparingly 
as possible.

3 NOTE CHORDS1 4 CHORDS

CHORD MOTION

Note: There are other 
3 note chords that are 
for keys only.

See page 512 for 
more details.

K

CHORDS CHORDS 2
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Listen to the example chords if you don’t know 
what each type sounds like.

EXAMPLE CHORDS 
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BAR CHORD

F

C F
A

C F

THIRD (DYAD)

F
A

1

3

2

1

3

2

X X XX

KEY

F

X

1

String not played

Play open string

Note played

Fret number

It is not easy to describe what 
particular chords sound like. It 
is best to play them, or listen to 
them for yourself.

The example chords here are 
the main types discussed in 
the previous topic. The graphics  
show how to play each chord 
type on the guitar.

You can translate the chord 
structures to other instruments 
if you would like. Or, if you don’t 
have a suitable instrument, you 
can watch a YouTube video that 
illustrates this content:

youtu.be/65p_9NKKUDo

EBGDAE D G

POWER CHORD

F

C F

1

3

2

XXXDAE

A
D

1

3

2

XBGXXX

FOURTH (DYAD)

OCTAVE

F

F

1

3

2

XXXDXE

C F

G C 8

10

9

EBGDAX

SUSPENDED 2 CHORD

F

AUGMENTED

F
A C#

F 1

3

2

EBGDXX

DIMINISHED

F

G# F B 6

8

7

EBXDAX

SEVENTH

F
A

C 1

3

2

EBGDXX

E String name

Full sounding chord: 
1 2 or 1 3 chord

Smaller sounding chord: 
1 2 chord

Standard guitar chord for 
rock, metal, and punk: 
1 2 or 1 3 chord

Smaller sounding chord: 
1 2 chord

Open sounding chord: 
1 4 or 1 5 chord

The fifth (C) is raised a 
half step (C#): 
3 note chord

Added seventh note (E): 
3 note chord

The second (G) replaces 
the third (A): 
1 4 chord

The fifth (C) is lowered a 
half step (B): 
3 note chord

https://youtu.be/65p_9NKKUDo
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A sustained note is a note that is held for 
a period of time.

SUSTAINED NOTES 

Follow these rules for using 
sustained notes in Rock Band:

 ▪ Notes with no sustain 
should be no longer than a 
1/16th note

 ▪ No note should be shorter 
than a 1/64th note

In the example to the right the 
first chord is 2/16th notes long. 
It should not be sustained.
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CORRECTINCORRECT

There should be a gap between 
the end of a sustain and the 
start of the next note:

 ▪ The gap should be at least a 
1/32nd note gap

 ▪ A 1/16th note gap is standard

In this example the sustained 
chord is too long. It is touching 
the 16th note that follows it.

INCORRECT

Notes should not overlap:

 ▪ Guitar and bass notes 
should never overlap

If a note begins before the end 
of another note (or chord) it will 
not appear in-game.

Note: There are separate rules 
for sustains on keys. See pages 
513 — 514 for details.

CORRECTINCORRECT

You can author short sustains at 
slower tempos:

 ▪ At less than 100 BPM only 
author sustains for notes 
longer than an 8th note

 ▪ At more than 100 BPM only 
author sustains for notes 
longer than 3/16th notes

> 100 BPM< 100 BPM

1/16th note

G

B

CORRECT

1/16th note gap

SUSTAINED NOTES 2 
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In CAT sustain note length is set according to 
song tempo and instrument difficulty.

SUSTAINED NOTES AND 
SONG TEMPO 

We use CAT to automate many 
authoring tasks. One of these 
tasks is managing the length of 
sustain notes. 

CAT sets sustain note length 
based on:

 ▪ Song tempo, and

 ▪ Instrument difficulty

For example, a slow song will 
have a smaller sustain note gap 
than a faster song. 

The following functions in CAT 
set sustain note length for you:

 ▪ Automatic reduction (5-lane)

 ▪ Fix sustains

The graphics show how sustain 
note length and gaps vary with 
tempo and instrument difficulty.

SUSTAINED NOTES AND 
SONG TEMPO 2
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I recommend that you let CAT 
manage your sustain notes.

This will ensure that they are:

 ▪ Consistent

 ▪ Appropriate for different 
tempos

 ▪ Appropriate for each 
instrument difficulty

Note: In CAT the Automatic 
reductions (5-lane) function will 
ony adjust sustain note length 
for Hard, Medium, and Easy. To 
shorten Expert sustains use the 
Fix sustains function in CAT.

SUSTAIN NOTE GAP: 40 — 70 BPM

1/32nd

1/16th

1/8th

1/4th

EXPERT

HARD

MEDIUM

EASY

SUSTAIN NOTE GAP: 71 — 160 BPM

1/16th

1/16th

1/8th

1/4th

EXPERT

HARD

MEDIUM

EASY

SUSTAIN NOTE GAP: 161 — 300 BPM

1/8th

1/8th

3/16th

1/4th

EXPERT

HARD

MEDIUM

EASY

MINIMUM SUSTAIN NOTE LENGTH

5/16th

3/16th

1/8th

160 — 300 BPM

71 — 160 BPM

40 — 70 BPM

Turn to chapter 21 to 
learn how to use CAT.
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HOPOs are the smaller notes displayed on the 
guitar, bass and keys tracks. 

HOPOS: HAMMER-ONS AND 
PULL-OFFS 

Automatic HOPO notes are 
found in the Expert and Hard 
difficulties. They show quick 
changes between notes of 
different colors.  

Note: A quick change is a 
sixteenth note or faster.

Runs of notes of the same color 
are never HOPOs, no matter how 
fast they are played. 

You do not have to do anything 
special for HOPOs to appear in 
the game track. 

You can play guitar and bass HOPOs without 
strumming them.

HOPOS: 2
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You can see this in the 
“Automatic HOPO: 16th Note 
Pitch Bend” image on this page. 
The Blue and Orange notes 
are a sixteenth note apart. 
The Orange HOPO has been 
automatically generated.

You can find a longer example in 
the guitar part of “Landslide” by 
Fleetwood Mac.

The first Yellow gem of the song 
is not a HOPO. This is because 
it does not have any sixteenth 
notes that come before it. The 

fourteen 16th notes that follow 
it are all automatic HOPOs. 

The first Green gem of the 
second measure is also not a 
HOPO. This is because there is a 
sixteenth note gap between this 
Green gem and the Red gem 
before it.

On guitar, hammer-ons and 
pull-offs allow you to play many 
notes without picking each 
note. Several common guitar 
techniques use HOPOs:

 ▪ Trills

 ▪ Fast runs of notes, picking 
one note per string

 ▪ Using HOPOs with right hand 
tapping techniques

 ▪ Using HOPOs with the 
whammy (tremolo) bar

Expert HOPOs are authored on 
notes 101 F5 and 102 F#5:

Use these notes to force HOPOs 
on or off. 

Note: HOPO on / off notes 
should be the same duration as 
the notes or chords that they 
apply to. You can author Hard 
difficulty HOPOs on guitar and 
bass (but not keys).

Guitarists sometimes play 
notes or chords that are not 
strummed. If there is enough 
space around this note a HOPO 
is not generated. In this case we 
force a HOPO on for that note 
or chord. We do this for musical 
feel and do so sparingly. You can 
see an example of this in the 
chart and preview below. 

The yellow HOPO gem is a 
forced HOPO. The Orange HOPO 
is automatically generated.

AUTOMATIC 
HOPOS

Automatic HOPO: 16th Note 
Pitch Bend 

“LANDSLIDE” BY FLEETWOOD MAC

H

H

H

H

H

H

H

H

H

H

H

H

H

H

H

H

GUITAR HOPO 
TECHNIQUES

Automatic HOPO notes with the letter “H” under them.

“BEAST AND THE HARLOT” BY AVENGED SEVENFOLD

H

H

Forced Yellow HOPO: “Beast 
and the Harlot”

AUTHORING 
HOPOS

Forced HOPO

 
 
Force HOPO Off 
Force HOPO On
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
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You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Author the rhythms performed for each instrument. 

 ▪ Adjust the gems to fit each instrument.

 ▪ Keep pitches and gem color consistent where possible.

 ▪ Preserve the flow and motion of gems (even if it means 
breaking note consistency).

 ▪ Use five lanes for Expert and Hard. Use four lanes for 
Medium and three for Easy.

 ▪ Use the gem colors authored in expert at least once in the 
other difficulties.

 ▪ Quantize all notes for the sake of gameplay.

 ▪ There are five basic chord types in Rock Band. Each has its 
own unique feel.

 ▪ Leave a 1/6th note gap between the end of a sustain note 
and the start of the next note.

 ▪ Any note longer than 1/16th note is a sustain note.

 ▪ Automatic HOPOs are fast consecutive notes that are  
different colors (16th notes or faster).

INTRO TO GUITAR, BASS, AND KEYS



 ▪ Expert, Hard, Medium, and Easy
 ▪ Guitar animations
 ▪ Common authoring mistakes

GUITAR AND 
BASS

13
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In the previous chapter we reviewed the 
shared concepts for guitar, bass, and keys. 
In this chapter we take a closer look at 
how to author guitar and bass.

The main topics for this chapter follow the official Rock Band 
Network documentation:

 ▪ Rules for authoring Expert, Hard, Medium, and Easy

 ▪ Adding Orange gems to Medium

 ▪ Common authoring mistakes

 ▪ Authoring trill and strum markers

 ▪ Character animation

 ▪ Left and right-hand animation

Extra content is also provided:

 ▪ 1 4 power chords in Rock and Metal

 ▪ Chord change HOPOs

 ▪ Hard difficulty example reductions

Download links available from: 
rhythmgamingworld.com/customsbook

405 406GUITAR AND BASS
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Listen to the guitar part and review the 
PART GUITAR/BASS templates before you 
start to author.

GETTING STARTED WITH 
EXPERT GUITAR AND BASS 

407 GUITAR AND BASS 408

The gem layout for basic 5-Lane 
guitar is as follows:

Expert can use all five gems.

BASIC GUITAR / 
BASS LAYOUT

High notes

Low notes

In this chapter we cover guitar 
and bass:

 ▪ Author guitar on the PART 
GUITAR track 

 ▪ Author bass guitar on the 
PART BASS track 

 ▪ Expert gems are MIDI notes 
96 (C6) to 100 (E6)

You can see Expert MIDI notes 
in the graphic to the right. 

Author guitar and bass as 
follows:

 ▪ Start with Expert and 
rhythmically chart the actual 
guitar performance

 ▪ Adjust the notes to best fit 
the five basic gems

Note: When we talk about guitar 
assume that we are also talking 
about bass. The differences 
between the two instruments 
are minor. 

EXPERT  
OVERVIEW

EXPERT GUITAR / 
BASS TEMPLATE 

 
 
Trill Marker 
--- 
BRE 
BRE 
BRE 
BRE 
BRE 
--- 
Overdrive 
--- 
Solo Marker 
Force HOPO Off 
Force HOPO On 
 
Expert Orange 
Expert Blue 
Expert Yellow 
Expert Red 
Expert Green 
 

PART GUITAR

To change the PART 
GUITAR template to 
Rock Band colors see 
pages 121 — 122.

To add a percussive 
sound to your gems 
see page 293.

In Chapter 14 we talked about 
the shared rules for guitar, bass, 
and keys. This included:

 ▪ Note Consistency 
When to tie notes and gem 
colors together

 ▪ Chord Consistency 
Consistent use and motion 
of chords

 ▪ Preserving Motion 
The flow and motion of 
gems. How the song feels 
to play

 ▪ Lane Consistency 
The lane focus for each 
difficulty. This includes gem 
consistency between each 
difficulty

 ▪ Quantized MIDI Notes 
Chart notes to the MIDI grid. 
This removes imperfections 
found in the original 
performance

 ▪ Wrapping Notes 
Author melodic lines into 
patterns that fit in a five 
gem range

 ▪ Chords 
The five basic chord types 
and their “feel”

 ▪ Sustained Notes 
The rules for authoring held 
notes

 ▪ HOPOs 
Automatic HOPOs and how 
to turn HOPOs on and off

You should review these topics 
before you start to author your 
guitar chart.

This chapter contains additional 
information that is specific to 
guitar and bass.

REVIEW THE “INTRO TO GUITAR, BASS, 
AND KEYS” CHAPTER

bass. This is because bassists 
often change register in 
different sections of a song.

For example, they may drop 
down an octave in the chorus. 
Or they may slide up an octave 
in the bridge. 

The solution is to:

 ▪ Author each section 
separately

 ▪ Use the pattern that feels 
best for each part

 ▪ Maintain consistency in each 
section as much as possible

BASS GUITAR 
AUTHORING

Rules that apply only 
to bass are highlighted 
with this icon.

B

BConsistency can be hard 
to achieve when authoring 
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Some three note chords are not allowed on 
guitar and bass.

CHORDS 

A brief refresher on the rules for sustains.

SUSTAINS

409 GUITAR AND BASS 410

You can use all the 
chord types shown 
below for guitar, bass, 
or keys.

KEYS ONLY

GUITAR, BASS, AND KEYS CHORDS

The two graphics on the right 
show all the chords allowed on 
guitar and bass.

To review these chords in more 
detail see pages 391 — 392.

ALLOWED 
CHORDS

Three note chords that include 
Green and Orange gems are not 
allowed on guitar and bass.

PROHIBITED 
CHORDS

Short sustains (3/16th notes) 
are allowed below 100 BPM:

Short sustain are not allowed 
above 100 BPM:

Let’s quickly review the 
standards for sustain notes:

The standard gap between the 
end of a sustain and the next 
note is:

 ▪ A 16th note gap on Expert 
and Hard * 
 
* A 32nd note gap is also 
allowed on Expert, but this 
is not standard

 ▪ A quarter note gap for 
Medium and Easy

I recommend that you:

 ▪ Use CAT to reduce your 
guitar / bass charts, or

 ▪ Use the Fix sustains 
function in CAT

 ▪ On guitar and bass notes are 
not allowed to overlap

 ▪ Any note longer than a 1\16th 
note is a sustain note

 ▪ No note should be shorter 
than a 1/64th note

A visual guide for 
sustain note rules for 
guitar, bass, and keys is 
on pages 395 — 398.

< 100 BPM

> 100 BPM

SUSTAIN NOTE 
GAP REVIEW

SHORT SUSTAIN 
NOTE REVIEW

OTHER SUSTAIN 
NOTE RULES
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Tips and tricks for authoring Expert guitar 
and bass.

EXPERT 

Author pick-up notes between chords.
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If you are using separated audio 
or stems:

 ▪ Solo and listen to the guitar 
part all the way through 
before authoring

 ▪ Pay attention to changes 
between sections, chords, 
and melodic lines

This will give you a sense of 
the structure of the song. With 
this, there should be less need 
to make big changes to your 
authoring as you progress.

SOLO THE GUITAR 
TRACK

Start by authoring the main riff 
or chord progression:

 ▪ Build the rest of your 
authoring around that 
central element

Knowing how you want the most 
important part to feel will help 
inform you on how to author the 
rest of the song.

THE MAIN RIFF OR 
PROGRESSION

REPETITION IN 
SONGS
Some songs may contain a lot 
of repetition. In this case it can 
often be faster to:

 ▪ Author the repeating section 
for all difficulties, then

 ▪ Copy and paste the section 
through the rest of the song

LISTEN TO THE 
FULL MIX
If you do not have stems or 
separated audio:

 ▪ Listen to the full mix, turned 
down

This will help you focus on the 
rhythm and musical context of 
the part that you are authoring.

NO OVERLAPPING 
NOTES
Make sure that there are no 
overlapping notes:

 ▪ Notes in chords should begin 
and end at the same time

 ▪ Single notes and chords 
must end before the next 
note or chord begins

Note: The transparent notes 
shown below should be 
removed.

PICK-UP NOTES BETWEEN CHORDS

You should not try to make your 
Expert chart harder than the 
actual guitar performance. 

Charts can be extremely 
difficult if that is what the 
actual guitar part calls for.

Check out the songs below for 
some examples: 

 ▪ “Thrasher” by Evile  
16th notes at 208 BPM

 ▪ “Caprici Di Diablo” by Yngwie 
Malmsteen  
16th note triplets at 166 BPM

 ▪ “Bodhisattva” by Steely Dan  
16th notes / fast chord 
changes at up to 220+ BPM

MIDI CHART VS 
GUITAR PART

CORRECTINCORRECT

When guitarists strum chords 
there is often a “pick up” sound 
between chords. This is usually 
an 8th or 16th note.

Try to author pick-ups as single 
note(s):

 ▪ The “pick-up” should be the 
lowest note of the chord 
that you are moving to

Pick-up notes make it easier 
for the player to get to the 
new chord. They give the part 
a more musical feel, as there 
is movement between chords 
when playing an actual guitar.

For example, see how Harmonix 
charted “How You Remind Me” 
by Nickelback (below).

NO OVERLAPS
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EXPERT (CONTINUED) EXPERT TRICKS AND TIPS 
CONTINUED 4
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AUTHORING PITCH 
BENDS
Pitch bends in melodic lines and 
solos are authored as follows:

 ▪ Add a 16th note at the start 
of the note, one gem lower 
than the target gem

PITCH BENDS

MUTED GUITAR 
CHORDS
Guitar players often mute single 
notes or chords. They do this by 
resting their strumming hand on 
the strings while playing.

To translate this to Rock Band 
we author muted chords as 
single notes. This highlights the 
contrast between chords that 
ring out and muted notes.

For example an E chord might 
be authored on Green and Red. 
If the same chord is muted then 

“SOUTH OF HEAVEN” BY SLAYER

it is only authored on Green.  
(The red notes of the muted E 
chord are not authored):

 
 
 
 
 
The [preverse] riff of “South of 
Heaven” (below) mixes chords 
with muted single notes.

Palm muted single notes on the open E string.

AMBIENT GUITAR 
NOISE
There is a lot of ambient guitar 
noise in rock music. This 
noise is not usually caused by 
strumming but by:

 ▪ Feedback

 ▪ Delay 

 ▪ Other guitar FX

“LAZY EYE” BY THE SILVERSUN PICKUPS

Guitar noises like this often 
have little obvious rhythm. 
The best way to author these 
sounds is with a stream of 
sixteenth notes. This is a lot 
more satisfying then playing 
long sustain notes. 

“Lazy Eye” by the Silversun 
Pickups is a good example.

AUTHORING 
TRILLS
Author trills as alternating notes 
that are next to each other.

Use 16th notes (or other notes if 
they match the rhythm better).

Trills usually drift away in time 
from the grid, but this method 
feels the best to play.

16TH NOTE TRILLS

MutedUn-muted
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Hard should be the “reasonable” version of 
Expert. Expert players should be able to score 
100% on Hard with minimal practise.

HARD 
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Author Hard gems on notes 84 
(C5) to 88 (E5):

 
Hard can use all five gems.

Reduce your Expert chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction (5-Lane) button

 ▪ Uncheck Medium and Easy

 ▪ Under Options make sure 
that the instrument is set to 
Guitar or Bass

 ▪ Click the Reduce button

HARD GUITAR 
OVERVIEW

 
 
Hard Orange 
Hard Blue 
Hard Yellow 
Hard Red 
Hard Green

PART GUITAR

H

REMOVE SUBTLE 
VARIATIONS

CHORDS AND 
FAST CHANGES
Keep all chords from Expert 
unless it does not make sense 
to do so. For example, when:

 ▪ Chords represent 
harmonizing guitar parts or 
strong harmonics

Note: Fast chords / chord bends 
can be difficult for Hard players.  

Start note reduction for Hard by 
removing subtle variations. This 
will make parts that are more 
consistent to play:

 ▪ Start by removing motion 
or strumming that is a 16th 
note or faster *

 ▪ Adjust note wrapping for 
Hard. See page 421.

H

X

H

FAST BENDS

For example,  “And Justice For 
All” by Metallica (178 BPM). 
See “Fast Chords” graphic. Or, 
“Surfing With The Alien” by Joe 
Satriani (168 BPM). See “Fast 
Bends” graphic. 

In other cases Harmonix has 
reduced Expert chords to single 
notes in Hard. For example, the 
[intro] to “And Justice For All”.

XX

FAST CHORDS

H

NO GREEN / 
ORANGE CHORDS
Green / Orange chords are not 
allowed in Hard. 1 4 chords can 
be a good replacement.

For example, “Blood And 
Thunder” by Mastadon (below). 
In this case the Green / Orange 
chord is reduced to a 1 2 chord.

NO THREE NOTE 
CHORDS
Three note chords are not 
allowed in Hard. 1 4 chords can 
be a good replacement. 

For example, “Closer To The 
Heart” by Rush (below).

X

H

X

H

NO 3 NOTE CHORDS NO 1 5 CHORDS

* Note: This is based on the 
tempo of the song.
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HARD (CONTINUED) 
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SUSTAIN NOTE 
LENGTH
Durations in Hard should be the 
same as in Expert. *

* Unless the sustains are 
visually too short. In this case 
they should be changed to 
sixteenth notes.

H

X

CHORD TO CHORD 
HOPOS
In Rock Band, fast movement 
between chords is represented 
with HOPOs. 

On Hard, chord to chord HOPOs 
are reduced to:

 ▪ Single note to chord HOPOs

H

X

H

X

H H H

H
H

H
H

8TH NOTE PICK 
UP CHORD
There are situations where 
Expert chords can be reduced 
to single notes in Hard.

For example, an 8th note pick 
up chord before a series of 
chords can be reduced to a 
single gem.

A pick up chord is a chord that 
is played before or during a 
series of strummed chords. 

To change chords the guitarist 
will change one, or both, of the 
following:

 ▪ Left hand chord fingering

 ▪ Left hand position up or 
down the fretboard

This often produces a 
transitional “pick up” sound 
between the first and second 
chords.

Reducing a pick up chord to a 
single gem helps to:

 ▪ Make fast tempo songs 
easier to play

 ▪ Make hand position changes 
easier to manage

H

H
H

GREEN TO 
ORANGE JUMPS
Try to avoid quick Green to 
Orange jumps on Hard.

For example, in “Tornado of 
Souls” (below) the Orange to 
Green jump is removed. The 
tempo is 180+ BPM. 

On fast songs consider changing 
8th note Green to Orange jumps 
to Green / Blue.

H

X

SUSTAIN LENGTH CHORD HOPOS CHORD HOPOS 8TH NOTE PICK UP FAST JUMPS

H

X

HOPO notes and 
chords have the letter 
“H” underneath them.
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Some additional tips and tricks for authoring 
Hard guitar.

HARD TIPS AND TRICKS 
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If the strong beats of a song are 
upbeats, or syncopated, do not 
remove them in haste.

Removing every other 16th note 
is not always the best way to 
reduce notes.

It is better to leave more space 
between syncopated notes than 
to leave them out.

KEEP THE 
RHYTHMIC FEEL 

H

X

“HEART OF GLASS” 

When you reduce notes do not 
extend any of the remaining 
notes to fill space.

Note reduction gives the player 
extra time to prepare for the 
notes to come. 

This extra space is just as 
important as the notes played.

DO NOT EXTEND 
REDUCED NOTES

DO NOT EXTEND NOTES

E

H

Do not extend 
reduced notes.

CONTINUOUS 8TH 
NOTES
For continuous 8th notes the 
official docs recommend:

 ▪ At 160+ BPM, remove every 
fourth 8th note per half 
measure 

For example, “Walk of Life” 
by Dire Straits (170 BPM). In 
practice Harmonix does this:

H

H

“WALK OF LIFE” 

 ▪ Remove the last 8th note 
per measure

For example, “Hanging on the 
Telephone” by Blondie. If the 
8th notes are very fast and 
have motion, then try to keep 
the motion notes for Hard. For 
example, “Caught in a Mosh”.

REDUCING 16TH 
NOTE TRIPLETS
There are two ways to reduce 
16th note triplets for Hard:

 ▪ Remove the second note of 
each triplet (method A)

 ▪ Remove the third note of 
each triplet (method B)

H

X

METHOD A

Choose the method that feels 
the best to play. Both methods: 

 ▪ Preserve the syncopated 
groove of the triplet

 ▪ Make the part easier to play

H

X

METHOD B

“HANGING ON THE TELEPHONE”
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After removing 16th notes in Hard remember to 
adjust your note wrapping.

HARD TIPS AND TRICKS 
(CONTINUED) 

MEDIUM
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As you can see the Hard 
reduction does not preserve the 
motion of the Expert chart.

The “Correct Wrapping” graphic 
shows the correct way to 
reduce and wrap notes.  

H

X

CORRECT WRAPPING

You may have to wrap notes for 
each difficulty after notes have 
been removed.

For example, below is a 
descending line of 16th notes 
that have been reduced to 8th 
notes for Hard.

H

X

INCORRECT

WRAPPING NOTES 
ON HARD

This Hard chart has an 8th note 
spacing with wrapping that 
preserves motion.

As you can see, more space 
between notes allows for more 
linear motion.

Try to keep the rhythmic and melodic feel of 
Expert and Hard but in a way that is much 
easier to play.

Author Medium gems on notes 
72 (C4) to 75 (D#4):

Medium focus is on the Green 
 to Blue gems.

Reduce your Hard chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction (5-Lane) button

 ▪ Uncheck Hard and Easy

 ▪ Under Options make sure 
that the instrument is set to 
Guitar or Bass

 ▪ Click the Reduce button

MEDIUM GUITAR 
OVERVIEW

 
 
Medium Orange 
Medium Blue 
Medium Yellow 
Medium Red 
Medium Green

PART GUITAR

REMOVE 8TH 
NOTES
Removing the remaining 8th 
notes from Medium is a good 
way to reduce from Hard:

 ▪ Try to only have playable 
notes on strong quarter note 
beats

Note: You can keep some 
8th notes in Medium. But 

M

the context, song BPM, and 
instrument tier are key factors 
in this decision.

You can see examples of strong 
quarter note beats and some 
off beat notes below. The song 
in both of these examples is 
“Roundabout” by Yes.

132 BPM IMPOSSIBLE 

M

H

135 BPM IMPOSSIBLE 

H

M



GUITAR AND BASS

Keep chords from Hard and avoid fast chord 
changes.

MEDIUM (CONTINUED)

Three note chords, 1 4 chords, and 1 5 chords 
are not allowed on Medium.
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Keep all chords from Hard 
unless it does not make sense 
to do so. For example, if:

 ▪ Chords represent 
harmonizing guitar parts or 
strong harmonics

KEEP CHORDS 
FROM HARD

NO THREE NOTE 
CHORDS

AVOID FAST 
CHORD CHANGES
Try to avoid fast chord changes. 

There are a couple of ways to 
do this. For example, you can 
change fast chords into single 
notes. For example,  “And 
Justice For All” by Metallica. The 
tempo is about 98 BPM. 

Three note chords are not 
allowed on Medium.

For example, “Barracuda” by 
Heart (below):

M

H

KEEP CHORDS

M

X

NO 3 NOTE CHORDS

M

H

“AND JUSTICE FOR ALL”

If you keep chords take the 
musical context and instrument 
tier into account. 

In “Walk” by Pantera the Expert 
chords have a Green root note 
between them. These notes 
were removed in Hard. The 
chords are further reduced for 
Medium. The BPM is 125. 

M

H

“WALK” BY PANTERA

NO GREEN / 
ORANGE CHORDS
Green / Orange chords are not 
allowed in Medium.

Reduce 1 5 chords from Hard to 
1 2 or 1 3 chords for Medium.

For example, “Barracuda” by 
Heart (below):

NO 1 4 CHORDS

Green / Blue and Red / Orange 
chords are not allowed in 
Medium.

Reduce 1 4 chords from Hard to 
1 2 or 1 3 chords for Medium.

For example, “Rainbow in the 
Dark” by Dio (below):

H

M M

NO 1 4 CHORDS NO 1 5 CHORDS

X
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Sustain notes should be shorter in Medium. 
Avoid quick jumps from low to high notes.

MEDIUM (CONTINUED) MEDIUM TIPS AND 
TRICKS
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SUSTAIN NOTE 
DURATION

Reduce sustains with a 3/16 
note duration to 16th notes. You 
can see an example of this in 
“Foolin’” by Def Leppard. See 
the “Sustain Duration” graphic.

Note: If you manually shorten 
sustains look out for note tails 
that are too short. 

Change any sustain that looks 
too short in-game to a standard 
16th note.

Note: Pre-RBN songs have an 
8th note gap between sustains. 
For example, “Smoke on the 
Water” by Deep Purple.

 

Sustains should be shorter in 
Medium to give the player more 
time between notes:

 ▪ Try to leave a quarter note 
between the end of a note 
and the start of the next

 ▪ Use the Fix sustains script in 
CAT to correct sustain notes 

M

H

SUSTAIN DURATION

AVOID QUICK 
JUMPS
Try to avoid quick jumps 
between low and high notes:

 ▪ Green to Blue or Orange

 ▪ Red to Orange

For example, “Caprici di Diablo” 
by Yngwie Malmsteen. Tempo is 
156 — 171 BPM. Impossible tier.

M

AVOID QUICK JUMPS

H

If the strong beats of a song are 
upbeats, or syncopated, do not 
remove them in haste.

Removing every other 8th note 
is not always the best way to 
reduce notes.

It is better to leave more space 
between syncopated notes than 
to leave them out.

KEEP THE 
RHYTHMIC FEEL 

M

H

“HEART OF GLASS” 

When reducing triplets in 
Medium:

 ▪ Keep only the downbeat of 
each triplet

You can see this in the two 
methods below:

Note: Both 16th note triplet 
patterns in Hard produce an 8th 
note pattern in Medium.

M

H

TRIPLET METHOD A

REDUCING TRIPLETS FOR MEDIUM 
DIFFICULTY

M

H

TRIPLET METHOD B

“SMOKE ON THE WATER”
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Medium notes and chords need to be wrapped 
to four lanes at a time.

MEDIUM TIPS AND TRICKS 
(CONTINUED) 
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WRAPPING NOTES 
FOR MEDIUM
After you have reduced your 
Medium chart you may need to 
adjust your note wrapping.

In the example below, removing 
every other 8th note from Hard 
leaves these 1/4 note gems:

M

H

NOTE WRAPPING

 ▪ Orange, Yellow, Blue, and 
Red

These gems do not reflect the 
motion of the part. So, in this 
situation we adjust the gems 
to Blue, Yellow, Red, and Green. 

WRAPPING 
CHORDS 
Medium is restricted to four 
lanes at a time. So, if Expert 
uses all five lanes for chords 
you will need reduce them to 
four lanes.

The default chords for Medium 
are in the graphic to the right.

M

H

CHORD WRAPPING

For songs that do not have 
many chords try the following:

 ▪ Move every chord in the 
song down one position

For example, a Yellow / Blue 
chord would become a Red / 
Blue chord. 

This may allow you to adjust 
your chords for Medium without 
much extra work.

In songs with a lot of chords 
you may not be able to use a 
unique pair of gems for each 
chord. In this case you can re-
use chords in different sections 
of the song.

For example, you could use 
Green / Yellow gems for one 
chord in the verse and for a 
different chord in the chorus.

Note: You can use Yellow / 
Orange and Blue / Orange 
chords when adding Orange 
gems to Medium.

MEDIUM CHORDS

M

Note: You may not be able to 
wrap notes visually based on 
the pattern of the Hard gems.

For example, in Hard, is a jump 
from Red to Blue:

 ▪ A jump from a lower note to 
a higher pitched note, or

 ▪ A descending note that has 
been wrapped to Blue

This should be clear from 
listening to the song.

Always make sure that 
when you wrap notes 
they feel right for the 
part authored.

MEDIUM TIPS AND TRICKS 
(CONTINUED) 2
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Medium guitar players find it difficult to shift 
their hand position from the first four buttons. 
So, add appropriate Orange gems with care.

ADDING ORANGE GEMS 
TO MEDIUM

MEDIUM ORANGE 
GEMS REFERENCE
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Medium difficulty uses the first 
four gem colors:

But, you should add at least one 
Orange gem to Medium if there 
is an Orange gem in Expert. This 
requires the player to shift their 
hand position and changes the 
gem focus:

We need to make sure that 
Medium players have enough 
time to manage this transition.

Use the priority list to the 
right to add Orange gem(s) to 
Medium. Restrict your note 
patterns to four lanes at a time. 

Note: Lane consistency is also 
discussed on page 387.

Add a single Orange gem in 
a unique section of the song. 
For example:

 ▪ A guitar or bass slide

 ▪ The bridge of the song

 ▪ The intro or outro section

 ▪ During a guitar or bass solo

 ▪ The big final note of a solo 
or outro

 ▪ Some other event that only 
happens once in the song 

Add Orange gem(s) to a 
section that does not repeat 
often:

 ▪ If possible try to translate 
a riff (or section) to the top 
four gems on the guitar

This will prevent the player 
from shifting hand position 
too much.

1

2

When parts of a song repeat 
they sometimes have small 
changes:

 ▪ Add an Orange gem to a 
repeating part that has a 
small change in it 

 

If there is no other way to 
find a unique part for an 
Orange gem:

 ▪ Choose a random part of the 
song to alter

3

4

OVERVIEW ORANGE GEM PRIORITY LIST

This page shows how Orange gems were added 
to Medium in the Rock Band 3 setlist. Items of 
interest are highlighted in bold.

The following guitar solos have 
up to four Orange notes:

“25 or 6 to 4”, “Been Caught 
Stealing”, “Bohemian Rhapsody”,    
“Centerfold”, “China Grove”, 
“Crazy Train”,  “Dead End 
Friends”, “Everybody Want to 
Rule the World”, “Foolin”, “Here I 
Go Again”, “I Love Rock N’ Roll”,  
”I Need to Know”, “In the 
Meantime”, “The Killing Moon” 
“King George”, “Llama”, “Me 
Enamora”, “Misery Business“ 
“No One Knows”, “The Power 
of Love”, “Radar Love” (Expert 
chords to single notes),  
“Sister Christian”, “Space 
Oddity”, “Werewolves of 
London”.

These solos have 5 or more 
Orange notes:

“Caught in a Mosh”, “Cold as 
Ice”: (8th notes), “Free Bird”: 
(50+ total) (30+ 8th notes) 
“I Wanna be Sedated“: (10+) 
“Smoke on the Water”.

GUITAR SOLOS UNIQUE PARTS

These songs have unique 
measure(s) with Orange notes:

“20th Century Boy”, “Antibodies”, 
“Beast and the Harlot”, “Before 
I Forget”, “Break on Through 
(To the Other Side)”, “Combat 
Baby” (x2), “The Con” (Green /
Orange chord to Orange gem), 
“Crosstown Traffic” (Chord 
bends to Oranges gems), “Don’t 
Stand So Close to Me”, “False 
Alarm”, “Get Free”, “Get Up, 
Stand Up”, “Heart of Glass” 
(x2), “Hey Man, Nice Shot”, 
“Humanoid”, “I Got You (I Feel 
Good)”, “Jerry Was a Racecar 
Driver”, “Just Like Heaven” (3 
note chords to Orange gems), 
“Killing Lonliness”, “Lasso”, 
“Living in America”, “Low 
Rider”, “Plush” (3 note chord 
to Orange gem), “Oh My God”, 
“Portions for Foxes” (Chords to 
Orange gem), “Rock Lobster”, 
“Roundabout” (Green to Orange 
jump), “Saturday Night’s Alright 
for Fighting” (3 note chords to 
Orange gems, Green / Red chord 
to Orange gem jump), “Stop Me 
If You Think You’ve Heard This 
One Before”, “Walk of Life”.

REPEAT PARTS

These songs have parts that are 
repeated two or more times:

“Don’t Bury Me ... I’m Still Not 
Dead” (x2), “Du Hast” (x7), “Fly 
Like an Eagle” (x3) and Green 
to Orange jump (x2), “Good 
Vibrations” (x4), “The Hardest 
Button to Button” (x3), “I Can 
See for Miles” (x4 Yellow / 
Orange chord), “Last Dance” 
(x4), “The Look” (x2), “Midlife 
Crisis” (x2), “Misery Business” 
(x2), “Need You Tonight” (x2), 
“Oye Mi Amor” (x2), “Rehab” 
(x6 Blue / Orange chords), 
“Something Bigger, Something 
Better” (x4), “This Bastard’s Life” 
(x2), “Viva la Resistance” (x2).

Note: Many songs in 
the setlist have a single 
Orange gem.

The reduction changes 
highlighted are from 
Expert to Medium.



Let’s look at how Harmonix added Orange 
gems to some Medium guitar parts.

MEDIUM ORANGE GEM 
EXAMPLES 

“Heart of Glass” by Blondie has 
two unique measures. The first 
measure is a pattern of rising 
8th notes (see “Heart of Glass” 
1). The second is four rising 
off-beat chords (see “Heart of 
Glass” 2).

Harmonix choose the first 
pattern to add an Orange note 
to Medium. The pattern is first 
reduced to quarter notes. The 
gems are then wrapped to 
follow the rising melody (see 
“Heart of Glass” 3).

The hand position shift requires 
the little finger to move from 
Blue to Orange. 

The player’s hand position then 
returns to normal with the next 
Green gem.

This is easier for the player  
than playing off beat chords.

The song tempo is 116 BPM.
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“Been Caught Stealing” has a 
single Orange note during a 
guitar solo. This is a common 
way to add an Orange gem for 
many Rock Band songs. Here 
there is at least a quarter note 
gap to change hand position. 
The tempo is 104 BPM.

 
“Du Hast” has a unique measure 
that repeats during each chorus. 
It repeats seven times in total. 
There is a quarter note gap 
between the Yellow / Orange 
chord and the preceding Red 
gem. The tempo is moderate at 
around 125 BPM

“Walking on the Sun” by Smash 
Mouth has a unique high 
pitched chord at the end of the 
song. There is a dotted quarter 
note gap between the Blue / 
Orange chord and the preceding 
Yellow gem. The tempo is 
moderate at 125 BPM. This is a 
perfect opportunity to add an 
Orange gem.

GUITAR AND BASS

X

X

“HEART OF GLASS” 1

“HEART OF GLASS” 2

M

“HEART OF GLASS” 3

M

“BEEN CAUGHT STEALING”

M

“WALKING ON THE SUN”

“DU HAST”

M
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Easy should be easy to play.

EASY 
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EASY GUITAR 
OVERVIEW

EASY SHOULD BE 
EASY
Easy should not be difficult to 
play. The Easy player should be 
able to:

 ▪ Look at the game track

 ▪ See the note

 ▪ Look at their guitar

 ▪ Play the note

 ▪ Look for the next note

That is a lot to do between 
notes, so leave a good amount 
of space between them.

If Easy is not challenging enough 
the player will just move up to 
Medium difficulty.

Remove the remaining quarter 
notes where possible.

It is good practise to leave a 
half note space between notes 
for Easy players.

E

M

HALF NOTES

REMOVE QUARTER 
NOTES

Reduce chords to single notes 
on Easy.

See “Subdivisions” by Rush as 
an example (below).

E

M

NO CHORDS

NO CHORDS ON 
EASY

Sustained notes on Easy should 
be the same as they are on 
Medium. They should have a 
quarter note gap. 

E

M

SUSTAINED NOTES

SUSTAINED 
NOTES

Author Easy gems on notes 60 
(C3) to 62 (D3):

Easy focus is on the Green  to 
Yellow gems.

Reduce your Medium chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction (5-Lane) button

 ▪ Uncheck Hard and Medium

 ▪ Under Options make sure 
that the instrument is set to 
Guitar or Bass

 ▪ Click the Reduce button

 
 
Easy Orange 
Easy Blue 
Easy Yellow 
Easy Red 
Easy Green

PART GUITAR

E

Easy players find it difficult to 
shift their hand position from 
the first three buttons. 

Take care to add appropriate 
Blue and Orange gems. 

Use the same priorities as with 
Medium (page 429). Restrict 
notes to three lanes at a time:

 ▪ Green, Red, Yellow, or

 ▪ Yellow, Blue, Orange

WRAPPING NOTES 
ON EASY

ORANGE AND 
BLUE GEMS

Make sure that Easy notes are 
wrapped correctly.  

Use “Wrapping Notes for 
Medium” as your guide. Adjust 
your focus to three lanes at a 
time and half notes instead of 
quarter notes. (See pages 427 
— 428 for Medium wrapping).



Range shift indicators last for 
four beats on the note highway. 
For songs written in 4/4 they 
will last one measure:

 

 
Arrows point to the left or 
the right, indicating the hand 
position shift up, or down, the 
fretboard. 

The thin gold bar indicates the 
start, and scope, of the range 
shift. In the above example, the 
scope (or length) of the gold bar 
is four notes (green, red, yellow, 
and blue). 

Range shift regions highlight 
the active fret buttons in 
each range. Notes outside 

of the current range are not 
illuminated. For example:

 
A Medium shift to orange notes 
is pictured below:

 
 
 
 
Note: The number of arrows 
displayed in a range shift is set, 
and cannot be changed. 
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YARG range shift indicators are for Easy and 
Medium guitar and bass players on YARG. 

YARG RANGE SHIFT 
INDICATORS (OPTIONAL) 

Range shift markers are visual 
indicators on the YARG note 
highway for guitar and bass. 
They show players their starting 
hand position and let players 
know when to shift their hand 
position up or down. This allows 
players to prepare for hand 
shifts, so that there are no 
surprise orange notes. 

The No Range Shift feature uses 
range shift markers to condense 
four or five note charts down to 
a smaller range of notes. Three 
notes for Easy and four notes 
for Medium. 

The lower difficulties typically use only two 
range shifts each.

YARG RANGE SHIFT SYNTAX
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OVERVIEW VISUAL ELEMENTS

Range shift indicator arrows 
and gold bar (Medium)

Use Magma v4.0.3 or 
later to compile YARG 
range shifts in Rock 
Band custom songs.

Range shift indicators 
currently require 
nightly build b2973 or 
later of YARG.

SYNTAX

Active fret buttons - Medium 
- Finger position 1 (GRYB)

Active fret buttons - Medium 
- Finger position 2 (RYBO)

Medium range shift to finger 
position 2 (RYBO)

YARG range shift markers are 
placed as text events in REAPER:

[ld_range_shift diff 
position size]

The parameters are defined in 
Table 1 (to the right).

If a size is not provided, the 
default size is 3 for diff 0 (Easy) 
and 4 for diff 1 (Medium).

We can take advantage of this 
feature and use short notation 
that does not include the size 
variable. Typical short form 
notation is listed in Table 2. 

Note: The typical notation does 
not include the Easy shift to RYB 
(highlighted in blue). This shift 
can work well for key changes 
where you want the player to 
continue to use their first three 
fingers. It may also work for 
songs with only GRYB gems. In 
most cases a shift up to YBO 
works best, and may be less 
confusing for players. 

diff The instrument difficulty. 0 = Easy, 1 = Medium, 2 = 
Hard, and 3 = Expert.

position Index finger position. 1 = green, 2 = red, and 3 = 
yellow. (0 is assumed to be an open note).

size The size of the note range. For example, 3 = GRY, 
RYB, or YBO (Easy). 4 = GRYB and RYBO (Medium). 

Table 1: Range Shift Parameters

Easy [ld_range_shift 0 1]

Easy [ld_range_shift 0 3]

Medium [ld_range_shift 1 1]

Table 2: Typical Notation

Medium [ld_range_shift 1 2]

G R Y - - 

- - Y B O 

- R Y B O 

G R Y B - 

Difficulty Frets Short Notation

Easy [ld_range_shift 0 2]- R Y B - 

Parameter Description

https://github.com/YARC-Official/YARG-BleedingEdge/releases


Give the player time to move 
their hand during a range shift. 
On Easy try to have about one 
measure without notes between 
ranges. (An unsustained note 
on beat one of a measure is 
allowed).

On Medium try to have about 
half a measure without 
notes between ranges. (An 
unsustained note on beat three 
of a measure is allowed).

Double, or halve range gaps 
for very fast or slow songs. For 
example, at 61 bpm use a half 
note gap on Easy and a quarter 
note gap on Medium.

The range shift text event 
marks where the gold line 
(at the end of the range shift 
indicator) will appear. In-game, 
range shift indicator arrows 
appear four beats before the 
text event. When the position 
of the text event is reached in-
game, the newly used frets are 
illuminated. The newly un-used 
frets are turned off. 

The position of Easy and 
Medium range shifts can differ, 
but this is not a common 
occurrence. 

GUITAR AND BASS

A range shift indicator is always placed at the 
start of a song. 

YARG RANGE SHIFT 
INDICATORS (CONTINUED) 

As discussed earlier in this 
chapter, you should chart Easy 
and Medium sections as usual:

 
Position range shift text events 
as follows:

 ▪ At measure 1.1.0 (before 
any notes are played). This 
defines the starting range of 
notes for the player 1

 ▪ Where a shift in hand 
position needs to occur

1 The game will default to a 
GRYBO range for any notes 
before the first marker. 

YARG recommendations for range shifts.

437 GUITAR AND BASS 438

Start your song on GRY or GRYB 
if possible. The player’s index 
finger will already be on the 
green fret after pressing the 
start song button. 

TEXT EVENT PLACEMENT

E

E

M

M

[ld_range_shift 1 2]

MEDIUM SHIFT UP

Use ranges of three notes for 
Easy and four notes for Medium, 
even if some notes in the range 
are not used. For example, a 
YBO section that only uses BO.

Use shifts for long sections 
that feel noticeably higher in 
pitch. For example, key changes, 
sections with pedal FX, or alt-
charted sections. 

Do not add a shift is there is no 
audible difference. Many bass 
charts only have a starting range 
marker and no shift. 

Place range shift text events at 
the start of the first note of the 
new range.

If the first note of the new 
range is off-beat, use the first 
beat before the note.

SONG START

[ld_range_shift 0 1]

[ld_range_shift 1 1]

Place Easy and Medium 
range shifts at measure 
1.1.0, even if no range 
shift occurs. This helps 
players know which set 
of frets to use.

NOTE RANGES RANGE START SHIFT GAP

E

[ld_range_shift 0 3]

HIGHER PITCH

E

M

ON-BEAT NOTE SHIFT

OFF-BEAT NOTE SHIFT



Do not place shifts right before 
a empty section without any 
notes. 

Place shifts at the start of a 
range so that they align with the 
music properly. 

GUITAR AND BASS

Only author range shifts for Easy and Medium 
guitar and bass.

YARG RANGE SHIFT 
INDICATORS (CONTINUED) 

Try not to shift too often, or use 
shifts for very short sections. 
Constant shifting can be tiring. 

For a three to four minute song 
one shift up is usually plenty. 
Three shifts should be the 
maximum. 

Only use shift markers for Easy 
and Medium. 

Some YARG range shift recommendations only 
apply to YARG (and not Rock Band).
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Do not place range shifts on 
PART DRUMS. Shifts on this track 
will be ignored. 

MINIMIZE SHIFTS
Don’t put open notes in the 
measure before a range shift 
(unless absolutely necessary). 
Open notes can cover shift 
indicators, and be a lot for 
players to handle. 

Note: Open notes in YARG are 
allowed in any note range. Open 
notes are not charted in the 
Rock Band games. 

Do not cut notes from the end 
of a solo to make space for a 
shift gap. Instead, cut the start 
of the section after the solo. 

This rule can override the verse 
and chorus rule. 

IN-RANGE NOTES

NO PART DRUMS

NO PART KEYS

EMPTY SECTIONS

EASY & MEDIUM

OPEN NOTES SOLOS RANGE SIZE

DEFAULT RANGE

STAR POWER
Do not place star power phrases 
entirely in the gap between 
range shifts. This can destroy 
star power pathing and make it 
impossible to gold-star a song.

3 - 4 Minutes

MINIMAL SHIFTS UP

3 - 4 Minutes

MAXIMUM SHIFTS UP

Do not place range shifts on 
PART KEYS. Shifts on this track 
will be ignored. 

Do not place notes that are not 
part of the current note range. 
For example, do not author 
orange or blue notes in the 
default Easy note range: 
 
 
 
 
 
 

Out of range notes will appear 
on the note highway, but they 
will break when the No Range 
Shifts modifier is selected. 

E

[ld_range_shift 0 1]

XX
RANGE SHIFT

X X

RANGE SHIFT GAP

X

Do not create shifts from one 
range size to another. For 
example GRY to RBYO.

Do not put an entire chart on 
position 2 or 3 just because 
it sounds high in pitch. Stick to 
the default range shifts for Easy 
and Medium. 

For extra details visit 
the YARG wiki:

https://docs.yarg.in/
songs/charting/guitar/
ld-range-shifts

Do not cut notes from the start 
of a verse or chorus to make 
space for a shift gap. Cut notes 
from the end of the previous 
section instead.

VERSE & CHORUS

https://docs.yarg.in/songs/charting/guitar/ld-range-shifts
https://docs.yarg.in/songs/charting/guitar/ld-range-shifts
https://docs.yarg.in/songs/charting/guitar/ld-range-shifts
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Select a text event from the list:

 ▪ Click the Text drop-down 
menu to view text events

 ▪ Select a text event from the 
list

 ▪ Click the OK button

Your chosen text event is now 
added to your MIDI track.

You can now load the text event 
list into REAPER as normal:

 ▪ Double-click in the green 
highlighted area

 ▪ In the Add Text Event 
window click the Load 
button

 ▪ In the Load text file window 
select the YARG - Range 
Shift text file

 ▪ Click the Open button

442

Typing text events by hand is 
never recommended. Instead, 
follow these steps to create a 
text event list that you can load 
into REAPER.

 ▪ Copy and paste the YARG 
range shift short notation 
(Table 2 p.436) into 
Notepad

1

441

3

2
Save the text file in your 
REAPER install folder:

 ▪ Save the file to: C:\REAPER\
Data\Text_Strings

 ▪ Name the: YARG Range 
Shifts.txt

4

TEXT EVENTS AND TEXT 
STRINGS 2
LOAD TEXT EVENTS INTO 
REAPER 2

YARG RANGE SHIFT TEXT 
EVENTS LIST
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Avoid these mistakes to improve your guitar 
and bass charts!

COMMON AUTHORING 
MISTAKES 

 ▪ Only author sustains 
for notes that you can 
reasonably expect to 
whammy 
 
The short sustains to the 
right are nearly impossible 
for most players to whammy.  
A very skilled player could 
probably get Overdrive from 
the medium sustains. This 
length of sustain is fine 
when the notes are the 
same color. If the color of 
these sustains changed they 
would probably be removed. 
The long sustains here are 
obviously not an issue.

 ▪ Turn up the bass in the mix. 
The game is not fun to play 
if you cannot hear what you 
are playing 
 
Use EQ to bring out the 
upper bass frequencies. This 
will let you hear the attack 
of the pick on the strings of 
the bass guitar. 

 ▪

 ▪ Only author one guitar part 
at a time 
 
It is fine to switch between 
the most fun or interesting 
guitar parts. But, you should 
only author one guitarist at 
a time.

 ▪ Author muted chord notes 
as the lowest note of the 
nearest chord

 ▪ Author individual notes with 
chord accents as as the 
lowest note of the nearest 
chord

 ▪ Author percussive strums 
as the lowest note of the 
nearest chord

 ▪ Leave at least a 16th note 
gap between the end of a 
sustain and the next note

 

 ▪ The player should not be 
expected to play continuous 
8th notes if the song is over 
160 BPM

 ▪ Do not author nuanced pick 
up notes between chords in 
Hard

 ▪ Do not author passing, 
or muted notes between 
chords for Hard

 ▪ Chords in Expert should be 
chords in Hard * 
 
* Unless there is a very 
special circumstance that 
prevents it.

 

 ▪ Don’t just author every 
quarter note. Try to pick out 
notes that best represent 
the feel of the song

 ▪ When sustains are reduced 
from Hard make sure that 
they are reasonable to play 
on Medium

 ▪ Do not use these chords on 
Medium: 
 
Green / Blue 
Green / Orange 
Red / Orange

 ▪ There are no chords on Easy

 ▪ Easy should be easy, but 
also fun 
 
Don’t leave sections of 
your song empty if you can 
author gems.  
 
You can also add gems if the 
section is not very busy.

Short sustain tails should be 
removed

Medium length sustains can 
be a judgement call

Long sustains are always fine

ALL DIFFICULTIES EXPERT HARD MEDIUM EASY
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Trill markers are used to trigger free form lanes. 
They are for rapid alternating notes.

TRILL MARKERS 

Strum markers are also used to trigger free 
form lanes. Use these lanes for fast, odd 
rhythm strumming sections. 

STRUM MARKERS
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There may be cases when 
playing the authored part may 
feel better than playing free 
form lanes. For example, when 
the song tempo is too fast or 
too slow. But, free form lanes 
can be a good choice in certain 
situations:

 ▪ If the part is very fast and 
without regard for tempo

 ▪ If it is very difficult to match 
the original performance

 ▪ If there is a very long stretch 
of 16th or 32nd notes

For example, the solo in “Crazy 
Train” has trill markers. The 
tempo is 140 BPM.

The solo in “Surfing with 
the Alien” does not use trill 
markers. The tapped trills are 
four measures long with 32nd 
notes at 168 BPM. 

Use the option that works best 
for your song.

Author trill markers so that they 
cover sets of trilled notes. If the 
notes in the trill change, you 
must author a new trill marker 
for those notes.

Note: The marker should only 
cover the start of the final note 
of the trill. To do this, add .01 
to the length of the trill marker 
(see page 447).

To use trill markers 
on Expert and Hard 
change the note 
velocity of the marker. 
See pages 175 — 176.

For more on trills see 
page 155.

To use strum markers 
on Expert and Hard 
change the note 
velocity of the marker. 
See pages 175 — 176.

For more on tremolo 
see page 156.

TRILL MARKER 
OVERVIEW
Author trill markers on note 127 
(shown in bold below):

When a player plays the notes 
in a (trill marker) free form lane:

 ▪ They do not have to play the 
authored rhythm

 ▪ They must play alternating 
notes at 160ms or faster *

* If the player plays below 
160 ms the free form lanes 
disappear. The player must then 
play the trill as authored.

 
 
Trill Marker 
Strum Marker 
--- 
BRE 
BRE

PART GUITAR

WHEN TO USE 
TRILL MARKERS

AUTHORING TRILL 
MARKERS

There may be cases when 
playing the authored part may 
feel better than playing free 
form lanes. But, free form lanes 
can be a good choice in certain 
situations:

 ▪ If the part is very fast and 
without regard for tempo

 ▪ If it is very difficult to match 
the original performance

 ▪ If there is a very long stretch 
of 16th or 32nd notes

For example, “25 or 6 to 4” uses 
a strum marker for 16th notes in 
the final long strummed chord 
of the song. 

Another well-known example 
is the intro pick slide to “Crazy 
Train” by Ozzy Osbourne.

Use strum markers if and when 
it feels right for your song.

It is easy to break combo when 
moving between tremolo parts. 

In this case it is best to:

 ▪ Make sure that the final note 
of the tremolo is not covered 
by the tremolo marker

Note: You can use strum / 
tremolo lanes on sections of 
single notes or chords. 

STRUM MARKER  
OVERVIEW
Author strum markers on note 
126 (shown in bold below):

Note: Strum markers are also 
known as Tremolo markers.

When a player plays the notes 
in a strum lane:

 ▪ They do not have to play the 
authored rhythm

 ▪ They must strum notes at 
160ms or faster *

* If the player plays below 
160 ms the free form lanes 
disappear. The player must then 
play the part as authored.

 
 
Trill Marker 
Strum Marker 
--- 
BRE 
BRE

PART GUITAR

WHEN TO USE 
STRUM MARKERS

AUTHORING 
STRUM MARKERS
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AUTHORING TRILL MARKERS AUTHORING TRILL MARKERS 
2
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Trill markers cover trilled notes including the 
start of the last note of the trill.

Here you can see some trill 
markers from “25 or 6 to 4”. 
Each marker starts at the 
beginning of the first note of 
the trill. 

Author the marker so that it 
ends at the beginning of the last 
note of the trill. 

Then follow these steps to 
extend the marker to cover the 
start of the last note of the trill:

 ▪ Click the trill marker to 
select it

 ▪ Press Ctrl + F2 to open the 
Note Properties window

 ▪ In the Length field add 0.1 to 
the note length value *

* In this case the note length 
changes from 0.1.75 to 
0.1.76.

 ▪ Click OK to close the Note 
Properties window.

Some other examples of trills in 
Rock Band include:

 ▪ “Superunknown” by 
Soundgarden  
Guitar solo | 16th notes | 
135 BPM 
111 ms between notes

 ▪ “Cold As Ice” by Foreigner 
Guitar solo | 16th notes | 127 
BPM and 140 BPM 
118 and 107 ms between 
notes

 ▪ “Love Spreads” by The Stone 
Roses 
Guitar solo | 16th notes | 
88 BPM 
170 ms between notes

Note: 93 BPM is almost exactly 
160 ms between 16th notes.

98.1.00
2:44.177

97.3.00
2:43.384

98.3.00
2:44.970

Trill Marker

BRE

BRE

BRE

BRE

BRE (Use all 5)

---

Expert Orange

Expert Blue

Expert Yellow

Expert Red

Tempo = 151.3 BPM 16th notes Trill sections can be authored 
one after another as needed

Expert Green

Trill Marker Trill Marker Trill Marker

TRILL MARKERS: “25 OR 6 TO 4” BY CHICAGO
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Use animations to change the actions and 
attitude of in-game characters.
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Text events are placed to set 
the character animation state:

You can use CAT to create these 
markers if you like:

 ▪ Press F9 to open CAT

 ▪ Press the Create Animation 
Events button

The Create animation markers 
dialogue will open:

 ▪ In the Select Instrument 
menu select Guitar or Bass

 ▪ In the Select Expression 
menu choose Play, Mellow, 
or Intense

 ▪ Click the Create markers 
button

Adjust automatic animation 
markers if needed. Add extra 
animation markers as required.

[play]

ANIMATION 
MARKERS

TEXT 
EVENTS

CHARACTER  
ANIMATION

CHARACTER ANIMATIONS GUITARIST ANIMATION 
 EXAMPLE

1 3

Count-in: No character 
animations.

After count-in: Guitarist is not 
playing but is moving to the 
beat, use [idle].

Guitarist starts to play: Use 
[play], [mellow], or [intense].

Guitarist plays solo: Use [play_
solo]. When the solo ends use 
the [play] marker.

Band starts to play: Use [play], 
[mellow], or [intense]. At end 
of song use: [idle_realtime]

[idle] [play]

[idle] [intense]

If you use CAT to generate 
character animations you may 
need to:

 ▪ Add character animation 
text events

 ▪ Modify text events

 ▪ Change the position of text 
events

In the example above you can 
see song sections and character 
animation text events.

Note: Some of the text events 
begin an eighth note early or an 

eighth note late. This is so that 
the animation does not start or 
end abruptly with the music. 

With proper spacing like this, 
your animations will flow with 
the music.

[play_solo] [play] [idle_realtime]

Character animations should not be added 
during the count-in.

COUNT-IN NO GUITAR GUITAR

GUITARGUITAR BAND STOPS

[idle_realtime] The character does not move to the beat 
of the music. The character is waiting for 
their cue. This is useful in slower songs, 
or slow parts in a song.

[idle]

[play] The character is playing.

[mellow] The character is playing in a mellow 
manner.

[intense] The character is playing in an intense 
manner. For example, aggressive metal.

The character will bop and wave to the 
beat of the music. Use [idle] before the 
song starts, after the song finishes, or 
during downtime. Downtime is at least 
two measures of rest.

[idle_intense] Character is idling in an intense manner.

[play_solo] The character is playing fast notes and 
showing off.

Load these text events 
into REAPER:

Use the Instruments text events list. 
See pages 125 — 126.

For a short puase you 
can use: [mellow]. 
For more than two 
measures use [idle].



GUITAR AND BASS

Left-hand animation moves the character’s 
hand up and down the neck of the guitar. This 
adds realism to guitar and bass animation. 
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EXPERT GUITAR / 
BASS TEMPLATE 

 
 
Left-hand Highest 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
Left-hand Lowest 
 

PART GUITAR

LEFT-HAND 
OVERVIEW 
Note: Left-hand animation is 
optional. Magma will generate 
left and right-hand animations 
if you do not author any. This 
information is for authors who 
want a high level of detail in 
their customs.

The guitar and bass templates 
include MIDI notes for character 
left hand position. (See the 
graphic to the right). 

As you can see, these notes 
provide hand positions on 
the guitar neck, from low to 
high. These hand positions are 
approximate. This is because 
guitar models and hand size 
vary a lot in-game. In fact, 
most character and guitar 
combinations won’t let you go 
above the twelfth fret. 

The image to the right shows 
the relationship between guitar 
frets and MIDI notes. Thanks to 
C3 author Orange Harrison for 
working this out.

MIDI NOTES TO 
FRETS GUIDE

 
 
Low 
- 
2 
- 
3 
- 
4 
- 
5 
- 
- 
7 
- 
- 
9 
- 
- 
- 
12 
High 
 

LEFT-HAND 
ANIMATION
Left-hand animation is 
controlled by MIDI notes and 
text events:

 ▪ MIDI notes set the hand 
position on the guitar neck

 ▪ Text events set fingering for 
single notes and chords

Animation cues are not needed 
for each note: 

 ▪ Strumming motion is based 
on the notes and chords in 
the Expert chart

 ▪ Finger motion is based on 
movement of notes in the 
Expert chart

Note and chord animation is 
separate from the left-hand fret 
position animation. 

For example, a fast repeated 
line in a guitar solo only needs 
one left hand animation note.

You can approach how you 
would like to animate the left 
hand in different ways:

 ▪ Refer to guitar tabs for left 
hand position

 ▪ Refer to video of live concert 
performances

 ▪ Divide the song into low, 
mid, and high frets

Use a single MIDI note to set 
the left-hand position. To 
change the hand position author 
a different hand position. The 
character’s hand will slide to 
the new position just before the 
start of that note.

Refer to the “Hand Maps” topic 
on page 457 to customize left 
hand fingering.

LEFT HAND ANIMATION 2LEFT-HAND ANIMATION 
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Choose a right-hand animation style for the 
bass player. 

RIGHT HAND ANIMATION 
FOR BASS 

There are three right-hand 
animations for the bass 
player in Rock Band. 

By default the bass player uses 
their fingers to play the bass 
in-game.

If this is the case in your song, 
you do not need to do anything.

To change the right-hand 
animation, add text event(s) to 
the PART_BASS track: 

 ▪ [map StrumMap_Default] 
Bass player plucks strings 
with fingers

 ▪ [map StrumMap_Pick] 
Bass player uses a pick

 ▪ [map StrumMap_SlapBass] 
Bass player slaps the strings

Typically only one of these text 
events is needed per song. For 
example:
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B

[map StrumMap_Pick]

PART BASS

[MAP STRUMMAP_SLAPBASS]

THUMB AND FINGERS PLUCK THE STRINGS

[MAP STRUMMAP_PICK]

PICK PLUCKS THE STRINGS

[MAP STRUMMAP_DEFAULT]

FINGERS PLUCK THE STRINGS



ADD FRET NUMBERS TO THE 
GUITAR / BASS TEMPLATES 

2

1

2
If the MIDI Editor is undocked 
follow these steps:

 ▪ Click File > Customize note 
names > Load note names 
from file

By default the left hand MIDI 
animation notes do not include 
fret numbers. You can add fret 
numbers to the template with a 
custom keymap.

If the MIDI Editor is docked 
follow these steps:

 ▪ Right click the MIDI Editor 
Tab

In the context menu select:

 ▪ File > Customize note names 
> Load note names from file

GUITAR AND BASS455

4

3

GUITAR AND BASS 456

3

4

The Load MIDI note names from 
file window will open:

 ▪ Browse to: C:\REAPER\
Data\ix_keymaps

 ▪ Select GuitarFrets.txt

Note: You will need to 
download this file from: 
rhythmgamingworld.com/c3-
authoring-tools/

 ▪ Click the OK button

The Load MIDI note names from 
file window will close:

Your guitar or bass template 
will now have fret numbers for 
character animation. 

https://rhythmgamingworld.com/c3-authoring-tools/
https://rhythmgamingworld.com/c3-authoring-tools/
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Hand maps are text events that are used to 
animate left-hand fingering.

HAND MAPS 

After you have authored 
character left-hand positions 
you can add Hand Maps.

Hand maps are text events 
that control left-hand fingering 
animations. They let you set 
different styles of left-hand 
animation for different parts of 
your song.

You can use as many, or as few, 
hand maps as your song needs.

To the right you can see the 
hand maps available and a brief 
description of what they do.

Starting on the facing page you 
can see images for left-hand 
animation. 

Note: Try to avoid typing text 
events by hand. Load these text 
events into REAPER. Use the 
Instruments text events list. 
See pages 125 — 126.

HAND MAP IMAGES: 
 BASIC CHORD SHAPES
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[map HandMap_Default] Single gems animate single fingers. 
Sustain notes animate vibrato. 
Chords animate chord fingerings.

[map HandMap_NoChords] Single finger and vibrato animation.

[map HandMap_AllChords] Chord animation only.

TEXT EVENT ANIMATION

[map HandMap_Solo] Animate D chord for all chords and 
vibrato for sustained chords.

[map HandMap_DropD] Animate open hand for all Green 
gems. All other gems are chords.

[map HandMap_DropD2] Open hand for all Green gems.

[map HandMap_AllBend] Animate ring finger, high vibrato.

[map HandMap_Chord_A] Animate A Minor chord.

[map HandMap_Chord_C] Animate C chord.

[map HandMap_Chord_D] Animate D chord.

OVERVIEW

[map HandMap_Chord_A]

A CHORD C CHORD D CHORD

[map HandMap_Chord_C] [map HandMap_Chord_D]

[map HandMap_Default] 
[map HandMap_AllChords]

BASIC CHORD #1 BASIC CHORD #2

[map HandMap_Default] 
[map HandMap_AllChords]
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HAND MAP IMAGES: SINGLE 
NOTES, VIBRATO, AND DROPD 
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SINGLE NOTES: POSITION #1

SINGLE NOTES: POSITION #2

VIBRATO

VIBRATO 

DROP D

OPEN HAND

DROP D

CHORD

Vibrato is animated with an wide 
finger movement across the 
guitar neck.

The Drop D animation for vibrato 
is a bit more subtle.

The open hand, or Drop D 
animation for single notes leaves 
the low E string open. This is 
used for guitar parts that use the 
low E string as a pedal note. The 
Drop D chord fingering looks like 
a power chord. 

These two Drop D animations 
work very well for many rock and 
metal songs.

Single note animations are 
played in two positions across 
the guitar strings. The first 
position is near the G string. The 
second position is near the low 
E string. Finger motion can be 
fast, but not always in sync with 
the notes played.

DROP D
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LEFT-HAND ANIMATION 
EXAMPLE 
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Another option is to give each 
chord it’s own fret. This may not 
work for complex songs with a 
lot of chord changes though.

Depending on the song it may 
work out best to divide the 
song into low, middle, and high 
sounding chords. From there 
you can assign fret numbers 
(and chord shapes if needed).

If you have a song with a 
lot of muted chords try the 
AllChords handmap. 

Finally, don’t feel that you need 
to move the left-hand for every 
single note or chord. 

As you can see, in the solo 
section, you can group many 
notes together on one fret. 
Remember, there are two hand 
positions for single notes. So, 
the left-hand animation will 
move from higher strings to 
lower strings on the same fret. 

Finally, pay attention to any 
animation that is combined with 
a close-up of the fretboard. For 
example, during a guitar or bass 
solo. There are several cuts 
that will really highlight your 
animation choices. 

Left-hand animation can make 
your player character look much 
more realistic. But don’t expect 
complete realism:

 ▪ The template only has about 
half as many frets as a real 
guitar, and

 ▪ There are a limited number 
of chord shapes

 ▪ Guitar models and hand size 
vary a lot in-game

In this example we have four 
made up measures of guitar 
tablature. I’ve charted the left-
hand as accurately as I can:

 ▪ Different chord shapes for 
power chords on adjacent 
strings

 ▪ An open hand handmap for 
chords played over the open 
E string

You can simplify these 
animations and deviate from 
them to get good results.

You could remove the chord 
handmaps, and see how the 
animation looks without them.

Note: Having so many chords on 
the same frets might not look 
good. In this case you can group 
a few chord changes on one 
fret. For example, put the first 
three chords on fret 7 and the 
next three chords on fret 5.

Left Hand Lowest 1

- 

- 2

- 

- 3

- 

- 4

- 

- 5

- 

- 

- 7

- 

- 

- 9

- 

- 

- 

- 12

Left Hand Highest

   E: --------------------|-------------------------|       12--15-12--12-15-12-15-15---|-12-------------------------------| 
   B: 9--10--7------------|-------------------------|       --14-----14-----------------|---15-12--------------------------| 
   G: 7--8---5--9--10--7--|-------------------------|       ----------------------------|--------14-12---------------------| 
   D: ----------7---8--5--|-------------------------|       ----------------------------|-------------15-12----------------| 
   A: --------------------|--------9-----7-----5----|       ----------------------------|-------------------15-12--13------| 
   E: --------------------|--0--0--7--0--5--0--3--0-|       ----------------------------|-------------------------------15-|

1 2 3 4

[map HandMap_Chord_D]

[map HandMap_Chord_A]

[map HandMap_DropD]

[map HandMap_Solo]
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1 4 POWER CHORDS 
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POWER CHORDS 
EXPLAINED
There are several commonly 
used types of power chords in 
rock and metal:

 ▪ Partial power chords which 
use the root and fifth notes

 ▪ Full power chords that use 
the root, fifth, and octave

 ▪ Fourth chords, use the fifth 
and octave from a full power 
chord, but do not have the 
root note. They are implied 
power chords.

 
Partial, full, and implied G 
power chords are shown above.

These chords are easy to play 
and can be quickly moved up 
and down the fretboard and 
across strings. Many rock and 
metal songs have fast chord 
changes played this way.

EF# G F#

In Rock Band power chords are 
typically 1 2 or 1 3 chords. Using 
1 4 chords can: 

 ▪ Reduce finger and hand 
position shifts in fast chord 
changes

 ▪ Anchor chord changes to a 
root note 

 ▪ Make the chord changes 
easier to play

You can see this in the 
examples for this topic. 

“RAINING BLOOD”

Eb B Eb D

110 BPM168 BPM

“Holy Wars ... The Punishment 
Due”, “Nemesis” and “The 
Pallbearer Walks Alone” all have 
similar riffs:

 ▪ Low power chords played off 
an open E string

Compare the tabs for each song 
to the guitar charts. You will see 
that the 1 4, 1 3, and 1 2 chords 
mirror the tones and semi-
tones between the chords. 

In “Raining Blood” we see the 
same idea, but the chords all 

work off Red gems. This works 
well here because the chords 
are higher than the open E 
string. Compare this to “Blood 
and Thunder” on the next page.

“Deathbed Atheist” is different 
because the chords all use 
the open E string. This is not 
unusual in Rock and Metal. 

You can think of these chords 
as dyads, partial chords, or just 
intervals. The intervals in these 
chords are:

 ▪ Augmented Seventh

 ▪ Seventh

 ▪ Sixth (also known as an 
augmented fifth)

“And Justice For All” is shown 
for contrast. It shows the typical 
method for charting chords. The 
1 4 chords in this song are used 
for unique individual chords. 

Use the charting method that 
works best for your song.

“AND JUSTICE FOR ALL”

178 BPM

D C# B D

“DEATHBED ATHEIST”

130 BPM

“THE PALLBEARER ...” 

102 BPM

F E FE G

“NEMESIS”

98 BPM

C E C D#

“HOLY WARS”

   D: ----5---5 
   A: 5---5---5 
   E: 3---3----

1 4 POWER 
CHORDS

   D: ------------- 
   A: 4---5-------4 
   E: 2---3---0---2

“HOLY WARS”

   Bb: ------------- 
    F: ----6-------5 
    C: 0---4---0---3

   D: ------------- 
   A: 3-----5-----3 
   E: 1-0-0-3-0-0-1

“THE PALLBEARER ...” “NEMESIS”

   Db: -------------9-8 
   Ab: ----------10-7-6 
   Eb: 0-0-0-0-0--8----

   Db: ------------- 
   Ab: 6---5---3---5 
   Db: 0---0---0---0

   D: 5---4---2---5 
   A: 5---4---2---5 
   E: -------------

“RAINING BLOOD” “AND JUSTICE FOR ALL”“DEATHBED ATHEIST”

X X X X X X

G POWER CHORDS
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CHORD CHANGE HOPOS 

Rock and metal guitar players 
often move power chords 
quickly up and down the 
fretboard. Quick chord changes 
are played as follows:

 ▪ The guitar player picks a 
chord

 ▪ The guitar player slides 
the chord up or down the 
fretboard to a new chord

The guitar player may, or may 
not, pick the second chord. This 
can depend on the style and 
speed of the song.

465 GUITAR AND BASS 466

When the second chord is not 
picked, it emphasizes the slide 
sound between the chords. 

In Rock Band you can chart this 
sound with chord HOPOs. Let’s 
take a look at a few examples.

The [verse] of “Blood and 
Thunder” has a good number of 
chord HOPOs. You can see this 
in the two examples below. The 
first is a power chord slide up. 
The second is chords that slide 
up and down the guitar neck. 

Single power chord slides are 

more common. You can see this 
in the next example - from the 
[verse] riff of “Caught in a Mosh” 
by Anthrax. The Yellow / Blue 
chord is a power chord slide 
and is a HOPO. 

Note: The open E string gems 
around these chords are on  
Yellow gems. This is likely done 
for playability. The tempo for 
this section is very fast, at 
about 220+ BPM.

“Hangar 18” features three quick 
power chord slides in a row in 
[gtr_riff_3]. Notice that the first 

chord is authored as a single 
note. This is likely because the 
chord change is very fast.

“Master of Puppets” uses a 
similar technique with single 
note HOPOs for sliding chords:

“Bodhisattva” has a large 
amount of chord change HOPOs. 
They occur in the [fast_picking] 
section. The guitarist slides a 
chord between the third and 
seventh frets while picking fast. 
The guitar part has a fairly clean 
tone and the slide sound is 
clearly heard.

The final example is “No More 
Tears”. In [gtr_line_1] the guitar 
player uses a slide. 

A slide is a metal tube worn on 
a single finger of the fretting 
hand. The slide rests on the 

strings and is moved up and 
down the neck of the guitar. 
This allows the guitarist to 
slide from one pitch, or chord, 
to another. The player avoids 
pressing the strings against the 
frets of the guitar. 

This technique produces a 
distinct sound. In this example 
we can see a plucked chord 
(Green / Red) followed by a 
higher slide chord. The higher 
chord is not plucked and is 
charted with a HOPO. 

SLIDES BETWEEN 
CHORDS

H

92 BPM

“BLOOD AND THUNDER”

   D: 10-9-7-10-9---- 
   A: -8-7-5-8--7---- 
   E: ------------0-0

“BLOOD AND THUNDER”

HH

91 BPM

H H

   D: 9-----7-9---- 
   E: 7-----5-7---- 
   E: --0-0-----0-0

“BLOOD AND THUNDER”

“BLOOD AND THUNDER” “HANGAR 18” 

HH H

   D: --------------- 
   A: 4-5---4-5---4-5 
   E: 2-3---2-3---2-3

“HANGAR 18” 

125 — 131 BPM223 BPM

“CAUGHT IN A MOSH”

“CAUGHT IN A MOSH”

H

“BODHISATTVA” 

223 BPM

H

   E: 3-/-7-7-\-3 
   B: 3-/-7-7-\-3 
   G: -----------

“BODHISATTVA” 

H H H H H

96 BPM

“NO MORE TEARS”

   B: --------------- 
   G: 5-/-7---------- 
   D: 5-/-7----------

“NO MORE TEARS”

H

   D: ----9--10---- 
   A: ----9--10---- 
   E: 0---7---8---0

X X X X X X

HH

“MASTER OF PUPPETS”

X
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Expert to Hard reductions are the most difficult 
to get right.

AUTHORING REDUCTIONS 

Reductions from Expert to Easy 
are best done one difficulty 
at a time. The recommended 
method is as follows:

 ▪ Use CAT to reduce from 
Expert to Hard

 ▪ Review the CAT reduction 
and make changes as 
needed

 ▪ Repeat these steps for Hard 
to Medium and for Medium 
to Easy

The changes that you may need 
to make depend on the musical 
context. You may need to:

 ▪ Add or remove notes

 ▪ Wrap notes (for each 
difficulty)

 ▪ Find the dominant rhythm

Refer to the authoring rules for 
each difficulty as you complete 
this step.

HARD REDUCTION:
“HEART OF GLASS” 

BY BLONDIE

467 GUITAR AND BASS 468

Hard reductions can be the 
most difficult to get right. You 
may need to:

 ▪ Keep some sixteenth notes 

 ▪ Reduce syncopated rhythms 

 ▪ Pick out accented notes in 
a solo

 ▪ Decide which notes or 
chords to remove

 ▪ Wrap gems to match the 
song audio, or to meet the 
authoring rules

For some songs you may have 
to make many judgement 
calls. These will be based on 
the musical context, authoring 
rules, and song tempo. These 
choices will form the framework 
for Medium and Easy. So it is 
worth taking extra time to refine 
and polish your Hard reductions. 

If you do, you will find that your 
Medium and Easy charts should 
fall into place more easily. 

It can be frustrating to remove 
a note in Hard, only to find that 
you want to play it in Medium. 

Next let’s take a look at how 
to reduce some existing song 
measures taken from the Rock 
Band 3 setlist. 

Note: These examples may 
deviate from the official 
Harmonix charts.

Syncopated sixteenth note rhythms, at a  
moderate tempo.

The [main_riff] to “Heart 
of Glass” has a sixteenth 

These changes keep the same 
rhythmic feel through out all of 
these measures.

* An argument could be made 
to keep these notes in Hard. 
There is a strong accent on the 
two sixteenth notes at the start 
of each measure. They may have 
been removed because of the 
quick Green to Blue jumps.

H

note syncopated rhythm. 

To reduce this riff for Hard:

 ▪ Remove sixteenth notes 
from the syncopated rhythm

 ▪ Remove subtle variations

H

111+ BPM SOLID TIER 35 36

37 38

   Expert notes removed from Hard 

In this Harmonix chart: 

 ▪ Syncopated 16th note Blue 
gems have been reduced

 ▪ The Orange pitch slide gem 
has been shifted to the start 
of the slide

 ▪ Green note variations have 
been removed (measure 36 
and 38)

[main_riff]REDUCTIONS 
OVERVIEW

HARD 
REDUCTIONS

**

   Expert notes that could be kept in Hard*

Rock Band 3 era charts 
from Harmonix can 
be a good source 
of inspiration. But, 
Harmonix does not 
always follow their own 
authoring rules.

* *
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HARD REDUCTION:  
“CAUGHT IN A MOSH” 
BY ANTHRAX
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The [main_riff_1] from 
“Caught in a Mosh” is very 

These reductions give the player 
some breathing room. They let 
the player focus on the main 
points of motion. 

Overall, this chart achieves a 
good balance for the player. This 
is important given the very fast 
song tempo. (This chart differs 
slightly from the official chart).

H

fast continuous eighth notes. 
These measures repeat, and 
work off the low open E string. 

To reduce this riff for Hard:

H

203+ BPM IMPOSSIBLE TIER 20 21

22 23

Very fast eighth note motion with a Green root 
note gem.

   Expert notes that are removed or wrapped in Hard 

 ▪ Reduce Green gems (to 
isolate motion gems)

 ▪ Keep the motion gems

 ▪ Wrap gems for Hard

 ▪ Reduce short sustain notes 
to 16th notes

H

39 40

   Expert notes that are removed or shortened in Hard

HH

H

H HOPO chords

The [verse] riff from 
“Caught in a Mosh” 

The extra breathing room makes 
this challenging part a bit more 
playable. The player has some 
time to anticipate the chords 
and plays most of the single 
Yellow notes.   

H

features very fast eighth notes 
and fast power chord changes. 

Note: This Hard reduction 
differs from the official 
Harmonix chart.

To reduce this riff for Hard:

 ▪ Remove notes around fast 
chord changes

 ▪ Reduce short chord sustains 
to sixteenth notes

 ▪ * Reduce the number of 
continuous eighth notes

37 38 220+ BPM IMPOSSIBLE TIER 
[main_riff_1] [verse]

Very fast eighth notes with sliding power chords.

*

*
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Moderate tempo sixteenth notes with Green 
root note gems, and power chord slides.

HARD REDUCTION:
“BLOOD AND THUNDER” 
BY MASTADON

Moderate tempo sixteenth and thirty-second 
note melody line.
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The [intro] and [chorus]
to “Blood and Thunder” 

Keeping the chord motion and 
removing the Green gems works 
well for the [intro] chart. 

* The removal of the basic 
16th note strumming in the 
[chorus] is a judgement call. 
At this tempo I would make an 
argument to keep them. They 
are not fast chord changes. 

H

is sixteenth notes and power 
chord slides. 

The [chorus] part is basic power 
chords. Most of these chords 
have a sixteenth note strum 
before the downbeat chord.

To reduce these riffs for Hard: 

H

90+ BPM NIGHTMARE TIER 13 14

15 16

   Expert notes that are removed in Hard 

 ▪ Remove the Green root 
notes from the [intro]

 ▪ Keep the [intro] chord 
motion

 ▪ Reduce [intro] fast chord 
changes

 ▪ * Remove [chorus] 16th note 
chord strums

H

39

   Expert notes that are removed or wrapped in Hard

These two guitar riffs are 
in 11/8 time. These riffs 

* Some may make an argument 
for sixteenth notes here. But, 
keeping them interrupts the 
groove of the section.

H

are part of a melodic line with 
several variations. 

In Expert, [gtr_riff_a] contains 
16th and 32nd notes. [gtr_riff_b] 
is straight 16th notes. 

To reduce these riffs for Hard:

 ▪ Remove the 32nd notes

 ▪ Remove the 16th notes

 ▪ Wrap the remaining 8th 
notes for Hard as needed

The final 8th note pattern is not 
too challenging given the tempo 
of the song.

37 90+ BPM NIGHTMARE TIER 
[intro]

[chorus]

[gtr_riff_a]

[gtr_riff_b]

*

*

* *
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Fast eighth notes and chord changes.

HARD REDUCTION: 
“25 or 6 to 4” BY CHICAGO 

Sixteenth note trills, and thirty-second note 
strumming with a strum marker.
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The [intro] to “25 or 6 to 
4” has some judgement 

The next issue is the Green 
to Blue / Orange jump. Is the 
tempo fast enough to justify 
removing the Green gem? If it is 
then we need to be consistent. 
This means also removing the 
last note from the other similar 
measures. Note: These notes 
are highlighted with an asterisk. 
Harmonix chose to remove 
them from the Hard chart.

H

calls to make. To reduce this riff 
for Hard:

 ▪ Remove 16th notes

 ▪ Avoid fast chord changes

 ▪ Reduce the Green / Orange 
chords (measure 18)

H

145+ BPM IMPOSSIBLE TIER 15 16

17 18

   Expert notes that are removed or wrapped in Hard 

 ▪ Wrap notes for Hard

In measure 18 you can see why 
you should use Green / Orange 
chords sparingly. They need to 
be wrapped for Hard. 

I think Harmonix made good 
choices for the Hard chords 
here. But, this is quite different 
to play than the expert part. 

H

175 176

   Expert notes that are removed or wrapped in Hard

The [gtr_solo_2b] has 
sixteenth note trills with 

Reducing this part to 8th notes 
fits with the musical context. 
The previous four measures are 
8th notes that slow down from 
144 to 62 BPM. The player has 
one beat to adjust to the 87 
BPM tempo change.  

* Note: CAT will automatically 
fix pitch bends on Hard. 

H

three Expert trill markers. To 
reduce this solo for Hard:

 ▪ Remove 16th notes

 ▪ Wrap notes for Hard

 ▪ Fix pitch bend *

The 16th note Red to Yellow 

sustain is reduced to a single 
gem. This gem is wrapped to 
Green so that it fits in with the 
ascending trill note pattern. The 
16th note trills are reduced to 
8th notes.

The [ending] has 32nd notes 
with a strum marker on Expert:

 ▪   Remove 16th / 32nd notes

97 98 151 BPM IMPOSSIBLE TIER 
[intro_a] [gtr_solo_2b]

*

*
*

87 BPM [ending]

*
*



GUITAR AND BASS

Moderate tempo off-beat rhythms, and 
sixteenth note strumming.

HARD REDUCTION:
“THE LOOK” BY ROXETTE 
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The [intro] to “The Look” 
has an off-beat rhythm, 

 ▪ Avoid fast chord changes

The main focus of the rhythm is 
kept. Sixteenth note strumming 
before the chord change is 
removed. * This reduction is 
also applied to measure 20 to 
keep the measures consistent. 
There is no chord on the 
downbeat of measure 21.

H

with 16th notes and triplets. To 
reduce this for Hard:

 ▪ Remove fast motion

 ▪ Wrap notes for Hard

 ▪ Make parts consistent

H

95 BPM CHALLENGING TIER 9 10

19 20

   Expert notes that are removed or adjusted in Hard 

Sixteenth note triplet motion 
and some 16th notes have been 
reduced for Hard. Descending 
motion has been wrapped for 
Hard. These changes produce 
consistency between these two 
measures.

The [chorus] has some 16th note 
strumming which is reduced:

H

55 56

   Expert notes that are removed or shortened in Hard

The [bridge] has off-
beat rhythms and fast 

In measures fifty-five and 
fifty-six 16th note strumming is 
reduced: *

 ▪ Avoid fast chord changes 
and Green / Orange jumps

The last 16th note strum is 
removed from other measures 
for consistency. The remaining 
16th note strumming pattern is 
fine at this tempo.

H

ascending motion. To reduce 
this for Hard:

 ▪ Reduce motion

 ▪ Wrap notes for Hard

Motion is reduced giving some 
breathing room in and around 

the motion parts. As you can 
see this gives consistency to the 
upward motion parts.

* On Hard (measure 50) the 
rhythm of the asterisked notes 
is 8th notes. It is not straight 
8th notes on Expert. I assume 
that these notes were quantized 
by mistake on Hard. 

49 50 95 BPM CHALLENGING TIER 
[intro] [bridge]

[chorus_1]

* *

* *

*
*

*

* *
* *
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EXAMPLE REDUCTION:  
“CRAZY TRAIN” 

In Hard Harmonix avoids 
the Green / Orange jump 

Medium is quarter notes, 
wrapped to four lanes. 

Easy is half notes, 
wrapped to three lanes. H M E

by moving the Green gems up to 
Red. * The asterisked notes are 
also removed. I feel that they 
could have been kept. 

Note: Harmonix charted the 
sustains with an 8th note gap. 
This used to be the standard, 
before the launch of the Rock 
Band Network.

* The sustains should be the 
same as for Medium (with a 
quarter note gap).

19 20
[intro]

E

M

H

X

Hard reduces the 16th 
notes to 8th notes. The 

Medium outlines the 
chord movement. Chords 

Easy follows the chords 
in single notes. Notes are 

188 BPM CHALLENGING TIER 

H M E

chords from Expert are retained. are wrapped for Medium. * The 
quarter note sustain chord feels 
good. It is not hard to prepare 
for the Red gem that follows.

wrapped for three lanes. * The 
sustain is the same as Medium. 
There is plenty of time to pre-
pare for the next note.

21 22
[verse_1]

134+ BPM

*
*

*
*

*

*

*
*

E

M

H

X

*

*
*
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1

479 INTRODUCTION 480

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Start by authoring the main riff and build the rest of the 
song around it.

 ▪ Author muted notes and chords as single notes.

 ▪ Author guitar noise as a stream of sixteenth notes.

 ▪ Follow the Orange gem priority list to add Orange gems to 
Medium and Easy.

 ▪ Make sure that trill markers only cover the start of the final 
trilled note.

 ▪ Make sure that strum markers do not cover the final 
tremolo note.

 ▪ Change the velocity of trill and strum markers if you want 
them to work on Hard.

 ▪ If the bass player picks or slaps the bass, remember to 
author the correct right-hand animation.

 ▪ Left-hand animation is optional.

 ▪ Don’t type text events by hand. Load preset text events 
instead. 
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 ▪ Lane shifts
 ▪ Expert, Hard, Medium, and Easy
 ▪ Pro keys animation

14
PRO KEYS
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Pro keys authoring is optional. It requires 
you to author notes played in the original 
performance.

Pro keys requires you to author the pitch of the right-hand keys 
part. This is like authoring vocals, but the range of available 
notes is much smaller. 

A separated keys track, or keyboard stem, will make authoring 
less difficult. Sheet music or MIDIs can also help you wiith Pro 
Keys authoring. Topics covered in this chapter include:

 ▪ The Pro keys template

 ▪ Lane shift notes and note ranges

 ▪ Wrapping notes

 ▪ Overlapping gems

 ▪ Trills and trill markers

 ▪ Glissando lanes

 ▪ Overdrive, Unison, and solo markers

 ▪ Expert, Hard, Medium, and Easy difficulties

 ▪ Character and Pro keys animations

By the end of the chapter you will understand how to author 
Pro keys. This will provide you with a solid foundation for your 
5-lane keys chart.

483

Download links available from: 
rhythmgamingworld.com/customsbook
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Listen to the keyboard part and review the PART 
REAL KEYS template before you start authoring.

THE PRO KEYS MIDI 
TEMPLATE 

AUTHORING PRO KEYS

Trill Marker 
Glissando Marker 
BRE Lanes (x5) 
Overdrive Marker 
Solo Marker 
C4 
B 
Bb 
A 
G# 
G 
F# 
 
 
Eb 
D 
C# 
C2 
A2 - C4 Range 
G2 - B3 Range 
F2 - A3 Range 
E2 - G3 Range 
D2 - F3 Range 
C2 - E3 Range 

PART REAL KEYS X

Two octave range

[PART REAL_KEYS_X]

To the right you can see a 
compact view of the pro keys 
MIDI template.

It is quite different to the 
other Rock Band instrument 
templates.

The majority of the template 
is taken up with a two octave 
range of notes from C2 to C4.

There are also a few special 
notes at the top and bottom of 
the template:

 ▪ Trill marker

 ▪ Glissando marker

 ▪ Overdrive marker

 ▪ Solo marker

 ▪ Lane shift notes 

Text events are at the bottom of 
the template. 

PRO KEYS MIDI 
TEMPLATE

Author the notes played by the right hand of 
the keyboard player in your song.

Lane shift notes

Start with the Expert MIDI in the 
PART REAL_KEYS_X track.

Author the rhythm and pitch 
of the right hand part of the 
keyboard performance.

Consider using separated audio 
tracks to author pro keys. 

Adjust your chart to fit within 
the limitations of a two octave 
range with these techniques:

 ▪ Lane shifting

 ▪ Melodic wrapping

 ▪ Voice adjustment

We discuss these techniques as 
we work through this chapter.

Note: You can add the left-hand 
part if the section is playable 
with one hand in-game.

AUTHORING 
OVERVIEW

PRO KEYS BY C3 AUTHOR JIMANGI
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The PART REAL KEYS X panel to 
the left shows:

 ▪ The two octave range of 
notes for Pro keys

 ▪ Six lane shift notes

Each lane shift range covers a 
span of ten white keys on the 
keyboard. It takes a total of six 
lane shifts to cover the whole 
two octave range.

There are three primary range 
shifts. These are the easiest 
ranges to read in-game.

Note 1: The color code for 
lane shifts is not related to 
the colors on the pro keys 
controller.

Note 2: You should see range 
shifts in the C3 Template. If not 
use the following notes:

 ▪ MIDI note 0: C2-E3

 ▪ MIDI note 2: D2-F3

 ▪ MIDI note 4: E2-G3

 ▪ MIDI note 5: F2-A3

 ▪ MIDI note 7: G2-B3

 ▪ MIDI note 9: A2-C4

In the Piano Roll view of the C3 
Template these notes are all on 
white keys. Never use black key 
notes for lane shifts.

LANE SHIFT NOTES 
AND RANGES 
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Authoring rules for lane shift notes.

LANE SHIFTS

The Pro keys track in-game only 
shows ten white keys at a time:

Most songs do not fit into such 
a small range of notes. Because 
of this limitation we use lane 
shifts to show different ranges 
of notes. 

Try to mostly use the ranges 
below. They are the easiest 
ranges to read in game:

 ▪ A2 - C4

 ▪ F2 - A3

 ▪ C2 - E3
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Lane shift notes set the position 
of a lane shift in-game. Author 
lane shift notes about one 
measure before the first note of 
the new note range. *

 ▪ * This depends on the 
tempo of the song

This allows time for the in-game 
lane shift animation and for the 
player to anticipate the shift.

Keep range shifts notes to a 
minimum. They make gameplay 
more difficult for the player.

Avoid shifting for single notes or 
chords. Try not to shift unless 
there is a measure or more 
before shifting back.

Lane shifts often happen on 
repeated notes or on sustained 
notes. This makes the lane shift 
easier for the player to process. 
This is better than placing a 
lane shift for a new section of 
the song.

There will be cases where 
you need to adjust octaves, 
voicings, and melodic lines. It is 
often better to:

 ▪ Shift a higher set of notes or 
chords down an octave (to 
fit in the current range) or

 ▪ Change a chord voicing if the 
top note or two is out of the 
cuurent range

If this happens make sure that 
the new note placement feels 
natural to play.

If you have a large lane shift 
up or down you might need to 
remove the note entirely.

Any notes that are outside of 
the current range appear to 
the side of the track. Because 
of this we try to add lane shift 
notes as early as possible. Use 
lane shift notes where the notes 
played fit into the current and 
next range of notes.

Each Pro Keys difficulty must 
have a lane shift note at the 
start of the MIDI chart. Author 
the lane shift note before any 

other notes in the song. This 
note will set the starting lane 
shift for the song.

LANE SHIFT 
OVERVIEW

A2 - C4 RANGE SHIFT

LANE SHIFT 
AUTHORING

A#
A3
G#
G3
F#
F3
E3
D#
D3
C#
C3
B2
A#

A2-C4 Range

AUTHOR LANE SHIFTS ONE MEASURE BEFORE THE FIRST NOTE OF THE NEW RANGE

X

A2

Correct Lane Shift Incorrect Lane Shift

START OF EACH 
DIFFICULTYNotes should never 

appear outside the 
current range. Place 
your range shift notes 
so that this does not 
happen.
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WRAPPING NOTES 

In Pro Keys charts long melodic 
lines are often wrapped. This is 
because of the small ranges of 
notes displayed in-game. 

Wrapping here is similar to the 
way we wrap notes for 5-lane 
guitar and bass. 

OVERLAPPING GEMS

491 PRO KEYS 492

When wrapping make sure that 
you do so in a place that makes 
rhythmic and melodic sense. 

Note: Each difficulty has interval 
jumping rules. They specify 
the largest amount of notes 
that you can jump between, 
from high to low or vice versa. 

Be sure to follow the interval 
jumping rules for each difficulty. 

The graphic below shows 
how to wrap out of range and 
unplayable notes inside a single 
note range. 

C#
C3
B2
A#
A2
G#
G2
F#
F2
E2
D#
D2
C#

WRAPPING NOTES IN A PRO KEYS NOTE RANGE

C2

F3
E3
D#
D3

B1
A#

C
3-

E2
 N

O
TE

 R
AN

G
E

C2

A#1 Unplayable Note

F3 Out of Range Note

Lowest Playable Note

THREE AND FOUR GEMS OVERLAPPING

Pro and 5-lane keys both allow 
overlapping gems. Follow 
these guidelines for gems that 
overlap:

 ▪ No more than four 
overlapping gems at a time * 
 
* With more than four 
broken notes in a chord the 
first note should end before 
adding another note.

 ▪ Overlapping notes should 
not span more than an 
octave * 
 
* If a broken chord spans 
more than one octave the 
first note should end before 
adding another note.

 ▪ Expert allows up to four 
overlapping gems

 ▪ Hard allows up to three 
overlapping gems

 ▪ In general Medium does not 
allow overlapping gems * 
 
* Except in rare cases when 
spaced out over a quarter 
note or more.

 ▪ Easy does not allow 
overlapping gems
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TRILL MARKERS 
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Trill markers are used to trigger free form lanes. 
They are for rapid alternating notes.

There may be cases when 
playing the authored part may 
feel better than playing free 
form lanes. For example, when 
the song tempo is too fast or to 
slow. Having said this, free form 
lanes can be a good choice in 
certain situations:

 ▪ If the part is very fast and 
without regard for tempo

 ▪ If it is very difficult to match 
the original performance

 ▪ If there is a very long stretch 
of 16th or 32nd notes

Use this option if it works well 
for your song.

Author trill notes to the rhythm 
of their performance in the song.

Author Trill markers so that they 
cover sets of trilled notes. If the 
notes in the trill change, author 
a new trill marker for those 
trilled notes.

Note: The marker should only 
cover the start of the final note 
of the trill. To do this add .01 
to the length of the trill marker 
(see facing page).

Trill markers are only 
used on Expert Pro Keys.

Trills are only used for 
two notes at a time. 
Three note trills (or 
higher) will break the 
game. For more on 
trills see page 155.

TRILL MARKER 
OVERVIEW
Author trill markers on MIDI 
note 127 (G8):

When a player plays the notes 
in a (trill marker) free form lane:

 ▪ They do not have to play the 
authored rhythm

 ▪ They must play alternating 
notes at 160ms or faster *

* If the player plays below 
160 ms the free form lanes 
disappear. The player must then 
play the trill as authored.

 
 
Trill Marker 
Glissando Marker 
BRE 
BRE 
BRE

PART REAL_KEYS_X

WHEN TO USE 
TRILL MARKERS

AUTHORING TRILL 
MARKERS

AUTHORING TRILL 
NOTES

Author trill markers to cover trilled notes. The 
last note of the trill is only partially covered.

112.3112.2 112.4

Here you can see a 16th note 
trill and trill marker. The marker 
starts at the beginning of the 
first note of the trill. 

Author the marker so that it 
ends at the start of the last 
note of the trill. 

Then follow these steps to 
extend the marker to cover the 
start of the last note of the trill:

 ▪ Click the trill marker to 
select it

 ▪ Press Ctrl + F2 to open the 
Note Properties window

 ▪ In the Length field add 0.1 to 
the note length value *

* In this case the note length 
changed from 0.2.00 to 
0.2.01.

 ▪ Click OK to close the Note 
Properties window.

112.1

TRILL MARKER

AUTHORING TRILL MARKERS
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Glissando is a slide from one pitch to another.

GLISSANDO LANES OVERDRIVE, UNISON, AND 
SOLO MARKERS
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On keys, glissando is a slide up 
or down the keyboard on the 
white or black keys. 

Famous examples include:

 ▪ The start of “I Want You 
Back” by The Jackson 5

 ▪ The start of “Dancing Queen” 
by ABBA

For very elaborate glissandos 
check out the intro to “I 
Don’t Like Mondays” by The 
Boomtown Rats.

Finally, “Great Balls of Fire” by 
Jerry Lee Lewis has glissandos 
throughout the whole song.

Follow these rules when you 
use glissando lanes:

 ▪ Use glissando lanes for 
reasonable playable 
glissandos 

 ▪ Try to use glissando lanes 
for glissandos of a quarter 
note or longer

 ▪ Only author white notes in a 
glissando lane

 ▪ Space notes evenly between 
the start and end of the 
glissando

Overdrive and Unison phrases 
are authored for all instruments 
at the same time. 

There is a special caveat when 
you author Pro Keys and Keys:

 ▪ Overdrive and Unison 
phrases in the Pro Keys and 
Keys tracks must match

 ▪ Author Overdrive and Unison 
phrases in the PART REAL_
KEYS_X and PART KEYS 
tracks

For detailed authoring rules 
refer to Chapter 17. The rules for 
Overdrive and Unison phrases 
start on page 595. 

 

GLISSANDO 
MARKERS
Author Glissando markers on  
note 127 (G8):

 ▪ Glissando markers do not 
usually cover the first note 
of the glissando * 
 
* This encourages players to 
play the glissando.

 ▪ Notes covered by a glissando 
marker are not scored * 
 
* The player can play any 
notes to get a score for 
playing the glissando

 
 
Trill Marker 
Glissando Marker 
BRE  
BRE  
BRE

PART REAL_KEYS_X

GLISSANDO 
EXAMPLES

GLISSANDO NOTE 
AUTHORING

Note: Glissando is only 
authored on Expert 
difficulty.

OVERDRIVE AND 
UNISON PHRASES

PRO KEYS SOLO 
MARKERS
Author solo markers on note  
115 (G7):

Follow the same rules for solo 
markers as the other Rock Band 
instruments (see page 611).

 
 
BRE  
BRE  
BRE (Use all 5) 
Overdrive Marker 
Solo Marker

PART REAL_KEYS_X

 
 
BRE  
BRE  
BRE (Use all 5) 
Overdrive Marker 
Solo Marker

PART REAL_KEYS_X
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Author the right-hand part played in the original 
performance.

EXPERT PRO KEYS 

Remove unnecessary 16th notes. Reduce the 
interval between jump notes and the number of 
notes in chords.

HARD PRO KEYS
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Expert chords can contain up 
to four notes, within the span 
of an octave. (An octave is eight 
white keys or 12 semitones).

You can use lane shifts in 
Expert Pro Keys.

Note: A very short lane shift is 
not recommended. For example, 
do not shift to one or two notes 
in the middle of a larger pattern. 
In this case it may make more 
sense to adjust those notes into 
the visible range of notes. 

Sustained notes need space 
between the sustained note(s) 
and the note(s) that follow.

 ▪ For simple transitions leave 
a 16th note gap * 
 
* For example, single notes 
to single notes, or a single 
note into a chord that uses 
that note.

 ▪ For other transitions leave 
an eighth note gap * 
 
* For example:

 ▪ A transition between two 
chords, or 

 ▪ A transition between a chord 
and an unrelated note

Expert Pro Keys use the PART 
REAL_KEYS_X track:

 ▪ Expert gems are MIDI notes 
42 (C2) to 72 (C4)

Author Pro Keys as follows:

 ▪ Start with Expert and 
rhythmically chart the actual 
keys performance

Your 5-lane keys chart should 
reflect the part played by the 
right hand of the keyboardist in 
your song. 

You may keep sections that add 
the left hand part if the section 
is playable with one hand.

EXPERT PRO KEYS 
OVERVIEW

EXPERT PRO KEYS 
CHORDS

LANE SHIFT 
NOTES

SUSTAINED NOTE 
GAP

Hard chords should only contain 
two or three notes, within the 
span of seven white keys (11 
semitones). 

You can use lane shifts in Hard 
Pro Keys.

After reducing from Expert 
make sure to remove lane shifts 
that are no longer needed.

Keep the initial lane shift from 
the start of the Expert chart.

Try to avoid interval jumps 
larger than seven white keys (11 
semitones). If you cannot avoid 
such a large jump leave twice 
as much space between the 
notes. This may involve reducing 
sustain note length or removing 
extra notes.  

 

Author Hard Pro Keys on the 
PART REAL_KEYS_H track:

 ▪ Hard gems are MIDI notes 42 
(C2) to 72 (C4)

Hard Pro Keys should be a more 
playable version of the Expert 
chart. Start by removing:

 ▪ Unnecessary 16th notes

 ▪ Grace notes *

 ▪ Any left hand part included 
in Expert 
 
* Grace notes are extra 
decorative notes that are 
not vital to the harmony or 
melody. 

HARD PRO KEYS 
OVERVIEW

HARD PRO KEYS 
CHORDS

LANE SHIFT 
NOTES

INTERVAL JUMPS 
BETWEEN NOTES

SUSTAINED NOTE 
GAP

Sustain notes should be the 
same as they are in Expert. The 
exception is when you reduce 
sustains for interval jumps.
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Leave a quarter note between gems. Reduce 
the interval between jump notes. Reduce 
chords to two notes.

MEDIUM PRO KEYS 

Leave about a half note between gems. 
Reduce the interval between jump notes. 
Reduce chords to single notes.

EASY PRO KEYS
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Author Medium Pro Keys on the 
PART REAL_KEYS_M track:

 ▪ Medium gems are MIDI notes 
42 (C2) to 72 (C4)

Reduce Medium Pro Keys to the 
basic rythmic core of the song, 
following these rules:

 ▪ A quarter note between each 
playable gem

 ▪ Two note chords 

 ▪ No Lane shifts

 ▪ Small interval jumps

MEDIUM PRO 
KEYS OVERVIEW

Medium chords should only 
contain two notes, within 
the span of six white keys (9 
semitones).

If this is not possible reduce 
chords to the most prominent 
single note. 

Try to avoid interval jumps 
larger than six white keys (9 
semitones). If you cannot avoid 
such a large jump leave extra 
space between the notes. This 
may involve reducing sustain 
note length or removing notes.

MEDIUM PRO 
KEYS CHORDS

LANE SHIFT 
NOTES

INTERVAL JUMPS 
BETWEEN NOTES

SUSTAINED NOTE 
GAP

Lane shifts are not allowed on 
Medium Pro Keys. Instead, shift 
notes so that they fit within the 
visible range of your choice. 

Note: Each range covers a 
span of 10 white keys on the 
keyboard. The total range, 
including black keys, is 16 
semitones.

Sustain notes should have a 
quarter note gap between the 
end of the sustain and the next 
note. This may make some 
sustains too short.

For example, reduce most 
sustains shorter than 3/16ths to 
16th notes. * 
 
* This is the case for most song 
BPMs.

Author Easy Pro Keys on the 
PART REAL_KEYS_E track:

 ▪ Easy gems are MIDI notes 42 
(C2) to 72 (C4)

The rules for Easy Pro Keys are:

 ▪ About a half note between 
each playable gem

 ▪ No chords 

 ▪ No Lane shifts

 ▪ Smaller interval jumps

EASY PRO KEYS 
OVERVIEW

Chords are not allowed on Easy 
Pro Keys.

Reduce all chords to the most 
prominent, musically sensible 
single note.  
 

Try to avoid interval jumps 
larger than five white keys (7 
semitones). If you cannot avoid 
such a large jump leave extra 
space between the notes. This 
may involve reducing sustain 
note length or removing notes.

EASY PRO KEYS 
CHORDS

LANE SHIFT 
NOTES

INTERVAL JUMPS 
BETWEEN NOTES

SUSTAINED NOTE 
GAP

Lane shifts are not allowed on 
Easy Pro Keys. 

The visible range of notes 
should be the same as it is for 
Medium Pro Keys.

Sustain notes on Easy Pro Keys 
should be the same as Medium.
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Text events are used for character animation.

CHARACTER ANIMATION 

TEXT 
EVENTS

CHARACTER  
ANIMATION

ANIMATION 
MARKERS

KEYS ANIMATION 
 EXAMPLE

1 3

Count-in: No character 
animations.

After count-in: Keyboardist is 
not playing but is moving to 
the beat, use [idle].

Keyboardist starts to play: Use 
[play], [mellow], or [intense].

Keyboardist plays solo: Use 
[play_solo]. When solo ends 
use the [play] marker.

Band starts to play: Use [play], 
[mellow], or [intense]. At end 
of song use: [idle_realtime]

[idle_realtime] [play]

[idle] [mellow]

If you use CAT to generate 
character animations you may 
need to:

 ▪ Add character animation 
text events

 ▪ Modify text events

 ▪ Change the position of text 
events

In the example above you can 
see song sections and character 
animation text events.

Note: Some of the text events 
begin an eighth note early or an 

eighth note late. This is so that 
the animation does not start or 
end abruptly with the music. 

With proper spacing like this, 
your animations will flow with 
the music.

[idle_realtime]

Character animations should not be added 
between measures one and three.

COUNT-IN NO KEYS KEYS

KEYSKEYS BAND STOPS

Text events are placed to set 
the character animation state:

You can use CAT to create these 
markers if you wish:

 ▪ Press F9 to open CAT

 ▪ Press the Create Animation 
Events button

The Create animation markers 
dialogue will open:

 ▪ In the Select Instrument 
menu select Pro Keys

 ▪ In the Select Expression 
menu slect Play, Mellow, or 
Intense

 ▪ Click the Create markers 
button

Animation text events are 
placed in the PART REAL_
KEYS_X track. Adjust these text 
events if needed.

[play]

[idle_realtime] The character does not move to the beat 
of the music. The character is waiting for 
their cue. This is useful in slower songs, 
or slow parts in a song.

[idle]

[play] The character is playing.

[mellow] The character is playing in a mellow 
manner.

[intense] The character is playing in an intense 
manner. For example, aggressive metal.

The character will bop and wave to the 
beat of the music. Use [idle] before the 
song starts, after the song finishes, or 
during downtime. Downtime is at least 
two measures of rest.

[idle_intense] Character is idling in an intense manner.

[play_solo] The character is playing fast notes and 
showing off.

Load these text events 
into REAPER:

Use the Instruments text events list. 
See pages 125 — 126.

[play_solo] [play]

For a short puase you 
can use: [mellow]. 
For more than two 
measures use [idle].
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LEFT AND RIGHT 
HAND ANIMATION 
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Author left and right-hand 
animations for Pro Keys in the 
following tracks:

 ▪ PART KEYS_ANIM_RH

 ▪ PART KEYS_ANIM_LH

Use notes C2-C4. 

In Rock Band most Pro Keys 
charts are right-hand only. To 
animate the right-hand simply 
copy the Expert Pro Keys chart 
to the PART KEYS_ANIM_RH 
track. CAT can do this for you:

 ▪ Press F9 to open CAT

 ▪ Click the Create pro keys 
animations button

It is OK to only have right-hand 
animations in-game. 

You can author left-hand 
animations more generally if you 
need them. Make sure that they 
line up with the rhythm of the 
song in a reasonable way. 

Putting left and right hand 
animations together can be a 
challenge though. The in-game 
keyboard only has a range of 
three octaves. You can see 
this in the graphic below. The 
challenge comes from the 
overlap between the left and 
right-hand animations. This 
happens in the middle octave 
on the keyboard.

If there is a left-hand part you 
may need to: 

 ▪ Move the left-hand 
animations to lower keys

 ▪ Move the right-hand to 
higher keys

To have all the parts that you 
need for Expert Pro Keys:

 ▪ Author the entire part, 
including the left-hand

Then move the left-hand parts 
to the left-hand animation 
track.  Finally copy the 
remaining right-hand part to the 
right-hand animation track.

LEFT-HAND ANIMATIONSC2 C4

C2 C4RIGHT-HAND ANIMATIONS

THREE OCTAVE RANGE
IN-GAME KEYBOARD

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1

INTRODUCTION 504

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Author the pitch and rhythm of the right-hand keyboard 
performance.

 ▪ Author a starting lane shift in each Pro Keys track.

 ▪ Try to use only the primary lane shift ranges.

 ▪ Place lane shift notes so that the part feels natural to play.

 ▪ No notes should be visible outside of the current note 
range.

 ▪ Wrap notes that are unplayable or outside of the current 
note range.

 ▪ Use trill markers when appropriate. Make sure that you only 
cover the start of the final trilled note with a trill marker.

 ▪ Glissando lanes are for playable glissandos that last a 
quarter note or more.

 ▪ Overdrive and Unison phrases must be identical in Pro Keys 
and 5-lane Keys charts.

 ▪ Use the right-hand Expert chart for right-hand animation.

PRO KEYS



 ▪ Expert, Hard, Medium, and Easy
 ▪ Character animation
 ▪ Common authoring mistakes

5-LANE  
KEYS

15
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In this chapter we cover how to author 
basic (5-lane) keys.

Read Chapter 14 “Intro to Guitar, Bass, and Keys” before working 
through this chapter. It contains shared rules and concepts 
that apply to authoring basic keys.

Authoring 5-lane keys is like authoring 5-lane guitar or bass 
parts. The main differences are sustained notes and chords.

In this chapter we will cover:

 ▪ Lane consistency for keys

 ▪ Extra chords for keys

 ▪ Overlaps and sustains

 ▪ Rules for authoring Expert, Hard, Medium, and Easy

 ▪ Character animation

 ▪ Example reductions

Download links available from: 
rhythmgamingworld.com/customsbook
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Listen to the keyboard part and review the PART 
KEYS template before you start authoring.

GETTING STARTED WITH 
EXPERT KEYS 
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The official RBN docs suggest 
authoring Pro keys before 
tackling Basic keys. 

Doing so can give you a good 
idea of the:

 ▪ Melodic structure, and

 ▪ The correct rhythms

Basic keys authoring is very 
similar to authoring 5-lane 
guitar and bass. Use your Pro 
keys chart as a general guide for 
your 5-lane keys part.

The shared rules and concepts 
that apply to guitar, bass, and 
keys are covered in Chapter 14.

This includes:

 ▪ Note Consistency 
When to tie notes and gem 
colors together

 ▪ Chord Consistency 
Consistent use and motion 
of chords

 ▪ Preserving Motion 
The flow and motion of 
gems. How the song feels 
to play

 ▪ Lane Consistency 
The lane focus for each 
difficulty. This includes gem 
consistency between each 
difficulty

 ▪ Quantized MIDI Notes 
Chart notes to the MIDI grid. 
This removes imperfections 
found in the original 
performance

 ▪ Wrapping Notes 
Author melodic lines into 
patterns that fit in a five 
gem range

 ▪ Chords 
The five basic chord types 
and their “feel”

 ▪ Sustained Notes 
The rules for authoring held 
notes

You should review these topics 
before you start to author your 
keys chart.

Additional information that is 
specific to keys is contained in 
this chapter.

The gem layout for basic 5-Lane 
keys is as follows:

BASIC KEYS 
LAYOUT

High notes

Low notes

Basic (5-lane) keys are authored 
on the PART KEYS track:

 ▪ Expert gems are MIDI notes 
96 (C6) to 100 (E6)

You can see these notes in the 
graphic to the right. The graphic 
show the top section of the 
PART KEYS template.

Author keys as follows:

 ▪ Start with Expert and 
rhythmically chart the actual 
keys performance

 ▪ Adjust the notes to best fit 
the five basic gems

Your 5-lane keys chart should 
reflect the part played by the 
right-hand of the keyboardist in 
your song. 

EXPERT KEYS 
OVERVIEW

EXPERT KEYS 
TEMPLATE 

 
 
Trill Marker 
--- 
BRE 
BRE 
BRE 
BRE 
BRE 
--- 
Overdrive 
--- 
Solo Marker 
Force HOPO Off 
Force HOPO On 
 
Expert Orange 
Expert Blue 
Expert Yellow 
Expert Red 
Expert Green 
 

PART KEYS

To change the PART 
KEYS notes to Rock 
Band colors see pages 
121 — 122.  

A NOTE ABOUT 
PRO KEYS

Note: You do not have 
to author a Pro keys 
chart. You can author 
5-lane keys without 
authoring the Pro keys 
part at all. 

REVIEW THE “INTRO TO GUITAR, BASS, 
AND KEYS” CHAPTER
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Each gem color found in Expert must be used 
at least once in the other difficulties.

LANE CONSISTENCY 

There are extra three note chords that can be 
used for keys.

CHORDS

511 KEYS 512

Lane consistency for keys is not 
quite the same as it is for guitar 
and bass.

In 5-lane keys the gem focus 
is five notes, regardless of 
difficulty. This means that there 
are no hand position shifts 
for keys. Despite this there 
are situations that present 
challenges when authoring keys.

GEM FOCUS FOR KEYS

X

H

M

E

For example, songs with less 
than five chords are hard to 
Reduce to Easy. This is because 
chords are not allowed in Easy.

You cannot use all five gems 
with only four chords.

In this case you can use a 
restricted range of notes (most 
likely Green to Blue).

The Lane Consistency 
topic for guitar and 
bass in on page 387.

Three note chords are usually 
used for non-standard or “big” 
sounding chords:

 ▪ Augmented chords

 ▪ Seventh chords

 ▪ Diminished chords

They are also used for normal 
chords that have tension added 
to them.

For 5-Lane keys there are two 
types of 3 note chords:

 ▪ Standard three note chords 
used for keys, guitar and 
bass (bottom left), and

 ▪ 3 note chords that include a 
note between the Green and 
Orange gems. (See the Keys 
Only graphic).

Note: You may lose motion 
consistency if you mix standard 
and keys only chords together. 

Always make sure that keys 
only chords feel good within the 
overall part when using them.

KEYS ONLY

You can use all the 
chord types shown on 
this page for keys. 

To review how to use 
each chord type see 
pages 391 — 392.

GUITAR, BASS, AND KEYS CHORDS

As with guitar and bass, any 
gem color missing from Expert 
cannot be used in the other 
difficulties.

So, if Expert only has Green, 
Red, Yellow, and Blue gems then 
this should apply to the other 
difficulties as well.
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Some of the rules for sustained notes and 
overlaps on 5-lane keys are different than 
for guitar and bass.

OVERLAPS AND SUSTAINS 

There should be a gap between 
the end of a sustained note and 
the start of the next note:

 ▪ The gap should be at least a 
1/32nd note gap

 ▪ A 1/16th note gap is standard

513 KEYS 514

Rock Band does not have a 
sustain pedal for keys. So we 
recommend an 8th note gap 
between sustained chords. This 
prevents the stem from muting 
while the player is changing 
chords. This also means that 
quarter notes chords do not 
have sustains.

16TH NOTE GAP

1/16th note gap
1/4 NOTE CHORDS8TH NOTE CHORD GAP

> 100 BPM

< 100 BPM

You can use short sustains at 
slower tempos:

 ▪ < 100 BPM only author 
sustains for notes longer 
than an 8th note

 ▪ > 100 BPM only author 
sustains for notes longer 
than 3/16th notes 

The rules for overlapping notes 
on keys are as follows:

 ▪ There should be no more 
than three overlapping notes 
at a time

SUSTAIN NOTE 
GAP

OVERLAPPING 
NOTES

SHORT SUSTAIN 
NOTES

3 OVERLAPPING NOTES

GAPS BETWEEN 
CHORDS

If standard sustains do mute 
stems use the guide below:

BPM Note Gap 
< 61 16th note 
61-120 8th note  
121-160 Dotted 8th note  
161-239 Quarter note  
240 + Dotted quarter note 

Note: This may mean that 
audible sustains may not have 
visible note tails.

MUTED STEM 
CHORDS & NOTES

OVERLAPS AND SUSTAINS 2
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Tips and tricks for authoring Expert keys.

EXPERT TIPS AND TRICKS  

Hard should be the “reasonable” version of 
Expert. Expert players should be able to score 
100% on Hard with minimal practise.

HARD

515 KEYS 516

If you have separated audio or 
stems:

 ▪ Solo and listen to the keys 
part all the way through 
before authoring

 ▪ Pay attention to changes 
between sections, chords, 
and melodic lines

This will give you sense of the 
structure of the song. 

With this, there should be less 
need to make big changes to 
your authoring as you progress.

SOLO THE KEYS 
TRACK

Try starting with the central 
riff or chord progression of the 
song:

 ▪ Build the rest of your 
authoring around that 
central element

Knowing how you want the 
most important part to feel will 
help inform you how to author 
the rest of the song.

CENTRAL RIFF OR 
PROGRESSION

AUTHORING 
GRACE NOTES

REPETITION IN 
SONGS
Some songs may contain a lot 
of repetition.

In this case it can often be 
faster to:

 ▪ Author the repeating section 
for all difficulties, then

 ▪ Copy and paste the section 
through the rest of the song

LISTEN TO THE 
FULL MIX
It helps to listen to the full mix, 
turned down, when authoring.

This will help you focus on the 
rhythm and musical context of 
the part that you are authoring.

Author grace notes in melodic 
lines and solos as follows:

 ▪ Add a 16th note at the start 
of the note, one gem lower 
than the target gem

GRACE NOTE

Author Hard gems on notes 84 
(C5) to 88 (E5):

 
Reduce your Expert chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction (5-Lane) button

 ▪ Uncheck Medium and Easy

 ▪ Under Options make sure 
that the instrument is set 
to Keys

 ▪ Click the Reduce button

HARD KEYS 
OVERVIEW

 
Hard Orange 
Hard Blue 
Hard Yellow 
Hard Red 
Hard Green

PART KEYS

H

REMOVE SUBTLE 
VARIATIONS

SUSTAIN NOTE 
LENGTH
Sustains in Hard should be the 
same as in Expert.

Note: CAT will take care of this 
for you when you reduce your 
chart from Expert to Hard.

Remove subtle variations so 
that parts are more consistent:

 ▪ Start by removing 16th notes 
or faster * 
* This decision is based on 
the tempo of the song.

 ▪ Adjust note wrapping for 
Hard. See page 519.

H

X

H

X

AUTHORING 
TRILLS
For trills refer to the topics on 
pages 527 — 528.

SUSTAIN LENGTHREMOVE VARIATIONS
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Long sections of three note chords can be 
thinned out. 

HARD (CONTINUED) 

Reduce 16th note triplets to make them easier 
to play on Hard. 

517 KEYS 518

THREE NOTE 
CHORDS
Three note chords are allowed 
in Hard.

Note: If you need to make long 
passages of three note chords 
easier to play in Hard you can 
thin them out. 

H

X

“CHINA ROAD” BY THE DOOBIE BROTHERS

For example, the reduction for 
“China Road” below. 

There is space between the 
main chord changes. There is 
also a single note lead-in to the 
Blue / Yellow chord at the end. 

CONTINUOUS 8TH 
NOTES
For continuous 8th notes the 
official docs recommend:

 ▪ At 160 BPM or more, remove 
every fourth 8th note per 
measure

H

X

CONTINUOUS 8TH NOTES 

REDUCING 16TH 
NOTE TRIPLETS
There are two ways to reduce 
16th note triplets for Hard:

 ▪ Remove the second note of 
each triplet (method A)

 ▪ Remove the third note of 
each triplet (method B)

H

X

METHOD A

Choose the method that feels 
the best to play. Both methods: 

 ▪ Preserve the syncopated 
groove of the triplet

 ▪ Make the part easier to play

H

X

METHOD B

In practice, Harmonix removes 
the last 8th note per measure. 

If the 8th notes are very fast 
and have motion, then keep the 
motion notes for Hard.
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HARD (CONTINUED) 

Try to maintain as much of the rhythmic and 
melodic feel of Expert and Hard but in a way 
that is much easier to play.

MEDIUM

519 KEYS 520

preserve the motion of the 
Expert chart.

You can see the correct way to 
reduce and wrap notes in the 
“Correct Wrapping” graphic.

 

H

X

CORRECT WRAPPING

After you have removed notes 
on Hard you may have to wrap 
the remaining notes.

For an example, look at the 
Hard reduction below. The 
remaining 8th notes do not 

H

X

INCORRECT

WRAPPING NOTES 
ON HARD

This Hard chart has an 8th note 
spacing with wrapping that 
preserves motion.

Note: Reductions allow more 
space between notes. This 
provides more linear motion.

Author Medium gems on notes 
72 (C4) to 75 (D#4):

 
Reduce your Hard chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction (5-Lane) button

 ▪ Uncheck Hard and Easy

 ▪ Under Options make sure 
that the instrument is set 
to Keys

 ▪ Click the Reduce button

MEDIUM KEYS 
OVERVIEW

 
Medium Green 
Medium Blue 
Medium Yellow 
Medium Red 
Medium Orange

PART KEYS

H

REMOVE 8TH 
NOTES
Removing the remaining 8th 
notes from Medium is a good 
way to reduce from Hard:

 ▪ Try to only have playable 
notes on strong quarter note 
beats

Note: You can keep some 
8th notes in Medium. But 

M

the context, song BPM, and 
instrument tier are key factors 
in this decision.

For example, in “Roundabout” 
by Yes there are quarter note 
and 8th note passages.

You can see the context, BPM, 
and instrument tier below:

M

H

M

H

128 BPM IMPOSSIBLE 118 BPM IMPOSSIBLE
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MEDIUM (CONTINUED) 
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Keep all chords from Hard 
unless it does not make sense 
to do so. For example, if:

 ▪ Chords represent 
harmonizing keyboard parts

KEEP CHORDS 
FROM HARD

AVOID FAST 
CHORD CHANGES
Try to avoid fast chord changes. 

You can so this in a couple of 
ways. You can, for example, 
make fast quarter note chord 
changes into single notes. 

You can see this in “Whip It” by 
Devo where the tempo is about 
160 BPM. Warmup tier.

M

H

KEEP CHORDS

M

H

“WHIP IT” BY DEVO

When you keep chords take the 
musical context and instrument 
tier into account. For example, 
“Break On Through (To The 
Other Side)” by The Doors 
(Challenging tier, 190 BPM).

Use the method that works best 
for your song.

M

H

“BREAK ON THROUGH”

SUSTAIN NOTE 
DURATION

If you manually shorten sustains 
look out for note tails that are 
too short. This can occur with 
sustained chords that have an 
8th note gap between them.

Finally, if a sustain looks too 
short in-game then reduce it to 
a standard 16th note:

 ▪ Reduce sustained notes that 
are less than a quarter note 
in length to 16th notes

 ▪ Chords should have a 1/4 
note of space between them

Sustains should be shorter in 
Medium to give the player more 
time between notes:

 ▪ Try to leave a quarter note 
between the end of a note 
and the start of the next

 ▪ Use the Fix sustains script 
in CAT 

M

H

SUSTAIN DURATION

NO THREE NOTE 
CHORDS
Three notes chords are not 
allowed on Medium.

You should reduce three note 
chords to two note chords.

For example, “China Grove” by 
The Doobie Brothers (below).

M

H

NO 3 NOTE CHORDS
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MEDIUM (CONTINUED) 
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When reducing triplets in 
Medium:

 ▪ Keep only the downbeat of 
each triplet

You can see this in both of the 
triplet patterns below:

Both 16th note triplet patterns 
in Hard produce an 8th note 
pattern in Medium.

If the strong beats of a song are 
upbeats, or syncopated, do not 
remove them in haste.

Removing every other 8th note 
is not always the best way to 
reduce notes.

It is better to leave more space 
between syncopated notes than 
to leave them out.

KEEP THE 
RHYTHMIC FEEL 

M

H

“HEART OF GLASS” 

M

H

TRIPLET METHOD A

REDUCE TRIPLETS

M

H

TRIPLET METHOD B

WRAP NOTES FOR 
MEDIUM
After you remove 8th note gems 
you will need to adjust your 
wrapping again. For example, 
if you remove 8th notes from 
Hard (in the graphic below) 
these 1/4 note gems remain:

M

H

NOTE WRAPPING

These gems do not preserve the 
motion of the part. So, adjust 
the gems to Blue, Yellow, Red, 
and Green.

Note: You may not be able to 
wrap notes visually based on 
the pattern of the Hard gems.

For example, is the jump from 
Red to Blue in Hard:

 ▪ A higher pitched note, or

 ▪ A descending note wrapped 
to Blue

This should be clear from 
listening to the song.

Always make sure that your 
wrapped notes feel right for the 
authored part.
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Easy difficulty should be easy to play. 

EASY 

525 KEYS 526

Author Easy gems on notes 60 
(C3) to 62 (D3):

 
Reduce your Medium chart:

 ▪ Press F9 to open CAT

 ▪ Click the Automatic 
reduction (5-Lane) button

 ▪ Uncheck Hard and Medium

 ▪ Under Options make sure 
that the instrument is set 
to Keys

 ▪ Click the Reduce button

EASY KEYS 
OVERVIEW

 
Easy Orange 
Easy Blue 
Easy Yellow 
Easy Red 
Easy Green

PART KEYS

H

EASY SHOULD BE 
EASY
Easy should not be difficult to 
play. The Easy player should be 
able to:

 ▪ Look at the game track

 ▪ See the note

 ▪ Look at their keyboard

 ▪ Play the note

 ▪ Look for the next note

That is a lot to do between 
notes, so leave a good amount 
of space between them.

If Easy is not challenging enough 
the player will just move up to 
Medium difficulty.

E

Remove the remaining quarter 
notes where possible.

It is good practise to leave a 
half note space between notes 
for Easy players.

E

M

HALF NOTES

REMOVE QUARTER 
NOTES

Reduce chords to single notes 
on Easy.

See “Subdivisions” by Rush as 
an example (below).

E

M

NO CHORDS

NO CHORDS ON 
EASY

Sustained notes on Easy should 
be the same as they are on 
Medium.

E

M

SUSTAINED NOTES

SUSTAINED 
NOTES
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AUTHORING TRILL MARKERS
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Trill markers are used to trigger free form lanes. 
They are for rapid alternating notes.

TRILL MARKERS 

There may be cases when 
playing the authored part may 
feel better than playing free 
form lanes. For example, when 
the song tempo is too fast or to 
slow. Having said this, free form 
lanes can be a good choice in 
certain situations:

 ▪ If the part is very fast and 
without regard for tempo

 ▪ If it is very difficult to match 
the original performance

 ▪ If there is a very long stretch 
of 16th or 32nd notes

Note: Trills are only used for 
two alternating notes. Three 
note trills or higher will break 
the game. 

Author trill markers so that they 
cover sets of trilled notes. So, 
if the notes in the trill change, 
author a new trill marker for 
those notes.

Note: The marker should only 
cover the start of the final note 
of the trill. Do this by adding .01 
to the length of the trill marker 
(see facing page).

To use trill markers 
on Expert and Hard 
change the note 
velocity of the marker. 
See page 176.

For more on trills see 
page 155.

TRILL MARKER 
OVERVIEW
Author trill markers on note 127 
(shown in bold below):

When a player plays the notes 
in a (trill marker) free form lane:

 ▪ They do not have to play the 
authored rhythm

 ▪ They must play alternating 
notes at 160ms or faster *

* If the player plays below 
160 ms the free form lanes 
disappear. The player must then 
play the trill as authored.

 
 
Trill Marker 
--- 
BRE 
BRE 
BRE

PART KEYS

WHEN TO USE 
TRILL MARKERS

AUTHORING TRILL 
MARKERS

Author trill markers to cover trilled notes. This 
includes the start of the last note of the trill.

112.3112.2 112.4

Here you can see a 16th note 
trill and trill marker. The marker 
starts at the beginning of the 
first note of the trill. 

Author the marker so that It 
ends at the start of the last 
note of the trill. 

Then follow these steps to 
extend the marker to cover the 
start of the last note of the trill:

 ▪ Click the trill marker to 
select it

 ▪ Press Ctrl + F2 to open the 
Note Properties window

 ▪ In the Length field add 0.1 to 
the note length value *

* In this case the note length 
changed from 0.2.25 to 
0.2.26.

 ▪ Click OK to close the Note 
Properties window.

112.1

TRILL MARKER
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Text events are used for character animation.

CHARACTER ANIMATION 

529 KEYS 530

TEXT 
EVENTS

CHARACTER  
ANIMATION

ANIMATION 
MARKERS

KEYS ANIMATION 
 EXAMPLE

1 3

Count-in: No character 
animations.

After count-in: Keyboardist is 
not playing but is moving to 
the beat, use [idle].

Keyboardist starts to play: Use 
[play], [mellow], or [intense].

Keyboardist plays solo: Use 
[play_solo]. When the solo 
ends use the [play] marker.

Band starts to play: Use [play], 
[mellow], or [intense]. At end 
of song use: [idle_realtime]

[idle] [play]

[idle] [mellow]

If you use CAT to generate 
character animations you may 
need to:

 ▪ Add character animation 
text events

 ▪ Modify text events

 ▪ Change the position of text 
events

In the example above you can 
see song sections and character 
animation text events.

Note: Some of the text events 
begin an eighth note early or an 

eighth note late. This is so that 
the animation does not start or 
end abruptly with the music. 

With proper spacing like this, 
your animations will flow with 
the music.

[idle_realtime]

Character animations should not be added 
between measures one and three.

COUNT-IN NO KEYS KEYS

KEYSKEYS BAND STOPS

Text events are placed to set 
the character animation state:

You can use CAT to create these 
markers if you wish:

 ▪ Press F9 to open CAT

 ▪ Press the Create Animation 
Events button

The Create animation markers 
dialogue will open:

 ▪ In the Select Instrument 
menu select Keys

 ▪ In the Select Expression 
menu choose Play, Mellow, 
or Intense

 ▪ Click the Create markers 
button

Adjust automatic animation 
markers if needed. Add extra 
animation markers as required.

[play]

[idle_realtime] The character does not move to the beat 
of the music. The character is waiting for 
their cue. This is useful in slower songs, 
or slow parts in a song.

[idle]

[play] The character is playing.

[mellow] The character is playing in a mellow 
manner.

[intense] The character is playing in an intense 
manner. For example, aggressive metal.

The character will bop and wave to the 
beat of the music. Use [idle] before the 
song starts, after the song finishes, or 
during downtime. Downtime is at least 
two measures of rest.

[idle_intense] Character is idling in an intense manner.

[play_solo] The character is playing fast notes and 
showing off.

Load these text events 
into REAPER:

Use the Instruments text events list. 
See pages 125 — 126.

[play_solo] [play]

For a short puase you 
can use: [mellow]. 
For more than two 
measures use [idle].
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EXAMPLE REDUCTION: 
“BREAK ON THROUGH” 
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EXAMPLE REDUCTION: 
“ROUNDABOUT” BY YES

E

M

H

X

Hard 16th notes reduced 
to three per beat in the 

Medium has 8th notes for 
the fast section. Notes  

Easy is quarter notes for 
the fast section. Chords 

130 BPM IMPOSSIBLE TIER 

H M E

fast section. Chords and 8th 
notes are the same as in Expert.

between quarter note chords 
are removed. No 3 note chords.

are single notes. A fast chord 
change is removed.

E

M

H

X

Hard loses an eighth note 
Green to Yellow / Blue 

Medium has a quarter 
note spacing (or more) 

Easy has some quarter 
notes. Chords are single 

188 BPM CHALLENGING TIER 

H M E

jump. This is reasonable given 
the fast tempo.

between notes and chords. notes. Most notes are a half 
measure apart (more or less).

7 8
[intro]

74 75
[chorus_1]
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Author the right-hand rhythms and pitches performed. 

 ▪ Adjust the gems to fit 5-lanes. 

 ▪ Start by authoring the main part and build the rest of the 
song around it.

 ▪ Keys can use three note chords with Green and Orange 
gems.

 ▪ Keys can have no more than three overlapping gems at a 
time.

 ▪ Quarter note chords should not be sustained.

 ▪ Make sure that trill markers only cover the start of the final 
trilled note.

 ▪ Change the velocity of trill markers if you want them to 
work on Hard.

 ▪ Don’t type text events by hand. Load preset text events 
instead. 

KEYS



 ▪ Vocal authoring
 ▪ Character animations
 ▪ Common authoring mistakes

VOCALS

16



Download links available from: 
rhythmgamingworld.com/customsbook

VOCALS

This chapter focuses on how to author a 
single vocal track.

Authoring vocals requires that you chart two things:

 ▪ The pitch sung, and

 ▪ The duration of vowel sounds

A separated vocal track, or vocal stem, makes authoring easier. 

The topics covered in this chapter include:

 ▪ Guidelines for authoring a single vocal track

 ▪ Authoring pitched and non-pitched voices

 ▪ How to author vocal slides, bends, and trills

 ▪ Authoring phrase markers and Overdrive

 ▪ How to format and import lyrics

 ▪ Spanish lyrics

 ▪ Vocal percussion

 ▪ In-game character animations

 ▪ Comparisons of generated vocal MIDI and authored vocals

537 538VOCALS



VOCALS

The main vocal part is authored in the PART 
VOCALS track.

INTRODUCTION TO VOCALS 

To the right is the top and 
bottom parts of the vocal MIDI 
template.

As you can see, this template is 
quite different to the other Rock 
Band instruments.

The majority of the template 
consists a five octave range of 
notes from C1 to C5.

There are also a few special 
notes at the top and bottom of 
the template:

 ▪ Overdrive

 ▪ Phrase Marker

 ▪ Not Displayed Percussion

 ▪ Displayed Percussion

 ▪ Lyric Shift

 ▪ Range Shift

Text events are at the bottom of 
the template. 
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Vocal authoring is usually done 
by ear. Scrub through your audio 
and listen for:

 ▪ The vocal pitch sung

 ▪ The duration of notes in 
each vowel sound

Author the pitches sung and 
their vowel sound duration in 
the MIDI template. 

Author MIDI notes in the 
same octave that the original 
performer sings them. 

If you are using stems:

 ▪ Align the vocal and dry vocal 
stems before authoring

A difference of 30 — 40 ms is 
fine and does not significantly 
impact scoring in-game.

If the timing difference is larger, 
adjust the dry vocal file to 
match the wet vocal file.

If vocal effects make authoring 
difficult then you can author  
from the dry vocal track. If you 
do, check your authoring against 
the wet vocals as this is what 
you will hear in game.

Tip: Dry vocals do not have 
added effects. Wet vocals do 
have added effects.

Use a small grid size when 
authoring vocals.

A 1/16 or 1/32 grid is too large. 
On these grids MIDI notes will 
often start too early or too late 
when compared to the audio. 
This can have an adverse effect 
on scoring.

Use the following grid sizes for 
vocal authoring:

 ▪ 1/64 grid with Snap enabled

 ▪ At around 90 BPM (and 
below) use a 1/128 grid with 
Snap enabled

VOCALS 
OVERVIEW

Overdrive 
Phrase Marker 
Not Displayed Percussion 
Displayed Percussion 
C5 
B 
Bb 
A 
G# 
G 
F# 
E 
Eb 
D 
C# 
C4 
 
 
Eb 
D 
C# 
C1 
Lyric Shift 
Range Shift

PART VOCALS

Five octave range

HOW TO AUTHOR 
VOCALS

DRY AND WET 
VOCAL STEMS

MIDI EDITOR 
GRID SIZE

[PART VOCALS]

Note timing can be 
off in separated vocal 
tracks. I recommend 
using separated vocal 
tracks to author pitch. 
Use the full mix audio 
to author the start and 
end of vocal notes.

Check out Nyxyxylyth’s 
vocal tutorial video:

www.youtube.com/
watch?v=Vt--Pg8Bp_w

http://www.youtube.com/watch?v=Vt--Pg8Bp_w
http://www.youtube.com/watch?v=Vt--Pg8Bp_w


VOCALS

VOCAL CHART OVERVIEW 

The main part of a vocal chart 
is the vocal tubes. They are the 
MIDI notes that mirror the vocal 
performance in your song.

Here you can see vocal tubes on 
notes B, Bb, and A.

Above the vocal tubes are 
Overdrive and phrase markers. 

The game scores each phrase 
on how well it is sung. Overdrive 
is paired with certain phrases 
for additional scoring.

Text events run along the 
bottom of the vocal chart. You 
use them for:

 ▪ Pitched note lyrics *

 ▪ Vocal slides, bends, and 
trills *

 ▪ Non-pitched note lyrics *

 ▪ Character animation

* Lyrics have the text event 
Type set to Lyrics. See the Add 
Text Event window.
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22.1.00
0:33.742

20.1.00
0:30.403

19.1.00
0:28.802

21.1.00
0:32.004

Overdrive

Phrase Marker

Overdrive

----

Phrase Marker

----

Not Displayed Percussion

Displayed Percussion

----

C5

B

Bb

A

pitched + Non# pitched#

Phrase Marker

[intense]

Character animation events are 
always enclosed with brackets  
[ ]. They also have the text 
event Type set to Text Event.

Vocal slides, bends, and trills 
all use the + sign. Use a slide 
(+) for any pitched note that 
changes pitch up or down. You 
can add as many + notes as 
you need to keep track of pitch 
changes.  

We use special characters for 
non-pitched lyrics. Add the # 
sign to text event lyrics to make 
them non-pitched.

Lyric text event for pitched 
vocals

Lyric text event for vocal slide Lyric text event for non-pitched 
vocals

Text event for vocal character 
animation

You only need to author 
vocal parts once. 
The in-game pitch 
detection takes care 
of the vocal difficulties 
for you.

Scrub audio and listen to vocal 
pitches and note duration in 
sung vowel sounds.

Compare the notes sung to the 
MIDI notes in the vocals track.

Draw vocal tubes in the MIDI 
editor that match the original 
vocal performance. 

Use an auto-generated vocal 
MIDI if you need help to identify 
vocal pitches.
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VOCAL TUBES AND 
SEPARATED AUDIO 

Use separated vocals or stems 
to author vocals if you can. 
Either of these will help you to:

 ▪ Author vocal pitches more 
easily, and

 ▪ Author vocal tubes using the 
audio waveform

Scrub your vocal audio to hear 
the pitches sung.

Draw a vocal tube of the correct 
pitch. Then adjust the length of 
the vocal tube.

To do this you need to be sure 
where the vowel being sung 
starts and ends. 

Your audio waveform can help 
you with this. 

In this example, the waveform 
shows the word ‘good’.

There is a hard ‘G’ sound at the 
start of the word, followed by 
the open vowel sound. 

The orange vocal tube charts  
the vowel duration according to 
the waveform. 

The white note tube shows the 
difference between scrubbing 
and looking at the waveform.

In the separated audio I could 
hear the vowel sound forming in 
the white note. 

When I checked the full mix 
I could not hear the vowel 
forming during the white note.

The blue note shows the vowel 
sound tapering off in the full 
mix audio. 

I like to toggle between the 
separated audio and the full 
mix. Then I can scrub the 
waveform to author the pitch 
and vocal tube in one pass.

If any of your note tubes sound 
early or late, can check them 
against the full mix. 

Do not author consonants that 
come after the vowel sound.

Hard ‘G’ sound at the start 
of the waveform. This is not 
authored.

Author the open vowel sound.

Vowel sound onset not heard in 
the full audio mix.

SEPARATED WAVEFORM

PART VOCALS

Vowel sound tapers off. Note: Not all waveforms will be 
as simple as this example. 



VOCALS

You do not have to author more than one 
vocal part for Rock Band. Authoring harmony 
parts is optional.

LEAD VOCALS

Songs often have harmony parts 
or more than one singer. You 
can author the harmonies if 
you would like, but this is not 
required. For songs where you 
only want to author a single 
vocal part there are some 
guidelines to follow:

 ▪ If there are many sung parts, 
author the part that you 
would sing along to

 ▪ Be consistent with parts that 
repeat in the song

For example, don’t author the 
lead vocal in the first chorus 
and the harmony in the second. 
This would confuse the singer.

 ▪ If two or more vocalists sing 
at different times it’s usually 
OK to author each part 
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The example to the right shows 
solo and harmony vocal charts 
for two overlapping phrases. 

The first phrase ends with “with 
your hands”. The second phrase 
begins with “Steal the rhythm”.

The last word of the first phrase 
“hands” overlaps the first word 
of the second phrase “steal”.

The overlapping note is the last 
vocal slide note from the word 
“hands”. It is the orange note in 
the SOLO VOCALS chart. 

Solo notes (PART VOCALS) are 
shown in blue. Harmony notes 
(HARM 2) are colored red.

The solution, if you want to 
chart harmonies, is in the 
HARMONY chart. 

Simply author the first phrase 
to PART VOCALS and the second 
phrase to HARM 2. 

The solution for solo vocals 
here is to shorten the end of 
the first phrase.

In this case removing the last 
vocal slide from the word 
“hands” is enough. This provides 
breathing space between both 
phrases. With the orange note 
removed you can author both 
phrases in PART VOCALS. 

To conclude, when phrases 
and overdubs overlap you have 
to decide how to best break 
them apart. Usually this means 
authoring all of the second 
phrase and less of the first. 

Ultimately your choice depends 
on the following:

 ▪ Which words are the most 
prominent 

 ▪ What makes the most sense 
lyrically

LEAD VOCALS VS 
MANY VOICES

OVERLAPPING 
VOCAL PHRASES

KEY:

with your hands + + + rhy-theSteal

SOLO VOCALS

HARMONY

+

Vocal slides are notated 
with the + symbol.

This graphic shows 
vocal slides in the MIDI 
notes instead of lyric 
text events. 

+

+

+

+

 PART VOCALS notes

 HARM 2 notes

 Vocal slide removed 
from solo vocals+

+

OVERLAPPING VOCALS EXAMPLE: 
“SPOONMAN” BY SOUNDGARDEN



VOCALS

Pitched vocals are words that are sung. 
Author them by charting the pitch and 
vowel duration of each syllable.

PITCHED VOCAL GUIDELINES 

Your Rock Band vocals chart is a 
simplified version of the original 
performance.

Author vocals on MIDI notes C1 
to C5. Note: C5 does not show 
up correctly in Rock Band Blitz.

Vocal charts should not include 
small details such as:

 ▪ Vibrato

 ▪ Short lead-ins *  
 
* A short lead-in is a quick 
change in pitch before the 
main pitch is sung.

As a general rule the following 
are also not included in vocal 
notes tubes: 

 ▪ Consonants at the start or 
end of a syllable

This rule reflects how people 
recognize note lengths when 
they sing. 
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There are a few exceptions to 
the rules:

 ▪ If you ignore loud and long 
consonants from the start of 
a note then it tends to feel 
late in-game

The solution is to chart the very 
end of the consonant. 

For example, you can chart the 
very end of a loud and long “Sh” 
or “S” sound.

 ▪ Determining when a note 
ends can depend on what 
you hear in-game

This is especially true for long 
notes that gradually fade in 
volume. In this case the note 
charted from the vocal track 
might be longer than what you 
hear in the full mix. 

In this case shorten notes to 
match what you hear in-game.

Note-on and note-off timing is 
when vocal notes start and end.

Note-on timing in particular is 
very important. It is a big focus 
of attention for players:

 ▪ Note-on timing should be 
very accurate

Note-off timing is less of a 
focus for players. You can 
sometimes make exceptions for 
note-off timing: 

 ▪ You can shorten notes to 
give other game elements a 
higher priority

For example, when:

 ▪ There are not enough places 
to deploy overdrive

 ▪ There is not enough room for 
the player to breathe

Rock Band 3 has a bug in the 
vocal system that impacts 
scoring. This bug can happen in 
the following situation:

 ▪ The last note in a phrase is 
pitched

 ▪ The first note in the next 
phrase is non-pitched

The bug makes these phrases 
extremely difficult to combo.

The bug mostly appears with 
short vocal phrases that have a 
small gap between them.

Regardless of phrase length you 
should follow best practices 
and use this solution:

 ▪ Leave a 16th note gap (four 
64th notes) between the 
two phrases

This means that you may have 
to shorten the phrase that ends 
with a pitched note.

Sometimes a syllable will 
change pitch. When this 
happens:

 ▪ Chart the vowel sound of the 
starting pitch until it begins 
to change

 ▪ Chart the continued vowel 
sound of the next pitch

Repeat the second step as 
many times as needed if a 
syllable has multiple notes.

Note: The gap between pitch 
change notes can vary. It 
depends on: 

 ▪ How much the pitch changes

 ▪ How slowly or quickly the 
pitch changes

A larger change in pitch tends to 
take longer. 

Always make sure that there 
is space between the end of 

one note and the start another. 
Vocal notes should not touch 
each other.

Pay particular attention to the 
space between vocal slides. 
A small space between slide 
notes creates a quick jump 
between notes. A larger space 
produces a slower, more 
gradual change between the 
two pitches. Note: If there is no 
space between slide notes they 
will appear as separate notes 
in-game. The lyrics for these 
notes will not show up in-game.

SIMPLIFIED VOCAL 
CHARTS

EXCEPTIONS TO 
THE RULES

NOTE-ON AND 
NOTE-OFF TIMING

PHRASE GAP 
COMBO BUG

SYLLABLES WITH MULTIPLE NOTES AND 
NOTE SPACING

Enable ReaSynth on 
your vocal MIDI track(s). 
This will let you listen 
back to the vocal notes 
that you have authored.

See pages 293 — 294.



VOCALS

Non-pitched vocals are words that are spoken 
or shouted. To author, chart the vowel sound of 
each non-pitched syllable.

NON-PITCHED VOCAL 
GUIDELINES 

Non-pitched notes are authored 
with the same general rules as 
pitched notes. 

This means that we do not 
include:

 ▪ Consonants at the start or 
end of a syllable

This keeps note tube timing 
consistent and avoids confusing 
the player.
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Sometimes a word has pitched 
and non-pitched syllables.

In this case:  

 ▪ Make the whole word either 
pitched or non-pitched

You will have to decide which 
option makes the most sense:

 ▪ Do not mix pitched and 
non-pitched syllables in the 
same word

Try to avoid mixing pitched and 
non-pitched words in a single 
vocal phrase. This is because:

 ▪ It can make phrases harder 
to sing

 ▪ It makes the vocal HUD 
harder to read

For example, if there is a non-
pitched word in the middle of a 
pitched phrase:

 ▪ Players have to adjust their 
vocal chords

The solution is to try to group 
the different types of syllables 
together as best you can.

Note: You do not need to apply 
this rule as strongly to the first 
or last words in a phrase.

We use two symbols for non-
pitched syllables:

 ▪ #

 ▪ ^

The # symbol is most commonly 
used. It provides standard 
scoring in-game.

The ^ symbol is used in special 
cases and gives the player a 
more generous score.

Use the ^ symbol in the 
following situations:

 ▪ If a phrase contains only one 
to three short syllables

 ▪ For vowels and consonants 
without sharp attacks. For 
example, “w” or “y” 

Indefatigably in-# de-# fa-# ti-# ga-# bly#

Cowardice cow-# ard-^ ice#

CONSISTENT 
VOCAL CHARTS

MIXED PITCH 
WORDS

MIXED PITCH 
PHRASES

NON-PITCHED 
NOTATION

NON-PITCHED EXAMPLES

Vowels and consonants 
without sharp attacks 
can be hard to register. 

This is especially true if 
you miss the start of a 
long note tube. In this 
case use ^ instead of #.

Way-^ ward!^

NON-PITCHED VOCAL GUID-
LINES 2



VOCALS

Every vocal MIDI note must be paired with a 
MIDI lyric text event. The MIDI lyric event must 
be placed precisely, at the start of each note.

LYRIC FORMATTING 

To start, use a search engine to 
find your song lyrics:

 ▪ Check that the phrasing 
looks good and that only the 
first word in each phrase is 
capitalized

Note: Some sites have songs 
with each word capitalized. You 
should avoid these lyrics. 

In REAPER, lyrics are formatted 
as a specific kind of text event:

 ▪ Text events for lyrics must 
be lyric text events

Imported lyrics are lyric text 
events by default. Manually 
created lyrics need to be set as 
lyric text events. 

Lyric text events created with 
Lyric to Clipboard are lyric text 
events by default. This method 
is recommended (p. 553). 
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Notes that slide, bend, or trill 
should be notated with the + 
sign in your lyric .txt file.

Work through your vocal MIDI 
and lyric text file together. 

For each slide, bend, or trill 
note add a + sign to the correct 
place in your text file.

For example, notate the word 
“Yeah!” sung over two notes as:

 ▪ Yeah! +

When individual syllables 
change pitch add the + sign 
directly after the hyphen. 
For example, the “der” in 
“Thunderstruck”:

 ▪ Thun- der- + struck

Do not use commas and periods,  
except for abbreviations. For 
example:

 ▪ A.M.

 ▪ P.M.

Add an = sign to the end of a 
syllable to display a hyphen.

For example, the hyphen in the 
word “Ex-girlfriend”:

 ▪ Ex=girl- friend

Use the Merriam-Webster online 
dictionary to check hyphenation 
if you need to.

You can also use Dictionary.
com as a reference for words 
not found on Merriam-Webster .

If the hyphenation on these two 
sites conflicts pick one and use 
it through-out your whole song.

Capitalize the first syllable of 
every phrase.

You should also use capital 
letters for the following:

 ▪ Proper nouns, for example 
“John”, “Oxford University”, 
“American”, “California”

 ▪ Words that follow a ! or ? 
mid phrase

 ▪ Acronyms that would look 
wrong in lower case. For 
example “CIA”, “MVP”

For punctuation, you may only 
use the following:

 ▪ ?

 ▪ !

Try to use question marks and 
exclamation marks sparingly. 
Only use them where you feel 
they are appropriate.

 ▪ Do not use quotation marks

LYRICS AND TEXT 
EVENTS

SLIDES, BENDS, 
AND TRILLS

HYPHENATED 
WORDS

PUNCTUATION 
AND CAPITALS

COMMAS AND 
PERIODS

Lyrics need to be broken down 
into individual syllables. The 
best way to do this is to use an 
online lyric hyphenator:

http://endless 
 renovation.com/rb/hyph

 ▪ Paste your song lyrics into 
the hyphenator

 ▪ Click the Convert button

 ▪ Copy and paste your lyrics 
into a .txt file and save it 
with your custom song

Note: The hyphenator will add 
an @ sign to the start of each 
line. This is used to automate 
phrase markers with CAT.

Each syllable should separated 
by a dash: 

 ▪ For ex- am- ple

If you need to add a space after 
each dash, use the Replace 
feature in Notepad to do this. 

BROKEN VOWEL 
SOUNDS
A singer will sometimes break 
up vowels with a glottal stop.

For example the “is” in Blur’s 
“Song 2”:

 ▪ i- is

Use hyphens for each syllable 
sung this way.

MULTI-SYLLABIC CONTRACTION
For multi-syllabic contractions 
the following hyphenation is 
preferred:

 ▪ It- ‘d

 ▪ It- ‘ll

 ▪ Must- ‘ve

 ▪ Should- ‘ve

 ▪ Would- ‘ve

 ▪ Could- ‘ve

 ▪ Should- n’t

 ▪ Would- n’t

 ▪ Could- n’t

 ▪ Must- n’t

SYLLABLE 
HYPHENATION

http://endlessrenovation.com/rb/hyph
http://endlessrenovation.com/rb/hyph
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Use the Lyric To Clipboard Tool to create MIDI 
notes and lyric text events together. 

If you author your vocal MIDI 
notes first you will need to 
import your lyrics when you are 
done. Each time you make a 
change to your lyric text file you 
have to check your vocal MIDI 
and lyrics for errors. This can 
be tedious and time consuming. 
It is not a recommended 
workflow. 

You can also add lyrics to 
your vocal MIDI notes as 
you author them, but this is 
also not recommended. This 
method increases the chance of 
mistakes:

 ▪ Hyphenation errors

 ▪ Formatting errors

 ▪ Spelling mistakes

 ▪ Using text events instead of 
a lyric event

JAPANESE LYRICS
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Lyrics To Clipboard download:  
www.mediafire.com/ 
file/3zjz01gukpk8kpm/ 
LyricsToClipboard_070420 
22.zip/file

 

The website will hyphenate your 
lyrics. Copy and paste the lyrics 
into Notepad, then save the text 
file in a folder with your custom 
song files. 

Note: The Romaji hyphenator 
works regardless of whether 
your text is in English or not. 
This means that you should 
double-check your lyrics before 
using them. 

Use the Lyric To Clipboard tool 
to add MIDI notes and lyrics 
into REAPER. I find it best to do 
this one phrase at a time. This 
way you can make sure that you 
author each syllable correctly. 

Note: You should not combine  
Romaji syllables (except in 
very rare circumstances). This 
is especially true if you do not 
understand Japanese.

Japanese is usually written 
in a combination of kana and 
kanji symbols. However, Rock 
Band does not support these 
symbols and only supports Latin 
characters. Because of that, 
Romaji lyrics need to be used 
instead for the song.

Romaji is the romanization 
of Japanese using the Latin 
(Roman) alphabet.

Most popular Japanese songs 
have Romaji lyrics available that 
are either official or fan-made.

Check out GhostByob’s J-Rock 
Band Channel for Japanese 
custom songs in Rock Band! 

 

To hyphenate your lyrics use 
Kueller’s lyric hyphenator:

https://endlessrenovation.
com/rb/hyph

Follow these steps:

 ▪ Copy and paste your lyrics 
into the hyphenator

 ▪ Click the drop-down menu 
and select Romaji

 ▪ (Optional) Click the Do not 
append @ to the start of 
each line checkbox

 ▪ Click the Convert button

IMPORTED VS 
MANUAL LYRICS

JAPANESE VS 
ROMAJI

HYPHENATE YOUR ROMAJI AND ADD 
YOUR LYRICS INTO REAPER

Use StackOverflow’s Lyric To 
Clipboard tool to create MIDI 
notes and lyric text events:

 ▪ Hyphenate and format your 
lyrics in a text file

 ▪ Copy and paste a vocal 
phrase into the app

 ▪ Check Placeholder notes

 ▪ Choose an appropriate note 
size and spacing

 ▪ Click the Generate Lyrics 
button

 ▪ Paste MIDI notes and lyrics 
into PART VOCALS

Author with the MIDI notes that 
you have created. Your lyrics are 
already attached to each note.  
Repeat the process for the 
whole song. When you are done 
use CAT to add vocal slide text 
events to any vocal slide MIDI 
notes that you authored. 

LYRIC TO 
CLIPBOARD

The best lyr- ics

Use Kueller’s hyphenation tool to hyphenate 
Japanese lyrics for Rock Band. 

AUTHORING LYRICS AND 
VOCAL MIDI NOTES 

AUTHOR RECOMMENDED

http://www.mediafire.com/file/3zjz01gukpk8kpm/LyricsToClipboard_07042022.zip/file
http://www.mediafire.com/file/3zjz01gukpk8kpm/LyricsToClipboard_07042022.zip/file
http://www.mediafire.com/file/3zjz01gukpk8kpm/LyricsToClipboard_07042022.zip/file
http://www.mediafire.com/file/3zjz01gukpk8kpm/LyricsToClipboard_07042022.zip/file
https://www.youtube.com/GhostByob
https://www.youtube.com/GhostByob
https://endlessrenovation.com/rb/hyph
https://endlessrenovation.com/rb/hyph


VOCALS

There are several rules for Spanish lyrics to be 
aware of.

SPANISH LYRICS

In Spanish the hyphenation of 
words can depend on:

 ▪ The structure of the word, 
and

 ▪ The next word in the phrase

This means that, depending 
on the context, syllables can 
change.
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Single consonants that are 
between vowels join the 
following consonant.

Separate multi-syllable words 
with dashes:

 ▪ Pá- ra- me

 ▪ Mu- je- res

The combinations “ch”, “ll”, and 
“rr” are never separated:

 ▪ No- ches

 ▪ Ca- lle

The letter “y” is considered a 
consonant when it is followed 
by a vowel. 

 ▪ O- ye- ra

In other cases, it is considered 
a vowel:

 ▪ Rey

 ▪ Soy

Separate two consonants that 
are between vowels, unless the 
second consonant is “i” or “r”:

 ▪ Jun- to

 ▪ Fren- te

 ▪ Des- cu- bro

 ▪ A- blan- dar

 ▪ A- pro- bar

When there are more than two 
consonants between vowels:

 ▪ join the last consonant with 
the next vowel, unless it is 
an “i” or “r”

For example:

 ▪ Trans- pa- ren -te

 ▪ Mués- tra- me

Split neighboring strong vowels 
(“a”, “e”, and “o”) into two 
syllables:

Ca- os Ca- er

A diphthong is the sound 
made by two vowels in a single 
syllable. Here the weaker vowels 
are “i” and “u”:

 ▪ Ai- re 

 ▪ Aut- to 

 ▪ Pier- na

An accent over a weak vowel 
makes it strong. Separate 
accented weak vowels:

 ▪ Ca- í- da 

 ▪ Re- ú- ne

A triphthong is three sounds 
in one syllable. They always 
form one syllable. This is very 
common in Spanish words:

 ▪ A- pre- ciáis

Synalepha merges two words 
with neighboring vowels into a 
single syllable. 

In Rock Band we notate 
synalepha with this character:

 ▪ §

The symbol is lovingly referred 
to as “the galaxy.” 

We use it in to indicate when 
you should sing two words 
across a single syllable.

Synalepha is commonly used in 
Spanish and Italian poetry. For 
example, in this line of poetry 
by Garcilaso de la Vega:

 ▪ Los cabellos que al oro 
escurecían

This translates as “The hair that 
endarkened the gold.”

The words “que” and “al” 
form one syllable because of 
synalepha. The same is true for 
“ro” and “es”. 

 ▪ Los ca- be- llos que§al o- 
ro§es- cu- re- cí- an

Because of synalepha the line 
has eleven syllables. 

The exception to this rule is:

 ▪ If you notice a clear 
separation of words, or 
different notes in a phrase, 
then do not use synalepha

Tip: Press Alt + 0167 on the 
number pad for § the symbol.

Hyphenation tool for 
Spanish words:

respublicae.net/
lengua/silabas/
index.php

Note: It does not show 
synalepha. 

HYPHENATIONINTRODUCTION SYNALEPHA
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A vocal phrase should be about the length of a 
single breath for the average player.

VOCAL PHRASES AND 
OVERDRIVE DEPLOY 

Phrase markers are authored on 
note A6 (105). Their purpose is 
to break your vocal MIDI track 
into breaths. This gives: 

 ▪ The vocalist room to breathe

 ▪ The game a consistent 
structure to score 

Phrase markers should start 
before, and end after, the group 
of vocal notes that they cover.
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PHRASE MARKER 
OVERVIEW 

PHRASE MARKER 
LENGTH

STANDARD VS HD 
SCREENS

OVERDRIVE 
DEPLOY SECTIONS
Overdrive deploy sections 
appear between vocal phrases. 

For this to happen the gap 
between phrase markers must 
be more than 0.6 seconds. 

Overdrive deploy is not affected 
if notes and phrase markers do 
start or end together.

PHRASE MARKERS 
AND NOTE TUBES
If you start or end phrase 
markers on vocal notes it may 
cause visual glitches, such as:

 ▪ Overdrive notes not showing 
up correctly

 ▪ Lyrics displayed at the wrong 
time in static vocals mode

Sometimes you may not be able 
to avoid vocal notes and phrase 
markers starting and ending 
at the same time. This can be 
the case in songs with a lot of 
harmonies.  

Otherwise even a small gap 
between the start and end of 
phrase markers and note tubes 
is better. This gap can be as 
small as a 64th note, or even a 
128th note.

Vocal phrases should be about 
the length of a single breath. 

This means that a good phrase 
length for a mid-tempo song is 
two measures.

The smallest length for a phrase 
marker is:

 ▪ A quarter note

Any phrase marker shorter than 
this will cause the following 
error in Magma:

 ▪ Vocal phrase overlap

The number of words per 
phrase depends on the screen 
the player uses. 

Standard definition screens 
cannot display as many lyrics as 
a widescreen display.

If you can, test your song on a 
standard display using the static 
HUD to make sure you can view 
each phrase.

EXAMPLE PHRASE MARKER

Phrase markers should 
start and end on 
quarter (or eighth) note 
beats when possible. 

If you import lyrics with the @ 
sign at the start of each line, 
CAT can create phrase markers 
for you.

CREATE PHRASE 
MARKERS

Phrase Marker

Re fa sol + sol
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Use overdrive phrases to highlight 
memorable parts of the song.

VOCAL OVERDRIVE

Overdrive is authored on note 
G#7 (116) and is always paired 
with a vocal phrase. 

Overdrive and vocal phrases 
must line up with each other 
exactly. Follow the tip below to 
copy a vocal phrase and turn it 
into an Overdrive phrase. 

Tip: Turn Snap on. Press and 
hold the Ctrl key. Click-drag a 
vocal phrase upwards into the 
Overdrive row in the template.

Place Overdrive markers where 
they feel best in the song. 

A large vocal note range is difficult to read on 
the static vocal HUD.

STATIC HUD VOCAL RANGES

559 VOCALS 560

Follow these rules to place 
Overdrive markers correctly:

 ▪ Place one Overdrive phrase 
every five vocal phrases

 ▪ Author Overdrive markers 
consistently over similar 
melodic patterns

 ▪ Do not include vocal parts in 
Unison phrases

 ▪ Do not author Overdrive for 
about the last eight song 
measures

For example, let’s say that you 
author the second phrase of the 
first verse as Overdrive. 

You should then author the 
same melody in the remaining 
verses as overdrive too. The 
same idea applies to the chorus 
or any other part of the song.

Note: If you are authoring 
harmonies you must add 
Overdrive to the PART VOCALS 
and HARM1 tracks. *

The vocal MIDI template has a 
five-octave range. 

This range is too large to be 
displayed all at once in the 
static vocal HUD in-game.

A comfortable range for the 
static HUD is two to two and a 
half octaves. A wider range of 
notes is difficult to read. 

* The game does allow 
different overdrive 
phrases for PART 
VOCALS and HARM1.

But, because of a bug, 
the overdrive phrases 
in these two tracks 
must match.

To fix this problem we use a 
range divider marker:

 ▪ %

Place the % marker:

 ▪ Between vocal ranges, and

 ▪ At the end of the last lyric in 
a phrase 

This will separate the vocal 
ranges of the phrases that come 
before and after it.

Players will be able to see pitch 
changes more easily. 

Note: This function only applies 
to the static HUD, not the 
scrolling one.

VOCAL RANGESOVERVIEW

OVERDRIVE

PHRASE MARKER

OVERDRIVE

VISUAL BUG

PHRASE MARKER

OVERDRIVE

PHRAS

Touching phrase markers 
and Overdrive can cause 
gold color lyrics.

Yeah +% I can

VOCAL RANGES

PHRASE MARKER PHRASE MARKER

HIGH NOTE RANGE LOW NOTE RANGE

Range Marker (%)
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If you find that some lyrics and 
notes do not match:

 ▪ Add new lyric text event in 
the problem area(s)

 ▪ Press Ctrl + A to select all 
MIDI notes

 ▪ Press Shift + A to align lyric 
events with notes

New lyrics (and all the lyric text 
events that follow) are shifted 
to the next MIDI note. 

Note: You can edit your lyric 
.txt file and re-import it if you 
prefer (see steps 1 and 2).

Lyric text events are added to 
the selected MIDI notes. Check 
through your vocal MIDI for any 
mistakes:

 ▪ Make sure that each note 
has the correct lyric event 
attached to it

562

Importing lyrics from a .txt 
file is no longer my preferred 
workflow. This topic is included  
for reference.  

Here we will look at importing 
lyrics for a whole song.

 ▪ Open your vocal MIDI track 
(in this case PART VOCALS)

 ▪ Press Ctrl + A to select all 
MIDI notes 

1

561

IMPORT LYRICS FROM A 
TEXT FILE

3

2
Import your hyphenated and 
formatted lyric .txt file:

 ▪ Press Ctrl + L

The Load lyrics from file 
window will open:

 ▪ Browse to your lyric .txt file 
and select it

 ▪ Click the Open button

4

IMPORT LYRICS FROM A TEXT 
FILE 2
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CAT will create phrase markers 
for your vocal MIDI.

The Create phrase markers 
window will open.

Note: There is a checkbox to 
Create overdrive markers for 
Vocals or Harmony 1. Leave 
this box unchecked. It is 
recommended that you pick 
memorable melodies for the 
vocalist yourself.

 ▪ Click the Create phrase 
markers button

564

In the previous topic we 
imported song lyrics into 
REAPER.

The lyrics have the @ sign at 
the start of each line.

CAT uses the @ sign to create 
phrase markers for each line.

1

563

CREATE PHRASE MARKERS 
WITH CAT

3

2
Open CAT:

 ▪ Press the F9 key

CAT will open. In the Vocals 
section:

 ▪ Click the Create phrase 
markers button

4

CREAT PHRASE MARKERS 
WITH CAT 2
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You can have tambourine, cowbell, or hand 
claps in a percussion section. Only one type of 
percussion can be used per song.

VOCAL PERCUSSION 

Some songs have long periods 
when the singer is silent.

This might be during:

 ▪ Instrumental breaks, or

 ▪ Solos

In these cases, a percussion 
section can be a good option. 

Consider the following benefits 
to help you decide:

 ▪ A fun way to keep the 
vocalist engaged

 ▪ Can maintain immersion for 
the singer

 ▪ Should fit in with the style 
or mood of the song

Remember, these sections 
are an addition to the artists’ 
original work. So be thoughtful 
about what you add, and where:
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 ▪ Do not put percussion in 
every available spot

 ▪ If the percussion 
instruments don’t fit the 
mood of the song, it is okay 
not to use them

 ▪ Do not put percussion at 
the start of a song. The 
introduction sets the mood 
for the song, and we prefer 
to keep it unchanged

Note: Each percussion section 
must be placed under one (or 
more) phrase markers. 

Refer to the Percussion Phrase 
Marker topic on the facing page 
for details.

Author playable percussion 
notes on MIDI note C6 (96). 
Author non-playable notes on 
MIDI note C#6 (97).

Add one of the following pairs of 
text events in PART VOCALS.

Tambourine:

 ▪ [tambourine_start]

 ▪ [tambourine_end]

Cowbell:

 ▪ [cowbell_start]

 ▪ [cowbell_end]

Clap:

 ▪ [clap_start]

 ▪ [clap_end]

These text events set up the 
animation cues. They also set 
the audio sample type used in 
the Magma Game Data tab.

The official docs recommend 
placing a phrase marker every 
two measures of percussion. *

This stops the whole percussion 
section from appearing in the 
static vocals HUD.

The problem does not appear to 
affect Rock Band 3. It might still 
affect other titles though.

In Rock Band 3 you should be 
able to place one phrase marker 
for each percussion section. 

If you experience issues, revert 
back to the two-measure 
recommendation.

* This depends on the tempo 
of the song and the amount of 
percussion notes played.

MIDI NOTES AND 
TEXT EVENTS

Percussion sections appear in-
game for the vocalist to play.

They are authored on the PART 
VOCALS track. 

There are two types of vocal 
percussion:

 ▪ Non-displayed percussion, 
and

 ▪ Displayed percussion

Non-displayed percussion is not 
playable. For example, check 
out “Hysteria” by Muse. The 
vocal chart uses both types of 
vocal percussion:

In Magma select the 
vocal percussion that 
you authored in the 
PART VOCALS track.

WHEN TO ADD A PERCUSSION SECTION?INTRODUCTION
PERCUSSION 
PHRASE MARKER

MAGMA

“HYSTERIA” BY MUSE
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Animation markers let you control the 
animation state of the singer. 

ANIMATION MARKERS 

567 VOCALS 568

But what happens if the 
previous animation state was 
[idle] instead of [play]?

Here the singer would stay 
in an idle state, but with a 
tambourine in their hand. 

Finally, make sure that you 
leave a gap between singing 
and percussion sections. A 
gap of at least one measure is 
recommended. 

This gives the player time to 
adjust between singing and 
playing percussion. It also 
provides time to change the 
character animation state. You 
should apply the one measure 
gap before and after each 
percussion transition.

Adjust the animation play state 
after each transition, if needed.

PERCUSSION ANIMATIONS STATES AND 
TRANSITIONS
There are three different 
percussion animations:

 ▪ Clap

 ▪ Cowbell

 ▪ Tambourine

Let’s use the tambourine as an 
example. To get the singer to 
play the tambourine requires a 
sequence of text events: 

 ▪ A play animation state: 
[play]

 ▪ A percussion marker: 
[tambourine_start]

 ▪ A camera cut: 
[coop_v_near]

In this sequence the percussion 
marker inherits the play 
animation state. Percussion 
animation starts at the next 
camera cut. In this case 
[coop_v_near]. 

Text events are placed to set 
the character animation state:

You can use CAT to create these 
markers if you wish:

 ▪ Press F9 to open CAT

 ▪ Press the Create Animation 
Events button

The Create animation markers 
dialogue will open:

 ▪ In the Select Instrument 
menu select Vocals

 ▪ In the Select Expression 
menu choose Play, Mellow, 
or Intense

 ▪ Click the Create markers 
button

Adjust automatic animation 
markers if needed. Add extra 
animation markers as required.

[play]

ANIMATION 
MARKERS

TEXT 
EVENTS

CHARACTER  
ANIMATION

[idle_realtime] The character has their microphone 
down and is not moving to the beat. The 
character is waiting for their cue. Useful 
in slower songs, or slow parts in a song.

[idle] The character has their microphone down 
and dances to the beat. Use [idle] before 
the song starts, after the song finishes, 
or during downtime. Downtime is at least 
two measures of rest.

[idle_intense] The character is idling in an intense 
manner. For example, the vocalist picks 
up the mic stand and dances, or jumps 
up and down next to the mic stand.

[play] The standard singing state.

[mellow] Use for slow, quiet sections of a song.

[intense] For hard, fast sections of a song. For 
example, aggressive metal.

Load these text events 
into REAPER:

Use the Instruments text events list. 
See pages 125 — 126.

[idle] and [idle_realtime] are 
responsive animations. The 
singer will quickly go into the 
mic down position. 

This means that you should not 
use these animations as soon as 
the singer stops singing. Putting 
the mic down too quickly will 
look unnatural. 

It is best to put the mic down 
a beat or so after the character 
stops singing.

Use [idle_realtime] for sections 
where you don’t want the 
singer moving to the beat. For 
example, during song intros and 
the end of songs.

[idle_intense] is great for when 
the vocalist is into the song but 
has a section where they are 
not singing. 

IDLE ANIMATION 
STATES
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VOCAL PERCUSSION 
EXAMPLE 

In this example the vocalist 
plays quarter notes on the 
tambourine. 

You would see something like 
this in “Don’t Fear the Reaper” 
by The Blue Oyster Cult.

Here the whole section has 
a single phrase marker. This 
should work for Rock Band 3. 
For other titles revert to two 
measure phrase markers. 

The [play] text event enables 
vocal percussion animation.

The percussion text events 
[tambourine_start] and 
[tambourine_end] determine:

 ▪ The type of percussion

 ▪ The duration of the 
percussion animations

Percussion animation starts 
with the next camera cut.

569 VOCALS 570

41.1.00
1:08.742

39.1.00
1:04.680

38.1.00
1:02.978

40.1.00
1:06.382

Overdrive

----

Phrase Marker

----

Not Displayed Percussion

Displayed Percussion

----

C5

B

Bb

A [tambourine_end]

Note: If the [idle] state is 
inherited instead of a [play] 
state the singer will idle with 
percussion in their hand.

Percussion end marker to be 
placed at end of percussion 
section

Phrase Marker

With the tambourine you can 
mix played and non-played 
notes if you wish:

In the above example the 
vocal percussion hits on each 
quarter note. The non-played 
notes animate softer unplayed 
tambourine shakes.

[play] [tambourine_start]

Percussion animation start here.

PART VOCALS

[coop_v_near]

The switch between regular and 
percussion animations happens 
at the end of this sequence:

An animation marker sets a 
[play] or [idle] state.

The percussion marker inherits 
its state from the previous 
animation marker.

The next camera cut in the 
EVENTS track starts the 
percussion animation.

[play] [tambourine_start] [coop_v_near]

EVENTS

21 3
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To export audio:

 ▪ Click File > Export > Export 
as WAV

Import your saved file into a 
new track in REAPER:

 ▪ Press Ctrl + T to create a 
new track

 ▪ Drag and drop your audio file 
from Windows Explorer into 
the new track

To fade bleed from other 
instruments in and out:

 ▪ Click and drag to make a 
selection

 ▪ Press Ctrl + , to fade in 

 ▪ Press Ctrl + . to fade out 

Tip: The period and comma keys 
typically have < and > symbols 
on them. Use these symbols as 
a visual reminder. 

On the left is a fade out at the 
end of a vocal section. Here the 
guitar and vocals bleed together.

572

You can use separated vocals 
for lip-sync animations and to 
generate vocal MIDI notes.

In either case you may find 
that you want to clean up your 
separated vocals.

You can use Audacity to remove 
noise and fade in and out of 
vocal sections if you need to.

Download Audacity from:  
www.audacityteam.org/.

1

571

CLEANING UP SEPARATED 
VOCAL TRACKS

3

2
To remove noise from non-vocal 
sections of the track:

 ▪ Click and drag to make a 
selection

 ▪ Press Ctrl + L

The selected area is replaced 
with silence.

To start and stop playback:

 ▪ Press the Spacebar

4
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Convert your dry or separated 
vocal track to MIDI.

In the MIDI Editor:

 ▪ Press the Home button

In the Transport Bar:

 ▪ Click the Record button

Your vocal audio is converted to 
MIDI in real time.

Wait for the song to finish:

 ▪ Click the Stop button in the 
Transport Bar

 ▪ Click the Save All button

Copy your separated vocal track 
to the Audio File track:

 ▪ Select your separated audio 
vocal track 

 ▪ Press Ctrl + C

 ▪ Select the Audio File track 
(MIDI area not track control)

 ▪ Press the Home button

 ▪ Press Ctrl + V

 ▪ Solo the Audio File track

Note: Check that the copied 
audio lines up with the other 
audio tracks before proceeding.

574

If you find it difficult to author 
vocal pitches you can convert 
dry or separated vocals to MIDI.

This will give you a baseline of 
generated pitches to work from.

Note: It may take some work to 
turn the generated track into a 
good vocal MIDI track.

 ▪ Download Audio to MIDI.
RTrackTemplate

 ▪ Copy the template to C:\
Reaper\TrackTemplates

1

573

3

2
Open the template in REAPER:

 ▪ Select your PART VOCALS 
track

 ▪ Click Track > Insert track 
from template > Open 
Template

 ▪ Select Audio to MIDI.
RTrackTemplate

 ▪ Click OK

The Audio File and MIDI 
Converted tracks appear under 
your PART VOCALS track.

The MIDI Converted track is 
armed, and ready to record.

4

HOW TO AUTO-GENERATE 
VOCAL MIDI TRACKS
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This example shows a generated vocal track 
that closely matches the authored vocals.

AUTO-GENERATED VOCALS

   

Here you can see a comparison 
of auto-genereted and authored 
vocal tracks.

As you can see, this generated 
MIDI provides a good baseline to 
work from:

 ▪ Vocal pitches are accurate

 ▪ Note timing is also quite 
good

 ▪ You can visually pick out 
many of the notes from the 
vocal melody

 ▪ Sustained notes are clearly 
visible  

 ▪ There are few random notes 

The main work here is to scrub 
the audio and check:

 ▪ Note pitches

 ▪ Note on and off timing

   

AUTHORED VOCALS

This example is a best-case 
scenario. You are more likely to 
find that an auto-generated MIDI 
is more difficult to work with:

 ▪ Some vocal pitches might not 
generate MIDI notes

 ▪ Note pitches may often show 
vibrato

 ▪ Note pitches may jump 
between octaves

 ▪ Many of the note durations 
may be very short

 ▪ It might be harder to see 
what the vocal melody is

 ▪ MIDI note on and note off 
timings may not be accuarte

In a worst-case scenario you can 
only use the generated notes as 
a very rough guide for your chart.

GENERATED VOCALS
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To close the track in the 
background:

 ▪ Right click the track tab

In the context menu:

 ▪ Click Contents > Close all 
inactive media items

To toggle between tracks:

 ▪ Press Alt + N

The foreground track will 
alternate between PART VOCALS 
and the MIDI Converted tracks.

578

It is very helpful to view 
generated and authored notes 
in the same editor window:

 ▪ Press and hold the Ctrl key

 ▪ Select the PART VOCALS and 
MIDI Converted MIDI tracks

Note: Make sure that you select 
both of the MIDI tracks. If you 
select the track control panels 
the next step will not work:

 ▪ Press Ctrl + Alt + E

1

577

VIEW MULTIPLE MIDI TRACKS 
IN A SINGLE EDITOR WINDOW

3

2
Both tracks will appear in a 
single editor window. One track 
is displayed normally, the other 
is muted in the background.

4
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Dry-vox are required for lip-sync animation. 
There are several options to choose from.

DRY-VOX AND LIP-SYNC 
ANIMATION 

Lip sync animation is a 
noticeable part of your custom 
song. When this animation is 
not in sync with the song, it 
does not look professional.

The standard method to 
produce lip sync animation is:

 ▪ Use dry vocal stem(s) in 
Magma when compiling your 
custom song

Stems are not an option for 
most custom songs though. 
This leaves us with a few other 
options to consider:

 ▪ Record dry vocals

 ▪ Vocal MIDI and lyrics export 
to Onyx

 ▪ Separated vocal audio

Let’s take a look at these 
options in more detail.

Record your own dry vocals for the best 
lip-sync animations.

DRYVOX AND LIP-SYNC ANI-
MATION 2
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The .milo file is a file that exists 
inside a custom song. For Rock 
Band 3 the .milo file can 
contain the following:

 ▪ Lip-sync data

 ▪ Venue information

 ▪ Character animation tweaks

 ▪ Vocal assignments (which 
character sings which part)

The .milo file extension is 
formatted as follows:

 ▪ .milo_*

The asterisk refers to the 
console platform. So a .milo 
for the xBox would be:

 ▪ .milo_xbox

DRYVOX 
OVERVIEW

Another option for lip-sync 
animations is to use Onyx. 

Onyx uses phonetic analysis to 
convert your vocal chart(s) into 
a lip-sync file. The basic steps 
are as follows:

 ▪ Export your REAPER project 
MIDI file 

 ▪ Open your MIDI in Onyx

 ▪ Create a lip-sync Rock Band 
3 .milo file

 ▪ Overwrite the .milo in your 
custom song file with the 
.milo from Onyx

For step-by-step instructions 
refer to pages 583 — 584.

Note: You will still need dry vox 
audio to compile your song with 
Magma. You can use the song 
audio if you plan to overwrite 
the .milo later.

VOCAL MIDI & 
LYRICS EXPORT

You can produce very good lip-
sync animations if you record 
your own dry vocal track(s). 

Don’t worry about having a   
great singing voice. You do not 
have to sing if you don’t want 
to. Many authors get the best 
result as follows:

 ▪ Speak in a monotone voice

 ▪ Focus on note-on and note-
off timing

You can record your dryvox 
directly into REAPER. Then 
export your dry vocal track using 
the dry vocal preset. 

To setup the dry vocal preset 
see pages 69 — 70.

RECORD DRY 
VOCALS

.MILO FILES 
EXPLAINED

DRYVOX AND 
MAGMA 
All the dryvox audio options 
use Magma to generate lip-sync 
animation:

 ▪ Dryvox stems

 ▪ Separated vocal audio

 ▪ Recorded dry vocals

For any of these options:

 ▪ Render each dryvox file 
using the dryvox preset

 ▪ Link to the rendered files in 
Magma when you compile 
your custom

Magma has fields for three vocal 
audio tracks:

 ▪ Solo / Harmony 1

 ▪ Harmony 2

 ▪ Harmony 3

1 2 3

Separated vocal audio can be 
a good alternative to dry vocal 
stems. But, you can quickly run 
into problems:

 ▪ Other instruments may 
bleed into the vocal track

 ▪ Separated audio does not 
produce solo and harmony 
vocal parts

If your song has more than one 
vocal part you may need to use 
an alternative method. 

SEPARATED 
VOCAL AUDIO

Note: Check your 
lip-sync animations in-
game. They may not be 
perfect when you use 
separated audio.
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The Select files to save or 
delete window will open. To 
save your dry vocal:

 ▪ Click the Save All button

Disarm the DRYVOX01 track:

 ▪ Click the red circle button to 
dis-arm the track:

Repeat steps 2 — 4 for harmony 
dry vocal tracks if needed.

Click the Record button in 
the Transport Bar to begin 
recording:

 ▪ Pay attention to your note on 
and off timing

 ▪ Sing or speak the lyrics as 
clearly as you can

You may experience some visual 
latency as REAPER records your 
dry vocal track.

Click the Stop button in the 
Transport Bar to stop recording.

582

Microphone setup in REAPER 
was briefly covered on page 
54. To check, or change your 
recording settings:

 ▪ Press Ctrl + P to open 
REAPER preferences

 ▪ In the left preferences pane 
click Device (Under Audio)

 ▪ Check the Input Device 
listed. Select your 
microphone if available. 
Otherwise select Microsoft 
Sound Mapper.

 ▪ Click the OK button

1

581

RECORD DRY VOCALS

3

2
Prepare your dry vocal track for 
recording. For this example we 
will use DRYVOX01:

 ▪ Expand DRYVOX01 to see the 
track controls

 ▪ Click the red circle button to 
arm the track:

 ▪ Click the Input drop down 
button:

 ▪ Select Input: Stereo > Left / 
Right from the context menu

 ▪ Click the Project timeline. 
Press the Home key to 
return the play cursor to the 
start of the Project

4
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The last step requires a 
complete custom file. This 
means that you will need to 
compile your custom song 
with Magma. This is covered in 
chapter 22. 

Package the lip-sync tracks(s) 
into a .milo file for Rock Band 3:

 ▪ Click the Lipsync tab

Note: The MIDI file field 
references the same filename. 
This is the overwritten lip-sync 
file from step 2.

 ▪ Click the Make RB3 .milo_* 
button

The Save Milo file window will 
open:

 ▪ Click the Save button

Your .milo_xbox file is in the 
output directory.

584

Export your Project MIDI.

For a full band custom (without 
harmonies) solo these tracks:

 ▪ Song Audio, Count-in, 
Drums, Guitar, Bass, Vocals, 
Keys, Events, Venue, Beat 

 ▪ Click File > Export Project 
MIDI 

 ▪ Check your Export settings

 ▪ Click the OK button to save 
your MIDI file

1

583

ONYX: CREATE LIP-SYNC 
FILE FOR MAGMA

3

2
Use Onyx to convert the MIDI 
file to a lip-sync file:

 ▪ Click the Other tools button

The Tools window will open:

 ▪ Click the Lipsync tab

 ▪ Click the folder button. 
Browse for your exported 
MIDI file

 ▪ Click the Turn vocal tracks 
into LIPSYNC* tracks for 
RB3 button

The Task tab will open. The 
conversion will run. The original 
file is overwritten.

4

Add your .milo file into 
your finished custom 
on page 799.

ONYX: CREATE LIPSYNC FILE 
FOR MAGMA 2
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At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Author the vowel sound of each word. Do not author the 
consonants.

 ▪ Author the most prominent vocal part.

 ▪ Check lyric spelling, syllables, and punctuation.

 ▪ Don’t author minute details such as little slides and vibrato. 
These details are not fun to sing.

 ▪ Never author two notes side by side with no space between 
them. This causes slides to not work properly. It also makes 
separate syllables of the same pitch look like one note.

 ▪ Start every vocal phrase with a capital letter.

VOCAL AUTHORING



 ▪ Workflow
 ▪ Drum fills, Unisons, Overdrive
 ▪ Big Rock Ending, solos

17
DRUM FILLS, 
OVERDRIVE ...
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Follow this workflow to author instrument 
markers.  

WORKFLOW
Markers are an essential part of your 
custom song.

In Rock Band 3 we use markers for drum fills, Unison phrases, 
Overdrive, solos, and Big Rock Endings.

The focus of this chapter is on the rules for authoring markers. 
We also look at the best workflow for authoring markers.

These symbols help you know which rules are for which 
instruments:

By the end of the chapter you will have learned how to:

 ▪ Author each marker

 ▪ Author drum fills that match the style of the song

 ▪ Stack instrument charts to author Unisons and Overdrive

 ▪ Calculate the frequency of Unisons and Overdrive phrases

OVERVIEW
Each instrument MIDI has 
markers that are needed to 
complete the chart. These 
markers include:

 ▪ Solos

 ▪ Drum fills

 ▪ Overdrive

 ▪ Unisons

 ▪ Big Rock Endings (BRE)

The correct workflow will help 
to simplify your decision making 
for this process. 

1: SOLOS
Solo markers are used for solos 
on drums, guitar and bass. (See 
page 611).

Author drum solo markers first 
so that you do not author drum 
fills during a drum solo.

2: DRUM FILLS
Drum fills are an important part 
of your drum chart. Author drum 
fills so that they feel right for 
your song. You will then know 
where you can put Overdrive 
and Unison phrases. 

3: OVERDRIVE
Overdrive phrases highlight 
interesting parts for each 
instrument. Stack your 
instrument charts (Ctrl + Alt 
+ E) and author Overdrive 
phrases for guitar. Convert each 
Overdrive phrase to a Unison 
phrase with the U key. Note: 
Vocal Overdrive is on page 559. 

4: UNISONS
Unison phrases highlight 
interesting parts that the whole 
band plays together. Cycle 
through your instrument charts 
with Alt + N. Convert about half 
of your Unisons into separate 
Overdrive phrases.
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D

G

B

Drums

Guitar

Bass

K Keys

5: BIG ROCK 
ENDINGS
Big Rock Endings are at the end 
of a song. They are for the whole 
band to play. You cannot have 
drum fills, Unisons, or Overdrive 
during a BRE. Vocal parts cannot 
be authored during a BRE either.

DRUM FILLS WORKFLOW



DRUM FILLS, OVERDRIVE, UNISONS, BIG ROCK ENDINGS, AND SOLOS

Drum fills enable a drummer to deploy overdrive. 
The crash that deploys overdrive appears at the 
end of a drum fill section.

DRUM FILLS 

Drum fills are authored on 
notes 120 (C8) to 124 (E8):

 
Below is a drum fill marker for a 
single measure. It contains five 
sustained notes. The notes all 
start and end together. 

Drum fills can vary in length to match the style 
of the song. Place them where they feel the 
best to play.

591 DRUM FILLS, OVERDRIVE, UNISONS, BIG ROCK ENDINGS, AND SOLOS 592

A common method for authoring 
drum fills is to:

 ▪ Place a fill marker every four 
measures

This works well for most songs. 
Exceptions are when the song is 
very fast or very slow:

 ▪ Very Fast - Author two 
measure fills every eight 
measures (if it feels right to 
do so)

 ▪ Very Slow - Author half 
measure fills every two 
measures (< 75 — 80 BPM)

Fills should line up with 
important transitions in a song.

For example, if a verse has two 
extra bars before the chorus:

 ▪ Author the fill so that it ends 
at the chorus (rather than 
simply authoring every four 
measures)

Fills should end so that they 
match the style of the song.

For example, if the band 
pauses before the next section, 
consider ending the fill at the 
start of the pause.

Fills should end so that they 
match the style of the song. For 
example, “Kickstart My Heart” 
by Mötley Crüe. As you can see 
the chorus emphasizes the 
last upbeat of the measure. 
The drum fill ends to match 
this syncopated feel. The crash 
that appears at the end of the 
fill matches the original drum 
performance. 

Sometimes a song may have 
a great fill, or groove, that you 
want the drummer to play.

You cannot play these parts if 
you author a fill over them.

Not authoring a fill is an artistic 
decision that has the ability to 
improve or hamper gameplay. 
So, playtest your chart before 
finalizing your decision.

For example, “Tom Sawyer” 
by Rush mixes the regular and 
artistic placement of fills.

At the end of the guitar solo the 
main theme returns with a short 
Unison phrase. This is followed 
by an epic fill that you definitely 
want the drummer to play. 

DRUM FILL 
OVERVIEW

ONE FILL EVERY 
FOUR MEASURES

MATCH THE STYLE 
OF THE SONG

IMPORTANT 
TRANSITIONS

ARTISTIC 
DECISIONS 

 
Drum Fill 
Drum Fill 
Drum Fill 
Drum Fill 
Drum Fill (use all 5 lanes)

PART DRUMS

REGULAR PLACEMENT OF FILLS

Blue Tom

“KICKSTART MY HEART”

DRUM FILL MARKER

Upbeat emphasis

“TOM SAWYER” BY RUSH

UNISON
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Drum fills are special - they allow the player 
some freedom of expression.

RULES AND ADVICE FOR 
AUTHORING DRUM FILLS 

Make sure that you end drum fill markers correctly.

HOW TO AUTHOR 
DRUM FILLS
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It is important to understand 
how to author drum fills 
correctly.

There are two example 
measures below.

Note: Most of the drum gems 
are greyed out. The colored 
gems are the ones that will 
deploy overdrive when hit.

In the first measure the drum 
fill ends on the four count.

The kick and the ride start on 
the four count.

If the player has enough 
Overdrive energy: 

 ▪ The Overdrive crash replaces 
the kick and ride

The same principal applies to 
the second measure.

Here the drum fill ends on the 
downbeat. It ends on the one 
count of the next measure.  

This is also where the kick and 
the Green crash begin. They 
start on the downbeat.

If the player has enough 
Overdrive energy: 

 ▪ The Overdrive crash replaces 
the kick and crash

Drum fill lanes always end 
where the note to deploy 
overdrive starts.

Do not extend the fill so that it 
covers the first note of the next 
measure. Doing so will ruin the 
drum fill.

DOUBLE-LENGTH 
FILLS
It can be fun to occasionally 
author a double-length fill (if it 
fits the song).

A good place to do this might be 
after a long build up to the last 
loud chorus of the song.

END OF LONG 
REST SECTIONS
Fills are a good way to end 
a long rest section for the 
drummer. This gives the 
drummer a small drum solo 
before the beat comes back in.

NO FILLS IN 
DRUM SOLOS
Do not author drum fills during 
drum solo sections.

START OF LONG 
REST SECTIONS
Try to avoid authoring fills right 
before a long section of rest. 
This will help the drummer to 
not waste overdrive.

FILLS AT THE END 
OF A SONG
Fills are fun to play and so you 
might want to put them at the 
end of your songs. Consider the 
following points before you do:

 ▪ The written ending may be 
more fulfilling for the rest of 
the players to hear

 ▪ The written ending may have 
a lock-step rhythm with the 
rest of the band that already 
sounds great

Try not to overwrite great song 
endings with a drum fill.

1 2 3 4 1 2 3 4 1

DRUM FILL 
ACTIVATION

DRUM FILLS AND OVERDRIVE ACTIVATION NOTES

AUTHORING 
STYLES
You can choose to mix and 
match methods as needed:

 ▪ One fill every four measures

 ▪ Match the song style

 ▪ Make artistic decisions

The method(s) that you choose 
can depend on the song. 

Personally, I start with one fill 
every four measures and work 
from there. If a fill doesn’t feel 
right I will delay it or change the 
length of the fill if needed.

I try to avoid authoring fills that 
sound awkward in their duration 
or place in the song. 

Leaving space for the drummer 
to play a great fill also works 
very well. It’s all about how the 
song feels to play.
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Unison phrases represent an interesting part 
that is played by the whole band. Overdrive 
phrases represent an interesting part played by 
a single instrument.

INTRODUCTION TO UNISON 
AND OVERDRIVE 

Overdrive (OD) phrases produce 
the white gems that appear in 
the instrument tracks in-game. 

When played they fill the 
player’s energy bar. The player 
deploys Overdrive for score 
multipliers (when they have 
enough energy).  

Unison phrases are Overdrive 
phrases that the band plays 
together. When the whole band 
plays them, they result in bonus 
points for the band. 
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Unison and Overdrive phrases 
are placed where an interesting 
part is played. 

Interesting does not have to 
mean that the part is difficult 
to play. It means that the part is 
memorable. 

Unison and Overdrive phrases 
are authored on note 116 (G#7):

A phrase authored for a single 
instrument is an Overdrive 
phrase. 

If the same phrase is authored 
for all instruments then it is a 
Unison phrase.

Overdrive phrases cannot 
overlap unless they are Unison 
phrases. 

Author Unison and Overdrive 
phrases for all instruments 
charted (drums, guitar, bass, 
and keys).

MEMORABLE 
PHRASES

UNISON & 
OVERDRIVE 

AUTHORING 
UNISON & OD

 
 
 
 
OVERDRIVE

DRUMS, GUITAR, 
BASS, & KEYS

Note: Vocal parts are 
never included in 
Unison phrases.

PLAYABLE 
INSTRUMENTS

INSTRUMENT OVERDRIVE

The graphic below shows 
Overdrive for each instrument. 

Each Overdrive phrase is on a 
different measure.

EXAMPLE 
OVERDRIVE

D

G

B

K

If an instrument is not played 
often in a song it may be 
hard to find places for Unison 
phrases. In this case:

 ▪ A single instrument can be 
left out of the Unison phrase

Overdrive / Unison phrases 
should be one measure in 
length. Note: There may be 
exceptions but try to stick to 
this rule.

LENGTH OF 
PHRASES

OD = ONE MEASUREINSTRUMENT UNISONS

The graphic below shows 
Unisons for each instrument. 

Each Unison phrase is on the 
same measure.

EXAMPLE UNISON 
PHRASES

D

G

B

K

The workflow for 
creating Unison and 
Overdrive phrases 
starts on page 602.
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INTRODUCTION TO UNISON 
AND OVERDRIVE  
(CONTINUED)
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Do not place an Overdrive 
phrase immediately after a 
drum fill (see image below). 

Doing so places a drum fill 
activation gem at the start of 
the Overdrive measure. 

NO OD AFTER A 
DRUM FILL

OVERDRIVE IN 
DRUM SOLOS

The player must deploy 
Overdrive if they don’t want to 
fail the Overdrive measure. 

This means that the player 
cannot stack Overdrive if they 
want to.

NO OVERDRIVE AFTER A DRUM FILL

*

   Overdrive Notes          Drum Fill Activation*

OVERDRIVE

Drums cannot have a Unison or 
Overdrive phrase at the same 
time as a drum fill. 

Do not author more than four 
Overdrive phrases during a 
drum solo. * 
 
* Four Overdrive sections will 
fill the Overdrive energy meter. 
Any extra Overdrive energy will 
be wasted. 

If there is a Unison phrase 
right before the drum solo only 
author two Overdrive phrases in 
the drum solo.

Drums should not have an 
Overdrive phrase that touches a 
drum fill.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is because an Overdrive off 
note happens at the same time 
as a drum fill on note. 

This rule exists in the CARV 
validation scripts in CAT. For 
more information about CARV 
see page 762. 

NO DRUM OD 
TOUCHING FILLS 

NO OD WITH FILL

NO OVERDRIVE

D

G, B, K: OD WITH FILL

OVERDRIVE

G

B

K

NO UNISON WITH FILL

NO UNISON

D

INSTRUMENT OD 
AND DRUM FILLS 
Guitar, bass, and keys can have 
Overdrive phrases at the same 
time as a drum fill. 
 
 
 
 
 
 
 
 
 
 
 
 

 
The graphic above shows the 
guitar, bass, keys, and drums 
tracks stacked togther.

NO DRUM UNISON 
/ OD WITH FILLS

MAX OD DRUM SOLO

DRUM SOLO

MAX OD AFTER UNISON

DRUM SOLO

2

4

U

NO OD TOUCHING FILL

OD

D
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For each instrument author an Overdrive phrase 
about every forty beats.

UNISON AND OVERDRIVE 
FREQUENCY 

The frequency of Overdrive and 
Unison phrases is based on:

 ▪ The number of beats in a 
song

For Rock Band instruments a 
good estimate is one Overdrive 
phrase every forty beats. This is 
one Overdrive phrase every ten 
measures of 4/4.

Note: The number of phrases 
can be less if an instrument is 
not playing for a large part of 
the song.

For other time signatures the 
number of phrases will vary. See 
table on the facing page.

599 DRUM FILLS, OVERDRIVE, UNISONS, BIG ROCK ENDINGS, AND SOLOS 600

You may find songs where an 
instrument is idle (not playing) 
for a large part of the song.

In this case you should:

 ▪ Re-calculate the amount of 
Overdrive phrases needed

To do this, subtract the number 
of idle measures from the total 
number of song measures. 

For example, if the song is 100 
measures long and the drums 
play for 50:

 ▪ 100 - 50 = 50 measures 
played

 ▪ 50 / 10 = 5 Overdrive phrases 
needed

Unison and Overdrive phrases 
should be spaced evenly 
throughout the song.

For example, we don’t want 
eight phrases in the first half of 
the song, and only two in the 
second half. 

A good way to check is to zoom 
out so that you can see the 
whole song. Make sure that:

 ▪ Phrases are evenly spaced

 ▪ The number of phrases in 
each half of the song is 
about the same

Unison and Overdrive phrases 
should not be played at the end 
of a song:

 ▪ Do not place Unison phrases 
in the last twelve song 
measures *

 ▪ Do not place Overdrive 
phrases in the last eight 
song measures *

* Try to stick to these guidelines 
as best you can.

For vocals, one Overdrive phrase 
every five vocal phrases is 
recommended. 

Overdrive phrases should not be 
played at the end of the song:

 ▪ Do not place Overdrive 
phrases in the last eight 
measures 

IDLE 
INSTRUMENTS

FREQUENCY OF 
PHRASES

EVEN PHRASE 
SPACING

FREQUENCY OF OVERDRIVE / UNISON 
PHRASES BY TIME SIGNATURE

END OF THE 
SONG 

1 10

4/4: ONE OVERDRIVE EVERY TEN MEASURES

VOCAL 
OVERDRIVE

Time  
Signature

Beats Per 
Measure

Phrase 
Frequency 
(Measures)

Overdrive / Unison Phrase 
Calculation

2022/4
40 beats / 2 beats per 

measure = 20

1333/4
40 beats / 3 beats per 

measure = 13.3

1044/4
40 beats / 4 beats per 

measure = 10

855/4
40 beats / 5 beats per 

measure = 8

6 or 766/4
40 beats / 6 beats per 

measure = 6.6

5 or 677/4
40 beats / 7 beats per 

measure = 5.7

121
U

81
O

NO UNISON PHRASES IN THE LAST TWELVE MEASURES

NO OD PHRASES IN THE LAST EIGHT MEASURES
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Calculate Unison and Overdrive frequency for 
other time signatures by counting beats.

UNISON AND OVERDRIVE 
FREQUENCY (CONTINUED) 

For time signatures not shown 
on the previous page you need 
to count beats:

 ▪ Count the number of beats 
in a measure, or

 ▪ Use the beat track as a 
reference * 
 
* See next topic to use this 
method.

For example, a measure of 7/8 is 
counted like this:

 ▪ One, Two, One, Two, One, 
Two, Three

The beats are highlighted in 
bold. As you can see, 7/8 has 
three beats in a measure.

UNISON AND OVERDRIVE 
WORKFLOW
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Use the beat track to count 
beats as follows. First make 
sure that the time signature is 
set in the timeline:

Next create the beat track:

 ▪ Press F9 to open CAT

 ▪ Click the Create BEAT Track 
button

 ▪ Click the Create BEAT Track 
notes button

Finally, open the BEAT track:

 ▪ Double click on the BEAT 
track MIDI

The BEAT track will open and 
shows up beats and downbeats 
with MIDI notes: 

The example above is a measure 
of 7/8. It has one downbeat and 
two up beats. 

Three beats per measure means 
that 7/8 has the same Overdrive 
/ Unison frequency as 3/4. (See 
table on the previous page).

COUNT BEATS WITH 
THE BEAT TRACK

OTHER TIME 
SIGNATURES

   Downbeats

   Up beats

D

G

B

K

U

U

U

U

U

U

U

U

D

G

B

K

U

U

U

U

U

U

U

U

AUTHOR PHRASES AS UNISON PHRASES

CHANGE UNISON TO OVERDRIVE

The graphics below show how 
to author Overdrive and Unison 
phrases:

 ▪ Stack your instrument tracks 
together

 ▪ Author Overdrive for guitar

 ▪ Change each Overdrive into 
a Unison phrase

 ▪ Break Unison phrases apart 
into Overdrive phrases

The next few topics discuss this 
workflow in more detail. 

To set up the Unison 
phrase action see 
pages 85 — 86.

U

U

U

U

U

U

U

U

U

U

U

U

O

O

O

O

O

O

O

O

O

O

O

O

10 20

10 20
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UNISON AND OVERDRIVE 
TIPS AND TRICKS 

UNISON AND OVERDRIVE 
TIPS AND TRICKS 2
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Look for measures where the 
whole band plays an interesting 
part together:

 ▪ A lead line

 ▪ Breakdown

 ▪ Pickup

 ▪ Build up to a chorus or solo

Unison phrases can be less than 
a measure long, if needed. This 
can happen for:

 ▪ Breaks

 ▪ Pickups

The opening pickup for 
“Supreme Girl” by The Sterns is 
a good example:

If you author Pro keys:

 ▪ Author Unison / Overdrive 
to the PART KEYS and PRO 
REAL_KEYS_X tracks * 
 
* The sections must be the 
same for both tracks.

SHORT UNISON 
PHRASES

SUBSET UNISON 
PHRASES

KEYBOARD 
OVERDRIVE

LOOK FOR PARTS 
OF INTEREST

“SUPREME GIRL”

UNISON

A subset Unison phrase is when 
a Unison is not authored for all 
instruments.

This can happen when an 
instrument does not play often 
during a song. Most often this 
happens with keys.

In this case you can author a 
subset Unison for the other 
instruments. For example, a 
Unison phrase for drums, guitar, 
and bass (but not keys).

You should only do this if: 

 ▪ A standard Unison is not 
possible, or very non-
musical to create 

A two-instrument Unison is 
possible - but very unusual. 
Note: You need a special 
circumstance to justify this.

For vocal Overdrive see 
page 559.

It is usually best to start 
authoring Overdrive / Unisons 
with the guitar track. This is 
beacuse it tends to have the 
most interesting parts to author.

START WITH THE 
GUITAR TRACK

PART KEYS: OVERDRIVE

PRO REAL_KEYS_X: OVERDRIVE
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UNISON VS OVERDRIVE 
PHRASE RATIO 

As per the official Rock Band 
Network docs, the number of 
Unison and Overdrive phrases is 
usually about the same:

 ▪ “adjust every other [Unison] 
phrase to be an Overdrive 
phrase”

Remember: You need Overdrive 
for gold stars in-game. Too 
much Overdrive is not good, and 
neither is too little. 

Ideally, you should only adjust 
the Overdrive / Unison ratio 
based on scoring.

With that in mind let’s take a 
quick look at Overdrive and 
Unison phrases in a random 
selection of songs. 

Key:
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UNISON VS 
OVERDRIVE

“25 OR 6 TO 4”

6 10

Ratio: 1 : 1.6

“CAUGHT IN A MOSH”

11 12

Ratio: 1 : 1.09

“EVERYBODY WANTS TO 
RULE THE WORLD”

5 6

Ratio: 1 : 1.2

“CRAZY TRAIN”

7 8

Ratio: 1 : 1.14

“I LOVE ROCK N’ ROLL”

2 3

Ratio: 1 : 1.5

“LIVING IN AMERICA”

4 5

Ratio: 1 : 1.25

“GET UP, STAND UP”

5 5

Ratio: 1 : 1

“BEAST AND THE  
HARLOT”

9 11

Ratio: 1 : 1.2

“HEART OF GLASS”

5 5

Ratio: 1 : 1

“RAINBOW IN THE 
DARK”

6 6

Ratio: 1 : 1

“WHIP IT”

4 5

Ratio: 1 : 1.25

“MISERY BUSINESS”

6 7

Ratio: 1 : 1.6

As you can see, most of the 
songs sampled have close to 
a 1 : 1 ratio. It is not unusual 
for a song to have one or two 
more Overdrive phrases than 
Unison phrases. “25 or 6 to 4” 
appears to be a special case. It 
has a few empty measures after 
one Overdrive. Other Overdrive 
phrases are followed by some 
very low note density measures. 

Unison Overdrive
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Zoom out to review your charts:

 ▪ Press and hold Alt and use 
the scroll wheel to zoom out

You should see:

 ▪ Alternating Unison and 
Overdrive phrases

 ▪ Evenly spaced phrases

To close background tracks:

 ▪ Right click the track tab

 ▪ Click Contents > Close all 
interactive media items

Repeat step 2 until you have 
authored Unison phrases for the 
whole song. 

Now break every other Unison 
phrase apart into individual 
Overdrive phrases:

 ▪ Press Alt + N to cycle 
through the instruments

 ▪ Keep one phrase in place. 
Drag the others into 
adjacent measures

This converts Unison phrases 
into separate Overdrive phrases. 
This also keeps phrases evenly 
spaced throughout the song.
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Stack instrument tracks as 
follows:

 ▪ Press and hold the Ctrl key

 ▪ Select instrument tracks one 
at a time * 
 
* In this example the drums, 
guitar and bass tracks are 
selected

Note: Make sure that you select 
instrument MIDI tracks. If you 
select the track control panels 
the next step will not work:

 ▪ Press Ctrl + Alt + E

1
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STACK INSTRUMENT TRACKS 
TO AUTHOR UNISON & OD

3

2
The selected tracks appear in 
a single editor window. One 
track is displayed as normal. 
The others are greyed out in the 
background. Author Overdrive / 
Unison phrases as follows:

 ▪ Select the guitar track * 
 
* Press Alt + N to cycle 
through tracks if needed

 ▪ Draw an Overdrive phrase

 ▪ Select the Overdrive phrase

 ▪ Press the U key to convert 
the Overdrive phrase to a 
Unison phrase

4
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Big Rock Endings (BRE) happen at the end of 
a song. The whole band rocks out before a 
final hit.

BIG ROCK ENDINGS BIG ROCK ENDINGS 2
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Author a Big Rock Ending at the 
end of a song when:

 ▪ The part is too difficult to  
author, or

 ▪ The part is too difficult and 
you cannot play it in a way 
that feels good

Notes should not overlap the 
start or end of a BRE marker.

Check your song in-game to 
make sure this is not happening.

Do not author vocal parts during 
a Big Rock Ending. If a vocal part 
overlaps you must choose how 
to proceed. Choose one of the 
folowing options:

 ▪ Author the BRE but not the 
vocal phrase that overlaps

 ▪ Do not author the Big Rock 
Ending

 ▪ Author all the instruments 
and vocals through to the 
end of the song

All instruments need character 
animations to be authored 
during a Big Rock Ending. 

Guitar and bass:

 ▪ Author Expert notes during 
the BRE to generate rhythms 
for left-hand animations

Drums* and keys:

 ▪ Only require animation notes

* For drums you can author 
the Expert part and use CAT to 
generate animations.

Author BREs on notes 120 (C8) 
to 124 (E8):

Below you can see a BRE for 
four measures. * Note: On PART 
DRUMS use the same rows as 
you would for a drum fill. 

BIG ROCK ENDING 
OVERVIEW

 
 
BRE 
BRE 
BRE 
BRE 
BRE (use all 5 lanes)

BRE MARKER

DRUMS *,  GUITAR, 
BASS, & KEYS

THE BRE FINAL 
HIT

WHEN TO AUTHOR 
A BRE?

THE [CODA] TEXT 
EVENT

If you are using Pro keys:

 ▪ Author a BRE on note 120 
(C8) in PART REAL_KEYS_X

A [coda] text event is needed at 
the start of a BRE:

 ▪ Author the [coda] command 
in the EVENTS track

EVENTS

[coda]

The final hit of the BRE should 
happen after the BRE markers 
end. This is required for:

 ▪ Drums, guitar, bass, and keys

 ▪ Expert, Hard, Medium, and 
Easy

The final hit is very important. 
Without a final note (or hit) the 
BRE score will not count. 

Note: The final hit can be more 
than one note. Do not use  
sustain notes.

THE FINAL HIT NO OVERLAPPING NOTES

NO OVERLAPPING 
NOTES

PRO KEYS BRE 
MARKER

NO VOCALS 
DURING A BRE

ANIMATION 
NOTES 

EXAMPLE EXPERT NOTES FOR ANIMATION

G

B
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Solo markers are used for drums, guitar, bass, 
and keys.

SOLOS 

611

Solos should be dictated by the 
music. Avoid putting solos on:

 ▪ Small fills 

 ▪ Repeated lead lines

Only use a solo marker for an 
obvious solo.

For example, the first two 
measures of the guitar solo 
from “Here I Go Again” by 
Whitesnake. 

For songs that end with a solo 
make sure that you end the solo 
marker as soon as possible. This 
gives time for the solo score 
marker to appear before the 
end of the song.

SOLO MARKER 
OVERVIEW

SOLOS AT THE 
END OF A SONG

WHEN TO AUTHOR 
A SOLO?

X

“HERE I GO AGAIN” BY WHITESNAKE69 70

Author solo markers on note 
103 (G6):

Solo markers should start and 
end with the first and last notes 
of the solo.

 
SOLO

DRUMS, GUITAR, 
BASS, & KEYS

 SUMMARY

 ▪ Author drum solos first, then drum fills, Unisons, and 
Overdrive markers.

 ▪ Drum fills can be authored once every four measures.

 ▪ You can author drum fills to match the style of the song.

 ▪ Unison and Overdrive phrases are typically one measure.

 ▪ Do not author a Unison phrase or a drum overdrive with a 
drum fill.

 ▪ Author one Unison or Overdrive every ten measures for 4/4.

 ▪ Do not author Unisons in the last twelve song measures.

 ▪ Do not author Overdrive in the last eight song measures.

 ▪ Start by authoring Overdrive / Unisons for the guitar track. It 
usually has the most interesting parts.

 ▪ Big Rock Endings need a final hit for each instrument.

 ▪ Do not author vocals during a Big Rock Ending.

 ▪ Author animation notes for all instruments during a BRE.

MARKERS



 ▪ Harmony phrase markers
 ▪ Vocal range Shift
 ▪ Rock Band Harmonies Project

18
VOCAL 
HARMONIES
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Authoring vocal harmonies is an option for 
songs with many vocal parts. You do not 
have to author vocal harmony parts if you 
do not want to.

Lead vocal parts are authored in the PART VOCALS track. We 
covered this process in chapter 16. Here we discuss the how 
the PART VOCALS track and the harmony tracks work together. 
The main topics covered in this chapter are as follows:

 ▪ Phrase markers in harmony tracks

 ▪ How to use range shift markers

 ▪ New special lyric characters

 ▪ The Rock Band Harmonies Project and example harmonies 
from “New Kid in School”

 ▪ The snap to key feature

To identify vocal and harmony tracks we use these symbols:

615

V

1

2

PART VOCALS

HARM1

HARM2

3 HARM3
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Vocal harmonies are made up of the lead vocal 
part and up to two harmony parts.

HARMONY AUTHORING 

We author Vocal harmonies on 
the following tracks:

 ▪ HARM1 contains the lead 
vocal part. It is represented 
by the blue line in-game. 
This track is usually similar 
to the PART VOCALS track

 ▪ HARM2 is for two part 
harmony songs. It is 
represented by the red line 
in-game. In three part songs 
this track is usually for high 
pitch harmony parts

 ▪ HARM3 is only used for 
three part harmonies. It is 
represented by the gold line 
in-game. This track is usually 
for middle or low pitch 
harmony parts
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HARMONIES 
OVERVIEW

PART VOCALS AND 
HARM1

PART VOCALS AND HARM1 PHRASE 
MARKERS EXAMPLE

 
 
HARM1 
HARM2 
HARM3

HARMONIES

V

1

2

Phrase Marker

Phrase Marker

Phrase Marker

Author harmonies the same 
way that you author lead (or 
solo) vocals. Keep the following 
things in mind though:

 ▪ When authoring harmonies 
quantize your notes to a 1/64 
note grid. This will keep your 
authoring clear and easier 
to read

 ▪ Author block harmonies with 
the exact same timing *  
 
* Block harmonies are 
harmonies that are sung in 
the same rhythm. We author 
them with the same timing 
even if the audio timing is 
not exactly the same. This 
keeps the vocal HUD clear, 
and makes it easier to read.

AUTHORING 
HARMONIES

Author harmonies after you have 
completed your PART VOCALS 
track. Use PART VOCALS as the 
starting point for HARM1. 

Your HARM1 track will usually be 
the same as your PART VOCALS 
track. But, there are some 
differences that you need to be 
aware of:

 ▪ The game will use Overdrive 
phrases and Events from 
PART VOCALS. These 
elements do not need to 
be in the HARM1 track. If 
you do copy these elements 
to HARM1 they must be 
identical to the PART 
VOCALS track

 ▪ The phrase markers in 
HARM1 are used for vocal 
scoring. The same is true 
in PART VOCALS. The 
difference is that in HARM1 
the lead and harmony notes 
must be under a HARM1 
phrase marker

This means that phrase markers 
in HARM1 must cover all the 
notes in HARM2 and HARM3. 

For example, if you have a call 
and response part:

 ▪ Extend the phrase markers 
in HARM1 to cover the notes 
in HARM2

The best way to do this is to 
copy the phrase markers from 
PART VOCALS to HARM1. Then 
extend the phrase markers to 
also cover notes in HARM2. 

You can see a simple example 
on the facing page:

 ▪ PART VOCALS has the lead 
part and phrase marker

 ▪ HARM1 has the lead part. 
The phrase marker is 
extended to also cover 
HARM2 notes

 ▪ HARM2 has the harmony 
notes 

HARMONY PHRASE MARKERS
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HARM2 uses phrase markers for static vocals 
mode. HARM3 does not use phrase markers.

HARMONY AUTHORING 
(CONTINUED) 

Use range shift notes to make small pitch 
changes easier to see.
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Note: The speed of the HUD 
change is based on the duration 
of the range shift note.

Use the range shift note to keep 
the range of vocal notes in the 
HUD small. This will make small 
changes in pitch easier to see.

Note: Range shifts are only used 
when there significant changes 
in vocal range in a song. 

The graphic to the right shows 
the perfect situations for a 
range shift. This is because the 
two ranges do not overlap.

With a range shift note the 
zoom level of the HUD will be 
set to the size of the red box. 
This is the larger of the two 
ranges. The vocal HUD will slide 
up where you place the range 
shift note. 

Without a range shift note the 
vocal range would be from the 
lowest to the highest note in 
the chart. 

Phrase markers are required in 
HARM2, but they do not control 
scoring:

 ▪ HARM2 phrase markers 
control when lyrics shift in 
Static Vocals mode *

 ▪ Extend HARM2 phrase 
markers to include all 
HARM3 notes

 ▪ Note: HARM3 does not use 
phrase markers

* Static Vocals mode displays 
lyrics in static chunks:

 ▪ HARM1 phrase markers and 
lyric shift markers control 
lead vocal lyric chunks

 ▪ HARM2 phrase markers 
control harmony lyric chunks

Note: Most songs will not need 
adjustments for Static Vocals. 
Simply copy HARM1 phrase 
markers to HARM2.

HARM2 AND 3 
PHRASE MARKERS

STATIC VOCALS 
LYRIC SHIFT
The lyric shift note sets extra 
shift points for lyrics in static 
vocals mode.

You can find the lyric shift note 
at the bottom of the vocal MIDI 
templates:

Lyrics shift automatically with 
each new phrase marker. But 
sometimes there are too many 
lyrics in a phrase. In this case 
add lyric shift notes to create 
extra shift points. 

Note: Use this feature sparingly. 
Harmonix used it to add extra 
polish to songs:

 ▪ To make lead and harmony 
lyrics line up in certain 
situations

For most songs, lyric shift notes 
are not needed at all.

VOCAL RANGE 
SHIFT
When a song has a large vocal 
range the vocal HUD will zoom 
out to show all the notes.

The zoom level is set at the 
start of the song, based on the 
vocal range of the whole song. 
This makes small changes in 
pitch much harder to read.

The zoom does not adjust itself 
to different vocal ranges during 
the song. 

The solution to this problem is 
to author range shift notes.

Note: The Range shift note is 
under the Lyric Shift note at the 
bottom of vocal MIDI templates.

The range shift note tells the 
vocal HUD to adjust the zoom 
level to the vocal notes that 
come after it. This means that 
you can separate vocal ranges 
from each other with a range 
shift note. 

VOCAL RANGE SHIFT EXAMPLE

   Add Range Shift Note Here

VOCAL RANGE SHIFT

 
 
Lyric Shift 
Range Shift

LYRIC SHIFT



VOCAL HARMONIES

Use the $ symbol to hide lyrics in HARM2 or 3 
when needed. 

HARMONY AUTHORING 
(CONTINUED) 

THE ROCK BAND 
HARMONIES PROJECT
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Vocal Overdrive for PART 
VOCALS and HARM1 can be 
authored separately. But a Rock 
Band 3 bug prevents this from 
being practical.

When PART VOCAL and HARM1 
Overdrive phrases do not match:

 ▪ PART VOCAL Overdrive 
visuals are applied to HARM1 

This means that Overdrive 
visuals in-game may not 
synchronize with HARM1 
Overdrive phrases. 

Because of this issue Overdrive 
phrases must be identical in 
PART VOCALS and HARM1.

In Rock Band 2 the end of a 
phrase was calculated based on 
the position of the last note in 
the phrase. 

This is not the case in Rock 
Band 3. In RB3 the end of a 
phrase marker marks the end 
of a phrase. This is important 
because the end of a phrase 
can trigger:

 ▪ Animations and sound 
effects, and

 ▪ Vocal score calculations (if 
applicable)

For this reason authors should 
try to end phrase markers on 
strong beats, such as:

 ▪ Quarter notes, and 

 ▪ Eighth notes

This allows animations and 
sounds to sync to the rhythm of 
the song.

The Rock Band Harmonies 
Project (RBHP) is a fan project. 
It aims to upgrade all pre-
RB3 disc and DLC tracks with 
harmonies.

The project may also make 
other improvements to tracks, 
including:

 ▪ Pro drums

 ▪ Pro keys

 ▪ Pro guitar / bass

 ▪ Other chart fixes

You can download RBHP MIDI 
files from Github:

 ▪ github.com/FujiSkunk/rbhp 
forked from github.com/
rbhp-espher/rbhp

The RBHP is a great resource to 
study harmony MIDIs for your 
favorite Rock Band songs! 

HIDE LYRICS 
FROM THE HUD
We use the $ sign to hide lyrics 
in HARM2 and HARM3 tracks:

 ▪ $ 

Add the $ sign at the end of 
lyric text events.

Use the $ symbol if HARM2 and 
HARM3 are singing different 
parts at the same time. Hide the 
harmony lyric that you do not 
want to display. 

For example, to hide the lyric 
“harmony”:

 ▪ har-$

 ▪ mo-$

 ▪ ny$

You can edit lyric events 
manually to hide them. Or you 
can use the Hide Lyrics function 
in CAT to do it for you. CAT can 
hide all, or selected lyric events 
in HARM2 and HARM3.

HARMONY 
OVERDRIVE BUG

PHRASE MARKER 
END POINT

RBHP PROJECT 
OVERVIEW

ROCK BAND: HARMONIES PROJECT 
“NEW KID IN SCHOOL” BY THE DONNAS

https://github.com/FujiSkunk/rbhp
https://github.com/rbhp-espher/rbhp
https://github.com/rbhp-espher/rbhp
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“NEW KID IN SCHOOL” 
HARM1 

HARM1 contains the lead vocal 
part. This was first authored in 
the PART VOCALS track.

When you copy PART VOCALS to 
HARM1 the following elements 
are required:

 ▪ Phrase markers

 ▪ Lead vocal MIDI notes

 ▪ Lyric text events

Typically you will copy the whole 
MIDI track from PART VOCALS 
to HARM1. 

This means that HARM1 will 
also contain items that are not 
needed in HARM1:

 ▪ Overdrive markers

 ▪ Animation text events

It is fine to leave these items 
in HARM1 only if they remain 
identical to PART VOCALS.

ROCK BAND: HARMONIES 
PROJECT
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If you copy Overdrive from PART 
VOCALS to HARM1 and need to 
extend the phrase marker:

 ▪ Do not extend Overdrive to 
match the phrase marker

The HARM1 Overdrive marker 
must be the same as the one in 
PART VOCALS.

In this example, the harmony is 
a block harmony:

 ▪ Do you feel lonely?

The blue line shows the 
HARM1 (lead vocal line). On 
the following pages we look at 
how to author the harmony in 
HARM2 and 3.

If the harmony was a call and 
response we would extend the 
phrase marker to cover the 
HARM2 and 3 notes. In this case 
we do not need to extend the 
phrase marker.

Lead vocal MIDI notes 
Identical to PART VOCALS 

Lead vocal lyrics: 
Identical  to PART VOCALS

Overdrive: 
Identical to PART VOCALS 
Not required in HARM1

Phrase markers:  
Must cover lead and 
HARM2 /3 notes

Phrase Marker

Overdrive

Bb

G

F#

B

C3

C#

D

Eb

E

F

G#

Overdrive

Phrase Marker

HARM1 Properties: 1 2 3 4

Tell me you lone-hon- ey + do feel + ly?
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“NEW KID IN SCHOOL” 
HARM2 

HARM2 contains the main 
harmony part for this song.

HARM2 requires the following 
elements:

 ▪ Phrase markers

 ▪ Harmony MIDI notes

 ▪ Lyric text events

The phrase markers are copied 
from HARM1. In this example 
the phrase marker is not 
extended. This is because this is 
a block harmony part. Common 
intervals for harmony parts are:

 ▪ Minor 3rd (3 half steps)

 ▪ Major 3rd (4 half steps)

 ▪ Perfect 5th (7 half steps)

 ▪ Octave (12 half steps)

If you compare the pitches in 
this part to HARM1 you will see 
that this part is a perfect 5th 
(seven half steps) higher.  

ROCK BAND: HARMONIES 
PROJECT
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You can see this in the 
screenshot below:

 
The red line shows the HARM2 
harmony part.

In other parts of the song the 
lead and harmony part sing at 
the same pitch. 

Harmony parts can be higher, 
lower, or the same pitch as the 
lead vocal part.

Harmony MIDI notes 
 

Harmony lyrics Phrase marker 
Copied from HARM1 

Phrase Marker

D

B

Bb

Eb

E

F

F#

G

G#

A

C4

Overdrive

Phrase Marker

1 2 3

you lone-do fe- el ly? +

HARM2 Properties:
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“NEW KID IN SCHOOL” 
HARM3 

HARM3 contains the second 
harmony part, and requires the 
following elements:

 ▪ Harmony MIDI notes

 ▪ Lyric text events

Phrase markers are not required 
for HARM3.

In this phrase the HARM3 part is 
the same as the HARM2 part. 

You can see this in the 
screenshot below:

HARM3 is the gold line in-game. 

ROCK BAND: HARMONIES 
PROJECT

627 VOCAL HARMONIES 628

Harmony MIDI notes 
 

Harmony lyrics

D

B

Bb

Eb

E

F

F#

G

G#

A

C4

Overdrive

Phrase Marker

1 2

you lone-do fe- el ly? +

HARM2 Properties:
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SNAP TO KEY SNAP TO KEY 2

Snap to key can be very helpful when authoring 
vocals and harmonies.

The chord types are:

 ▪ Major triad

 ▪ Minor triad

 ▪ Major 7th

 ▪ Minor 7th

 ▪ Dominant 7th

 ▪ Diminished triad

 ▪ Diminished 7th

 ▪ Augmented 5th triad

In western music we organise 
groups of notes into keys. The 
key tells you the notes that 
belong to a specific scale. 

For example, the notes for the C 
major scale are:

 ▪ C, D, E, F, G, A, and B

There are no sharp or flat notes 
in the C major scale. The root 
note of the scale is C. 

Compare this to the C minor 
scale which has three flat 
notes:

 ▪ C, D, Eb, F, G, Ab, and Bb

There are many different keys 
to choose from. In this topic we 
will cover:

 ▪ How to set the key to a song

 ▪ The keys available in REAPER

 ▪ Snap to key in REAPER

You select song key in REAPER 
using two drop down menus:

 ▪ Note

 ▪ Scale

Use the note menu to select the 
root note of the scale. 

The scale drop down lists the 
following scale types:

 ▪ Chords

 ▪ Major

 ▪ Minor

 ▪ Natural minor

 ▪ Melodic minor

 ▪ Harmonic minor

 ▪ Pentatonic

 ▪ Blues

The snap to key feature restricts 
the notes that you author to the 
selected key.

To use this feature:

 ▪ Check the Scale checkbox to 
enable snap to key

 ▪ Select a root note

 ▪ Select a scale

For example, the C major scale:

Your MIDI notes are now locked 
to the selected scale.

This can save you time when 
authoring vocal parts. For 
example, “New Kid in School” is 
in A# Major. If you copy the lead 
part up a perfect 5th you get 
the notes for the harmony part. 
You can see this in the graphic 
to the right.

KEYS AND SCALES 
IN MUSIC

KEYS AND CHORDS TYPES IN THE 
REAPER MIDI EDITOR

THE SNAP TO KEY 
FEATURE

you lone-do feel + ly?

Lead

Harmony

Note: If you select 
the wrong key you will 
author incorrect notes.

Remember: When snap 
to key is enabled it 
applies to all of your 
MIDI tracks. Uncheck 
the Scale check box to 
turn off snap to key:

Turn off snap to 
key to author other 
instruments: 

D G B K

SNAP TO KEY

http://songkeyfinder.com/
http://songkeyfinder.com/
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ HARM1 is usually the same as the PART VOCALS track.

 ▪ Block harmonies are harmonies sung with the same rhythm. 
Author them with the same timing (even if the timing is not 
exactly the same in the audio).

 ▪ Add range shift notes for songs with a large vocal range.

 ▪ Use the $ sign to hide HARM2 and HARM3 lyrics if needed. 
There is a CAT function that will do this for you.

 ▪ HARM1 should have phrase markers, lead vocal MIDI notes, 
and lyric text events.

 ▪ If you copied Overdrive markers to HARM1 do not extend 
them to match extended phrase markers. 

 ▪ HARM2 should have phrase markers (from HARM1), harmony 
MIDI notes, and lyric text events.

 ▪ HARM3 should have harmony MIDI notes and lyric text 
events only. 

VOCAL HARMONIES



 ▪ Text events
 ▪ Crowd animations
 ▪ Practice Mode
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The EVENTS track typically contains only text 
events. They are used to control crowd audio, 
crowd animations, and practice sections. 

OVERVIEW
Text events in the EVENTS track structure 
your custom song.

Practice sections form part of the structure of your custom 
song. They provide a few benefits:

 ▪ They divide your song into sections that players can 
practice. For example, parts of the chorus, or guitar solo

 ▪ They structure the venue cues that Magma generates

You can author text events to create practice sections, or 
Magma can generate them for you. I recommend that you 
author practise sections. This is better for players, if they want 
to practise your song. It is also better for Magma, if you choose 
to have Magma generate your venue.

Other text events in the EVENTS track mark important 
functions such as:

 ▪ When the song audio starts and ends

 ▪ When the crowd should cheer at the start and end of your 
song

 ▪ When the score screen should appear

 ▪ Crowd animation

The last part of the chapter includes a full list of practise 
sections. I have edited the list it to make it more readable 
and to take up less space. The full list of practice sections is 
available in the RBN Docs if you need it.
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Download links available from: 
rhythmgamingworld.com/customsbook

The C3 Template contains 
many sample text events in the 
EVENTS track. 

 
They have different purposes 
and affect the main functions of 
the game. Along with the tempo 
map they form the structure of 
your custom song. 

Text events in the EVENTS track 
fit into four groups:

 ▪ Crowd audio

 ▪ Crowd animation

 ▪ Practice sections

 ▪ Big Rock Endings (see pages 
609 — 610)

Text events in the EVENTS track 
include:

 ▪ [crowd_normal] 
Sets a crowd animation 
state

 ▪ [music_start]  
Controls crowd audio

 ▪ [prc_intro] 
Practice section type event

 ▪ [music_end] 
Controls crowd audio

 ▪ [end] 
End of song events

Sample events are pre-set 
in the C3 Template. It is very 
unlikely that they are in the 
correct place for your song. 
You will need to move some of 
these events to their correct 
position. Others, wil need to be 
removed and replaced. 

The first few text events in the 
EVENTS track are shown in the 
graphic below:

EVENTS

[music_start]

EVENTS TRACK 
OVERVIEW

EXAMPLE TEXT 
EVENTS

[prc_intro]

[crowd_normal]

[EVENTS] [music_start] [prc_verse_1a]

EVENTS

http://docs.c3universe.com/rbndocs/index.php?title=All_Practice_Sections
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The [end] text event is an important element in 
your custom song.

THE [END] TEXT EVENT 

The [end] event is the most 
important text event in your 
song. It sets the point where:

 ▪ Sound playback stops, 

 ▪ Tracks are removed from the 
screen, and 

 ▪ Scores are tabulated

To avoid clicks and pops in the 
audio place the [end] event 
after all audio stems have faded 
completely.

If it takes some time for the 
audio to fade you can fade 
the last note a little early. 

The [music_start] and [music_end] text events 
control crowd audio.

THE [MUSIC_START] AND 
[MUSIC_END] TEXT EVENTS
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Bass parts usually ring out the 
longest, so they are most often 
faded short. 

You can find the [end] event at 
measure 92.4 in the EVENTS 
track. Drag it to the correct 
place at the end of your song. 
Or if you prefer you can delete it 
and create a new one.

Note: The [end] text event must 
be the last item in your project:

 ▪ There must not be any MIDI 
notes or text events after 
the [end] text event

Once the [end] event is in the 
right place, use CAT to create a 
new BEAT track:

 ▪ Press F9 to open CAT 

 ▪ Click the Create BEAT track 
button

The Manage Beat Track window 
will open:

 ▪ Click the Create BEAT track 
notes button

Check that the last note of the 
BEAT track occurs one beat 
before the [end] text event.

The [music_start] text event 
has two functions, it:

 ▪ Shifts the crowd audio from 
the “intro” state to the 
“play” state, and

 ▪ Triggers a ‘big cheer’ sound 
effect

The “intro” audio state is the 
crowd milling about the club 
waiting for the band to play. 

The “play” audio state is when 
the crowd reacts to how well 
you are playing the song. The 
crowd will cheer if you are doing 
well, and boo if you are not. The 
“big cheer” happens at the start 
of the “play” audio state. 

You can find the [music_start] 
event at measure three of the 
EVENTS track. 

Move the [music_start] event to 
the following place in your song:

 ▪ Where the crowd would 
recognize the song and get 
excited

This is usually when a main riff 
starts or when the whole band 
starts to play together.

The [music_end] event also has 
two functions, it:

 ▪ Shifts the crowd audio 
from the “play” state to the 
“outro” state, and

 ▪ Triggers a ‘big cheer’ sound 
effect

The “outro” audio state is 
the crowd cheering your 
performance. A “big cheer” also 
happens at the start of the 
“outro” audio state. 

You can find the [music_end] 
event at measure ninety-one. 

Move the [music_end] event to 
the following place in your song:

 ▪ Right after the last note or 
when the crowd would start 
cheering at the end of a song

[end]

EVENTS

BEAT

The BEAT track ends 
one beat before the 
[end] text event.

[music_start]

EVENTS

[music_end]

EVENTS
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The crowd intensity is controlled by text events 
in the EVENTS track.

CROWD ANIMATIONS 

Crowd animations are a lot like 
the player animation events. 
You place text events where you 
want the animation to start. 

Crowd animations have three 
intensity levels:

 ▪ mellow

 ▪ normal

 ▪ intense

You must place one of these 
events near the start of your 
song. A good place would be 
where you want the crowd to 
start jumping up and down. 

If you are playing well the crowd 
will go crazy. If not, they will 
mellow out. 

If you want more control over 
the crowd intesity you can add 
more text events to the song.

The crowd will react based on 
your band meter. The intensity 
of the crowd will never go above 

Load the EVENTS list for crowd animation and 
clapping sound text events.

CROWD ANIMATION 
TEXT EVENTS
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[crowd_realtime] The crowd is animated without moving to 
a beat. This is the default animation for 
the beginning of a song.

[crowd_intense] Allows for maximum crowd intensity. The 
crowd will go crazy and jump around if 
you are doing well.

[crowd_normal] The crowd will sway and put their hands 
up, but will never get really crazy.

[crowd_mellow] The crowd sway to the song and stay 
pretty mellow.

TEXT EVENT CROWD ANIMATION
The Events list is a text file that 
includes the crowd animation 
and clapping sound text events. 
Load the list as follows:

 ▪ Double-click in the EVENTS 
track text event area

The Add Text Event window 
opens:

 ▪ Click the Load button

 ▪ Browse to C:\Reaper\Data\
Text_strings\

 ▪ Select the Text Events 
List - Events.txt file

 ▪ Click Open

The Text drop down menu will 
now show crowd animation text 
events and practice sections.

Note: There must be at least 
one practice section authored 
for a song to compile correctly.

THE EVENTS LIST

TEXT EVENT CLAPPING SOUND

[crowd_clap] A clapping sound will play with the song 
when you are doing really well. This is the 
default state.

[crowd_noclap] This turns off the clapping sound effect, 
no matter how well you are doing. Use 
this when the crowd wouldn’t clap along. 
For example, during a rhythm break 
down, or during a quiet section. 

OVERVIEW
the intensity level that you have 
set in the EVENTS track.

Remember:

 ▪ Crowd text events stay 
in effect until you place 
another one on the track

It is a good idea to:

 ▪ Use [crowd_mellow] for 
quiet parts of the song 
 
It would look unatural for 
the crowd to be going crazy 
at that point

 ▪ Gradually increase the crowd 
intensity 
 
For example, use [crowd_
normal] for a pre-chorus 
and [crowd_intense] for the 
chorus. The extra crowd 
intensity during the chorus 
can work very well.

The crowd will normally clap 
along with the song when your 
band meter is full. The clap 

tempo will be the same as the 
notes in the BEAT track.

If you need the crowd to stop 
clapping anywhere in the song 
use the [crowd_noclap] event.

If you want the crowd to 
start clapping again place the 
[crowd_clap] event.

You should also use the [crowd_
noclap] event as follows:

 ▪ Place the [crowd_noclap] 
event just before the last 
note of the song 
 
This stops the crowd from 
clapping after the last note 
of the song

If you do not do this the crowd 
will continue to clap until the 
[end] event. This usually sounds 
quite odd.
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If you are using stems you can add timekeeping 
notes for Practice Mode.

PRACTICE MODE 
TIMEKEEPING NOTES 
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PRACTICE MODE 
OVERVIEW
The EVENTS track contains the 
following MIDI notes:

 ▪ D0 (26): Hi-hat sample

 ▪ C#0 (25): Snare sample

 ▪ C0 ((24): Kick srum sample

These samples play alongside  
isolated stems when Practice 
Mode speed is less than 100%. 

They are used for timekeeping 
during Practice Mode.

4.34.2 4.44

[prc_intro]

EVENTS

Practice sections are text events. If you author 
them as lyric events they will not work.   

PRACTICE SECTIONS

Practice sections are authored 
in the EVENTS track:

Author practice sections as text 
events. 

If you do not author practice 
sections then Magma will 
generate some for you. 

Magma will divide the song 
into five, ten, or twenty parts. 
This depends on the length of 
the song. Practice sections are 
named based on the number of 
divisions. For example:

 ▪ “10-20%”, or “10-15%”

The Events list includes the full 
list of practice sections. Load 
the list as follows:

 ▪ Double-click in the EVENTS 
track text event area

The Add Text Event window 
opens:

 ▪ Click the Load button

 ▪ Browse to C:\Reaper\Data\
Text_strings\

 ▪ Select the Text Events 
List - Events.txt file

 ▪ Click Open

The Text drop down menu will 
now show practice sections. 
Type your search in the text 
field to select practice sections 
from the list.

Note: There must be at least 
one practice section authored 
for a song to compile correctly.

Ideally you should author 
practice sections. Place a text 
event at the start of a song 
section and select a practice 
section name.

For example, place a “Chorus” 
practice section at the start of 
the song chorus.

You can place the same practice 
section name more than once, 
but this is not recommended. 
Sections will not appear as 
unique sections in-game if you 
do this. Instead, author each 
section with a unique name. 
For example, you could divide a 
chorus into two sections:

 ▪ [prc_chorus_1]

 ▪ [prc_chorus_1a]

As you place sections think 
about how a player might want 
to practice different parts of 
the song. Divide your song into 
logical sections. 

EVENTS

[prc_chorus]

PRACTICE 
SECTIONS

LOAD EVENTS 
TEXT EVENTS 

AUTO-GENERATED 
SECTIONS

AUTHORED  
SECTIONS

Only use these special 
timekeeping notes if 
your song has stems.
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Lighting in auto-generated venues requires  
specific practice section(s) to work.

VENUES, TEXT EVENTS, 
AND PRACTICE SECTIONS

Magma will generate a venue if 
you do not author one. But, to 
do this, Magma needs at least 
one of the following practice 
sections:

 ▪ [prc_intro]

 ▪ [prc_verse]

 ▪ [prc_chorus]

 ▪ [prc_bridge]

 ▪ [prc_outro]

Variations of these sections will 
also work. For example:

 ▪ [prc_chorus_1], or

 ▪ [prc_intro_a]

Note: The text events list is in 
alphabetical order. This means 
that practice sections are not 
always grouped together properly.
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For example, if you were 
searching for an intro practice 
sections you would type:

 ▪ [prc_intro

The initial results would be: 
 
[prc_intro]  
[prc_intro_a]  
[prc_intro_b]  
[prc_intro_c] 
[prc_intro_chorus]  
[prc_intro_chorus_a]  
[prc_intro_chorus_b]  
[prc_intro_chorus_c]  
[prc_intro_chorus_d] 
[prc_intro_d]  
[prc_intro_e]

As you can see the intro_chorus 
group interrupts the intro 
practice sections list.

The rest of this chapter 
contains a list of practice 
section text events. This list has 
been abbreviated to save space. 
For example: 
 

[prc_intro]  
[prc_intro_a]  
[prc_intro_b]  
[prc_intro_c]  
[prc_intro_d]  
[prc_intro_e]

 
[prc_intro]  
_a, _b, _c, _d, _e

This keeps the list compact. It 
also lets you see events and 
their variations at a glance.  

Keywords are highlighted in 
bold. The descriptive names 
for practise sections are not 
included. For example, the 
descriptive name for [prc_intro_
slow_a” is “Intro slow a”.

C3 TEMPLATE: 
EVENTS TRACK

The C3 Template includes default practice 
sections in the EVENTS track.

The EVENTS track in the C3 
Template includes the following 
practice sections:

 ▪ [prc_intro]

 ▪ [prc_verse_1a]

 ▪ [prc_verse_1b]

 ▪ [prc_bridge_a]

 ▪ [prc_verse_2a]

 ▪ [prc_verse_2b]

 ▪ [prc_chorus_1a]

 ▪ [prc_gtr_solo]

 ▪ [prc_verse_3a]

 ▪ [prc_verse_3b]

 ▪ [prc_verse_3c]

 ▪ [prc_chorus_2a]

 ▪ [prc_outro]

These text events serve as an 
example song structure. You can 
see that verses are divided in 
to two sections each. While the 
intro, bridge, chorus, solo, and 
outro have one section each.

Your song may have its own 
unique structure. You can 
organize your practice events 
in a way that makes the most 
sense for your song.

You may find that a practice 
section around every four 
measures might work well for 
your song. A practice section 
after a riff repeats twice can 
also work well for some songs.

Let’s take a closer look at some 
common practice sections:

 ▪ Intro: 
The first part of the song. It 
sets up the song and leads 
into the verse.

 ▪ Verse: 
Contains the main lyric 
back story. Each verse has 
different lyrics. The music is 
usually identical.  

 ▪ Bridge: 
Also known as the pre-
chorus. Connects the verse 
to the chorus. Often uses 
the IV or ii chord to lead into 
the chorus. Can also use 
new patterns or harmonies. 
In pop music the bridge is a 
section that contrasts with 
the verse. It breaks up the 
repetitive pattern of words 
and music in the song. 
A common bridge is the 
middle eight (usually placed 
after the second chorus). 

 ▪ Chorus: 
The part of the song that 
repeats the most. It contains 
the main idea of the song 
musically and lyrically. Most 
choruses are eight measures 
long. The chorus may also 
double in length later on in 
the song.

 ▪ Outro: 
The last part of the song. 
Often this may be the chorus 
repeated to fade (“outro 
chorus”). Otherwise, the 
outro may be a new section 
that closes the song.

ORIGINAL LIST

ABBREVIATED LIST



EVENTS TRACK645 EVENTS TRACK 646

INTRO, FADE, ENTERS, VERSE VERSE, CHORUS, BRIDGE 

[prc_intro]  
_a, _b, _c, _d, _e 
 
[prc_intro_slow]  
_a, _b, _c, _d, _e 
  
[prc_intro_fast]  
_a, _b, _c, _d 
 
[prc_intro_heavy]  
_a, _b, _c, _d 
 
[prc_quiet_intro]  
_a, _b, _c, _d 
 
[prc_noise_intro]  
_a, _b, _c, _d 
 
[prc_drum_intro]  
_a, _b, _c, _d 
 
[prc_bass_intro]  
_a, _b, _c, _d 
 
[prc_vocal_intro]  
_a, _b, _c, _d 
 
[prc_gtr_intro]  
_a, _b, _c, _d, _e 
 
[prc_violin_intro]  
_a, _b, _c, _d  
 
[prc_strings_intro]  
_a, _b, _c, _d 
 
[prc_orch_intro]  
_a, _b, _c, _d 
 
[prc_horn_intro]  
_a, _b, _c, _d 
 

[prc_harmonica_intro]  
_a, _b, _c, _d 
 
[prc_organ_intro]  
_a, _b, _c, _d 
 
[prc_piano_intro]  
_a, _b, _c, _d 
 
[prc_keyboard_intro]  
_a, _b, _c, _d 
 
[prc_dj_intro]  
_a, _b, _c, _d 
 
[prc_intro_hook]  
_a, _b, _c, _d 
 
[prc_intro_riff]  
_a, _b, _c, _d 
 
[prc_fade_in]  
_a, _b, _c, _d

[prc_drums_enter]  
[prc_bass_enters]  
[prc_gtr_enters]  
[prc_rhy_enters]  
[prc_band_enters]  
[prc_syth_enters]  
[prc_keyb_enters]  
[prc_organ_enters]  
[prc_piano_enters]  
[prc_kick_it] 

[prc_intro_verse]  
_a, _b, _c, _d

[prc_intro_chorus]  
_a, _b, _c, _d

[prc_verse]  
_a, _b, _c, _d, _e, _f 

[prc_verse_1]  
a, b, c, d, e, f 
 
[prc_verse_2]  
a, b, c, d, e, f 
 
[prc_verse_3]  
a, b, c, d, e, f 
 
[prc_verse_4]  
a, b, c, d 
 
[prc_verse_5]  
a, b, c, d 
 
[prc_verse_6]  
a, b, c, d 
 
[prc_verse_7]  
a, b, c, d

[prc_verse_8]  
a, b, c, d

[prc_verse_9]  
a, b, c, d 

[prc_alt_verse]  
_a, _b, _c, _d

[prc_quiet_verse]  
_a, _b, _c, _d

[prc_preverse]  
_a, _b, _c, _d

[prc_preverse_1]  
a, b, c, d

[prc_preverse_2]  
a, b, c, d

[prc_preverse_3]  
a, b, c, d

[prc_preverse_4]  
a, b, c, d 

[prc_preverse_5]  
a, b, c, d

[prc_postverse]  
_a, _b, _c, _d 
 
[prc_postverse_1]  
a, b, c, d

[prc_postverse_2]  
a, b, c, d

[prc_postverse_3]  
a, b, c, d

[prc_postverse_4]  
a, b, c, d

[prc_postverse_5]  
a, b, c, d

[prc_chorus]  
_a, _b, _c, _d

[prc_chorus_1]  
a, b, c, d

[prc_chorus_2]  
a, b, c, d

[prc_chorus_3]  
a, b, c, d

[prc_chorus_4]  
a, b, c, d

[prc_chorus_5]  
a, b, c, d

[prc_chorus_6]  
a, b, c, d

[prc_chorus_7]  
a, b, c, d

[prc_chorus_8]  
a, b, c, d

[prc_chorus_9]  
a, b, c, d

[prc_chorus_break]  
_a, _b, _c, _d

[prc_breakdown_chorus]  
_a, _b, _c, _d

[prc_alt_chorus]  
_a, _b, _c, _d

[prc_prechorus]  
_a, _b, _c, _d

[prc_prechorus_1]  
a, b, c, d

[prc_prechorus_2]  
a, b, c, d

[prc_prechorus_3]  
a, b, c, d

[prc_prechorus_4]  
a, b, c, d

[prc_prechorus_5]  
a, b, c, d

[prc_postchorus]  
_a, _b, _c, _d

[prc_postchorus_1]  
a, b, c, d

[prc_postchorus_2]  
a, b, c, d

[prc_postchorus_3]  
a, b, c, d

[prc_postchorus_4]  
a, b, c, d

[prc_postchorus_5]  
a, b, c, d

[prc_bridge]  
_a, _b, _c, _d

[prc_bridge_1]  
a, b, c, d

[prc_bridge_2]  
a, b, c, d

[prc_bridge_3]  
a, b, c, d

[prc_bridge_4]  
a, b, c, d

prc_bridge_5]  
a, b, c, d

[prc_bridge_6]  
a, b, c, d

[prc_bridge_7]  
a, b, c, d 
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BRIDGE, SOLO
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[prc_bridge_8]  
a, b, c, d

[prc_bridge_9]  
a, b, c, d

[prc_gtr_solo]  
_a, _b, _c, _d, _e, _f, _g, _h, _i, 
_ j, _k, _l, _m, _n, _o, _p, q, _r, _s 
 
[prc_gtr_solo_1]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_gtr_solo_2]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_gtr_solo_3]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_gtr_solo_4]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_gtr_solo_5]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

prc_gtr_solo_6]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_gtr_solo_7]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_gtr_solo_8]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_gtr_solo_9]  
a, b, c, d, e, f, g, h, i, j, k, l, m, n

[prc_slide_solo]  
_a, _b, _c, _d

[prc_slide_solo_1]  
a, b, c, d

[prc_slide_solo_2]  
a, b, c, d

[prc_slide_solo_3]  
a, b, c, d

[prc_slide_solo_4]  
a, b, c, d

[prc_drum_solo]  
_a, _b, _c, _d

[prc_drum_solo_1]  
a, b, c, d

[prc_drum_solo_2]  
a, b, c, d

[prc_drum_solo_3]  
a, b, c, d

[prc_drum_solo_4]  
a, b, c, d

[prc_perc_solo]  
_a, _b, _c, _d

[prc_perc_solo_1]  
a, b, c, d

[prc_perc_solo_2]  
a, b, c, d

[prc_perc_solo_3]  
a, b, c, d

[prc_perc_solo_4]  
a, b, c, d

[prc_bass_solo]  
_a, _b, _c, _d

[prc_bass_solo_1]  
a, b, c, d

[prc_bass_solo_2]  
a, b, c, d

[prc_bass_solo_3]  
a, b, c, d

[prc_bass_solo_4]  
a, b, c, d

[prc_organ_solo]  
_a, _b, _c, _d

[prc_organ_solo_1]  
a, b, c, d

[prc_organ_solo_2]  
a, b, c, d

[prc_organ_solo_3]  
a, b, c, d

[prc_organ_solo_4]  
a, b, c, d

[prc_piano_solo]  
_a, _b, _c, _d

[prc_piano_solo_1]  
a, b, c, d

[prc_piano_solo_2]  
a, b, c, d

[prc_piano_solo_3]  
a, b, c, d

SOLO, PART

prc_piano_solo_4]  
a, b, c, d

[prc_keyboard_solo]  
_a, _b, _c, _d

[prc_keyboard_solo_1]  
a, b, c, d

[prc_keyboard_solo_2]  
a, b, c, d

[prc_keyboard_solo_3]  
a, b, c, d

[prc_keyboard_solo_4]  
a, b, c, d

[prc_synth_solo]  
_a, _b, _c, _d

[prc_synth_solo_1]  
a, b, c, d

[prc_synth_solo_2]  
a, b, c, d

[prc_synth_solo_3]  
a, b, c, d

[prc_synth_solo_4]  
a, b, c, d

[prc_harmonica_solo]  
_a, _b, _c, _d

[prc_harmonica_solo_1]  
a, b, c, d

[prc_harmonica_solo_2]  
a, b, c, d

[prc_harmonica_solo_3]  
a, b, c, d

[prc_harmonica_solo_4]  
a, b, c, d

[prc_sax_solo]  
_a, _b, _c, _d

[prc_sax_solo_1]  
a, b, c, d

[prc_sax_solo_2]  
a, b, c, d

[prc_sax_solo_3]  
a, b, c, d

[prc_sax_solo_4]  
a, b, c, d

[prc_horn_solo]  
_a, _b, _c, _d

[prc_horn_solo_1]  
a, b, c, d

[prc_horn_solo_2]  
a, b, c, d

[prc_horn_solo_3]  
a, b, c, d

[prc_horn_solo_4]  
a, b, c, d

[prc_flute_solo]  
_a, _b, _c, _d

[prc_flute_solo_2]  
a, b, c, d

[prc_flute_solo_3]  
a, b, c, d

[prc_flute_solo_4]  
a, b, c, d

[prc_noise_solo]  
_a, _b, _c, _d

[prc_noise_solo_2]  
a, b, c, d

[prc_noise_solo_3]  
a, b, c, d

[prc_noise_solo_4]  
a, b, c, d

[prc_dj_solo]  
_a, _b, _c, _d

[prc_dj_solo_2]  
a, b, c, d

[prc_dj_solo_3]  
a, b, c, d

[prc_dj_solo_4]  
a, b, c, d

[prc_slow_part]  
_a, _b, _c, _d

[prc_slow_part_2]  
a, b, c, d

[prc_slow_part_3]  
a, b, c, d

[prc_slow_part_4]  
a, b, c, d
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[prc_fast_part]  
_a, _b, _c, _d

[prc_fast_part_2]  
a, b, c, d

[prc_fast_part_3]  
a, b, c, d

[prc_fast_part_4]  
a, b, c, d

[prc_quiet_part]  
_a, _b, _c, _d

[prc_quiet_part_2]  
a, b, c, d

[prc_quiet_part_3]  
a, b, c, d

[prc_quiet_part_4]  
a, b, c, d

[prc_loud_part]  
_a, _b, _c, _d

[prc_loud_part_2]  
a, b, c, d

[prc_loud_part_3]  
a, b, c, d

[prc_loud_part_4]  
a, b, c, d

[prc_heavy_part]  
_a, _b, _c, _d

[prc_heavy_part_2]  
a, b, c, d

[prc_heavy_part_3]  
a, b, c, d

[prc_heavy_part_4]  
a, b, c, d

[prc_spacey_part]  
_a, _b, _c, _d

[prc_spacey_part_2]  
a, b, c, d

[prc_spacey_part_3]  
a, b, c, d

[prc_spacey_part_4]  
a, b, c, d

[prc_trippy_part]  
_a, _b, _c, _d

[prc_trippy_part_2]  
a, b, c, d

[prc_trippy_part_3]  
a, b, c, d

[prc_trippy_part_4]  
a, b, c, d

[prc_break]  
_a, _b, _c, _d

[prc_break_1]  
a, b, c, d

[prc_break_2]  
a, b, c, d

[prc_break_3]  
a, b, c, d

[prc_break_4]  
a, b, c, d

[prc_breakdown]  
_a, _b, _c, _d

[prc_breakdown_1]  
a, b, c, d

[prc_breakdown_2]  
a, b, c, d

[prc_breakdown_3]  
a, b, c, d

[prc_breakdown_4]  
a, b, c, d

[prc_gtr_break]  
_a, _b, _c, _d

[prc_gtr_break_1]  
a, b, c, d

[prc_gtr_break_2]  
a, b, c, d

[prc_gtr_break_3]  
a, b, c, d

[prc_gtr_break_4]  
a, b, c, d

[prc_bass_break]  
_a, _b, _c, _d

[prc_bass_break_1]  
a, b, c, d

[prc_bass_break_2]  
a, b, c, d

BREAK, INTERLUDE, 
SOUNDSCAPE, JAM 

[prc_bass_break_3]  
a, b, c, d

[prc_bass_break_4]  
a, b, c, d

[prc_drum_break]  
_a, _b, _c, _d

[prc_drum_break_1]  
a, b, c, d

[prc_drum_break_2]  
a, b, c, d

[prc_drum_break_3]  
a, b, c, d

[prc_drum_break_4]  
a, b, c, d

[prc_organ_break]  
_a, _b, _c, _d

[prc_organ_break_1]  
a, b, c, d

[prc_organ_break_2]  
a, b, c, d

[prc_organ_break_3]  
a, b, c, d

[prc_organ_break_4]  
a, b, c, d

[prc_synth_break]  
_a, _b, _c, _d

[prc_synth_break_1]  
a, b, c, d

[prc_synth_break_2]  
a, b, c, d

[prc_synth_break_3]  
a, b, c, d

[prc_synth_break_4]  
a, b, c, d

[prc_piano_break]  
_a, _b, _c, _d

[prc_piano_break_1]  
a, b, c, d

[prc_piano_break_2]  
a, b, c, d

[prc_piano_break_3]  
a, b, c, d

[prc_piano_break_4]  
a, b, c, d

[prc_keyboard_break]  
_a, _b, _c, _d

[prc_keyboard_break_1]  
a, b, c, d

[prc_keyboard_break_2]  
a, b, c, d

[prc_keyboard_break_3]  
a, b, c, d

[prc_keyboard_break_4]  
a, b, c, d

[prc_horn_break]  
[prc_sctrach_break]  
[prc_perc_break]  
[prc_dj_break] 

[prc_interlude]  
_a, _b, _c, _d 
 
[prc_interlude_1]  
a, b, c, d 
 
[prc_interlude_2]  
a, b, c, d 
 
[prc_interlude_3]  
a, b, c, d 
 
[prc_interlude_4]  
a, b, c, d

[prc_soundscape]  
_a, _b, _c, _d 
 
[prc_soundscape_1]  
a, b, c, d 
 
[prc_soundscape_2]  
a, b, c, d 
 
[prc_soundscape_3]  
a, b, c, d 
 
[prc_soundscape_4]  
a, b, c, d

[prc_jam]  
_a, _b, _c, _d 
 
[prc_jam_1]  
a, b, c, d 
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[prc_jam_2]  
a, b, c, d

[prc_jam_3]  
a, b, c, d

[prc_jam_4]  
a, b, c, d

[prc_space_ jam]  
_a, _b, _c, _d

[prc_space_ jam_1]  
a, b, c, d

[prc_space_ jam_2]  
a, b, c, d

[prc_space_ jam_3]  
a, b, c, d

[prc_space_ jam_4]  
a, b, c, d

[prc_vamp]  
_a, _b, _c, _d

[prc_vamp_1]  
a, b, c, d

[prc_vamp_2]  
a, b, c, d 

[prc_vamp_3]  
a, b, c, d 

[prc_vamp_4]  
a, b, c, d 

[prc_build_up]  
_a, _b, _c, _d 

[prc_build_up_1]  
a, b, c, d

[prc_build_up_2]  
a, b, c, d

[prc_build_up_3]  
a, b, c, d

[prc_build_up_4]  
a, b, c, d

[prc_speedup]  
_a, _b, _c, _d

[prc_speed_up_1]  
a, b, c, d

[prc_speed_up_2]  
a, b, c, d

[prc_speed_up_3]  
a, b, c, d

[prc_speed_up_4]  
a, b, c, d

[prc_tension]  
_a, _b, _c, _d

[prc_tension_1]  
a, b, c, d

[prc_tension_2]  
a, b, c, d

[prc_tension_3]  
a, b, c, d

[prc_tension_4]  
a, b, c, d 

[prc_release]  
_a, _b, _c, _d

[prc_release_1]  
a, b, c, d

[prc_release_2]  
a, b, c, d

[prc_release_3]  
a, b, c, d

[prc_release_4]  
a, b, c, d

[prc_crescendo]  
_a, _b, _c, _d

[prc_crescendo_1]  
a, b, c, d

[prc_crescendo_2]  
a, b, c, d

[prc_crescendo_3]  
a, b, c, d

[prc_crescendo_4]  
a, b, c, d

[prc_melody]  
_a, _b, _c, _d

[prc_melody_1]  
a, b, c, d

[prc_melody_2]  
a, b, c, d

[prc_melody_3]  
a, b, c, d

CRESCENDO, MELODY, RIFF 

[prc_melody_4]  
a, b, c, d

[prc_lo_melody]  
_a, _b, _c, _d

[prc_lo_melody_1]  
a, b, c, d

[prc_lo_melody_2]  
a, b, c, d

[prc_lo_melody_3]  
a, b, c, d

[prc_lo_melody_4]  
a, b, c, d

[prc_hi_melody]  
_a, _b, _c, _d

[prc_hi_melody_1]  
a, b, c, d

[prc_hi_melody_2]  
a, b, c, d

[prc_hi_melody_3]  
a, b, c, d

[prc_hi_melody_4]  
a, b, c, d

[prc_main_riff]  
_a, _b, _c, _d, _e, _f

[prc_main_riff_1]  
a, b, c, d, e, f

[prc_main_riff_2]  
a, b, c, d, e, f

[prc_main_riff_3]  
a, b, c, d, e, f

[prc_main_riff_4]  
a, b, c, d,

[prc_main_riff_5]  
a, b, c, d, 

[prc_main_riff_6]  
a, b, c, d, 

[prc_main_riff_7]  
a, b, c, d, 

[prc_main_riff_8]  
a, b, c, d, 

[prc_main_riff_9]  
a, b, c, d,

[prc_verse_riff]  
_a, _b, _c, _d

[prc_verse_riff_1]  
a, b, c, d

[prc_verse_riff_2]  
a, b, c, d

[prc_verse_riff_3]  
a, b, c, d

[prc_verse_riff_4]  
a, b, c, d

[prc_chorus_riff]  
_a, _b, _c, _d

[prc_chorus_riff_1]  
a, b, c, d 

[prc_chorus_riff_2]  
a, b, c, d

[prc_chorus_riff_3]  
a, b, c, d

[prc_chorus_riff_4]  
a, b, c, d

[prc_gtr_riff]  
_a, _b, _c, _d

[prc_gtr_riff_1]  
a, b, c, d

[prc_gtr_riff_2]  
a, b, c, d

[prc_gtr_riff_3]  
a, b, c, d

[prc_gtr_riff_4]  
a, b, c, d

[prc_bass_riff]  
_a, _b, _c, _d

[prc_bass_riff_1]  
a, b, c, d

[prc_bass_riff_2]  
a, b, c, d

[prc_bass_riff_3]  
a, b, c, d

[prc_bass_riff_4]  
a, b, c, d

[prc_big_riff]  
_a, _b, _c, _d
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[prc_big_riff_1]  
a, b, c, d

[prc_big_riff_2]  
a, b, c, d

[prc_big_riff_3]  
a, b, c, d

[prc_big_riff_4]  
a, b, c, d

[prc_bigger_riff]  
_a, _b, _c, _d

[prc_bigger_riff_1]  
a, b, c, d

[prc_bigger_riff_2]  
a, b, c, d

[prc_bigger_riff_3]  
a, b, c, d

[prc_bigger_riff_4]  
a, b, c, d

[prc_heavy_riff]  
_a, _b, _c, _d

[prc_heavy_riff_1]  
a, b, c, d

[prc_heavy_riff_2]  
a, b, c, d

[prc_heavy_riff_3]  
a, b, c, d

[prc_heavy_riff_4]  
a, b, c, d

[prc_fast_riff]  
_a, _b, _c, _d

[prc_fast_riff_1]  
a, b, c, d

[prc_fast_riff_2]  
a, b, c, d

[prc_fast_riff_3]  
a, b, c, d

[prc_fast_riff_4]  
a, b, c, d

[prc_slow_riff]  
_a, _b, _c, _d

[prc_slow_riff_1]  
a, b, c, d

[prc_slow_riff_2]  
a, b, c, d

[prc_slow_riff_3]  
a, b, c, d

[prc_slow_riff_4]  
a, b, c, d

[prc_swing_riff]  
_a, _b, _c, _d

[prc_swing_riff_1]  
a, b, c, d

[prc_swing_riff_2]  
a, b, c, d

[prc_swing_riff_3]  
a, b, c, d

[prc_swing_riff_4]  
a, b, c, d

[prc_chunky_riff]  
_a, _b, _c, _d

[prc_chunky_riff_1]  
a, b, c, d

[prc_chunky_riff_2]  
a, b, c, d

[prc_chunky_riff_3]  
a, b, c, d

[prc_chunky_riff_4]  
a, b, c, d

[prc_odd_riff]  
_a, _b, _c, _d

[prc_odd_riff_1]  
a, b, c, d

[prc_odd_riff_2]  
a, b, c, d

[prc_odd_riff_3]  
a, b, c, d

[prc_odd_riff_4]  
a, b, c, d

[prc_hook]  
_a, _b, _c, _d

[prc_hook_1]  
a, b, c, d 
 
[prc_hook_2]  
a, b, c, d

HOOK, DRUM ROLL, 
GTR, VOCAL

[prc_hook_3]  
a, b, c, d

[prc_hook_4]  
a, b, c, d

[prc_drum_roll]  
_a, _b, _c, _d

[prc_drum_roll_1]  
a, b, c, d

[prc_drum_roll_2]  
a, b, c, d

[prc_drum_roll_3]  
a, b, c, d

[prc_drum_roll_4]  
a, b, c, d

[prc_gtr_lead]  
_a, _b, _c, _d

[prc_gtr_lead_1]  
a, b, c, d

[prc_gtr_lead_2]  
a, b, c, d

[prc_gtr_lead_3]  
a, b, c, d

[prc_gtr_lead_4]  
a, b, c, d

[prc_gtr_fill]  
_a, _b, _c, _d 
[prc_gtr_fill_1]  
a, b, c, d

[prc_gtr_fill_2]  
a, b, c, d

[prc_gtr_fill_3]  
a, b, c, d

[prc_gtr_fill_4]  
a, b, c, d

[prc_gtr_hook]  
_a, _b, _c, _d

[prc_gtr_hook_1]  
a, b, c, d

[prc_gtr_hook_2]  
a, b, c, d

[prc_gtr_hook_3]  
a, b, c, d

[prc_gtr_hook_4]  
a, b, c, d

[prc_gtr_melody]  
_a, _b, _c, _d

[prc_gtr_melody_1]  
a, b, c, d

[prc_gtr_melody_2]  
a, b, c, d

[prc_gtr_melody_3]  
a, b, c, d

[prc_gtr_melody_4]  
a, b, c, d

[prc_gtr_line]  
_a, _b, _c, _d

[prc_gtr_line_1]  
a, b, c, d

[prc_gtr_line_2]  
a, b, c, d

[prc_gtr_line_3]  
a, b, c, d

[prc_gtr_line_4]  
a, b, c, d

[prc_gtr_lick]  
_a, _b, _c, _d

[prc_gtr_lick_1]  
a, b, c, d

[prc_gtr_lick_2]  
a, b, c, d

[prc_gtr_lick_3]  
a, b, c, d

[prc_gtr_lick_4]  
a, b, c, d

[prc_vocal_break]  
_a, _b, _c, _d

[prc_vocal_break_1]  
a, b, c, d

[prc_vocal_break_2]  
a, b, c, d

[prc_vocal_break_3]  
a, b, c, d

[prc_vocal_break_4]  
a, b, c, d
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AH, YEAH, OOHS, PRAYER, 
CHANT, SPOKEN, OUTRO ... 
[prc_ah]  
[prc_yeah] 

[prc_oohs]  
_a, _b, _c, _d

[prc_oohs_1]  
a, b, c, d

[prc_oohs_2]  
a, b, c, d

[prc_oohs_3]  
a, b, c, d

[prc_oohs_4]  
a, b, c, d

[prc_prayer]  
_a, _b, _c, _d

[prc_prayer_1]  
a, b, c, d

[prc_prayer_2]  
a, b, c, d

[prc_prayer_3]  
a, b, c, d

[prc_prayer_4]  
a, b, c, d

[prc_chant]  
_a, _b, _c, _d

[prc_chant_1]  
a, b, c, d 
 
[prc_chant_2]  
a, b, c, d
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[prc_chant_3]  
a, b, c, d

[prc_chant_4]  
a, b, c, d

[prc_spoken_word]  
_a, _b, _c, _d

[prc_spoken_word_1]  
a, b, c, d

[prc_spoken_word_2]  
a, b, c, d

[prc_spoken_word_3]  
a, b, c, d

[prc_spoken_word_4]  
a, b, c, d

[prc_outro]  
_a, _b, _c, _d

[prc_outro_1]  
a, b, c, d

[prc_outro_2]  
a, b, c, d 

[prc_outro_3]  
a, b, c, d 

[prc_outro_4]  
a, b, c, d 

[prc_outro_solo]  
_a, _b, _c, _d 
 
[prc_outro_chorus]  
_a, _b, _c, _d

[prc_ending]  
_a, _b, _c, _d

[prc_bre] 

[prc_fade_out]  
_a, _b, _c, _d

[prc_a]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_b]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_c]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_d]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_e]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_f]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_g]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_h]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_i]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_j]  
1, 2, 3, 4, 5, 6, 7, 8, 9

[prc_k]  
1, 2, 3, 4, 5, 6, 7, 8, 9

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1

INTRODUCTION 656

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Place the [end] event at the end of the song (after the audio 
stops playing).

 ▪ Make sure that there are no notes or text events after the 
[end] event.

 ▪ Place the [music_start] event where the crowd would 
recognize the song and get excited.

 ▪ Place the [music_end] event where the crowd would start to 
cheer at the end of a song.

 ▪ Add crowd animations to the EVENTS track. Your crowd 
should be excited about the song they are listening to.

 ▪ Place the [crowd_noclap] event just before the last note of 
the song.

 ▪ Only add special timekeeping notes for Practice Mode if your 
song uses stems. 

 ▪ Add practice sections to your song. This improves venue 
generation in Magma, and helps players practice your song.

EVENTS TRACK



 ▪ Generated venues
 ▪ Camera and lights
 ▪ Reference images

20
VENUE 
AUTHORING
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The VENUE track controls the camera and 
lighting for Rock Band. 

THE VENUE TRACK
Authoring a venue is optional. It lets you 
control the camera cuts and lighting for 
your song. If you do not want to author a 
venue Magma will generate one for you.

There are a couple of different approaches that you can take to 
venue authoring. You can update a theme, or create a new one. 
Or you can update a generated venue, or create a new venue 
from scratch.

This chapter covers the following topics:

 ▪ How to customize Magma themes to create your own 
custom theme

 ▪ Explore the camera cuts, lighting, and post processing 
effects that you can use

 ▪ Install venuegen to create custom venues from scratch

 ▪ Discover how to import Magma generated venues and use 
them as a template for a custom venue

 ▪ See which camera cuts take priority over others 

 ▪ Learn from community authored examples
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Download links available from: 
rhythmgamingworld.com/customsbook

To author a venue add text 
events to the VENUE track. 
Venue events include:

 ▪ Camera cuts

 ▪ Directed cuts

 ▪ Lighting

 ▪ Post processing effects

 ▪ Pyrotechnics

Camera cuts are pre-defined. 
You can choose from many 
different cuts, for example:

 ▪ Band shots

 ▪ Individual musicians

 ▪ Pairs of musicians

Camera cuts can have several 
different positions, such as: 

 ▪ Behind 

 ▪ Far 

 ▪ near 

 ▪ Close-up

 ▪ Close-up head

Directed cuts contain a range 
of special character animations. 
Lighting events allow you 
to control on-stage lights. 
Post processing effects are 
used to compliment camera 
cuts. Pyrotechnics trigger an 
explosion and sound effect.

VENUE TRACK 
OVERVIEW

The VENUE track has two text 
events at the start of the track:

 ▪ [lighting ()] 
The old default lighting 
event (see page 705).

 ▪ VENUE 
The track name text event. 

MAGMA will create a venue if 
you don’t add any other text 
events to the VENUE track.

 ▪ Remove the [lighting ()] 
text event so that Magma 
can generate your venue

INTRO TO CAMERA, LIGHTS, POST 
PROCESSING, AND PYROTECHNICS

[lighting ()]

VENUE

VENUE

For autogen Magma 
venues make sure that 
the only text event in 
the VENUE track is the 
track name.Magma will not generate any lighting 

if the [lighting ()] text event is in 
your VENUE track.
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Magma provides a variety of venue themes to 
choose from when you compile your song.

VENUE AUTOGENERATION 

If you have not authored a 
venue you can pick one from 
Magma’s theme list:

 ▪ Open Magma

 ▪ Click on the Game Data tab

 ▪ Click the Auto generation 
Theme drop down menu

The included themes are:

 ▪ Default

 ▪ Aggressive Metal

 ▪ Arena Rock

 ▪ Dark Heavy Rock

 ▪ Dusty Vintage

 ▪ Edgy Prog Rock

 ▪ Feel Good Pop Rock

 ▪ Garage Punk Rock

 ▪ Psych Jam Rock

 ▪ Slow Jam

 ▪ Synth Pop

You can open autogenerated themes with a text 
editor such as Notepad.

HOW TO OPEN THEMES
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Each theme contains different 
lighting, camera shots, and 
camera effects. You can change 
how your song looks and feels 
with a single click. 

Themes can also be edited and 
shared. You can create your own 
themes and add as much or as 
little to it as you would like. 

Creating your own themes is a 
great way to get into authoring a 
venue of your own!  

You can find Magma themes 
in the themes folder of your 
Magma installation. For 
example:

 ▪ C:\Magma\themes

Themes all have the following 
file extension:

 ▪ .rbtheme

To open a theme with Notepad:

 ▪ Right-click on a theme

 ▪ Click Open with in the 
context menu

 ▪ Select Notepad from the list 
of applications

 ▪ Click the Always button to 
always open themes with 
Notepad

To use autogen and 
custom themes you 
must author practice 
sections for your song. 
See pages 642 — 655.
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Themes are divided into three sections. Only a 
few elements make up each theme.

THE STRUCTURE OF A THEME 

To the right you can see part of 
the SynthPop Magma theme.

It has been edited and color 
coded so that it is easy to 
understand:

 ▪ Themes can have up to 
three sections: 
 
1. Camera pacing  
2. Extra sections 
3. Section presets

 ▪ Themes have a nested 
bracket structure

 ▪ Section names are in green

 ▪ Parameters are blue

 ▪ Parameter options are pink

 ▪ Text strings are orange

Note: We pair parameters and 
parameter options together 
to select venue effects. Some 
Parameters have more than one 
option to choose from.  
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(camera_pacing medium)

(extra_sections 
   (spacey 
      (practice_sections “*spacey*”) 
   ) 
)

(section_presets 
   (default  
      (allowed_lightpresets harmony sweep) 
      (allowed_postprocs ProFilm_a.pp) 
      (lightpreset_blendin 2) 
      (postproc_blendin 2) 
   )        
   (intro    
      (allowed_lightpresets silhouettes_spot) 
      (allowed_postprocs ProFilm_a.pp) 
      (lightpreset_blendin 2) 
      (postproc_blendin 2) 
   ) 
 
   (spacey 
      (allowed_lightpresets dischord) 
      (allowed_postprocs clean_trails.pp)             
      (lightpreset_blendin 2) 
      (keyframe_rate 2) 
      (postproc_blendin 2)

   ) 
)

1

2

3

The first section of a  
 theme is camera pacing. 
This controls the pace of 
camera cuts. There are five 
options to choose from:

 ▪ Minimal

 ▪ Slow

 ▪ Medium

 ▪ Fast

 ▪ Crazy

The syntax for medium camera 
pacing is:

(camera_pacing medium)

All preset Magma themes use 
medium camera pacing except 
for the SlowJam theme.

Camera pacing is a required 
element found at the start of 
each theme. 

CAMERA PRESET EXTRA SECTIONS

1 Extra sections are   
 optional. Use them   
to add uncommon practice 
sections to your theme (see 
page 665). Extra sections have 
two main elements:

 ▪ A section name, and 

 ▪ Named practice section(s)

Both of these elements are 
user defined. For example, 
spacey and *spacey* on the 
previous page. Here the section 
name spacey is mapped to the 
practice section(s) ”*spacey*”.

Note: The asterisk * is a wild 
card character. Any practice 
section with spacey in its name 
will be linked to the spacey 
section name. 

Tip: Add asterisks to expand 
the range of practice sections. 
Remove asterisks to exclude 
practice sections. 

2 3

SECTION PRESETS
Section presets use   

 section names to group 
practice sections and venue 
events together. For example:

(intro  
(allowed_lightpresets 
silhouettes_spot) 
(allowed_postprocs 
ProFilm_a.pp) 
(lightpreset_blendin 2) 
(postproc_blendin 2)

The intro section name has 
lighting and post processing 
events defined. These venue 
events are used for any practice 
sections in the EVENTS track 
that have intro in their name.

COMMENT LINES
Add a semicolon at the start of 
a line to turn it into a comment.  
Comments must be single lines 
of text. Comment lines are 
ignored by Magma:

; This is a comment
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Magma themes have built-in presets for 
common practice sections.

BUILT-IN PRESETS 

Use the SynthPop theme as a template for your 
own custom theme.

MAKING A CUSTOM THEME
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Built-in presets typically have 
a standard mapping to practice 
sections. For example:

(intro 
(practice_sections 
“*intro*”) 
)

The intro preset maps to all 
practice sections with intro in 
their name, from:

 ▪ [prc_intro]  
_a, _b, _c, _d, _e 
 
to

 ▪ [prc_intro_riff]  
_a, _b, _c, _d

This logic applies to all the 
built-in presets. It should be 
noted that presets can have 
more than one option. This is 
the case with the verse3 and 
chorus3 presets. They both have 
many text string options. 

For example:

(chorus3 
(practice_sections 
“*chorus_3*” “*chorus_4*” 
“*chorus_5*” “*chorus_6*” 
“*chorus_7*” “*chorus_8*” 
“*chorus_9*”) 
) 

The *chorus3* preset is mapped 
to seven practice sections from:

 ▪ [prc_chorus_3]  
a, b, c, d 
 
to

 ▪ [prc_chorus_9]  
a, b, c, d

Note: The chorus3 preset does 
not include the prechorus and 
postchorus practice sections. 
This is because they both have 
their own built-in presets.

The default preset is for any 
practice sections not found in 
any other presets.

To start your own custom 
theme first create a copy of the 
SynthPop theme:

 ▪ Open the SynthPop theme 
using Notepad

In Notepad:

 ▪ Click File > Save as

 ▪ In the Save as window, type 
a unique filename for your 
custom theme

 ▪ Make sure that the filename 
has the .rbtheme file 
extension

 ▪ Click the Save button

When you next open Magma 
your theme will appear in the 
auto generation theme drop 
down menu.

Make sure the practice sections 
in your song match the section 
presets in your theme. You may 
need to:

 ▪ Remove existing section 
presets that do not match 
your practice sections

 ▪ Customize the extra_
sections if needed:

(extra_sections 
   (spacey 
      (practice_sections 
“*spacey*”) ...

 ▪ Add custom section_presets 
if needed:

(spacey  
(allowed_lightpresets 
silhouettes_spot) ...

 ▪ Remove the extra-section if 
it is not used

The next step is to review venue 
parameters and options. Look 
through different themes to see 
which venue elements they use. 
For example:

DarkHeavyRock  
(allowed_lightpresets 
silhouettes_spot) 
(allowed_postprocs photo_
negative.pp)

FeelGoodPopRock 
(allowed_lightpresets harmony 
silhouettes_spot) 
(allowed_postprocs ProFilm_a.
pp)

PsychJamRock 
(allowed_lightpresets 
loop_warm)  
(allowed_postprocs 
posterize.pp)

Experiment with lighting and 
post-proc effects to give your 
theme its own look and feel.

Magma themes have a built-
in extra section that links to 
common practice sections:

 ▪ Default

 ▪ Intro

 ▪ Preverse

 ▪ Verse1

 ▪ Verse2

 ▪ Verse3 

 ▪ Bridge

 ▪ Solo

 ▪ Prechorus

 ▪ Chorus1

 ▪ Chorus2

 ▪ Chorus3 

 ▪ Postchorus

 ▪ Main_riff

 ▪ Outro

BUILT-IN SECTION PRESETS THEME NAME WHAT TO CUSTOMIZE?
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Build a custom theme using these 
parameters in any section preset.

THEME BLUEPRINT 

ALLOWED LIGHT PRESET

allowed_lightpresets sets 
the light preset to be used:

THEME BLUEPRINT 2
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(allowed_lightpresets searchlights manual_warm sweep)

Note: If more than one 
option is set a random 
one will be chosen 
from the options 
specified.

ALLOWED POST PROCS

allowed_postprocs sets the 
post processing to be used:

KEYFRAME RATE

keyframe_rate is used for 
manual light presets. It sets a 
“next” keyframe every N beats. 
See Manual Lighting Calls on 
page 677.

LIGHT PRESET BLEND IN

lightpreset_blendin is used 
to create a smooth transition 
between different lighting 
presets. The transition begins 
N beats before the start of the 
current section:

(allowed_postprocs video_trails.pp posterize.pp)

(keyframe_rate 2)

(lightpreset_blendin 1)

DIRECTED CUT AT START

dircut_at_start sets a 
directed cut to be used at the 
start of the section:

BONUS FX AT START

bonusfx_at_start will cause a 
bonusfx cue to be placed at the 
start of the section:

CAMERA PACING

camera_pacing overrides the 
default camera pacing for this 
section only. Use one of the 
following:

 ▪ minimal

 ▪ slow

 ▪ medium

 ▪ fast

 ▪ crazy

(dircut_at_start directed_all)

(bonusfx_at_start)

(camera_pacing slow)

Review pages 669 — 699 to decide which 
options (post processing, lighting presets, and 
directed cuts) to use.

Parameter Option(s) Parameter Option(s)

Note: A keyframe_rate 
of 2 will flash lights on 
beats one and three. 
A keyframe_rate of 
1 will flash lights on 
each beat. Themes use 
2 on verses and 1 on 
choruses.
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Post-processing effects are video effects added 
to an existing camera shot.

BASIC POST-PROCESSING 
EFFECTS 
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BLOOM

Brightens the picture slightly. Adds a 
choppy low frame-per-second effect.

Grainy video effect.

16MM FILM SEPIA_INK

Reduces colors to a wide range of 
yellowish-grey shades.

SILVERTONE

Reduces colors to a wide range of grey 
shades.

Default [ProFilm_a.pp]

LIGHTING TEXT EVENT

Color_Muted [ProFilm_b.pp]

Video_Grainy [video_a.pp]

LIGHTING TEXT EVENT

Sepia_Ink [film_sepia_ink.pp]

Silvertone [film_silvertone.pp]

Shitty_TV [shitty_tv.pp]

Bloom [bloom.pp]

16mm Film [film_16mm.pp]

The default post process effect. No notable 
effects.

DEFAULT COLOR_MUTED

Slightly mutes all colors.

Slightly grainy video.

VIDEO_GRAINY

SHITTY_TV

Very grainy video. Dramatically lightens 
colors.
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BASIC POST-PROCESSING 
EFFECTS (CONTINUED) 
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A choppy, low-frame-per-second effect.

PHOTOCOPY

VIDEO_BW

Reduces colors to grey shades. Slightly 
grity. A smaller range of grey than 
Silvertone.

Grainy video. Colors are reduced to a wide 
range of green shades.

VIDEO_SECURITY.PP

Film_BW [film_b+w.pp]

LIGHTING TEXT EVENT

Video_BW [video_bw.pp]

Contrast_BW [contrast_a.pp]

LIGHTING TEXT EVENT

Video_Security [film_sepia_ink.pp]

Blue_Filter [film_blue_filter.pp]

Desat_Blue [desat_blue.pp]

Photocopy [photocopy.pp]

Reduces colors to a range of grey tones. 
Note: The range of grey tones is smaller 
than Silvertone.

FILM_BW

CONTRAST_BW

A very gritty, somewhat polarized black and 
white filter.

Reduces colors to a wide range of blue 
shades.

BLUE_FILTER

Slightly gainy image, with a blue tinge.

DESAT_BLUE
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These are special video effects that are added 
to an existing camera shot.

SPECIAL POST-PROCESSING 
EFFECTS 
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Creates a long video feed delay and flattens 
colors.

DESAT_POSTERIZEBRIGHT

Brightens to bloom-esque effect. Lightens 
dark colors.

CLEAN_TRAILS

Creates a small video feed delay, like a 
visual “echo”.

FILM_CONTRAST.PP

Makes dark colors darker, and light colors 
lighter.

FILM_CONTRAST_BLUE

Makes dark colors darker, and light colors 
lighter. Adds a slight blue hue.

FLICKER_TRAILS

Creates a video feed delay. Slightly darkens 
images and mutes colors.

Bright [bright.pp]

LIGHTING TEXT EVENT

Posterize [posterize.pp]

Clean_Trails [clean_trails.pp]

LIGHTING TEXT EVENT

Film_Contrast [film_contrast.pp]

Film_Contrast_Blue [film_contrast_blue.pp]

Flicker_Trails [flicker_trails.pp]

Desat_Posterize [desat_posterize_trails.pp]

Video_Trails [video_trails.pp]

POSTERIZE

Flattens colors (most noticable in 
shadows).

VIDEO_TRAILS

Creates a video feed delay. A longer delay 
than Clean_Trails.
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SPECIAL POST-PROCESSING 
EFFECTS (CONTINUED) 

SPECIAL POST PROC EF-
FECTS 2
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HORROR_MOVIE

Polarizes colors to either red or black. Inverts colors.

PHOTO_NEGATIVE

MIRROR

The left side of the screen mirrors the right 
side. Changes colors to a variety of oranges, 
greens, and yellows.

PSYCH_BLUE_RED

Polarizes colors to either red or blue.

Lightens colors dramatically. Creates three 
small video feed delays in red, green, and 
blue.

SPACE_WOOSH

Film_Contrast_Gr... [film_contrast_green.pp]

LIGHTING TEXT EVENT

Film_Contrast_Red [film_contrast_red.pp]

Horror_Movie [horror_movie_special.pp]

LIGHTING TEXT EVENT

Space_Woosh [space_woosh.pp]

Mirror [ProFilm_mirror_a.pp]

Psych_Blue_Red [ProFilm_psychedelic_
blue_red.pp]

Photo_Negative [photo_negative.pp]

Makes dark colors darker, and light colors 
lighter. Adds slightly green hues.

FILM_CONTRAST_GREEN FILM_CONTRAST_RED

Makes dark colors darker, and light colors 
lighter. Adds slightly red hues.
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Manual lighting presets use keyframe rates or 
triggers to cycle through their colors.

MANUAL LIGHTING CALLS MANUAL LIGHTING CALLS 2
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VERSE CHORUS

Tends towards stark, dramatic colors, such 
as saturated blue and red. Invokes a peak 
state. Varies between venues.

MANUAL_WARM

Warm temperature lighting.

Tends towards soft yet full blends, such as 
orange and green. Varies between venues.

MANUAL_COOL

Cool temperature lighting.

Harsh lighting with a blend of dissonant 
colors.

DISCHORD

All lights are either on or off. This lighting 
preset cannot be used in Magma themes. It 
only responds to the [next] trigger.

STOMP

[lighting (verse)]

Dischord [lighting (dischord)]

LIGHTING TEXT EVENT

Stomp [lighting (stomp)]

Verse [lighting (verse)]

LIGHTING TEXT EVENT

Chorus [lighting (chorus)]

Manual_Cool [lighting (manual_cool)]

Manual_Warm [lighting (manual_warm)]
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These presets are set lighting cues. Many of 
them cycle automatically over time.

AUTOMATIC LIGHTING CALLS 
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FRENZY

Frenetic, dissonant lighting that alternates 
quickly.

HARMONY

A blend of lights with a harmonious color 
palette.

LOOP_COOL

A blend of cool temperature colors.

LOOP_WARM

A blend of warm temperature colors.

SILHOUETTES

Dark, atmospheric lighting. Shows character 
silhouettes. 

Searchlights that sweep individually. In 
this scene the left and right banks of lights 
alternate on and off.

SEARCHLIGHTS

Silhouettes [lighting (silhouettes)]

LIGHTING TEXT EVENT

Silhouettes_Spot [lighting (silhouettes_spot)]

Searchlights [lighting (searchlights)]

Loop_Cool [lighting (loop_cool)]

LIGHTING TEXT EVENT

Loop_Warm [lighting (loop_warm)]

Harmony [lighting (harmony)]

Frenzy [lighting (frenzy)]

Lights that sweep together 
in banks.

SWEEP

Sweep [lighting (sweep)]

SILHOUETTES_SPOT

Dark, atmospheric lighting. Shows 
illuminated character silhouettes.
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AUTOMATIC LIGHTING CALLS 
(CONTINUED) 
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STROBE_FAST

Strobe lights that blink on  
every sixteenth note. 

Darken the stage slowly to blackout. The 
fade takes 2 seconds. Does not work if 
previous light state is too close.

BLACKOUT_SLOW

Darken the stage quickly to blackout. The 
fade takes 0.2 seconds. 

BLACKOUT_FAST

Strobe_Slow [lighting (strobe_slow)]

LIGHTING TEXT EVENT

Strobe_Fast [lighting (strobe_fast)]

Blackout_Slow [lighting (blackout_slow)]

LIGHTING TEXT EVENT

Flare_Fast [lighting (flare_fast)]

BRE [lighting (bre)]

Blackout_Spot [lighting (blackout_spot)]

Flare_Slow [lighting (flare_slow)]

A blackout state with added 
underlighting.

BLACKOUT_SPOT

Bright white flare that fades slowly into the 
next lighting preset.

FLARE_SLOW

Bright white flare that fades quickly into 
the next lighting preset.

FLARE_FAST

Frenetic lighting for a Big Rock Ending. 
Looks like frenzy, only crazier.

BRE

STROBE_SLOW

Strobe lights that blink on 
every eighth note.

Blackout_Fast [lighting (blackout_fast)]
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Directed cuts are special camera shots that 
often have a unique animation. 

INTRODUCTION TO 
DIRECTED CUTS 
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Directed cuts in themes use 
this syntax in section presets:

(dircut_at_start directed_
all)

Venuegen uses MIDI notes, for 
example D_All. The VENUE track 
uses text events: 

[directed_all]

In venuegen, place a MIDI note 
where you want the ‘hit’ of the 
animation to be. 

The ‘hit’ in each animation will 
vary. If the shot is the bassist 
jumping, the beat that they land 
on is the hit. If the guitar player 
is kicking the camera, the hit is 
the impact of the kick. 

Not all directed cuts have a 
distinct hit though. 

Note 1: A directed cut can have 
several animations. For example, 
a cut may have band mates 
jump in the air or kick at the 
camera. This means that the 
length of the animation can 
vary, even for the same cut. The 
amount of pre-roll and post-
roll can also vary for different 
animations in the same cut. 
Keep this in mind when you 
place a cut in your VENUE track.

Note 2: In Magma themes 
the ‘hit’ is at the start of the 
practice section.

DIRECTED CUTS 
OVERVIEW
Directed cuts contain many 
unique animations. For example:

 ▪ Drummer twirling drum 
sticks

 ▪ Band mates jumping into 
the air

 ▪ Guitarist kicking towards the 
camera

Other directed cuts do not 
contain unique animations. 
Instead, they contain unique 
camera angles. For these shots 
we use this icon: THEME VS VENUE 

THE DIRECTED 
CUT HIT

PRE-ROLL AND 
POST-ROLL
Directed cuts can have pre-roll 
and post-roll animation:

 ▪ Pre-roll is animation that 
starts before the ‘hit’.

 ▪ Post-roll is animation that 
continues after the ‘hit’

Some cuts do not have any 
pre-roll. They start immediately 
where the text event is called. 
Others may have only a few 
seconds of pre-roll.

_cls Close-up shot

DIRECTED CUT SUFFIXES

_lt Long duration cut (long time)

_np Character is not playing

_pnt Character points at camera

_pr Longer pre-roll shot 1

_pt Longer post-roll shot 2

_kd Drummer’s kick drum

_b Bass player

_g Guitar player

_kb Keyboard / bass

_kd Keyboard / drummer

_kg Keyboard / guitar

_kv Keyboard / vocalist

<

Directed cuts often have 
suffixes. The table above lists 
the most common suffixes 
with a brief explanation. Easily 
understood suffixes such as 
“guitar” and “drums” are not 
included in the table above.

1 Vocal and guitar shots with 
the _pr suffix have longer pre-
roll. There is likely to be more 
animation before the text event. 

2 Vocal and guitar shots with 
the _pt suffix have longer post-
roll. They have more animations 
after the text event.

INTRODUCTION TO DIRECTED 
CUTS 2
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EXAMPLE DIRECTED CUTS 
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D_ALL_YEAH

D_ALL D_DRUMS

D_All [directed_all]

CAMERA TEXT EVENT

D_All_cam [directed_all_cam]

D_All_Yeah [directed_all_yeah]

CAMERA TEXT EVENT

D_Drums [directed_drums]

D_Drums_LT* [directed_drums_lt]

D_ALL_CAM

D_DRUMSD_ALL

D_DRUMS_LT*D_DRUMS_LT*

Many directed cuts have unique animations. 
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EXAMPLE DIRECTED CUTS 
(CONTINUED) 
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D_GUITAR

D_Vocals [directed_vocals]

CAMERA TEXT EVENT CAMERA TEXT EVENT

D_Gtr_Cam_PR [directed_guitar_cam_pt]

D_Guitar [directed_guitar]

D_Gtr_Cam_PT [directed_guitar_cam_pt]

D_VOCALS D_VOCALS

D_VOCALSD_VOCALS [DIRECTED_GUITAR_CAM_PT]

[DIRECTED_GUITAR_CAM_PT]

D_GTR_CAM_PR

Some directed cuts have many animations. For 
example, directed vocals.
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EXAMPLE DIRECTED CUTS 
(CONTINUED) 
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D_GTR_CLS*

D_DUO_GTR

D_DUO_GTRD_BASS_CLS*

D_DRUMS_POINT D_CROWD*

D_Bass_CLS* [directed_bass_cls]

CAMERA TEXT EVENT

D_Gtr_CLS* [directed_guitar_cls]

D_Drums_Point [directed_drums_pnt]

CAMERA TEXT EVENT

D_Crowd* [directed_crowd]

D_Crowd_Bass [directed_crowd_b]

D_Duo_Gtr [directed_duo_guitar]

D_GTR_CLS*

D_CROWD_BASS

Use close-up directed cuts for technical parts 
and solos.



D_All
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Full band cuts are very dramatic. They are for 
special moments in the song.

DIRECTED CUTS:
FULL BAND AND 
CROWD SHOT
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Shots where guitar, bass, 
keys and vocals interact. This 
includes band mates:

 ▪ Jumping into the air 

 ▪ Kicking towards the camera 
or crowd

 ▪ Dramatically dropping to 
their knees

These shots work well for:

 ▪ Exciting parts of the song, 
especially ones with sing-
alongs

Note: D_All_Cam typically lasts 
longer. The band interacts 
with the camera and rocks out 
together. 

A long panning shot of the 
entire band. It is more dynamic 
than standard camera shots like 
All_Near or All_Far.

A very dramatic cut:

 ▪ Singer points into the air in 
slow motion

 ▪ Pans to show rest of the 
band in slow motion

On bigger venues the guitarist 
leaps into the air and then 
slides on their knees (like Pete 
Townshend from The Who).  
 
Note: This does not happen if 
the keys player is on the stage. 

Note: Use full band 
cuts sparingly. Over-use 
can make the cuts look 
forced and cause them 
to feel less special.

D_All_Yeah is tricky to time 
correctly. It works well with 
BONUSFX for glam metal songs 
and other big bands.

Harmonix has used it in: 

 ▪ “Won’t Get Fooled Again” 
(RB1)

 ▪ “Thunderstruck (Live)” 

 ▪ “Bohemian Rhapsody”.

This cut is for Big Rock Endings:

 ▪ The guitarist swings their 
guitar into the floor, jumps 
on the guitar, and then back 
slams the guitar

 ▪ The drummer wildly hits the 
kit with their sticks

The hit in this cut is the guitar 
player falling backwards 
onto the guitar. Most of the 
animation is pre-roll.

You should place this text event 
on the final note of the BRE. 

This cut is in:

 ▪ “Run To The Hills” (RB1)

 ▪ “Let There Be Rock” (RB2)

 ▪ “Young Man Blues (Live at 
Leeds)” and “Do You Feel 
Like We Do (Live)” (DLC)

This is another cut for Big Rock 
Endings:

 ▪ The characters jump, stomp, 
or bang the drums on the 
final note of the BRE

Sometimes the band drops to 
the floor dramatically before the 
final hit. 

As with the previous cut, you 
should place this on the final 
notes of a BRE. It is generally 
used in most BREs. 

You can find this cut in some 
songs without BREs, such as 
“Aqualung” and “Visions” in RB2.

FULL BAND CROWD SHOT

A dynamic shot that includes 
the crowd:

 ▪ A wide stage shot that 
includes the crowd

 ▪ On bigger venues, an 
individual shot with a few 
crowd members

D_All_Cam

D_All_LT*

D_All_Yeah

< D_BRE D_BRE_Jump D_Crowd* <

D_BRE [directed_bre]

CAMERA TEXT EVENT

D_BRE_Jump [directed_brej]

D_Crowd* [directed_crowd]

D_All [directed_all]

CAMERA TEXT EVENT

D_All_Cam [directed_all_cam]

D_All_LT* [directed_all_lt]

D_All_Yeah [lighting (frenzy)]
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These directed cuts feature individual 
characters.

DIRECTED CUTS: 
SINGLE CHARACTER 
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INDIVIDUAL CHARACTER HITS
In the following shots a 
character performs an action. 
The action happens where 
the text event is placed in the 
VENUE track.

The bass player animation here 
is like the guitar player in D_Gtr. 
Most of the same animations 
are used:

 ▪ Bass player does not slide 
on their knees

 ▪ Bass player animations are 
less theatrical

The drummer hits the cymbals 
on their kit. Sometimes they 
twirl their sticks first.

A dynamic, panning shot of the 
drummer. Use for drum solos or 
interesting drum parts.

The guitarist performs a wide 
variety of actions:

 ▪ Slide on their knees

 ▪ Kick into the air

 ▪ Kick over the camera

 ▪ Bump camera with guitar

There are more actions but 
these are the most common.

The keyboard player jumps in 
the air or slams their hands on 
the keyboard.

The vocalist has a wide variety 
of animations:

 ▪ Point into the air

 ▪ Point to the crowd

 ▪ Kick into the air

 ▪ Kick the camera

There are also actions that are 
specific to certain genres.

INDIVIDUAL CHARACTER NOT PLAYING
In these shots the characters 
perform an animation while not 
playing. Use when the character 
is in an [idle] state.

The bass player animations 
are similar to the guitarist in 
D_Gtr_NP].

The drummer has a range of idle 
animations:

 ▪ Swirl drumsticks

 ▪ Stick tricks

 ▪ Motion to camera

There are other animations that 
involve camera interaction that 
are genre specific.

The guitarist performs a wide 
variety of idle actions:

 ▪ Kick

 ▪ Kick into the air (but not at 
the camera)

There are a lot of genre specific 
animations:

 ▪ Take hand off guitar with 
actions or mannerisms that 
fit the genre

There are very few animations 
for this directed cut:

 ▪ Keyboardist rocks back and 
forth

Most venues only have a single 
animation. 

The vocalist has a couple of idle 
actions:

 ▪ Kick into the air

 ▪ Jump

The vocalist holds the mic, but 
not up to their face.

There are other actions that do 
not involve singing into the mic.

D_Bass

D_Drums

D_Brums_LT* <

D_Gtr

D_Keys

D_Vocals

D_Bass_NP

D_Drums_NP

D_Gtr_NP

D_Keys_NP

D_Vox_NP

D_Bass [directed_bass]

CAMERA TEXT EVENT

D_Drums [directed_drums]

D_Drums_LT* [directed_drums_lt]

D_Gtr [directed_guitar]

D_Keys [directed_keys]

D_Vocals [directed_vocals]

D_Bass_NP [directed_bass_np]

CAMERA TEXT EVENT

D_Drums_NP [directed_drums_np]

D_Gtr_NP [directed_guitar_np]

D_Keys_NP [directed_keys_np]

D_Vox_NP [directed_vocals_np]
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DIRECTED CUTS: 
SINGLE CHARACTER 
(CONTINUED)
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INDIVIDUAL CHARACTER CAM SHOTS
Cam shots involve a character 
performing an action. The 
character may show off or 
interact with the crowd. 

Cam shots are not usually tied 
to a hit. You can use them at 
any point in the song.

The bassist shows off for the 
camera. This is usually more 
relaxed than the guitar player. 
Animations include:

 ▪ Hit camera with instrument

Bass has fewer animations and 
does not have _pr or _pt shots.

Bass has a lot of genre specific 
animations.

There are a large range of guitar 
animations:

 ▪ Drop to the floor

 ▪ Show off to camera

 ▪ Show off for crowd

These shots are generally used 
for exciting guitar parts:

 ▪ Guitar solos

 ▪ Technical guitar parts

There are several grenre specific 
animations.

Like D_Gtr_Cam_PR but with: 

 ▪ Longer post-roll

 ▪ Shorter pre-roll

The keyboardist rocks out and 
grooves.

Like D_Vox_cam_PT but with 
longer pre-roll, and shorter 
post-roll:

 ▪ More animations that land 
on the hit

A large range of animations used 
for exciting vocal moments:

 ▪ Interact with crowd or 
camera

 ▪ Rock the mic

Many genre-specific animations.

VOCALIST STAGEDIVE / CROWDSURF
The vocalist dives off the stage 
and leaps into the crowd or 
crowd-surfs, or both.

Note: Use this cut with caution. 
The next shot should cut away 
from the vocalist. Otherwise it 
will appear that the vocalist has 
teleported back onto the stage. 
Take care, as the vocalist can 
still appear in the background of 
the next shot.

After this cut, try to follow this 
recommendation. Leave sixteen, 
or more, measures before the 
vocalist:

 ▪ Sings

 ▪ Plays the tambourine or 
cowbell

Note: There is no lip-sync 
during a stage dive cut. The 
vocalists mouth will not move.

Like D_Stagedive but includes 
the vocalist crowd-surfing. 

Sometimes it shows the vocalist 
crowd-surfing without jumping 
off the stage.

The vocalist runs off the stage 
and jumps into the crowd.

This shot usually cuts away as 
soon as the vocalist jumps into 
the crowd.

D_Bass_Cam

D_Gtr_Cam_PR

D_Gtr_Cam_PT

D_Keys_Cam

D_Vox_Cam_PR

D_Vox_Cam_PT

D_Crowdsurf

D_Stagedive

D_Bass_Cam [directed_bass_cam]

CAMERA TEXT EVENT

D_Gtr_Cam_PR [directed_guitar_cam_pr]

D_Gtr_Cam_PT [directed_guitar_cam_pt]

D_Keys_Cam [directed_keys_cam]

D_Vox_Cam_PR [directed_guitar_cam_pr]

D_Vox_Cam_PT [directed_vocals_cam_pt]

D_Crowdsurf [directed_crowdsurf]

CAMERA TEXT EVENT

D_Stagedive [directed_stagedive]
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DIRECTED CUTS: SINGLE 
CHARACTER (CONTINUED) /
TWO CHARACTER SHOTS AND 
CROWD SHOTS
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CLOSE-UP SHOTS
Use close-up shots for special 
moments. For example:

 ▪ Interesting vocal parts

 ▪ Fast or technical guitar, 
bass, or heavy drum parts

Close-up of the bassist’s 
fretboard.

Close-up of the guitarist’s 
fretboard.

A dramatic animation that 
includes:

 ▪ Close-up of vocalist holding 
the mic

 ▪ Holding the mic with both 
hands, moving head back 
and forth

 ▪ Falling to the floor or to their 
knees holding the mic

Generally used for the vocalist 
hitting high notes, or even 
screamed or yelled parts.

The cut also has genre-specific 
animations.

Close-up of the drummer’s kick 
pedal.

POINTING

Drummer points to the camera 
with their sticks.

Note: In some animations the 
drummer is not playing, so use 
this with care.

CROWD 
INTERACTIONS

The same as D_Crowd_Gtr, but 
for the bassist.

Guitarist interacts with the 
crowd. This includes high fives 
and showing off.

TWO CHARACTER SHOTS
Sing-along shots that include 
two band mates interacting. 

Use these shots with the sing-
along MIDI notes found in the 
VENUE track:

In these shots the guitarist and 
bassist will interact with the 
vocalist. The drummer has their 
own set of solo shots.

For more on sing-along notes 
see page 711.

Drummer turns to the camera 
or interacts with it. 

 ▪ Use only when the drummer 
is singing. It looks awkward 
if the drummer is not singing

 ▪ Does not include other band 
members

The guitarist and vocalist 
interact. This includes:

 ▪ Guitarist and vocalist 
jamming together

 ▪ Guitarist and vocalist leaning 
into each other

 ▪ Guitarist singing into the 
vocalist’s mic

There are also genre-specific 
animations.

The same as D_Duo_Gtr, but for 
the bassist.

Guitarist and bassist jam 
out together. Works well for 
engaging moments.

Bassist and keyboardist rock 
out together.

Guitarist and keyboardist rock 
out together.

 
 
Guitarist Sing Along 
Drummer Sing Along 
Bassist Sing Along

VENUE

Vocalist and keyboardist rock 
out together.

D_Bass_CLS* <

D_Drums_KD* <

D_Gtr_CLS* <

D_Vox_CLS D_Drums_Point

D_Crowd_Bass

D_Crowd_Gtr
D_Duo_Bass

D_Duo_Drums

D_Duo_Gtr

D_Duo_GB

D_Duo_KB

D_Duo_KG

D_Duo_KV

D_Bass_CLS* [directed_bass_cls]

CAMERA TEXT EVENT

D_Drums_KD* [directed_drums_kd]

D_Gtr_CLS* [directed_guitar_cls]

D_Vox_CLS [directed_vocals_cls]

D_Drums_Point [directed_drums_pnt]

D_Crowd_Bass [directed_crowd_b]

D_Crowd_Gtr [directed_crowd_g]

D_Duo_Bass [directed_duo_bass]

CAMERA TEXT EVENT

D_Duo_Drums [directed_duo_drums]

D_Duo_Gtr [directed_duo_guitar]

D_Duo_GB [directed_duo_gb]

D_Duo_KB [directed_duo_kb]

D_Duo_KG [directed_duo_kg]

D_Duo_KV [directed_duo_kv]
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Pyrotechnic calls trigger an explosion and a 
sound effect. They should be used sparingly.

PYROTECHNICS 

Venuegen is used to create venues. You can 
use lighting, directed cuts, post-procs, and 
basic cuts in your venue!

VENUE CREATION
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Do not author [bonusfx] in Big 
Rock Endings. The effect will be 
triggered automatically:

 ▪ When players finish a BRE 
in an arena the effect is 
triggered if they hit the 
last note(s) to score bonus 
points. If any player misses 
the last BRE note(s) then the 
effect is not triggered

Use MIDI notes in the venuegen 
LIGHTING track:

For reference, the text events 
for pyrotechnics are [bonusfx] 
and [bonusfx_optional]. For 
themes refer to page 668.

So far in this chapter we have 
covered:

 ▪ Lighting

 ▪ Directed cuts

 ▪ Post Processing

These elements can be used for 
themes and venues. For the rest 
of the chapter we will focus on 
venues using venuegen.

Before venuegen was created 
authors made venues by 
placing text events. This was a 
cumbersome process:

 ▪ Scroll through a long list of 
text events 

 ▪ Place text events precisely 

 ▪ Navigate densely packed 
and often hard to read text 
events in the VENUE track

Triggers the explosion effect:

 ▪ Only seen in arena venues. 
BONUSFX is not triggered in 
smaller venues

The same as BONUSFX but only 
triggered when the player is 
doing well.

PYROTECHNICS BIG ROCK ENDING
Use pyrotechnics to accent 
certain parts of the song. You 
can use them two or three 
times per song, if appropriate.   

With venuegen these issues 
are no longer a problem. 
Authors place MIDI notes in the 
CAMERA and LIGHTING tracks. 
This makes venue authoring 
much like authoring any other 
instrument. Venuegen then 
converts these MIDI notes to 
text events in the VENUE track. 

It is assumed that you will use 
venuegen to author your venue. 

THEMES VS 
VENUES

A BRIEF INTRODUCTION TO VENUGEN

VENUGEN LIGHTING

BONUSFX

BONUSFX_Opt

BONUSFX

BONUSFX WITH D_ALL_YEAH

AUTHORING

 
 
BONUSFX 
BONUSFX_Opt

LIGHTING

INSTALL 
VENUEGEN
Download venuegen from 
github.com/kueller/venuegen:

 ▪ Download the .zip file

 ▪ Extract it to C:\Venuegen 

https://github.com/kueller/venuegen
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Add an action for Venuegen:

 ▪ Click the Actions menu > 
Show action list

 ▪ Click the New/load button

 ▪ Browse to the venuegen 
install folder and select 
venuegen.py

Add the F10 shortcut key:

 ▪ Select Custom: venuegen.py 
from the Actions list

 ▪ Click the Add button

 ▪ Press the F10 key

 ▪ Click OK

Load MIDI note names:

 ▪ Double-click the CAMERA 
track to open it

 ▪ Right click the CAMERA 
track tab

 ▪ Click File > Customize note 
names > Load note names 
from file in the menu

 ▪ Browse to the venuegen 
install folder and select 
CAMERA.TXT

Repeat these steps for the 
LIGHTING track and select the 
LIGHTING.TXT file.

702

To setup venuegen we need the 
latest Python 2.x with ReaScript 
enabled:

 ▪ Python 2.x installation 
(pages 29  — 30) 

 ▪ Enable ReaScript (pages 
91 — 92)

Open REAPER to verify these 
dependencies:

 ▪ Press Ctrl + P 

 ▪ Select Plugins > ReaScript

 ▪ Make sure that ReaScript is 
enabled and python27.dll 
is installed

1
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VENUEGEN SETUP

3

2
Add two new tracks above your 
VENUE track:

 ▪ Select the VENUE track

 ▪ Press CTRL + T twice

 ▪ Name the tracks CAMERA 
and LIGHTING

Add MIDI items to each track 
and then mute them both:

 ▪ Click the Insert menu > New 
MIDI item

 ▪ Click the Mute buttons

Resize the MIDI items to the 
length of your song.

4

VENUEGEN 2
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Use venuegen to create venues with MIDI notes. 
You can import existing venues into venuegen.

THE VENUEGEN INTERFACE 

Author individual and stacked camera cuts with 
MIDI notes in venuegen. 

VENUE CAMERA CUTS
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Press F10 to open the venuegen 
dialogue.

To map CAMERA and LIGHTING 
MIDI notes to text events:

 ▪ Click the Generate button

To transfer these text events to 
the VENUE track:

 ▪ Click the two Apply to 
VENUE buttons

To copy an existing venue into 
venuegen:

 ▪ Export the MIDI from an 
existing custom and import 
it into REAPER (see pages 
731 — 732) 

 ▪ Click the two Apply to 
CAMERA/LIGHTING buttons 
to create MIDI notes in 
venuegen

There are three main elements 
to venuegen CAMERA and 
LIGHTING tracks:

 ▪ The note names in the left 
hand panel 

 ▪ MIDI notes in the MIDI editor 
grid 

 ▪ Text events generated in the 
lower panel

B_Behind

NOTE NAMES AND MIDI

D_Near

TEXT EVENTS

TEMPLATE, MIDI, 
AND TEXT EVENTS

VENUEGEN DIALOGUE

Most directed cuts have an 
unpredictable start and end 
time. This is due to pre and post 
roll footage in these cuts. 

The following directed cuts can 
have predictable start and end 
times though:

 ▪ All cuts that end with LT*

 ▪ D_Bass_CLS*

 ▪ D_Gtr_CLS*

 ▪ D_Drums_CLS*

 ▪ D_Crowd*

Author predictable cuts as 
follows:

In this example you can see that 
D_Gtr_CLS* is one measure long.

The two text events generated 
by venuegen are both the same. 
They are positioned at the start 
and end of the MIDI note. 

The duration of this cut does 
not matter so long as it ends 
before the next cut starts.

You can author individual 
or stacked camera cuts in 
venuegen:

 

Individual cuts happen in 
sequence. Stacked shots are 
chosen according to cut priority. 
They are used to account for 
band members who may not be 
present (see page 714).

Note: Venuegen will generate 
single text events for the 
majority of  camera cuts.

B_Behind

INDIVIDUAL CUTS

D_Near

G_Hand

STACKED CUTS

V_Closeup

CAMERA TRACK 
BASICS

PREDITCABLE 
DIRECTED CUTS

PREDICTABLE CUTS

D_Gtr_CLS*

[directed_guitar_cls]

[coop_d_near]

VENUEGEN DIALOGUE
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These presets use keyframe triggers to cycle 
through their colors.

MANUAL LIGHTING CALLS 
WITH KEYFRAME TRIGGERS
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The following presets use 
keyframe triggers:

 ▪ Verse

 ▪ Chorus

 ▪ Manual_Cool

 ▪ Manual_Warm

 ▪ Dischord

 ▪ Stomp

Manual lighting presets use 
triggers to cycle through 
keyframes. 

In venuegen these triggers are 
first, next, and previous.

Their usage is as follows: 

 ▪ Call the first keyframe at the 
start of the lighting cue with 
first

 ▪ Call subsequent keyframes 
with next

 ▪ Call previous keyframes with 
previous

Each in-game venue has its own preset 
stage lighting setup.

VENUE LIGHTING 

Venue lighting cues change 
the lights in each venue. But 
each venue has its own preset 
lighting arrangement:

 ▪ Smaller venues have a small 
variety of lights

 ▪ Larger venues have dozens 
of lights available

Lighting cue text events are 
formatted as follows:

 ▪ [lighting (        )]

For example, a fast strobe 
would be:

 ▪ [lighting (strobe_
fast)]

Note: The following text events 
used in Rock Band 1 are no 
longer valid:

 ▪ [lighting ()]

 ▪ [verse]

 ▪ [chorus]

If [lighting ()] is at the start 
of your VENUE track change it 
to one of the following:

[lighting (intro)] 
 
[lighting (harmony)]

Note: The Verse and Chorus 
MIDI notes in Venuegen produce 
updated [verse] and [chorus] 
text events:

 ▪ [lighting (verse)]

 ▪ [lighting (chorus)]

SMALL VENUE LIGHTING EXAMPLES

Manual_Warm

[first] [next] [next]

[lighting (manual_warm)]

first

next next

MANUAL 
LIGHTING CALLS

MANUAL LIGHTING: FIRST, NEXT, AND PREVIOUS
In the example above the 
keyframes are called on quarter 
notes. You can space your venue 
keyframes as close or far apart 
as you want. 

Note: If your keyframes are very 
close together the effect may 
be jarring.

MANUAL LIGHTING PRESET AND TRIGGERS
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The RANDOM MIDI note generates a random 
camera cut.

RANDOM CAMERA CUTS
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The RANDOM MIDI note is at 
the top of the LIGHTING track 
template. It generates a random 
standard camera cut.  
Note: Standard cuts do not 
include directed cuts.

Most lighting and post processing cues can 
generate up to two text events. This allows for 
blending between cues.

LIGHTING AND POST 
PROCESS BLENDING

You can use the blending 
method to make a directed cut 
last for a custom duration:

By default lighting and post-
processing cues switch quickly 
from one to another:

 
In this example cue A generates 
a single text event. This is 
because cue A is touching cue 
B. The switch between these 
cues occurs at cue B.

The text events in the VENUE 
track are shown below:

When there is space between 
notes the cues blend together. 
For example:

 
Here cue A generates two text 
events. One at the start of the 
note and one at the end. The 
blend between cues happens in 
the gap between the two notes. 

The blend occurs between the 
blue text events below:

 
 
 

A
B

QUICK SWITCH

A
B

BLENDED CUES

DIRECTED CUTSLIGHTING & POST 
PROCESS BLENDING

A
B

BLENDED CUTS

A B

VENUE

A B

VENUE

A

[coop_k_near] [coop_k_behind]

[coop_b_behind]

B_Behind

RANDOM

RANDOM CAMERA CUTS
RANDOM CUTS 
OVERVIEW

When a RANDOM note is 
stacked with other cuts:

 ▪ A random cut is chosen that 
is lower in priority than the 
other stacked cut(s)

STACKED CUTS 
WITH RANDOM

Random generated cuts will be 
different than the previous and 
next camera cuts.

This is also true if there are 
stacked cuts before and after a 
random cut. 

RANDOM CUT 
GENERATION

Random cut generation looks at 
other random cuts.

Even with a whole venue of 
random cuts no camera cut will 
repeat twice in a row.

RANDOM CUTS IN 
A ROW

New random cuts will generate 
each time you click the 
Generate button in venuegen.

If you like the cuts generated 
change them to static cuts.

VENUEGEN CUT 
GENERATION

K_Near

G_Near G_Near
K_Behind

[coop_g_near]

[coop_g_near]

[coop_v_closeup]

[coop_dg_near]

RANDOM



VENUE AUTHORING

The STROBE note in venugen gives you more 
control over strobe lighting effects.

AUTOSTROBE 

The STROBE note is at the 
bottom of the LIGHTING track 
template. STROBE is similar 
to the Strobe_Slow and 
Strobe_Fast effects, but with 
more variation. This variation 
is provided by a range of note 
velocities.

To start, author a STROBE note 
with the desired duration. 

Note: Pay close attention to 
where STROBE notes begin. 
Generated text events are 
placed in relation to the 
position of the STROBE note. 
They do not automatically sync 
to the MIDI editor grid.

Next, adjust the velocity of the 
STROBE note: 

 ▪ Select the STROBE note and 
right click it

 ▪ Navigate through the Note 
velocity context menu to set 
a value: {4, 8, 16, 32, 104, 108, 
116, 132}
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NOTE VELOCITY

STROBE

STROBE NOTE 
OVERVIEW

1/4 NOTE STROBE

VELOCITY: 4

1/8 NOTE STROBE

VELOCITY: 8

1/16 NOTE STROBE

VELOCITY: 16

O

1/32 NOTE TRIPLET

VELOCITY: 132

O

Flare_Fast  
[lighting (flare_fast)]

Blackout_Fast  
[lighting (blackout_fast)]

O

Text events too dense 
to illustrate.

1/32 NOTE STROBE

VELOCITY: 32

O
O O O O

O O O O O O O

O O

1/4 NOTE TRIPLET

VELOCITY: 104

1/8 NOTE TRIPLET

VELOCITY: 108

1/16 NOTE TRIPLET

VELOCITY: 116

OO O

O O O OO O

The examples to the left show 
note velocity and STROBE 
rates. For example, the 1/4 note 
strobe has a velocity of 4. This 
turns the strobe on once every 
quarter note. (The strobe turns 
off between each quarter note).

For clarity, on and off symbols 
have been added to the top of 
each text event. The lighting 
calls used are below:

 
 
The 1/8 and 1/16 note strobes 
here are like the regular strobe 
lighting effects:

 ▪ Strobe_Slow 
8th note flash

 ▪ Strobe_Fast 
16th note flash

STROBE NOTE 
EXAMPLES

O O O

O

O O O O

O O O O

O O O O O O

O O O O

O O O O O

O O O O O O O
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Sing-along notes apply the lip-sync animation 
of the vocalist to other in-game characters.

SING-ALONGS 

There are three options for sing-
along notes in the VENUE track:

 

 
* Note: If these players are 
absent from the game then the 
keys character will sing along 
instead.

Extend these notes for the 
duration of the sing-along.

If harmony vocal parts are 
present:

 ▪ Guitarist lip-syncs HARM 2

 ▪ Bassist lip-syncs HARM 3

 ▪ Drummer lip-syncs HARM 1

The keyboardist will fill-in for 
guitar or bass if they are absent.

Spotlights highlight one or more of the 
characters on the stage.

SPOTLIGHTS

711 VENUE AUTHORING 712

Spotlight notes can be used 
one at a time or together in any 
combination:

Author spotlight notes for 
the duration of time that the 
spotlight is on. When the note 
ends the spotlight will turn off.

Note: Spotlights take about 
a second to be fully lit. If you 
want the spotlight to sync 
better with the music:

 ▪ Move spotlight notes so 
that they start a 32nd note 
before the spotlight hits *

 ▪ * Move notes back a 16th 
note at higher tempos

 
 
87 D#5 Guitarist Sing Along * 
86 D5  Drummer Sing Along 
85 C#5 Bassist Sing Along *

VENUE

SING-ALONG MIDI 
NOTES

SING-ALONG EXAMPLE

Bassist Sing Along

VENUE

VOCAL AND BASS SING-ALONG

D_Duo_Bass

SPOTLIGHT MIDI 
NOTES

 
 
41 E#1 Spotlight on Keys 
40 E1  Spotlight on Vocals 
39 D#1 Spotlight on Guitar 
38 D1  Spotlight on Bass 
37 C#1 Spotlight on Drums

VENUECAMERA

SPOTLIGHTS ON BASS, VOCALS, AND DRUMS

SPOTLIGHT EXAMPLE

Spotlight on Vocals

Spotlight on Drums

Spotlight on Bass

VENUE
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Follow these tips for great looking venues!

VENUE CREATION TIPS 

 ▪ Place a new camera cut 
every two to four seconds

Stack camera shots together so that you can 
get the shots that you want, no matter which 
instruments are being played.

STACKED CAMERA SHOTS 
AND SHOT PRIORITY
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This gives time for the shot to 
be established. It also allows 
time for camera movement 
in the shot. For example, an 
inward zoom, or pan to the left.

Note: Many shots veer away 
from their focus when held for 
too long. A four second limit 
prevents this from happening.

 ▪ Double-check lighting cues 
when using post-procs

Make sure that onstage action 
is visible. A blackout with the 
photocopy post-proc results in 
a black screen, for example.

You may often need to author 
more than one camera shot at a 
time in your venue. There are a 
couple of reasons for this:

 ▪ Only four band members are 
on stage at any given time

 ▪ Specific shots usually 
include the guitarist, bassist, 
or keyboard player

 ▪ You cannot guarantee which 
band members will be 
present in the song

For example, if you would like a 
two shot with:

 ▪ Vocalist and guitarist

You should also stack similar 
shots, such as:

 ▪ Bassist and keyboard player

This way, If the guitarist is not 
playing, you will still get a shot 
of the bass and keys players. 

 
Note: BK_Near has priority over 
GV_Near.

Stacked shots are prioritized by 
the camera system. The chosen 
shot is the one that:

 ▪ Most closely matches the 
band members present on 
the stage

If none of the stacked shots 
match the band members on 
the stage:

 ▪ A suitable generic shot is 
chosen. (One that most 
closely matches the band 
members on the stage)

2 to 4 seconds

CUT FOCUS DIRECTED CUTS

POST-PROCS

 ▪ At least one-twelfth of cuts 
should be directed cuts

1 12

Note: You do not have to 
manually add directed cuts. 
They are included in the pool of 
randomly produced cuts.

Cuts

SPECIAL MOMENTS
 ▪ Aim for two or three special 

moments each minute

0 60

One Minute

Add filler shots around these 
moments until the pace of cuts 
feels right.

CUT PACING
 ▪ Use the feel of the song to 

place cuts

1 12

Seconds

Above: Some songs have cuts 
that last almost twelve seconds.

Below: “Hello There” by Cheap 
Trick has cuts that average 1.5 
seconds each.

1 3

Seconds

The venue track should reflect 
the mood and feel of the song.

STACKING SHOTS SHOT PRIORITY

The shots on the 
following pages are 
listed in priority order, 
from most generic to 
most specific.

CAMERA

GV_Near

BK_Near

GV_NEAR

VENUE

GV_Near

BK_Near
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EXAMPLE CAMERA SHOTS 
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ALL_BEHIND

V_BEHINDD_NEAR

ALL_NEAR B_HAND

BD_NEAR GV_BEHIND

B_HEAD

All_Behind [coop_all_behind]

LIGHTING TEXT EVENT

All_Near [coop_all_near]

LIGHTING TEXT EVENT

BD_Near [coop_bd_near]

GV_Behind [coop_gv_behind]

B_Hand [coop_b_closeup_hand]

B_Head [coop_bd_near]

D_Near [coop_d_near]

V_Behind [coop_v_behind]Get creative with camera angles and the pacing 
of your shots! 
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CAMERA SHOT PRIORITY 
(GENERIC TO SPECIFIC) 

If no other shot can be 
matched, one of these is used.

Note: It is also possible that a 
three-character shot may be 
selected instead.
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These shots are also low 
priority. They work well in all 
contexts and are quite general. 
They are slightly more specific 
than four character shots.

There are fairly specific shots 
(but less specific than some 
two character combinations). 
Drums and vocals are lower 
priority (they are always present).

These shots are the most 
specific of the basic (non-
directed) camera shots.

Shots that include drums and 
vocals are lower priority. They 
are always valid, and so, more 
general.

Note 1: A single keys shot will 
have priority over these shots.

Note 2: If a band member is 
missing when one of these 
shots is called (and there are no 
other shots stacked):

 ▪ The camera will fall back 
to a single shot of the 
remaining band member

FOUR CHARACTER 
SHOTS

All_Behind

All_Far

All_Near

3 CHARACTERS 
(NO DRUMS)

Front_Behind

Front_Near

ONE CHARACTER 
STANDARD SHOTS

D_Behind

D_Near

V_Behind

V_Near

B_Behind

B_Near

G_Behind

G_Near

K_Behind

K_Near

ONE CHARACTER 
CLOSEUP SHOTS

D_Hand

D_Head

V_Closeup

B_Hand

B_Head

G_Head

G_Hand

K_Hand

K_Head

Two character combinations 
take priority. These shots take 
priority over more general single 
character shots. For example, a 
bass close-up beats a general 
keyboard shot. Again, drums 
and vocals are lower priority. 

TWO CHARACTER 
SHOTS

DV_Near

BD_Near

DG_Near

BV_Behind

BV_Near

GV_Behind

GV_Near

KV_Behind

KV_Near

BG_Behind

BG_Near

BK_Behind

BK_Near

GK_Behind

GK_Near

Turn to page 721 to 
see tables that convert 
venugen names to 
VENUE text events.
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Directed cuts are always more specific than 
normal shots. This list attempts to arrange 
them in order from least to most specific.

DIRECTED CUTS PRIORITY 
(GENERIC TO SPECIFIC) 

A full discussion of directed 
cuts can be found starting on 
page 683.
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These directed cuts 
do not contain unique 
animations. Instead 
they contain unique 
camera angles.

<

D_all

D_All_Cam

D_All_Yeah

D_All_LT*

D_BRE

D_BRE_JUMP

<

D_Crowd

D_Drums

D_Drums-Point

D_Drums_NP

D_Drums_LT*

D_Drums_KD*

D_Vocals

D_Vox_NP

D_Vox_CLS

D_Vox_Cam_PR

D_Vox_Cam_PT

D_Stagedive

D_Keys_Cam

D_Keys_NP

D_Duo_Drums

D_Duo_Gtr

D_Duo_Bass

D_Duo_KV

D_Duo_GB

D_Duo_KB

D_Duo_KG

<

<

D_Bass

D_Crowd_Bass

D_Bass_NP

D_Bass_Cam

D_Bass_CLS*

D_Gtr

D_Crowd_Gtr

D_Gtr_NP

D_Gtr_CLS*

D_Gtr_Cam_PR

<

<

FULL BAND / 
CROWD SHOTS

AUTHORING 
DIRECTED CUTS

SINGLE 
CHARACTER

TWO CHARACTER 
SHOTS

D_Gtr_Cam_PT

D_Keys

D_Crowdsurf
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VENUEGEN CAMERA TO 
VENUE TEXT EVENTS
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G_Behind [coop_g_behind]

G_Near [coop_g_near]

CAMERA CUT TEXT EVENT

K_Behind [coop_k_behind]

K_Near [coop_k_near]

D_Hand [coop_d_closeup_hand]

D_Head [coop_d_closeup_head]

V_Closeup [coop_v_closeup]

B_Hand [coop_b_closeup_hand]

B_Head [coop_b_closeup_head]

G_Head [coop_g_closeup_head]

G_Hand [coop_g_closeup_hand]

K_Hand [coop_k_closeup_hand]

RANDOM Generates a random 
camera cut

All_Behind [coop_all_behind]

CAMERA CUT TEXT EVENT

All_Far [coop_all_far]

All_Near [coop_all_near]

Front_Behind [coop_front_behind]

Front_Near [coop_front_near]

D_Behind [coop_d_behind]

D_Near [coop_d_near]

V_Behind [coop_v_behind]

V_Near [coop_v_near]

B_Behind [coop_b_behind]

B_Near [coop_b_near]

K_Head [coop_k_closeup_head]

DV_Near [coop_dv_near]

CAMERA CUT TEXT EVENT

BD_Near [coop_bd_near]

DG_Near [coop_dg_near]

BV_Behind [coop_bv_behind]

BV_Near [coop_bv_near]

GV_Behind [coop_gv_behind]

GV_Near [coop_gv_near]

KV_Behind [coop_kv_behind]

KV_Near [coop_kv_near]

BG_Behind [coop_bg_behind]

BG_Near [coop_bg_near]

BK_Behind [coop_bk_behind]

BK_Near [coop_bk_near]

CAMERA CUT TEXT EVENT

GK_Behind [coop_gk_behind]

GK_Near [coop_gk_near]

D_All [directed_all]

D_All_Cam [directed_all_cam]

D_All_LT* [directed_all_lt]

D_All_Yeah [directed_all_yeah]

D_BRE [directed_bre]

D_BRE_Jump [directed_bre_ jump]

D_Drums_NP [directed_drums_np]

D_Bass_NP [directed_bass_np]

<

These tables list venuegen camera cuts and 
their associated text events.
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VENUEGEN CAMERA TO 
VENUE TEXT EVENTS 
(CONTINUED)
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D_Gtr_NP [directed_guitar_np]

D_Vox_NP [directed_vocals_np]

CAMERA CUT TEXT EVENT

D_Keys_NP [directed_keys_np]

D_Drums [directed_drums]

D_Drums_LT* [directed_drums_lt]

D_Vocals [directed_vocals]

D_Bass [directed_bass]

D_Gtr [directed_guitar]

D_Keys [directed_keys]

D_Vox_Cam_PR [directed_vocals_cam_pr]

D_Vox_Cam_PT [directed_vocals_cam_pt]

D_Gtr_Cam_PR [directed_guitar_cam_pr]

D_Gtr_Cam_PT [directed_guitar_cam_pt]

D_Keys_Cam [directed_keys_cam]

CAMERA CUT TEXT EVENT

D_Bass_Cam [directed_bass_cam]

D_Stagedive [directed_stagedive]

D_Crowdsurf [directed_crowdsurf]

D_Vox_CLS [directed_vocals_cls]

D_Bass_CLS* [directed_bass_cls]

D_Gtr_CLS* [directed_guitar_cls]

D_Drums_KD* [directed_drums_kd]

D_Drums_Point [directed_drums_pnt]

D_Crowd_Gtr [directed_crowd_g]

D_Crowd_Bass [directed_crowd_b]

D_Duo_Drums [directed_duo_drums]

D_Duo_Gtr [directed_duo_guitar]

CAMERA CUT TEXT EVENT

D_Duo_Bass [directed_duo_bass]

D_Duo_KV [directed_duo_kv]

D_Duo_GB [directed_duo_gb]

D_Duo_KB [directed_duo_kb]

D_Duo_KG [directed_duo_kg]

D_Crowd* [directed_crowd]

<

<

<

< These directed cuts 
do not contain unique 
animations. Instead 
they contain unique 
camera angles.

<
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This custom venue really matches the mood of 
the song! 

VENUE EXAMPLE:
SIM “THE RUMBLING” 
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DRAMATIC, BRIGHT, SPOTLIGHT OPENING

V_Near 
Searchlights 
Bright 

INTENSE HORROR MOMENTS 

D_Gtr_Cam_PT 
Frenzy 
Horror_Movie

This is a dramatic song that 
changes mood often:

 ▪ Mid range vocal, guitar, and 
more restrained drums

 ▪ Low growling vocal, chunky 
guitar, and heavy drums

The transitions between these 
moods works very well. For 
example, dramatic hits on the 
drums are paired with chords 
on the guitar and keys. This is 
captured in the venue with:

 ▪ Great use of random camera 
cuts in time with the drums

 ▪ Stomp, spot lighting, 
blackouts, and fast strobes

 ▪ Bright and flicker trails post-
processing

Many thanks to C3 author Linos 
Melendi for permission to use 
this venue!

 

PHOTO NEGATIVE EFFECT

G_Near 
Photo_Negative 

BRIGHT AND STOMP

RANDOM 
Stomp 
Bright

GRAINY, COOL, GREEN EFFECT

D_Near 
Manual_Cool 
Video_Security

BRIGHT WITH RED TONES

V_Near 
Bright 
Film_Contrast_Red
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VENUE EXAMPLE: 
SIM “THE RUMBLING”
CAMERA CUTS
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RANDOM

D_Near

Bright

Film_Contrast_Red

Manual_Cool

Video_Security

next

Blackout_Spot

This MIDI combines two 
sequences of cuts for an 
intense section. At note A 
we are near the end of the 
“mellow” section and cut to the 
drummer. The first sequence 
is fast and bright. Notes 
B — D follow the drum hits 
with random cuts, Bright and 
Stomp. Film_Contast_Red and 
Blackout_Spot add the finishing 
touches. The effect is very 
dramatic! 

A

B C D

18 2019 21

A B

C D

D_Behind

D_Hand

Stomp

All_Behind

Manual_Warm

The second sequence is faster 
with blurred colorless cuts. 
Notes E follow the drum fill with 
random cuts, Strobe_Fast and 
Flicker_Trails. Most of the color 
is removed by Flicker_Trails 
giving an almost black and 
white look. Flicker_Trails also 
blurs the transition between 
cuts. In motion this effect looks 
amazing!

E

Flicker_Trails

Strobe_Fast

E E E E E E

E

E E
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VENUE EXAMPLE:  
SIM “THE RUMBLING”
BLENDING AND DIRECTED CUT
This example makes great use 
of blending between lighting 
cues. The notes A do not exist 
in the MIDI - they are used to 
show the fade between Sweep 
and Strobe_Slow. These slow 
strobe notes are 8th notes. They 
match the authored random 
cuts and are in time with the 
instruments and drum parts. 
The strobe flashes increase with 
intensity as the music builds up. 

A A

A A

Note: The bright part of each 
strobe hits a little after each 
cut. Here that works very well.

This is followed by Blackout_
Spot (note B). The music 
stops. The stage is dark and 
under lighting illuminates the 
characters. The characters jump 
into the air. This is controlled by 
the D_All cut (note C) that hits 
with the climax of the build up. 
So satisfying!

C

Front_Near

Bright.pp

Film_Contrast_Red

34 3635 37

D_Behind

B

All_Behind

Manual_Warm

RANDOM

Deafult

Dischord

Sweep

BONUSFX

Stobe_Slow

D_All

Horror_Movie

next

A A A A A A A A A

Blackout_Spot

C

BB

B

VENUE EXAMPLE:  
SIM “THE RUMBLING”
BLENDING AND DIRECTED CUT2
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To import the VENUE into 
venuegen:

 ▪ Press F10 to open venuegen

 ▪ Click the Pull LIGHTING from 
VENUE and Pull CAMERA 
from VENUE buttons

Open REAPER:

 ▪ Open a new project

 ▪ Select and then delete the 
existing MIDI items

 ▪ Drag and drop the .mid file 
into the PART DRUMS track 
at measure 1.1.00

The MIDI file import options 
window will open:

 ▪ Click OK to confirm

The venue (highlighted in 
yellow) is one of the imported 
MIDI items.

732

You can import authored and 
auto-generated venues into 
REAPER. Both of these options 
require a compiled custom:

 ▪ Open Nautilus

 ▪ Drag and drop the custom 
song file onto the Nautilus 
user interface

1

731

IMPORT AN EXISTING VENUE 
INTO VENUEGEN

3

2
A new window will open:

 ▪ Click the Contents tab

 ▪ Click songs > [custom song 
name]

In the lower panel:

 ▪ Select the .mid file

 ▪ Right-click the selected file 
and choose Extract selected 
files from the menu

 ▪ Click the Save button

The .mid file is saved to the 
same folder as the custom song.

4

IMPORT AN EXISTING VENUE 
INTO VENUEGEN 2
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IN-GAME VENUES 

PORTLAND, ME

small_club_01

DETRIOT, MI

small_club_02

MANCHESTER, MH

small_club_03

LA PESADILLA RESTAURANT

small_club_04

GOTTA SPARE BOWLING ALLEY

small_club_05

A reference gallery of in-game venues.
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INDIANAPOLIS, IN

small_club_10

SAN FRANCISCO, CA

small_club_11

VANCOUVER, BC

small_club_13

MEMPHIS, TN

small_club_14

BASEMENT SHOW, 18 W. 7TH ST.

small_club_15

AMSTERDAM, THE NETHERLANDS

small_club_06
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CHICAGO, IL

big_club_02

PORTLAND, OR

big_club_04

LOS ANGELES, CA

big_club_05

NEW YORK, NY

big_club_06

CHAPEL HILL, NC

big_club_07

TATTOO ANDY’S SKATELOFT

big_club_01
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CLEVELAND, OH

big_club_09

MATINÉE, VEXX NIGHTCLUB

big_club_10

WINNIPEG, MB

big_club_11

ROME, ITALY

big_club_12

MADRID, SPAIN

big_club_13

REYKJAVIK, OCELAND

big_club_08
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MILWAUKEE, WI

big_club_15

ATLANTA, GA

big_club_17

MONTREAL, CA

arena_01

RIO, BRAZIL

arena_02

TOKYO, JAPAN

arena_03

TIJUANA, MEXICO

big_club_14
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LONDON, ENGLAND

arena_06

BERLIN, GERMANY

arena_07

AUSTIN, TX

arena_10

DUBLIN, IRELAND

arena_11

ISTANBUL, TURKEY

arena_12

MOSCOW, RUSSIA

arena_04
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SAN DIEGO, CA

festival_02

SYDNEY, AUSTRALIA

festival_01

Note: Music videos are 
not included in the 
venue gallery.

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1

INTRODUCTION 746

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Themes work off practice sections in your EVENTS track.

 ▪ Use existing Magma themes as a template.

 ▪ Themes have three sections. Add lighting and post-procs to 
section presets.

 ▪ Use venuegen to author full venues with MIDI notes.

 ▪ Manual lighting calls use keyframes or triggers to cycle 
through their colors.

 ▪ Automatic lighting calls cycle automatically over time.

 ▪ Add post-proc effects to change the look of a camera shot.

 ▪ Directed cuts can be very dramatic. Use them for special 
moments in the song.

 ▪ Stack shots to account for instruments that are not being 
played in-game.

 ▪ Use note velocity to control strobe light rates.

 ▪ Blend lighting and post-proc calls for subtle transitions.

VENUE AUTHORING



 ▪ BEAT track
 ▪ Chart reduction
 ▪ Animation

21
AUTOMATION 
WITH CAT
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Use CAT to automate common authoring tasks.  

CAT
The C3 Automation Tool (CAT) provides 
a huge list of functions to make your 
authoring life easier!

Take a look at the screenshot on the facing page and you will 
see how many functions CAT has to offer. The grid of various 
size buttons is not pretty, but the functions are very useful.

At first glance it may not be obvious what some of the 
functions actually do. This chapter guides you through the 
basics of CAT, button by button. 

The only buttons not discussed are:

 ▪ Pro instrument buttons, and

 ▪ Automatic drum animations *

* Automatic drum animations were previously discussed on 
pages 367 — 368.

One final note. It is essential that tracks are named correctly  
for CAT to work. The C3 Template to takes care of this for you.  
Also, be sure that the [end] event in the EVENTS track is 
correctly placed. If not, some CAT functions will not work as 
expected. 

At the end of this chapter you will know how to use 40+ CAT 
functions. This knowledge will help you save a lot of time as 
you author your custom songs!  

CAT is an essential tool for 
custom song authors. It has 
almost fifty functions divided 
into the following sections:

 ▪ Animation and systems

 ▪ 5-lane Instruments

 ▪ Drums

 ▪ Vocals

 ▪ Supersets

 ▪ Pro Guitar/Bass

 ▪ Validation *

* The C3 Automatic Rules 
Validator (CARV) is included in 
CAT version 1.3.0. See page 762 
for details.

749

Download links available from: 
rhythmgamingworld.com/customsbook

To install CAT refer 
to pages 33 —  
34. To setup CAT 
dependencies see 
pages 29 — 30, 
and  91 — 94.

Press F9 to open CAT in 
REAPER.
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A beat track is needed for all custom songs.

This function creates downbeats 
and upbeats in the BEAT track:

 ▪ One downbeat per measure

 ▪ One upbeat per beat

Notes in the BEAT track end one 
beat before the [end] event in 
the EVENTS track. Make sure 
that you place your [end] event 
correctly in the EVENTS track 
(see page 637).

To create the BEAT track:

 ▪ Click the Create BEAT Track 
button

The Manage BEAT Track window 
will open:

 ▪ Click the Create BEAT Track 
notes button

Add character animation text events to the 
selected track.

CREATE ANIMATION EVENTS
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Halve BEAT track is used for 
animation purposes. It creates a 
half-speed BEAT track. 

To halve the whole BEAT track:

 ▪ Click the Halve BEAT track 
notes button

To halve selected measures:

 ▪ Select measures in the BEAT 
track

 ▪ Click the Halve selected 
BEAT track notes button

Create animation markers adds 
animation text events to the 
selected track. 

Click the Select instrument 
button to choose a track:

 ▪ Drums

 ▪ Guitar

 ▪ Bass

 ▪ Keys

 ▪ Pro Keys

 ▪ 2x Drums

 ▪ Rhythm

 ▪ Vocals

Click the Select expression 
button to choose an animation 
type:

 ▪ Play

 ▪ Mellow

 ▪ Intense

The play expression adds text 
events to appropriate positions 
in the track. For example:

 ▪ [play] 

 ▪ [idle]

 ▪ [idle_realtime]

Press the Create markers 
button to create animation text 
events.

The mellow expression will add:

 ▪ [mellow] 

 ▪ [idle]

 ▪ [idle_realtime]

The intense expression will add:

 ▪ [intense] 

 ▪ [idle]

 ▪ [idle_realtime]

Use the mellow or intense 
expressions if they apply to 
the whole song. Otherwise use 
the play expression. Add any 
[mellow] and [intense] text 
events as needed.

CREATE BEAT 
TRACK

HALVE BEAT 
TRACK

BEAT TRACK

ANIMATION 
MARKERS

CAT: MANAGE BEAT TRACK

CAT: CREATE ANIMATION MARKERS

CREATE BEAT TRACK
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Invalid markers cause problems when you compile 
your custom song.

REMOVE INVALID MARKERS 

Imported MIDI data often 
includes data that is not needed 
in custom songs.

To remove this data with CAT:

 ▪ Click the Remove invalid 
markers button

To review the event data in any 
MIDI track:

 ▪ Close CAT (if it is open)

 ▪ Press Alt + 3 (events view)

Note: This command does not 
remove SYSEX events from your 
MIDI. To delete SYSEX events 
use events view:

 ▪ Click SYSEX events * 
* Use the Ctrl or Shift keys 
to select multiple events

 ▪ Press the Delete key

To return to the default view:

 ▪ Press Alt + 2

5-lane functions are for guitar, bass, and keys.

CAT FUNCTIONS: 5-LANE
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REMOVE INVALID 
MARKERS

EVENTS VIEW WITH CHANNEL MARKERS

EVENTS VIEW WITH INVALID MARKERS REMOVED

CAT: ANIMATION AND SYSTEM Use Remove notes to reduce 
the note density for two or 
more measures. 

Use the Select grid drop down 
menu to choose the required 
note density:

REMOVE NOTES

REDUCE TO TRIPLE 
HITS
Removes the 4th note from a 
steam of selected notes: 

The example above is straight 
16th notes. The notes removed 
are white.

Use this function to fix sustain 
note length on 5-lane charts. 
Choose the instrument and 
difficulty in the drop down 
menus. The general sustain note 
gap for each difficulty is:

 ▪ Expert and Hard: 
One sixteenth note

 ▪ Medium and Easy: 
A quarter note

Note: The sustain note gap that 
CAT produces depends on the 
BPM of the song. See pages 
397 — 398 for details.

FIX SUSTAINS

This function will replace 
authored notes under roll and 
trill markers. It produces: 

 ▪ Eighth notes on Hard

 ▪ Quarter notes on Medium

 ▪ Quarter/half notes on Easy *

* Quarter notes for trills and 
half notes for rolls. 

For example, a sixteenth note 
Green/Red trill fixed on all 
difficulties:

FIX TRILLS / 
ROLLS

REDUCED NOTES

SUSTAIN NOTE GAP

X

H

M

FIX TRILLS

E

M

H

E
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CAT FUNCTIONS: 5-LANE 
(CONTINUED) 

Drum only CAT functions. For drum reductions 
see the ‘CAT Functions: Supersets’ topic.

CAT FUNTIONS: DRUMS
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Leave only a single snare when 
paired with any note:

 ▪ Kick

 ▪ Tom

 ▪ Cymbal

Works for all, or selected notes, 
on selected difficulty.

LEAVE SINGLE 
SNARE HITS

FLIP / UNFLIP 
DISCO BEATS
Flip disco notes based on disco 
flip markers. Applies to all, or 
selected notes. See pages 340 
— 342 for more details.

Unflip transforms a disco beat 
to an 8th note single handed 
beat on Hard. This function 
un-flips Yellow and Red gems. It 
only works inside disco flip text 
events. Note: The Automatic 
reductions (drums) function 
also performs the Unflip 
function. It does this when it  
reduces Expert drums to Hard.

REDUCE 2X BASS 
PEDAL
Reduces 16th note kicks to 8th 
notes:

Removes every other 16th note 
triplet from a sequence:

Remove notes by measure, 
beat, or ticks. Use the Beat drop 
down menu to select the beat. 
The number of beats listed will 
depend on the time signature.

The ticks drop down menu 
shows ticks for grid sizes up to 
32nd note triplets. For example:

 
Tick values repeat for each 
beat. The MBT counter in the 
Transport Bar shows ticks for 
the current play cursor position:

Use the checkboxes in the 
dialogue to select the note color 
to remove. You can remove all 
notes or selected notes. 

EDIT BY MBT

This fuction fixes notes that are 
off grid by a defined amount. * 
Grid options are:

 ▪ 1/16

 ▪ 1/32

 ▪ 1/64

* The default tolerance is 20 
ticks (about a 1/128 note). 

POLISH NOTES

REDUCE CHORDS
Reduce chords for Hard, 
Medium, and Easy. Click the 
Enable option checkbox to:

 ▪ Reduce three note chords to 
Green/Blue and Red/Orange 
chords (Hard)

 ▪ Allow Blue/Orange chords 
(Medium)

 ▪ Allow single Blue and Orange 
notes (Easy)

Focus charts to a range of 4 
notes (Medium) or 3 notes 
(Easy). Results can be variable.

LOWER FRETS 
COMPLEXITY

REMOVE KICKS

Remove kicks paired with:

 ▪ Any note

 ▪ Snare

 ▪ Any tom

 ▪ Any snare or tom

16TH NOTE TICKS

0 25 50 75 0

2X TO 1X

2X TO 1X

2X TO 1X

Reduces four straight 16th note 
kicks to three:

UNFLIP

X

H

REDUCE BY 
PATTERN
This function allows you to 
reduce parts of completed 
instrument charts:

 ▪ Click Reduce by Pattern

 ▪ Select one or more Expert 
measures in REAPER

 ▪ Select Hard, Medium or Easy 
from the drop-down menu

 ▪ Click Reduce by selected 
pattern

The reduction occurs:

 ▪ In the selected difficulty

 ▪ Wherever the selected 
pattern repeats in Expert
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CAT functions for vocals and harmonies.

CAT FUNCTIONS: VOCALS
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Adds a + text marker to any 
note without lyrics. This is 
useful when you:

 ▪ Add lyrics directly to 
each note. (You can avoid 
manually adding + markers)

 ▪ Find missing slides in a 
finished chart

ADD VOCAL 
SLIDES

ADD SPACE 
BETWEEN TUBES
Add space between phrase 
markers that touch:

 ▪ Shorten the end of each 
touching tube by 1/64th note

Remove illegal punctuation from 
lyric events:

 ▪ , (comma)

 ▪ “A” (quotation marks)

REMOVE ILLEGAL 
PUNCTUATION

CAPITALIZE FIRST 
LYRIC IN PHRASE
Capitalize the first letter of the 
first lyric per phrase marker:

Check for mid-phrase capital 
letters in lyrics. A dialogue 
window will open for each issue 
found. Click OK or Cancel to fix 
or ignore the issue:

CHECK / FIX 
CAPITALIZATION

HIDE LYRICS

Hide the selected lyric(s). 
Appends $ at the end of 
selected lyric(s) to hide them:

 ▪ Use to hide HARM2 and 
HARM3 lyrics when they 
differ * 
 
* Generally hide the part 
that matches HARM 1. If 
neither match hide the 
easier part.

Change lyrics to non-pitched. 
Append # or ^ at the end of 
each lyric. Use the drop down 
menu to select:

 ▪ Normal non-pitched (#)

 ▪ Loose non-pitched (^)

See also page 550.

CHANGE NOTES 
TO NON-PITCHED

CREATE PHRASE 
MARKERS
Generate phrase markers based 
on lyric text events. Uses the @ 
character at the start of each 
phrase.

Adjust phrase markers to the 
nearest eighth note or quarter 
note. Use the drop down menu 
to select grid size.

TRIM PHRASE 
MARKERS

COMPACT 
HARMONIES
Set HARM2 and 3 to HARM1 
phrase length when all these 
conditions are met:

 ▪ HARM1, 2, and 3 notes start 
at the same time

 ▪ HARM1, 2, and 3 notes have 
the same lyrics attached

 ▪ HARM1, 2, and 3 notes end 
with less than 1/64th note 
difference.

 ▪ Fix lyrics that are set as text 
events. 

Converts text events that are 
not a Trackname and do not 
start with the character [ to 
lyric events.

FIX TEXT EVENTS

ADD OVERDRIVE 
PHRASES
Create Overdrive phrases with 
a user defined frequency. 
The default frequency is one 
Overdrive phrase every four 
phrase markers.

PHRASE MARKERS

A long

PHRASE MARKER

CAPITALIZE LYRIC

@Here is

PHRASE MARKER

@ CHARACTER

VOCAL OVERDRIVE

TRIM MARKERS
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CAT FUNCTIONS: VOCALS 
(CONTINUED) 

Supersets are groups of functions that are run 
in series to complete complex tasks. 

CAT FUNCTIONS: SUPERSETS
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Remove empty pairs of phrase 
markers. Pairs are:

 ▪ HARM1 and HARM3, or

 ▪ HARM2 and HARM3

DELETE EMPTY 
PHRASES

COMPACT PHRASES

Try to make HARM1 and HARM2 
phrase markers the same. *

* If there are no other 
overlapping phrases.

Change un-pitched lyrics to 
pitched. Removes the # or ^ at 
the end of each lyric.

CHANGE NOTES 
TO PITCHED

EXPORT LYRICS

Export lyrics to a .txt file in the 
custom song project folder. 
There are two options for this 
function:

 ▪ Export vocals

 ▪ Export vocals with phrase 
markers

The later option adds the @ 
character to the start of each 
vocal phrase.

Show (un-hide) lyrics. Removes 
the $ character from hidden 
lyrics. The options are:

 ▪ Show all notes

 ▪ Show selected notes only

SHOW LYRICS

CREATE SING-A-
LONG NOTES
Create sing-a-long markers for 
harmony parts (in the VENUE 
track). The options are:

 ▪ Harmony 2 (guitarist)

 ▪ Harmony 3 (bassist)

 ▪ Harmony 1 (drummer)

Note: Keys sings the missing 
guitar or bass part.

Create automatic reductions 
for Hard, Medium and Easy. I 
recommend that you reduce 
one difficulty at a time. Then 
review the chart before you 
reduce the next difficulty. 
Automatic reductions have the 
following options:

 ▪ Grid size

 ▪ Consecutive notes

 ▪ Sparse notes

 ▪ Fix pitch bend

 ▪ Reduce chords

 ▪ Allow Blue/Orange chords on 
Medium

 ▪ Simplify notes (Medium and 
Easy)

Note: Automatic reductions 
work best on songs without a 
lot of offbeat notes or accents. 

REDUCTIONS: 
5-LANE

Create Hard, Medium, and 
Easy reductions for drums. The 
options for drums are:

 ▪ Grid size

 ▪ Consecutive notes

 ▪ Sparse notes

REDUCTIONS: 
DRUMS

 ▪ Remove kicks paired with 
percussion

 ▪ Unflip disco beat

This superset also simplifies 
rolls, starting from Hard.

COMPACT PHRASES

HARM1

HARM2

AUTOMATIC 5-LANE



AUTOMATION WITH CAT

CAT FUNCTIONS: SUPERSETS 
(CONTINUED) 
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The animation superset 
performs the following 
functions:

 ▪ Create drum animation 
notes

 ▪ Populate the BEAT track

 ▪ Add animation markers to all 
instruments

AUTOMATIC 
ANIMATIONS

The vocals clean up supserset 
fixes many vocal issues.

Phrase and note fixes:

 ▪ Fix long phrase markers

 ▪ Trim phrase markers to 
downbeat

 ▪ Clean up empty phrase 
markers

 ▪ Compact harmonies

 ▪ Compact harmonies phrase 
markers

Lyric and text fixes:

 ▪ Remove invalid characters

 ▪ Fix text events

 ▪ Fix capitalization

 ▪ Fix lyrics set as text events

You can select one or more 
vocal tracks for clean up.

VOCALS CLEAN 
UP

The general clean up superset 
fixes many general problems:

 ▪ Polish notes (excluding 
vocals)

 ▪ Fix sustains 
* Fix only stubby sustains 
* Fix stubby and too long 
sustains

 ▪ Simplify rolls, swells, trills, 
and tremolos

 ▪ Reduce double kick drum to 
single pedal

 ▪ Remove all invalid markers

 ▪ Copy missing Overdrive and 
solo markers to pro keys

You can select one or more 
instruments for clean up.

GENERAL CLEAN 
UP

Use the C3 Automatic Rules Validator (CARV) to 
check your REAPER project for errors.

CHART VALIDATION 
WITH CARV

CARV checks for specific errors 
in your REAPER project. The 
output is presented in a web 
page in your default browser.

CARV does not check for every 
possible error. It does catch 
some significant errors though:

Drums:

 ▪ Fill checks: OD or drum rolls 
inside fills, OD touching fills

 ▪ Tom marker animation check 
(disabled by default)

 ▪ Three limb and two limb 
check for Medium and Easy

 
Keys:

 ▪ Check for > 3 note chords

 ▪ Check for > 2 note chords

 ▪ Check for chords

Guitar and Bass:

 ▪ Check for three note  
chords with Green and 
Orange gems

 ▪ Check for > 3 note chords

 ▪ Check for > 2 note chords

 ▪ Check for Green / Orange 
chords

 ▪ Check for 1 4 chords

 ▪ Check for a chord (if there is 
one in Expert)

 ▪ Check for forced HOPOs

 ▪ Check for chords

Pro Keys:

 ▪ Check for > 5 note chords

 ▪ Check for > 3 note chords

 ▪ Check for > 2 note chords

 ▪ Check for chords

X

H

M

M/E

E

X/H

M

E

X

H

M

E

Vocals:

 ▪ Check lyrics for special 
characters

 ▪ Warn about periods in 
syllables

 ▪ Check for uppercase letter 
at the start of a phrase

 ▪ Check for uppercase 
syllables

 ▪ Check for 32nd note gap 
between notes

 ▪ Check for OD mismatch 
between PART VOCALS and 
HARM1

CARV does more than 
report errors. You can 
also use CARV to check 
your Overdrive phrases 
and song lyrics.
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Focus 1.
Introduction to the page - max of three lines of 
text.

TITLE 1 

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Focus 2.
Introduction to the page - max of three lines of 
text.

TITLE 1
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Create BEAT track is an essential function for every custom.

 ▪ Position the [end] event in your EVENTS track correctly 
before using CAT. 

 ▪ Reduce instruments one difficulty at a time. Review the 
reduced chart before proceeding to the next difficulty.

 ▪ Take care when you use superset functions. There are many 
options enabled by default.

 ▪ Use the C3 Template so that all your track names are 
correct for CAT.

AUTOMATION WITH CAT



 ▪ Magma requirements
 ▪ Magma
 ▪ Magma errors

PACKAGE 
CUSTOM 

22



768PACKAGE CUSTOMPACKAGE CUSTOM

MAGMA MIDI AND 
AUDIO FILESPackaging your custom song with Magma 

is the final step in the authoring process.

Magma is a tool that combines your audio file(s), MIDI file, and 
song metadata together. The output file is a complete Rock 
Band song package. 

Magma has three tabs to work through:

 ▪ Information (song metadata)

 ▪ Audio (song audio files, preview settings, and drum mix 
setting)

 ▪ Game Data (gameplay settings, MIDI file, and song ID)

This chapter walks you through these three tabs and some 
useful Magma settings. It also covers the Magma requirements 
and workflows that you need to complete before you start 
to package your custom. If you want to jump ahead, a walk-
through for a typical custom song is included.

This chapter also covers how to normalize your song audio. Pick 
the method that you like best.

By the end of this chapter you will have a complete custom 
song that is ready to play on your Xbox!

767

Download links available from: 
rhythmgamingworld.com/customsbook

To package your custom song 
you need the following:

 ▪ A complete (or almost 
finished) custom MIDI 

 ▪ A single, rendered audio file 
(unless you are using stems)

 ▪ Dry vox audio file(s), (if your 
song has vocals)

 ▪ Song metadata

The first few topics in this 
chapter will cover:

 ▪ REAPER MIDI export

 ▪ Song audio normalization

 ▪ Song audio export

 ▪ Dry vox export

GETTING STARTED

Magma expects a complete (or 
almost complete) MIDI file to 
package a custom song. If your 
MIDI is incomplete, you may 
need to add or adjust parts so 
that your MIDI will work with 
Magma. *

* Magma requirements are 
detailed in the Authoring 
chapters of this book.

AUDIO FILES
In most cases your song audio 
will be a single mixed audio file. 
The song audio requirements for 
Magma are:

 ▪ .wav file format

 ▪ 44.1 Khz (41000 Hz) sample 
rate

 ▪ Stereo

 ▪ 16 or 24 bit depth

Use the Render Song Audio 
preset to export song audio 
from REAPER with these 
settings. Note: The above 
settings also apply to stems, 
except that stems can be mono.

The render settings for dry vox 
audio are as follows: 

 ▪ .wav file format

 ▪ 16.0 Khz (16000 Hz) sample 
rate

 ▪ Mono

 ▪ 16 or 24 bit depth

For dry vox audio use the 
Render Dryvox for Magma 
Preset. 

To create these presets see 
pages 67 — 70.

MIDI FILE

Your priority for dry vox vocal 
tracks is as follows:

 ▪ Vocal stems

 ▪ Self recorded dry vox

 ▪ .milo vocal midi expoort

 ▪ Separated vocals

 ▪ Mixed audio *

* It is OK to use mixed audio 
if you have no other option. 
Lip-sync results will vary. Mixed 
audio is fine to use if you plan 
to replace it with a .milo vocal 
MIDI lyric export.

TEXT & METADATA
Text and metadata entered into 
Magma may only contain the 
following characters: 

 ▪ ABCDEFGHIJKLMNOPQRSTU 
VWXYZ

 ▪ abcdefghijklmnopqrstuvwxyz

 ▪ #$%&’()”+,-./

 ▪ :¿ÀÁÂÃÄÅÆÇÈÉÊËÌÍÎÏÐÑÒÓÔ
ÕØÙÚÛÜÝÞßàáâãäåæçèéêëìíî
ïðñòóôõøùúûü

 ▪ !¡©®°

DRY VOX PRIORITY
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Export your Project MIDI:

 ▪ Click the OK button

The MIDI export dialogue will 
open.

Note the number of exported 
tracks. A full band custom with 
a single vocal track is eight 
tracks. A full band custom 
without keys is seven tracks.

 ▪ Click the OK button

Check your MIDI export settings:

 ▪ Click File > Export project 
MIDI

The Consolidate MIDI window 
will open. Make sure that these 
buttons are checked:

 ▪ Entire project

 ▪ Consolidate MIDI Items: All

 ▪ Multitrack MIDI file

 ▪ Embed tempo map

Check your filename and output 
directory settings. 

770

Your project MIDI file is required 
by Magma to package your 
custom song.

Enable the following tracks in 
REAPER:

 ▪ PART DRUMS, PART GUITAR, 
PART BASS, PART KEYS *

 ▪ PART VOCALS, HARM1, 
HARM2, HARM3 *

 ▪ EVENTS, VENUE, and BEAT

* Only include instrument and 
vocal tracks you have authored.

1

769

EXPORT PROJECT MIDI

3

2
Make sure that all other tracks 
are muted:

 ▪ In the track controls click 
the M button

 
Note: You do not need to mute 
the SONG AUDIO and COUNTIN 
tracks. They are not exported.

Make sure that there are no 
tracks that are soloed:

 ▪ In the track controls toggle 
the solo button off

4

EXPORT PROJECT MIDI 2
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RENDER SONG AUDIO FOR 
MAGMA

PACKAGE CUSTOM

The Render window will open 
and process your audio:

 ▪ Wait for the render to finish, 
then click the Close button

Confirm your save settings and 
render your audio file:

 ▪ Set the output directory

 ▪ Set the file name

 ▪ Click the Render 1 file button

To render your song audio, solo 
your SONG AUDIO and COUNTIN 
tracks in REAPER:

 ▪ Click the S button in both 
track controls: 

 ▪ Check that there are no 
other tracks soloed

Open the Render to file window:

 ▪ Click File > Render

Hotkey: Ctrl + Alt + R

The Render to file window will 
open.

Choose the Render Song Audio 
Preset:

 ▪ Click the Presets button

In the pop-up menu click:

 ▪ All Settings > Render Song 
Audio

3
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RENDER SONG AUDIO FOR 
MAGMA2
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Modern versions of REAPER can perform LUFS 
normalization.

NORMALIZE SONG AUDIO: 
LUFS 
(MODERN REAPER)

LUFS normalization is a feature 
in newer versions of REAPER. It 
is simple to use, and automates 
the normalization process for 
you. I recommend this method 
for single (mixed audio) files. 

Download the latest version of 
REAPER from:

 ▪ https://www.reaper.fm/

Installation notes:

 ▪ Check the Portable install 
checkbox 

NORMALIZE SONG AUDIO: 
LUFS 2
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 ▪ Change the Destination 
Folder *

 ▪ Do not associate .rpp files 
with this installation

* When you click the Portable 
install checkbox the install 
folder changes to C:\REAPER. 
Do not use this folder - (see the 
warning below).

A portable install isolates the 
latest version from your REAPER 
v4.22 installation.

Open the new version of 
REAPER that you installed. 

Open a custom song project:

 ▪ Click File > Open Project

 ▪ Browse and select your 
custom song .rpp file

 ▪ Click the Open button

Your project will open. Solo the 
SONG AUDIO track:

 ▪ In the SONG AUDIO track 
controls click the S button

 ▪ Do not  solo any other tracks

 ▪ Click on the audio waveform 
in the SONG AUDIO track

 ▪ Press F2 to open the Media 
Item Properties window

To normalize audio:

 ▪ Click the Normalize button

The Normalize Media Items 
dialogue will open. Use the 
following settings:

 ▪ Normalize to: LUFS-I

 ▪ -6.40 LU

 ▪ Normalize each item 
separately

Note: This will alter your SONG 
AUDIO track audio file. Make 
sure that you back-up this file 
before proceeding.

 ▪ Click the OK button

The Normalize Media Items 
dialogue will close:

 ▪ Click the OK button

Turn the page to render your 
normalized audio for Magma.

LUFS / REAPER 
OVERVIEW

Do not install this 
version of REAPER to 
C:\REAPER. This will 
overwrite your REAPER 
v4.22 install. 

NORMALIZE 
AUDIO WITH LUFS

MEDIA ITEM PROPERTIES

PORTABLE INSTALL
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Normalize your song audio so that your Rock 
Band songs have a consistent volume.

NORMALIZE SONG AUDIO: 
W1 LIMITER 

When you play Rock Band you 
likely have to adjust the TV 
volume from time to time. This 
is because there is no single 
standard that defines what song 
loudness should be. 

This leaves the decision about 
what is loud enough, or too 
loud, to producers and audio 
engineers. The end result is 
that song loudness can be quite 
variable (depending on the 
songs that you are listening to).

There are various ways that you 
can normalize song volume, but 
you must do it properly. If not 
you will end up with audio that 
sounds flat or has unwanted 
noise from clipping.

To normalize our audio we will 
look at two methods:

 ▪ W1 Limiter

 ▪ LUFS normalization (see 
pages 773 — 774).
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The W1 Limiter was previously 
discussed on page 296. 
This discussion looked at 
the use of the plugin and the 
recommended settings. 

In this section we will detail the 
workflow and context for the 
recommended settings. 

After reviewing both of the 
normalization methods you can 
decide which one you want to 
use. The W1 Limiter method can 
be used for single or multitrack 
audio. The LUFS method is for 
single track audio only. 

I typically use the LUFS method 
as I do not have access to 
multitrack audio. I find the LUFS 
method easier to use. 

To install the W1 Limiter see 
pages 39 — 40.

The W1 Limiter is a plugin for 
the SONG AUDIO track:

 ▪ Resize the SONG AUDIO 
track so that you can see 
the track controls

 ▪ Click the FX button on the 
SONG AUDIO track 

The W1 Limiter has the following 
options:

 ▪ Ceiling

 ▪ Threshold

 ▪ Release

Use the recommended settings:

 ▪ Ceiling is an output level. 
The C3 Template sets the 
ceiling to -0.5dB. Set the 
ceiling to 0.0dB

 ▪ Threshold sets the level 
at which compression is 
applied.  Try to keep your 
average volume around 
-6.4dBFS. No louder than 
-3.7dBFS and no softer than 
-8.9dBFS

 ▪ Release is the amount of 
time it takes for the limiter 
to stop after the audio signal 
falls below the threshold. 
If you are not experienced 
with limiters it is best not to 
change this setting

NORMALIZATION OVERVIEW W1 LIMITER

W1 LIMITER

https://rhythmgamingworld.com/forums/topic/doctored-strange-levels-or-how-i-learned-to-stop-worrying-and-love-the-limiter/
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RENDER DRYVOX AUDIO FOR 
MAGMA

PACKAGE CUSTOM

The Render window will open 
and process your audio:

 ▪ Click the Close button

Repeat these steps for each of 
your dry vocal tracks.

Confirm your save settings and 
render your audio file:

 ▪ Set the output directory

 ▪ Set the file name

 ▪ Click the Render 1 file button

To render your dry vocals, solo 
your DRYVOX in REAPER:

 ▪ Click the S button in the 
DRYVOX01 track:

 ▪ Make sure that no other 
tracks are soloed

Open the Render to file window:

 ▪ Click File > Render

Hotkey: Ctrl + Alt + R

The Render to file window will 
open.

Choose the Render Dryvox for 
Magma Preset:

 ▪ Click the Presets button

In the pop-up menu click:

 ▪ All Settings > Render Dryvox 
for Magma

3

42

1

RENDER DRY VOX AUDIO FOR 
MAGMA 2
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Complete these tasks before you compile your 
custom song.

MAGMA CHECKLIST MAGMA CHECKLIST 2
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OVERVIEW 
OVERVIEW
A lot of work goes in to making 
a full band custom song. It is 
easy to miss a step or forget to 
complete something. 

This checklist is a reminder 
of the tasks that you need to 
complete.

Work through this list to avoid 
many potential Magma errors. 

Magma has a similar list that 
you can open and edit. Update 
the Magma list if you prefer. See 
page 782.

AUTHOR 
REDUCTIONS
Use CAT to create reductions 
for Hard, Medium, and Easy. 
Review each reduction before 
proceeding to the next difficulty. 
This applies to drums, guitar, 
bass, and keys. 

CREATE BEAT 
TRACK
Use CAT to create a beat track. 
Make sure that you position the 
[end] text event correctly in 
your EVENTS track. 

See pages 637 and 751. 

ADD DRUM FILLS 
Author drum fills in the PART 
DRUMS track. 

See pages 591 — 594.

 ADD DRUM 
ANIMATIONS
Use CAT to create drum 
animations. The CAT drum 
animations are better than the 
ones produced by Magma.  
See pages 367 — 369. 

ADD CHARACTER 
ANIMATIONS
Add character animation text 
events to each instrument 
MIDI. For example [play], [idle], 
[intense] and so on. For guitar 
and bass see pages 449 — 
450. The process is the same 
for keys (but does not include 
the [play_solo] text event).

ADD CROWD 
ANIMATIONS
Text events in the EVENTS track 
control crowd animation. See 
pages 639 — 640.

OVERDRIVE AND 
UNISON FOR 
INSTRUMENTS
Add Overdrive and Unison 
phrases for all instruments. 

See pages 595 — 604.

ADD VOCAL 
PHRASES 
Add phrase markers to each 
vocal MIDI track. See pages 
551, and 561 — 564.

ADD VOCAL 
OVERDRIVE
Add Overdrive to PART VOCALS. 
HARM1 will have the same 
Overdrive as PART VOCALS. *

* There can be exceptions to 
this rule. 

See pages 559 and 621.

ADD PRACTICE 
SECTIONS
Add practice sections to the 
EVENTS track.

See pages 642 — 655.

ADD SING-A-
LONG NOTES
Use CAT to create sing-a-long 
notes for harmonies in the 
VENUE track.

See page 759.

RENDER DRY 
VOCALS
Render stems for dry vocals 
if you have them. Otherwise 
render your own dry vocals or 
separated audio.

See pages 777 — 778.

For MIDI lip-sync / .milo dry-
vox see pages 583 — 584 and 
799 — 800.

NORMALIZE SONG 
AUDIO
Normalize your song audio for 
consistent in-game volume. See 
pages 775 — 774.

RENDER SONG 
AUDIO
Render your song audio for 
Magma. See pages 771 —772.

ALBUM ART
You will need the song album 
art to load into Magma. All 
album art is resized to a 256 x 
256 pixel 24-bit .bmp file. 

For consistency check the 
album art repository. Otherwise 
consider using the album art 
from existing customs. Other 
album art sources: 

 ▪ covers.musichoarders.xyz 
(use the Apple Music source)

 ▪ fanart.tv

https://keepitfishy.com/albumart/
covers.musichoarders.xyz
https://fanart.tv
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Review Magma settings before you build your 
first custom package file.

MAGMA SETTINGS 

Magma has several options 
enabled by default:

 ▪ Use silence tracks by default

 ▪ Analyze MIDI file for 
contents

 ▪ Increase song version 
automatically

 ▪ Append ‘_rb3con’ to file 
name

 ▪ Use ANSI encoding (default)

 ▪ Show toast notifications

 ▪ Override album art (*.png_
xbox)

There is typically no need to 
alter these options. A few of the 
options may need some further 
clarification though:

Silence tracks are enabled by 
default in Magma for drums, 
bass, guitar, and vocals. When 
players miss a note, the audio 
is not silenced. This is required 
for custom songs with a single 
audio source.

If you share your custom online you should 
enable .mogg encryption in Magma.
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Magma will analyze your MIDI 
for errors. Not all MIDI errors 
are easily seen. It is strongly 
recommended that you keep 
this setting enabled.

ANSI is the set of characters 
that you can use for song 
metadata. It includes the ASCII 
character set and 128 more 
characters. It is not the same as 
the UTF-8 character set.

Many Magma options are not 
enabled by default. Consider 
enabling the ones that you find 
most useful. 

ENCRYPT .MOGG 
FILE
Magma converts your custom 
song audio into .mogg files. 
These multitrack .ogg files are 
encrypted if you enable this 
option. You should encrypt your 
audio if you plan to upload your 
custom songs to RhythmVerse.

 

APPEND SONG 
VERSION TO 
FILENAME
When you compile a custom 
song Magma keeps track of 
versions for you. Use this option 
to add the version number to 
the filename.

 

DELETE RBA 
FILE(S)  
 
Magma creates two custom 
song files:

 ▪ .rbcon file

 ▪ .rba file

The .rbcon file is the one that 
you play on your Xbox. The .rba 
file is a Rock Band Audition 
file. Audition files were used to 
test songs for the Rock Band 
Network. Most authors do not 
have audition mode on their 
Xbox. Enable this option to 
automatically delete the .rba 
file produced by Magma.  

APPEND _RB3CON 
TO FILENAME
Use this option to add _rb3con 
to your custom song filename. 
This makes it easier to identify 
custom songs when you browse 
files on your PC.

 

USE UTF-8
Use this setting for metadata 
characters that are not included 
in the ANSI character set.

 

OPEN TO-DO LIST 
BY DEFAULT
Enable this option to view 
Magma’s To-Do list. Customize 
the list if you need to.

TO-DO LIST

MAGMA C3

MAGMA SETTINGS 2
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Enter your song metadata into Magma.

MAGMA: INFORMATION TAB 

TITLE
Song title. Maximum length 99 
characters.

 

MASTER? 
CHECKBOX
Uncheck if the song is a cover 
version.

 

ARTIST
Group or artist name. Maximum 
length 74 characters.

 

ALBUM CHECKBOX
Uncheck this checkbox if the 
song is a single.

 

ALBUM
The name of the album that the 
song originally appeared on.

Maximum length 74 characters.
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TRACK NUMBER
The song track number on the 
album from the “Album” field.

Number range 0 — 100.

YEAR RELEASED
The year of the song release. 
Check the re-release box to add 
a re-release date.

MAGMA: SONG METADATA
GENRE
The genre that best matches 
your song. This is subjective, but 
try to match your song to other 
songs in the Rock Band library.

SUB-GENRE
The sub-genre that best 
matches your song. (Each genre 
has a list of sub-genres).

LANGUAGES
Use the checkboxes for each 
language sung. Exceptions may 
include if a language:

 ▪ Only makes up a small part 
of the song, or

 ▪ Only uses a commonly 
understood word or phrase

AUTHOR(S)
Enter the names of the authors 
who worked on the song.

ALBUM ART
Click the ... button to load the 
song album art (see page 780).

KARAOKE
Check if the song has separate 
vocals and backing stems.

MULTITRACK
Check this box if the song has 
separate audio stems.

2X
Check if the song has a 2x bass 
pedal chart.

CONVERT
Check if the song is a 
conversion from another game.

RHYTHM ON KEYS
Check if the song has rhythm 
guitar charted to keys.

RHYTHM ON BASS
Check if the song has rhythm 
guitar charted to bass.

CAT EMH
Check if your CAT reductions are 
un-altered.

EXPERT ONLY
Check if the song only has the 
Expert difficulty authored.

ENCRYPT
Check to encrypt the song 
audio.

FILE PATH
The save directory and filename 
for your custom song.
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If your song has a drum part:

 ▪ Check the drum mix 
checkbox

Drums has three potential file 
fields. The Drum Mix drop-down 
menu unlocks the snare and 
kick options:

 ▪ Kit - use this option for a 
single mixed audio file

 ▪ Kit & Snare - use this option 
for separate kit and snare 
stems *

 ▪ Kit & Kick - use this option 
for separate kit and kick 
stems *

 ▪ Kit, Kick & Snare  - use this 
option for separate kit, kick 
and snare stems *

* The kit track usually contains 
an overhead recording of the 
rest of the kit.

If you have a single mixed audio 
file for your custom audio - use 
a silent file in the Kit field:

 ▪ Click the red button with the 
ellipses (...)

 ▪ Browse to your Magma 
installation folder

 ▪ Open the audio folder 

 ▪ Select the stereo44.wav 
file

Tip: Right click the file field to 
choose a silent file from the 
context menu:

If you have drum stems:

 ▪ Click the red button with the 
ellipses (...)

 ▪ Browse to and select your 
stem file(s)

For example, for three drum 
stems browse to each stem:

Add your song audio files to Magma.

MAGMA: AUDIO TAB 

In this tab you tell Magma 
where to find the audio tracks 
for your song.

For multitracks link each 
instrument to their respective 
audio stem. 

If you have a single audio track:

 ▪ Link each instrument to a 
silent audio track

 ▪ Link your mixed audio track 
to the BACKING track

Magma includes silent audio 
tracks. To find them: 

 ▪ Browse to your Magma 
installation folder and then 
click on the audio folder

There are 44.1 and 48kHz silent 
audio files:

 ▪ Mono

 ▪ Stereo

 ▪ 16 bit

 ▪ 24 bit

Note: All your audio files must 
match. They must have the 
same sample rate (kHz) and bit 
depth. Mixing the number of 
channels (stereo or mono) is not 
a problem. 

In the screenshot above we are 
using a single mixed audio file. 
It is the 16 bit, 44.1 kHz stereo 
audio file that we rendered with 
REAPER (see pages 771 — 
772). The silence files are also 
16 bit, 44.1kHz stereo files. 

Note: Silent files are a 
substitute for stems. 
When a silent file is 
muted in-game it does 
not impact the game 
audio output.

DRUM MIX SILENT FILES STEMSOVERVIEW
MAGMA: AUDIO FILES

DRUM MIX: KIT
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MAGMA: AUDIO TAB 
(CONTINUED) 

Bass: Check this box if you have 
a bass guitar part.

Guitar: Check this box if you 
have a guitar part.

Keys: Check this box if you have 
a synth, keyboard, or other track 
in PART KEYS.

 ▪ Add a silent file, or multi-
track audio file to the 
unlocked file fields 

 
The screenshot above shows 
the setup for bass, guitar, and 
keys with a mixed audio file.
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Vocals: Check this box if your 
song has vocals.

 ▪ Add a silent file, or a 
mixdown of your lead and 
harmony parts 

SOLO/HAMRONY 1 Dry Vocals: 

 ▪ Add a .wav file of your lead 
vocal *

* This vocal should have no 
added effects. Magma uses this 
file for lip-sync animations. It is 
not included in your final song 
package. This file should not 
include any background vocals.

If you do not have a lead vocal 
stem:

 ▪ Record your own dry vocals

 ▪ Use MIDI lip-sync .milo file

 ▪ Use a separated vocal track *

* For songs that have lead 
vocals only. Accurate animations 
are not guaranteed.

HARMONY 2 Dry Vocals: 

 ▪ Add the dry vocal .wav file 
for HARM2

This option requires at least 
two vocal parts. You will need 
to author PART VOCALS, HARM1 
and HARM2. 

HARMONY 3 Dry Vocals:

 ▪ Add the dry vocal .wav file 
for HARM3 

This option requires that you 
enable HARMONY 2. If HARM2 
and 3 are the same (just 
different pitch) then use the 
same file.  

BACKING: Enabled by default.

If you have a single mixed audio 
track:

 ▪ Add your rendered mixed 
audio track

To render your SONG AUDIO 
track see pages 771 — 772.

If you have multi-tracks:

 ▪ Add your backing track *

* This track includes any audio 
that is not in the bass, drums, 
guitar, keys, and vocals tracks.

The song preview controls let 
you to set the start point for the 
in-game song preview.

You can set a time in minutes, 
seconds, and milliseconds:

 ▪ Set the song preview start 
time

Song previews are 30 seconds 
long:

 ▪ Check the Song Length 
time to make sure that the 
preview does not run past 
the end of the song

Song length is set by the 
longest audio file in the project 
(not including dry vocals).

 ▪ Press the Play button to 
hear the song preview

The default audio quality is 5. 

For Wii and PS3 versions of Rock 
Band 3 set the audio quality to 3.

Wii Mode sets the maximum 
quality setting to 3. Press Ctrl + 
W to enable Wii Mode.

You can pan mono audio left 
and right. Values range from -1 
(all left) to 1 (all right). Use this 
settings for final tweaks to your 
stem mix.

Use attenuation controls if your 
stems are too loud in-game. 
Adjust quiet stems in REAPER. 
Attenuation reduction ranges 
from 0 to -10db.

 
The drum mix selection defines 
your recommended drum mix 
value. Magma updates text 
events in PART DRUMS for you 
by default.

BASS, GUITAR, ... VOCALS AND HARMONIES

Refer to pages 579 
— 580 to review your 
options for a lead dry 
vocal track.

To render dry vocal see 
pages 777 — 778.

BACKING

CROWD

SONG PREVIEW AUDIO QUALITY

PAN/ATTENUATION

REC. DRUM MIX
Crowd: If you have multitracks:

 ▪ Add the audio track for the 
crowd (if there is one) *

* This is mostly found in live 
recordings.

Add a silent file for songs with 
only one instrument authored.
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Set song game data and instrument difficulty tiers.

MAGMA: GAME DATA 
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ANIMATION SPEED
This setting controls in-game 
character animation speed:

 ▪ Slow (< 100 BPM)

 ▪ Medium (100 — 160 BPM)

 ▪ Fast (> 160 BPM)

The default is a medium tempo.  
Adjust the tempo to match the 
BPM of your song.

 

HOPO THRESHOLD
This sets the threshold for 
HOPO notes in milliseconds:

 ▪ 90

 ▪ 130

 ▪ 170 (default)

 ▪ 250

For example, if you have a song 
that does not show 16th note 
HOPOS at the default threshold:

 ▪ Increase the threshold 

MIDI PATH
Set this path to the MIDI file 
that you authored:

 ▪ Click the yellow button with 
the ellipses (...)

 ▪ Browse to your exported 
project MIDI file

To export your project MIDI file 
see pages 769 — 770.

 

AUTO-GENERATION 
THEME
If you did not author a venue 
choose a theme from the drop-
down menu:

 ▪ Aggressive metal

 ▪ Arena Rock

 ▪ Dark Heavy Rock

 ▪ Dusty Vintage

 ▪ Edgy Prog Rock

 ▪ Feel Good Pop Rock

 ▪ Garage Punk Rock

 ▪ Psych Jam Rock

 ▪ Slow Jam

 ▪ Synth Pop

Note: To use Magma themes do 
not place any camera or lighting 
cues in the VENUE track. To 
create your own Magma themes 
see pages 663 —676. 

MAGMA: GAME DATA
VOCAL GENDER
Select the gender of the singer 
in your PART VOCALS track:

 ▪ Male

 ▪ Female

VOCAL 
PERCUSSION
Select an instrument for vocal 
percussion:

 ▪ Tambourine

 ▪ Cowbell

 ▪ Hand clap

This sets the percussion sample  
played in-game by the lead 
vocal character.

VOCAL SCROLL 
SPEED
This sets the scroll speed for 
lyrics in-game. The default 
setting is Normal - 2300. If 
lyrics crowd the vocal HUD in 
your song, you can set the scroll 
speed to Fast - 2000.

VOCAL GUIDE 
PITCH VOLUME
This sets the guide pitch volume 
for the Audition and Training 
modes. The value range is:

 ▪ -10.0 to 0.00

The default value of -3.0 works 
for most songs. Adjust the 
volume if you have particularly 
loud or soft vocal stems.
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Tuning cents and vocal tonic notes are not used 
very often.

MAGMA: GAME DATA 
(CONTINUED) 

Give your song an age appropriate rating.
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Many thanks to author 
Orange Harrison for 
information on Tuning 
Cents, Vocal Tonic 
Notes, and Mute 
Volume Vocals.

TUNING CENTS
Tuning cents are not needed 
very often. They adjust the pitch 
of the whole vocal MIDI up or 
down by small amounts. This 
is for songs that are slightly 
off-key. Only use this feature if 
you are certain that your song 
needs it. 

A value of 50 adjusts the vocal 
pitch up a quarter note. Minus 
50 adjusts the pitch down a 
quarter note. It is best to adjust 
tuning cents in intervals of 10. 
The human ear cannot tell the 
difference between one or two 
tuning cents. 

You should not use a value 
greater than 50 or less than -50. 
If you need to do this, it means 
that your vocal chart is wrong. 

To test tuning cents, play 
your song on your Xbox. Use 
practice mode and turn on the 
pitch guide. Adjust the pitch in 
intervals of 10 until the pitch is 
correct.

DRUM KIT SFX
Drum kit SFX sets the drum 
sounds used before the drum 
track starts and for drum fills. 
The kit options are:

 ▪ Hard Rock Kit (default)

 ▪ Arena Kit

 ▪ Vintage Kit

 ▪ Trashy Kit

 ▪ Electronic Kit

Check the sound of the kits 
in-game. Pick the kit sound that 
best fits your custom song.

 

MUTE VOLUME ...
These two controls reduce the 
volume of a stem when the 
player misses a note:

The default in-game value for 
instruments is -96.0. For vocals 
it is -12.0 For each control you 
can specify a volume between 
-96.0 and 0. *

 ▪ * Do not use numbers above 
zero. Missed notes are not 
muted when the volume is 
set to zero.

For the singer, this will keep the 
vocal track playing (even if the 
singer fails).

If your song has ‘fake stems’ 
(produced by frequency banding):

 ▪ Adjust the Mute Volume 
control to make the game 
mute stems less harshly

SONG RATING
The song rating shows the age 
rating for your song in-game:

 ▪ 1 - Family Friendly

 ▪ 2 - Supervision 
Recommended

 ▪ 3 - Mature

 ▪ 4 - Unrated

Family Friendly means that the 
song should be suitable for the 
whole family to play.

Supervision Recommended 
means that lyrics or themes are 
not suitable for pre-teens.

Songs rated Mature contain 
strong explicit content. This 
includes explicit language, 
violence, and sex.

The Unrated rating is from the 
Rock Band Network. In-game it 
is treated the same as Mature.

VOCAL TONIC
Enable the Vocal Tonic Note 
checkbox to view a more 
detailed vocal HUD in-game.

This will make harmony parts 
easier to read.

Very few customs and Rock 
Band Network songs use this 
HUD. It is best not to use this 
feature unless you are sure how 
to use it.

The tonic note represents the 
key of a song. The tonic note 
values are:

 ▪ 0 - C

 ▪ 1 - C#

 ▪ 2 - D

 ▪ 3 - D#

 ▪ 4 - E

 ▪ 5 - F

 ▪ 6 - F#

 ▪ 7 - G

 ▪ 8 - G#

 ▪ 9 - A

 ▪ 10 - A#

 ▪ 11 - B
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Click checkboxes for solos and set a song ID.

MAGMA: GAME DATA 
(CONTINUED)

SOLOS
Check the boxes for the solos in 
your song. This identifies solos 
for use with game goals and 
challenges.

Vocal percussion counts as a 
solo. Make sure that instrument 
solos have solo markers in your 
MIDI project. Do not check a box 
for an instrument that does not 
have a solo.

Many thanks to author AddyMills 
for providing this information.

 

PRO TUNING
Pro tuning lets the game know 
the tuning for Pro guitar and 
bass parts. 

This is only needed if your Pro 
chart uses chord notation. The 
default tuning is below:

 ▪ E Standard 
E  A  D  G  B  E 
0  0  0  0  0  0 

Set a song version and file path. Check the box 
for fake Pro keys and keys animations if needed.

MAGMA: GAME DATA CONTIN-
UED 2
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For each string, raise or lower 
the numbers to change the 
tuning. For example, 1 raises the 
tuning for a string by half a step. 
Minus 1 lowers the tuning by a 
half step. 

Other common tunings:

 ▪  Drop D 
 D  A  D  G  B  E 
-2  0  0  0  0  0

 ▪  D Standard 
 D  G  C  F  A  D 
-2 -2 -2 -2 -2 -2

 ▪  Drop C 
 C  G  C  F  A  D 
-4 -2 -2 -2 -2 -2

 ▪  Open G 
 D  G  D  G  B  D 
-2 -2  0  0  0 -2

Many thanks to PimkinGuts92 
for this information.

 

SONG ID
It is important to give your song 
a unique ID. This is so that it 
does not conflict with any other 
Rock Band songs.

The maximum ID length is 25 
characters. 

For more information read the 
topic on page 798.

 

VERSION
Use the version number to keep 
track of your song versions. 

Note: By default the version 
number increases each time you 
compile your custom. 

DIFFICULTY
The difficulty rating is a tiered. 
Click a difficulty for each 
authored instrument:

 ▪ Warmup 

 ▪ Apprentice

 ▪ Solid

 ▪ Moderate

 ▪ Challenging

 ▪ Nightmare

 ▪ Impossible

Warmup is the default difficulty. 
Click the red dot to select the  
Impossible difficulty.

The band difficulty should be an 
average of the other parts.

 

FAKE PRO KEYS
Use this checkbox if you have 
authored 5-lane keys but not 
Pro keys. 

Magma will copy 5-lane keys to 
Pro keys to pretend that there 
are Pro keys. 

 

KEYS ANIMATIONS
Use this checkbox to let Magma 
auto-generate keys animations.

 

FILE PATH
Click the blue button with white 
ellipses (...) to set the file path 
for your custom song.

 

BUILD SONG
Save your Magma project:

 ▪ Click File > Save

 ▪ Select a path and filename

 ▪ Click the Save button

Click the Build Song button to 
compile your custom song.

Make sure that each 
version of your custom 
has a unique name and 
version number.  
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MAGMA WALK-THROUGH 

INFORMATION
Now that we are familiar with all 
the Magma forms, let’s take a 
look at a typical custom song.
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These screenshots show a full 
band custom with drums, guitar, 
bass, and vocals.

It does not include a 2x drum 
part or harmony vocals.

AUDIO
This custom has a single mixed 
audio file for the backing track. 

It is rendered to include the 
audio samples from the COUNT-
IN track in REAPER. 

The dry-vox track is a separated 
audio track.
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MAGMA WALK-THROUGH 
(CONTINUED) 
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GAME DATA
The Song ID is generated from 
the song filename.  

To review Song ID read the topic 
on the facing page.

To prevent duplicate song IDs, use your author-
name, songname, and version in your filename.

MAGMA: SONG ID 

OVERVIEW
Unique IDs are used for online-
play and to preserve scores in 
Rock Band 3. Authors used to 
have a unique author ID issued 
to them, which formed part 
of a unique song ID. When the 
limited number of author IDs 
ran out this caused issues. The 
result was that many authors 
could not take part in the 
author ID system. 

Magma no longer uses author 
IDs. Instead Magma generates 
a unique song ID from the 
filename of the song. 

SONG ID
The new Song ID system is easy 
to use. In the Game Data tab 
type the filename for your song.

It is recommended that you use 
the following format:

 ▪ authorname_songname_
version#

For example:

 ▪ doa_ComingAround_v1

To generate a unique Song ID 
click the New ID button.

D

 
 
The same filename will always 
generate the same Song ID. As 
long as the author name or song 
name is unique there should not 
be any duplicate song IDs.

Note: Magma can add the 
version number to your song 
filename automatically. To 
enable this option click:

 ▪ Options > Append song 
version to file name.

Use authorname_
songname_version# 
to avoid any chance of 
duplicate song IDs.

Note: If two or more 
songs collide, only one 
of them shows up in 
the game.
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The Building your song window 
will open.

If you are using an Onyx lip-sync 
file you will notice that Magma 
skips vocals auto-gen.

 ▪ Wait for the process to 
complete. This may take 
several minutes. 

If you experience errors in 
Magma, turn the page. Common 
Magma errors are discussed in 
the next topic. 

When the process is complete 
you can play-test your custom!

When you have completed all 
three tabs in Magma:

 ▪ Click the Build Song button

800

Follow these steps if you used 
Onyx to create a .milo lip-sync 
file for your custom song.

Note: Your lip-sync file must 
be in the same folder as your 
REAPER .mid file.

In Magma:

 ▪ Click Options > Advanced 
Settings > Override 
animations file (*.milo_xbox)

This setting adds your lip-sync 
to your custom song when you 
compile it.

1
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INJECT ONYX LIP-SYNC / 
.MILO INTO CUSTOM SONG

1

2
After you build your custom 
song your lip-sync will be ready 
to review in-game! 

2

BUILD CUSTOM SONG
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Troubleshoot compile errors in Magma.

MAGMA ERRORS 

TICK 0: GOT A 
TEXT EVENT ...
Tick: 0. Got a text event, 
but had no current track 
to put it into! str = 
[ProFilm_a.pp], type = 1

This error means that the 
Venuegen LIGHTING track is not 
muted. 

 ▪ Mute the LIGHTING track to 
fix this error

 

CONFUSED BY 
VOCAL PHRASE ...
Confused by vocal phrase 
overlap around [xx:x:xxx] 

This can refer to vocal phrase or 
other note overlap. 

 ▪ Check vocal phrases and 
notes around the timestamp

Note: The timestamp may 
not be accurate. There is an 
overlapping note somewhere in 
your vocal chart(s).
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TIME DIVISION 
MUST BE 480 ...
Time division must be 480 
ticks per quarter 

The time division of 480 ticks is 
set in REAPER during the RBN 
Tools installation. 

 ▪ Reinstall the RBN Tools

 ▪ Change the setting back to 
480 ticks

You may find that a reinstall of 
the RBN Tools does not correct 
this issue. In this case change 
the setting in REAPER:

 ▪ Press Ctrl + P to open 
REAPER Preferences

 ▪ Select MIDI in the left hand 
pane (under Media)

 ▪ In the Ticks per quarter note 
for new MIDI items field 
enter: 480

 ▪ Click the OK button

FOUND EVENT(S) 
AFTER THE ...
Found event(s) after the 
[end] event 

The [end] event is a text event 
in the EVENTS track. It is part of 
the C3 Template.

The [end] event marks the end 
of your custom song. Position 
it after all MIDI notes in your 
project.

 ▪ Move the [end] event to the 
correct position

There should not be any tempo 
markers or MIDI notes after the 
[end] event.

PART REQUIRED 
BUT NOT FOUND
Part [track] required but 
not found 

There are a couple of reasons 
why Magma cannot find a 
required track: 

 ▪ The track name text event is 
not in the correct position

 ▪ The track name text event 
no longer exists

 ▪ The track is muted in REAPER 
but expected by Magma

In the first two cases, open the 
problem track. Look at the text 
events at the start of the track. 
The track name should exist as 
a text event. The text event type 
should be Track name. If the 
text event does not exist:

 

 ▪ Create the text event

 ▪ Enter the track name in the 
text field

 ▪ Set the Type to: Track name

 ▪ Position the text event at 
1.1.00 (the start of the track)

For the later issue unmute the 
problem track:

 ▪ Click the M button in the 
track controls to unmute the 
track

GEMS CANNOT 
APPEAR  ...
Gems cannot appear before 
2.50 seconds into the song 

This error happens when there 
are notes in the first two and a 
half seconds of the song.

This is not allowed.

Fix this issue with one of the 
following methods:

 ▪ Add an extra measure (or 
more if needed) to the 
count-in * 
 
* Refer to the steps 3 and 4 
on pages 307 — 308 for 
an example.

 ▪ Export your MIDI. Create a 
new project. Set the count-
in BPM. Import your MIDI at 
the end of measures one 
or two (depending on how 
much extra space you need). 
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MAGMA ERRORS 
(CONTINUED) 

GEM ... DURATION 
... MAX IS 120
Gem at [xx:xx:xx] in ... 
difficulty has a duration 
of 160 ticks; max is 120 

Check your MIDI for sixteenth 
note triplet gems. A sixteenth 
note triplet is 160 ticks. A 
sixteenth note is 120 ticks.

Try quantizing the selected 
notes to a smaller size, for 
example sixteenth notes:

 ▪ Select the problem notes

 ▪ Press Q to Quantize

 ▪ Use the settings in the 
screenshots below:
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GEM ... DURATION 
OF 160 TICKS
If quantizing notes does not fix 
the issue try the following:

 ▪ Try deleting the problem 
notes and re-chart the 
section. Use a note size of a 
sixteenth note (or smaller if 
needed). Use the grid size of 
your choice

 ▪ Look for other issues in your 
project. For example, a time 
signature change that is not 
aligned correctly. This can 
appear to “eat” measures in 
REAPER and produce note 
length problems in Magma

ROLL EXTENDS 
TOO FAR PAST ...
Roll extends too far past 
last gem ... at [xx:xx:xx] 

A drum roll marker is too long. 
The roll marker should:

 ▪ End at the start of the last 
note of the roll, or

 ▪ Extend a little beyond the 
last note of the roll

 

To review drum roll markers see 
pages 353 — 354.

OTHER MAGMA 
ERRORS
For other Magma errors I 
recommend searching online 
for solutions. Follow links to: 
rhythmgamingworld.com/
forums/

When asking for help with 
Magma errors please use the 
Copy to Clipboard function. 

ONLINE HELP
For online help visit the C3 
forum at:

rhythmgamingworld.com

Stay connected on the 
RhythmVerse Discord.

MANUAL QUANTIZE SETTINGS

ROLL MARKER

INCORRECT

MARKER

CORRECT

MAGMA ERROR

MAGMA ERROR SEARCH RESULTS

https://rhythmgamingworld.com/forums
https://rhythmgamingworld.com/forums
https://rhythmgamingworld.com
https://discord.gg/N6Mpv8p6F4
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 SUMMARY

 ▪ Export your project MIDI from REAPER.

 ▪ Normalize your song audio file.

 ▪ Render your audio for Magma.

 ▪ Render dry vocals for Magma.

 ▪ Enter song metadata into Magma.

 ▪ Add silent tracks and backing track.

 ▪ Add instrument and song ratings.

 ▪ Package your custom in Magma.

 ▪ Inject lip-sync .milo into packaged custom (optional).

 ▪ You can use Author ID if your ID number is less than 9999.

 ▪ Each version of your custom must have a unique name and 
version number.

PACKAGE CUSTOM



 ▪ Title Updates 4 and 5
 ▪ Add customs to jump drive
 ▪ Play-test custom song

23
XBOX SETUP & 
PLAY-TESTING
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What do you need for custom and online play 
on the Xbox 360?

GETTING STARTED
We need to complete a few small steps to 
play your custom song on the Xbox 360. 

This is the final chapter of the book, and my favorite part of the 
custom authoring process. I spend plenty of time with the RBN 
Preview window in REAPER. But, there’s nothing like playing 
your custom song on the Xbox. It feels incredible to play your 
custom in-game for the first time!

In this chapter you will learn to:

 ▪ Format jump drives for the Xbox 360

 ▪ Add Title Updates to your jump drive(s)

 ▪ Copy custom songs to your jump drive using Nautilus

 ▪ Review your custom song charts for common mistakes

If you’ve worked through this book and made your first custom, 
congratulations! I hope that this book was helpful in guiding you 
through the process.

XBOX 360
A modded Xbox 360 is not 
required. Your Xbox Operating 
System must be dated 
04/30/2015 (or newer). 

JUMP DRIVE: 1GB
You only need a small jump 
drive for online play. We use this 
drive to store Title Update #5.

JUMP DRIVE: 32GB
This jump drive will store Title 
Update #4 as well as your 
custom songs.  

 

TITLE UPDATE 5
Title Update 5 was the last 
update for Rock Band 3. It 
included online play and access 
to the online store to purchase 
DLC. It does not support playing 
custom songs.

This update is in the down-
loadable version of Rock Band 3 
and the MadCatz game disc. 

TITLE UPDATE 4
Title Update 4 is the update 
used to play custom songs.

NAUTILUS
Use Nautilus to copy Title 
Update files and custom songs 
to your jump drives. 

 
EA GAME DISC
The EA Rock Band 3 game disc 
supports playing custom songs. 

Title Update 4 is included on 
this disc.
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Download links available from: 
rhythmgamingworld.com/customsbook

Note: You do not need 
to download TU4 or 
TU5. They are bundled 
with Nautilus. 
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Format your jump drives one at a time. If you 
do not play Rock Band online, you only need to 
format a single large jump drive.

FORMAT JUMP DRIVES 

OVERVIEW
You can format your jump 
drive(s) on your Xbox 360 or on 
your PC. 

Note 1: Jump drives need to 
be formatted to the FAT32 file 
system. 32 GB is the largest 
partition you can create using 
Windows Disk Management. 
With third party software you 
can create a 2TB partition. 

Note 2: Magma outputs lossy 
audio at a variable bit rate. A 32 
GB drive should be able to store 
enough custom songs to reach 
the Rock Band 3 song limit. 

 

Add TU4 and customs songs to your large jump 
drive. Add TU5 to your small jump drive.

TITLE UPDATE 4 AND 
TITLE UPDATE 5
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FORMAT ON PC
Plug your jump drive(s) into your 
PC and then follow the steps 
below for each drive.

Open Windows Explorer:

 ▪ Press the Windows + E keys

 ▪ Right click your jump drive * 
 
* Make sure that you select 
the correct drive

 ▪ Select Format from the 
context menu

 ▪ Check that the File system 
is set to FAT32

 ▪ Type a new drive name in 
the Volume label text field if 
needed

 ▪ Click the Start button

A warning will dialogue open:

 ▪ Formatting will erase ALL 
data on this disk

 ▪ Click the OK button

FORMAT ON XBOX
Plug your jump drive(s) into your 
Xbox 360 and then follow the 
steps below for each drive:

Navigate to:

 ▪ Settings > System > Storage

 ▪ Select USB Storage Device * 
 
* If more that one USB drive 
is found select the correct 
USB drive. Your drive may 
show up as ‘Unformatted’

 ▪ Select Format

A warning dialogue opens:

 ▪ This will remove all content 
on this device. Do you want 
to continue?

 ▪ Select Yes

Proceed to the TU5 on Xbox 
topic on the facing page.

OVERVIEW
For online play copy Title 
Update 5 (TU5) to your small 
jump drive. For custom songs 
copy Title Update 4 (TU4) to 
your large jump drive. 

Once your jump drives are set 
up make sure that you delete 
TU5 from your Xbox.

TU5 is read from your online 
play jump drive when you use it. 
Otherwise you will use TU4 on 
your custom play drive.

Do not plug your online play and 
custom play jump drives into 
your xbox at the same time.

TU4 & 5 ON PC
Complete these steps for each 
jump drive:

 ▪ Open Nautilus

 ▪ Click the RBtoUSB button

The RBtoUSB window will open:

 ▪ Click File > Open USB Drive

 ▪ Select your jump drive from 
the Drive Selector window

 ▪ Click the Tools menu

 ▪ To setup your custom song 
drive click Copy TU4 to drive

 ▪ To setup your online play 
drive click Copy TU5 to drive

 

TU5 ON XBOX
Plug your small jump drive (for 
online play) in to your Xbox 360. 
Navigate to:

 ▪ Settings > System > Storage

 ▪ Select Hard Drive

 ▪ Select Games and Apps > 
Rock Band 3

 ▪ Select Rock Band 3 Title 
Update #5

 ▪ Select Move

 ▪ Select your online play jump 
drive (USB Storage Device)

RBtoUSB

Next: Delete TU5 from 
your Xbox. Navigate to:

 ▪ Hard Drive > Games 
and App > Rock 
Band 3

 ▪ Delete Rock Band 3 
Title Update #5

RECOMMENDED
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Add custom songs to your jump drive with 
Nautilus.

ADD CUSTOM SONGS TO 
YOUR JUMP DRIVE 

Plug your (customs play) jump 
drive into your PC and follow 
these steps:

 ▪ Open Nautilus

 ▪ Click the RBtoUSB button

The RBtoUSB window will open:

 ▪ Click File > Open USB Drive

 ▪ Select your jump drive from 
the Drive Selector window

Open File Explorer:

 ▪ Browse to your custom song 
file location

 ▪ Drag and drop custom song 
files from File Explorer to 
the RBtoUSB window

Close your jump drive:

 ▪ Click File > Close drive

 ▪ Eject your jump drive from 
Windows

Your custom song(s) are now 
ready to play on your Xbox 360!

Playtest and review your custom song in-game 
to find and fix any mistakes.

CUSTOM SONG REVIEW
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OVERVIEW
Harmonix had strict standards 
for songs submitted to the Rock 
Band Network (RBN). You can 
review these standards here:

 ▪ http://docs.c3universe.
com/rbndocs/index.
php?title=Playtest_
Process

These standards are a great 
reference for all custom song 
authors. They provide:

 ▪ A list of the main authoring 
issues

 ▪ A longer explanations of the 
issues

 ▪ Issues by instrument and 
difficulty

 ▪ How to playtest your custom

This chapter contains a 
condensed version of the RBN 
standards. 

 
 

AUDITION MODE
Harmonix used Audition Mode 
to review songs for RBN. It 
allowed play-testers to:

 ▪ Auto-play tracks

 ▪ Play local multiplayer

 ▪ Timestamp issues for 
feedback

Today, you need a modded Xbox 
and Rock Band 3 Enhanced 
Edition to use Audition Mode:

 ▪ https://www.youtube.com/
watch?v=BGhHXJSnIFY

Without Audition Mode you can 
do the following:

 ▪ Playtest songs on Xbox 360

 ▪ “Auto-play” songs on Xbox 
360 (turn on No Fail)

PLAY-TEST
Playtest each instrument at 
each difficulty if you can. 

Note: You should not be playing 
at all times or using autoplay 
at all times. You will likely miss 
things while you play. If you only 
auto-play a song you might not 
get a feel for the song. Even 
when gems look right you may 
notice something wrong when 
you play it.

If you need to you can slow 
down very difficult parts in 
REAPER. To do this use the Rate 
slider in the Transport Bar:

 
This will allow you to slow down 
complex parts, and play along 
with them.

http://docs.c3universe.com/rbndocs/index.php?title=Playtest_Process
http://docs.c3universe.com/rbndocs/index.php?title=Playtest_Process
http://docs.c3universe.com/rbndocs/index.php?title=Playtest_Process
http://docs.c3universe.com/rbndocs/index.php?title=Playtest_Process
https://www.youtube.com/watch?v=BGhHXJSnIFY
https://www.youtube.com/watch?v=BGhHXJSnIFY
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Check your tempo map, audio, venue, animation, 
and song metadata.

NON-INSTRUMENT REVIEW 

CHECKLIST
Non-instrument review 
checklist:

 ▪ Are all playable instruments 
clearly heard in the mix?

 ▪ Is the tempo map accurate?

 ▪ Do camera and lighting cues 
look good?

 ▪ Does the animation speed of 
band members look good?

 ▪ Is the crowd animated?

 ▪ Are the difficulty ratings for 
the band and instruments 
accurate?

 ▪ Do instrument stems cut 
out of the mix properly when 
they are not being played?
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SONG SETUP
Each song should have a two 
measure (3 second) count-in. 
A count-in is not needed if the 
song has a playable count-in. 

It is very important that each 
player can hear the audio that 
corresponds to the gems they 
are playing.

It is critical that the tempo map 
is accurate. If the tempo map 
drifts away from the audio too 
much it ruins the gameplay of 
the song. Gems should always 
line up with the music.

Having the crowd clap along to 
the beat can be a nice addition 
to a song. It feels awkward if it 
is not used correctly though. For 
example, in a quiet, mellow part 
of the song.

ANIMATION
If your venue has too many 
camera cuts it will look jerky. In 
this case reduce the number of 
camera cuts.

Make sure that band member 
animation is appropriate for the 
song. Animations that are too 
fast or too slow won’t look right.

Crowd animation is also 
important. The most obvious 
issue is when the crowd is not 
animated at all. 

DIFFICULTY
Difficulty ratings are given to 
each instrument in the song and 
also to the band (page 794).

Songs are rated on the Expert 
part for each instrument. If a 
song is extremely easy it should 
go in warmup. If it is one of the 
hardest songs in the game it 
should go in impossible. While 
this is a subjective judgement it 
should not be ignored.

Compare your custom song to 
other songs already in the game. 
If you can find a song that is like 
your custom this will make the 
process easier.

There is no equation to 
determine song difficulty. But 
certain things tend to show up 
in more difficult songs:

BASS
 ▪ Fast notes 

 ▪ Lack of Overdrive in intense 
sections (especially guitar 
solos) 

 ▪ Chords

DRUMS
 ▪ Many fast rolls 

 ▪ Long disco flip sections 

 ▪ Off-beat kicks 

 ▪ Gems that are not consistent * 
 
* Sections that do not use 
one constant cymbal, for 
example

GUITAR
 ▪ Fast notes that are not 

HOPOs 

 ▪ “Snakes” (notes that move 
up and down the frets 
quickly) 

 ▪ Frequent Overdrive in 
difficult sections 

 ▪ Very difficult guitar solos

VOCALS
 ▪ Lots of short slides 

 ▪ Lack of space to breath or 
activate Overdrive 

 ▪ Large vocal range (lowest to 
highest notes)

BAND
 ▪ Overall difficulty of 

instruments 

 ▪ Difficult sections played by 
the band together (or not) 

 ▪ Lack of Overdrive during 
difficult sections 

 ▪ Unison phrases in difficult 
sections
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Check authoring, playability, animation and BRE.

PLAY-TEST: GUITAR AND BASS  

CHECKLIST
Key things to look out for 
include:

 ▪ Authoring

 ▪ Is authoring consistent on all 
difficulties?

 ▪ Is Expert a literal rhythmic 
transcription of the song?

 ▪ Is intent authored (not 
sloppiness)?

 ▪ Are HOPOs functional and 
reasonable?

 ▪ Playability

 ▪ Can you reasonably whammy 
all sustains?

 ▪ Is the difficulty acceptable 
for each difficulty?

 

Check solos at the end of the song, or before a 
BRE. Check bass player right hand animation.

SOLOS, BRE, AND 
ANIMATION
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CHECKLIST
Solos and BREs

 ▪ Are solos placed correctly? 
Are they the right length?

 ▪ Guitar solos should not end 
right before a BRE

 ▪ If there is a BRE does it 
function correctly? Is there 
at least one gem after the 
BRE lanes?

 ▪ Make sure there are no 
sustains after a BRE

Animation

 ▪ Are the guitarist animations 
correct?

 ▪ Is the bassist plucking the 
strings correctly? 

 

EXPERT & HARD
Chords should remain as 
consistent as possible. For 
example, author an E power 
chord the same way for the 
whole song. Do not author other 
chords using the same gems 
(unless you have run out of 
chord gems to use).

Author the intention of the 
guitarist. This means charting 
to the MIDI grid. Note: The solo 
in Blue Collar Man is a rare 
exception. Trying to play the 
sloppiness of the actual part is 
usually not fun at all.

Make sure that HOPOs make 
sense in your song. Forced 
HOPOs and forced strums 
can have a negative impact 
on gameplay. Make sure that 
repeating gems are not HOPOs. 
For example an Orange gem 
followed by an automatic HOPO 
Orange gem. 

Do not author slow guitar slides 
as a single long sustained note. 
Use multiple sustains with 
HOPOs instead.

MEDIUM & EASY
Medium should focus on Green, 
Red, Yellow, and Blue gems.

The focus for Easy is Green, 
Red, and Yellow with no chords.

Sustain notes can be a problem 
on Medium and Easy. Sustains 
are often short, with no 
functional value. If you cannot 
reasonably whammy these 
sustains, remove them.

Make sure that the difficulty is 
appropriate. The game should 
be playable and enjoyable on 
these difficulties. 

SOLOS AND BRE
The light blue solo section (in-
game) should begin and end 
with the guitar or bass solo.

There are two exceptions to this 
rule:

 ▪ When a solo is at the end of 
the song

 ▪ When a solo is directly 
before a BRE

In these cases, the solo should 
end just before the end of the 
song (even if the solo is still 
playing). It is important to end 
the solo this way - if not: 

 ▪ The solo bonus may not  
display correctly

 ▪ The solo bonus will cover up 
the BRE counter * 
 
* This is especially an issue 
for short BREs.

ANIMATION
Guitar and bass animations are 
not always 100% accurate to 
what is being played. But they 
should look real enough. The 
most important thing is that 
they are animated and not just 
standing still.  

You will want to check how the 
bassist is playing their bass. 
Bass players use their fingers 
or a pick to pluck the strings. 
For example, the bassists in 
Iron Maiden and Rush use 
their fingers. The bassists in 
Greenday, Kiss, and Motorhead 
use a pick. Other bassists use 
their thumb and fingers to slap 
the bass.

Drum animation is a bit more 
realistic. Actions for each 
part of the kit have their own 
unique animations. CAT does 
an excellent job in creating 
animations that match the 
Expert drum chart. 

https://www.youtube.com/watch?v=GuLMGSw284Q
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Check authoring, playability, and BRE.

PLAY-TEST: DRUMS 

CHECKLIST
Key things to look out for:

 ▪ Are drums authored to the 
correct pads?

 ▪ Are flams authored as two 
gems on Expert?

 ▪ Are disco beats authored 
correctly? 

 ▪ Does pad movement feel 
correct?

 ▪ Is Hard scaled back properly 
from Expert?

 ▪ Remove kicks from drum 
fills on Hard

 ▪ Un-flip disco beats on Hard

 ▪ Allow enough space for 
double crash hits on Hard

 ▪ Medium should contain the 
crucial parts of the song and 
still be easy to play

 ▪ No three limb hits on 
Medium
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 ▪ Rolls should be playable 
with one hand on Medium

 ▪ No kicks or snares between 
time keeping notes on 
Medium

 ▪ Allow enough space after a 
crash for the player to reset 
their hand position on Medium

 ▪ No gems should be paired 
with kicks on Easy

 ▪ Easy should only need two 
limbs 

 ▪ Are there enough drum fills? 
Are they the right length?

Animation

 ▪ Are drummer animations 
correct?

Big Rock Ending

 ▪ Does your BRE function 
correctly? 

 ▪ Is there at least one gem 
after the BRE lanes?

EXPERT
Every drum hit should be 
represented with a gem. 
Exceptions include:

 ▪ Kicks that are too fast to be 
played with one foot

 ▪ Accent emphasis - when 
possible we like to 
emphasize accented notes 
in single gem rolls. For 
example, “Excuse Me Mr” by 
No Doubt:

 ▪ Certain rolls (like buzz rolls) 
are not very playable in Rock 
Band. Scale such rolls back 
so that they feel right and 
are playable 

 ▪ The feel of the song is 
more important than small 
nuances. If you cannot hear 
hits in the game mix then do 
not author them 

HARD
The Hard difficulty should scale 
back from Expert:

 ▪ Keep the overall feel of the 
song but remove more of the 
nuances of the song

 ▪ The number of kicks should 
be about halfway between 
those on Expert and Medium

 ▪ No kicks during fills (fills 
played, not those used to 
activate Overdrive)

 ▪ Snare accents are still 
important on Hard. They 
should be scaled back to be 
a bit easier

 ▪ All crash cymbals should be 
authored to a single color

 ▪ No double crash hits unless 
there is a lot of space 
beforehand

 ▪ No quick hand crossovers

 ▪ Scale beats back in a 
consistent manner through 
out the whole song

MEDIUM
Medium difficulty is about the 
crucial parts of the song:

 ▪ No kicks or snares between 
timekeeping beats

 ▪ The kick with crash 
emphasis is important in 
medium (when the drummer 
plays them at the same 
time). But three limb hits are 
not allowed. If the drummer 
plays snare, kick, crash at 
the same time, the kick is 
usually removed

 ▪ Drum fills should be 
playable with one hand. This 
helps Medium players get a 
feel for the game

SOLOS, BRE, AND 
ANIMATION
Refer to the “Solos and BRE” 
and “Animation” sections on 
page 818.

EASY
Easy scales back Medium to 
even simpler beats:

 ▪ Use two limb patterns only. 
For example, patterns that 
use both hands or one hand 
and one foot

 ▪ Less intense sections are 
generally snares and kicks

 ▪ More intense sections are 
authored with both hands, 
but no kick

 ▪ On faster songs there should 
generally only be one kick 
between snare hits

 ▪ Make sure that there is 
enough space between 
hits. Easy players are not 
expected to move quickly 
between pads. This varies 
according to the tempo of 
the song. An 8th note of 
space is usually enough
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Check note pitch, lyrics, spelling, animation and 
percussion.

PLAY-TEST: VOCALS 

CHECKLIST
The main things to look for on 
vocals are:

 ▪ Are all note tubes the same 
pitch as the vocalist?

 ▪ Do note tubes end at the 
right time?

 ▪ Is each note tied to a single 
syllable?

 ▪ If there are vocal slides, 
does the slide timing match 
the vocalist?

 ▪ Do note tubes avoid long 
consonant sounds (c, f, s, z, 
etc)?

 ▪ Are non-pitched lyrics 
authored as talkies? Can 
you get an “awesome” rating 
with them?

 ▪ Are lyrics spelled correctly?

 ▪ Do the lyrics match what the 
singer is singing?
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CHECKLIST
 ▪ Do any hyphens appear 

where they should not?

 ▪ Does each phrase begin with 
a capital letter?

 ▪ Are vocal phrases a 
reasonable length?

 ▪ Do all the lyrics in a phrase 
fit on the static HUD screen?

 ▪ Are all Overdrive phrases 
usable?

 ▪ Does the vocalist animate 
properly?

 ▪ If used, do percussion 
section(s) make sense in the 
context of the song?

VOCAL TUBES
It is important that vocal tubes 
match the pitch that is being 
sung by the singer. This can be 
difficult to test, but there are 
two main ways to do this:

 ▪ Match what the singer is 
singing. See if this lines up 
with the vocal tubes, or

 ▪ Match the vocal tubes and 
see if that matches what the 
singer is singing

Ideally you should match the 
pitch and inflections of the 
singer to get an “awesome” 
rating. 

Note tubes should start and 
end at the right place. Usually 
the note tube begins with the 
first vowel sound of the lyric. 
For example, “cool” should start 
with the ‘ool” and not the “c”.

Each syllable should have its 
own note tube.

When notes do not have a 
clear pitch we author them as 

talkies. Sometimes a word will 
have a pitch that is difficult to 
place. These words also become 
talkies. For example, the word 
“ex- plo- sive” in “Skullcrusher 
Mountain” at the end of the 
bridge section. Do not mix and 
match pitched note tubes with 
talkies in any word. 

 
ANIMATION
Check that the vocalist is 
animated while singing. The 
vocalist should be idle if there 
are no vocals for some time. 

PERCUSSION
Percussion phrases follow the 
same rules as for sung vocals. 

The chosen percussion 
instrument should match the 
style of the song.

If a percussion section distracts 
from other instruments you can 
remove it from the song.

LYRICS & PHRASES
We recommended that you 
check lyrics in the static HUD. 
Issues are easier to see in the 
static HUD, and they will also 
show up in the scrolling HUD.

If a phrase length is too long it 
will show up on the static HUD. 
The lyrics will run off the screen 
and the bar on the note tubes 
will be very slow.

There are specific punctuation 
rules for Rock Band:

 ▪ You can use a question mark 
if the lyrics sung are actually 
a question

 ▪ Periods are only used for 
abbreviations, such as 
U.S.S.R

 ▪ You can use a single 
exclamation point when 
the singer is emphasizing a 
phrase. It is important not to 
do this too often though

 ▪ Hyphens should not appear 
in the static HUD unless 
required by the word. For 
example “Jack-in-the-box”

Phrase length can be too long 
or too short. Phrases that don’t 
finish where they should can be 
a problem. Typically a phrase 
should last for what the singer 
sings in a single breath. You 
can make sure that phrases are 
flowing smoothly in the scrolling 
or static HUD. 

Overdrive will only activate 
when there is enough space 
between phrases. It is 
important to make sure that 
you can activate every Overdrive 
phrase. Make sure there are no 
Overdrive activations available 
when the singing is over.

Finally, make sure that the lyrics 
(and spelling) match what the 
singer is singing! It is quite easy 
to miss a spelling mistake and 
then have to correct it after you 
finish your custom.
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At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
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Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

At the time of writing it is 2021 
and Rock Band 3 is just over 
10 years old. This means that 
used consoles, instruments, or 
adapters might be hard to find. 
It is certainly not impossible 
though.

Here’s a brief list of the things 
that you will need to author and 
play customs on Rock Band 3: 

PC or laptop: You don’t need 
a very powerful PC to author 
custom songs. I use a mid-
range PC from 2011 with 
Windows 10 and it does the job 
just fine.   

Xbox 360: Refurbished and used 
360s can still be found on Ebay 
and Amazon. You will need one 
with Operating System version 
2.0.17349.0 (April 30th, 2015) or 
higher.

Headphones: are very useful for 
authoring songs. They will help 
you pick out details better than 
using speakers.  
 
 
 

Rock Band 3 instruments: 
Used plastic instruments for 
Rock Band 3 can still be found, 
but they can be expensive. I 
recommend searching Facebook 
Marketplace or mobile apps 
such as Offer Up, Let Go, or 
Nextdoor.

Old or even broken instruments 
can be worth holding onto 
for spare parts. If you are 
holding on to a guitar with a 
broken strum bar I recommend 
replacing it with a Strum Fix 
Plus from ByteArts.

Rock Band 3: You will need the 
original game disc – the one 
with the Electronic Arts (EA) 
logo on it. The downloadable 
version and the MadCatz game 
discs do not work for customs. 

Flash drives: A 32 Gb flash 
drive is recommended to load 
customs songs onto your Xbox 
360. For regular play on Xbox 
Live you will need a 1Gb drive

Software: We will cover all the  
software that you will need to 
install in chapter one.

You may be wondering why 
I’ve focused on the Xbox 
and haven’t mentioned the 
PlayStation 3 or Wii in my list 
yet. There are a few reasons for 
this:

 ▪ You need to have a custom 
firmware (jailbroken) PS3.

 ▪ If you have a Wii you will 
need to soft-mod it.

 ▪ You have to convert Xbox 
customs to play them on the 
PlayStation or Wii. 

 ▪ The conversion to the Wii is 
not a simple process. 

So for this book, I will focus 
on producing customs for the 
Xbox. You can find help for the 
Playstation 3 and Wii in the C3 
forums here:

https://rhythmgamingworld.
com/forums/forum/c3-forums/

The [How To] Play Customs on 
PS3 and Wii threads are in the 
Custom Song Troubleshooting & 
Support section of the forums.

 SUMMARY

 ▪ Copy customs songs and TU4 to your large jump drive using 
Nautilus. 

 ▪ Use Nautilus to copy TU5 to your online play jump drive (if 
needed).

 ▪ Delete TU5 from your Xbox 360.

 ▪ Use one jump drive at a time - do not use them together at 
the same time.

 ▪ Play-test as many instruments and difficulties as you can.

 ▪ Review all instruments and difficulties with ‘no fail’ enabled.
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 ▪ A - Z
 ▪ Authoring terms
 ▪ Keyboard shortcuts

INDEX
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A
actions  71–88, 93–96

actions list  71
custom actions  75–88, 93–96

Alt + Q  83–84
Ctrl + Alt + S  95–96
F9  93–94
Q  75–76
Shift + L  89–90
Shift + Q  79–80
T  77–78
Tab  81–82
U  85–86, 87–88

edit actions  74
keyboard shortcuts  73
new actions  72

advanced tempo mapping  
231–252. See also tempo 
mapping

example  249–252
markers  237–238
overview  231–232
replace tempo markers  

241–242
steps  233–234
tempo map markers  239–240
working time signature  

235–236
remove  243–244

audio separation  258–264
mixed audio  259
models  273–274
pros and cons  261–262
separated audio  259
software  260. See also de-

mucs; See also Guitar 
Hero demucs GUI; 
See also spleeter; See 
also Universal Vocal 
Remover

waveforms  263
Audio to MIDI template

download  19

B
bar lines  142
Big Rock Ending (BRE)  609–610

workflow  590

INDEX

C
C3 community  13
C3 template  105–106

instrument difficulties  129
CARV  762
CAT  750–761

5-lane functions  754–755
create animation events  752
create BEAT track  751
download  19
drums  756
remove invalid markers  753
superset functions  760–761
vocals  757–759

chord consistency
guitar, bass, and keys  385

chords
example guitar chords  

393–394
guitar, bass, and keys  391

count-in. See also tempo map-
ping: count in

audio sample position  133
fix long or short count-in  

307–308
counting

eighth notes  147
eighth note triplets  150
quarter notes  146
sixteenth notes  148
triplets  149

CPlayer
download  20

crowd animation. See EVENTS 
track: crowd animation

Custom Tools
download  19

D
demucs  277–280

audio separation (command 
line)  279–280

dependencies  275–276
install  277–278

dotted notes  145
download directory  19–20
drum fills

authoring  593–594

workflow  590
drums  329–378

C3 template  329
character animation

events list  371
example  372
text events  370

common authoring mistakes  
363–364

crash  345
disco beat  340–344

authoring  341–342
disco flip  340
no flip  376
note weighting  343–344

double bass pedal  331–332
double crash  348
drum animation

C3 template  366
CAT  367–368
kit layout  365
options  367
tips  369

drum mix events  373–375
drum rolls  351–354

authoring  353–354
Easy

crashes (no kick)  362
kick and snare  362
reductions  362
two handed beats  362

flams  339
gem layout  329
Hard  355–358

16th note rolls  356
disco beat to “8 beat”  358
double crashes (space)  358
fast rolls (keep on grid)  357
hand crosses (none)  358
hand motion (less)  357
kicks and off-beat crashes  

356
kicks (less kicks)  357
kicks (remove from fills)  357
limb independence  355
multiple crashes (reduce)  

358
reductions (consistent)  358
right hand timekeeping  356
rolls (even number of hits)  

357
snare (remove accents)  357

hi-hat left foot pedal  349
hi-hat (open)  345
hi-hats on blue / green  346
hi-hats (open) on upbeats  

347–348
Medium  359–361

crash (reset after)  361
fills (accented pattern)  361
fills (one handed)  360
hi-hat (open)  361
kicks  359
kicks and crashes  360
limb independence (limited)  

359
rolls (one handed)  360
syncopation and feel  361
three limb hits (none)  361
timekeeping notes  359
triplets  360

MIDI grid  335
note consistency  336
PART DRUMS_2X track  

333–334
pro cymbals  331
reductions

“Crazy Train”  377–378
sticking  330
swells  351–352
tom fills  338
toms  337
un-accented hits  350

E
EVENTS track  636–655

crowd animation  639–640
[END] text event  637
[MUSIC_END] text event  638
[MUSIC_START] text event  

638
overview  636
practice mode

timekeeping notes  641
practice sections  642–655

authoring  642
auto-generated venues  644
C3 template  643
text events

ah  655
bre  655
break  649–650
bridge  646–647
build up  651
chant  655
chorus  646
crescendo  651
drum roll  654
ending  655
enters  645
fade in  645
fade out  655
gtr  654
hook  653–654
interlude  650
intro  645
jam  650–651
melody  651–652
oohs  655
outro  655
part  648–649
prayer  655
release  651
riff  652–653
solo  647–648
soundscape  650
speed up  651
spoken word  655
tension  651
vamp  651
verse  645–646
vocal break  654
yeah  655

F
FX  286. See also RBN preview

G
guitar and bass  407–470

1 4 power chords  463–464
ambient guitar noise  414
authoring tips  411
bass

authoring  408
right-hand-animation  

453–454
bends (pitch)  413

C3 template
add fret numbers  455–456

character animations  449
example  450

chord change HOPOs  465–
466

chords  409
common authoring mistakes  

443–444
Easy  433–434

chords (none)  434
orange and blue gems  434
quarter notes (remove)  433
sustained notes  434
wrapping notes  434

gem layout  407
hand maps  457–460

basic chord shapes  458
single notes, vibrato and 

drop d  459–460
Hard  415–421

8th note pick-up chord  418
8th notes (continuous)  420
chord changes (fast)  

415–416
chord to chord HOPOs  417
extend notes (do not)  420
jumps (green to orange)  418
orange / green chords  416
rhythmic feel  419
subtle variations  415
sustain note length  417
three note chords  416
triplets (16th note reduc-

tion)  419
wrapping notes  421

lane consistency  386
left-hand animation  451–452

example  461–462
Medium  422–432

1 4 chords  424
8th notes (remove)  422
chord changes (no fast)  423
chords  423
chords, green/orange  424
orange gem (examples)  

431–432
orange gem reference  430
orange gems (adding and 
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priority)  429
quick jumps (avoid)  425
rhythmic feel, upbeats and 

syncopation  426
sustain note duration  425
three note chords (none)  

424
triplets (reduction)  426
wrapping chords  428
wrapping notes  427

muted strings  413
overlapping notes  412
pick-up notes (chords)  412
reduction examples

“25 or 6 to 4”  473–474
“Blood and Thunder”  

471–472
“Caught in a Mosh”  469–470
“Crazy Train”  477–478
“Heart of Glass”  468
“The Look”  475–476

strum markers  446
sustained notes  410
trill markers  445

authoring  447–448
trills  414

Guitar Hero demucs GUI
download  20

Guitar Pro  313–317. See 
also MIDI: note length 
and BPM

conversion review  315–316
convert  313
import  314
song sections  317

H
harmony vocals  617–630

authoring  617–618
hide lyrics  621
lyric shift (static vocals)  619
phrase marker end point  621
phrase markers  619
range shift  619–620
Rock Band Harmonies Project 

(RBHP)  622–628
HARM1 “New Kid in School”  

623

HARM2 “New Kid in School”  
625–626

HARM3 “New Kid in School”  
627–628

snap to key  629–630
HOPOs

authoring  400
automatic HOPOs  399
guitar and bass techniques  

400

I
import

audio  191
custom song  319–322
separated audio  213

instrument markers
Big Rock Endings (BRE)  

609–610
drum fills  591–594
solos  611
unison & overdrive  595–608
workflow  590

J
Java Runtime Environment  22

download  20

K
keys  509–532

character animation  529–530
chords  512
Easy  525–526

chords (none)  526
Quarter notes (remove)  525
sustained notes  526

Expert  515
gem layout  509
Hard  516–519

8th notes (continuous)  518
subtle variations  516
sustain note length  516
three note chords  517
triplets (16th note reduction)  

517–518
wrapping notes  519

lane consistency  511
Medium  520–524

8th notes (remove)  520
chord changes (no fast)  521
chords  521
rhythmic feel (keep)  523
sustain note duration  522
three note chords  522
triplets (reduce)  523
wrapping notes  524

overlapping notes  513
reduction examples

“Break on Through”  531
“Roundabout”  532

sustained notes  513–514
trill markers  527–528

L
lyrics. See also vocals

Japanese lyrics  554
lyric formatting  551–552
Spanish lyrics  555–556

Lyric To Clipboard tool  553

M
Magma

audio tab  785–788
author and song ID  798
build custom song  800
checklist  779–780
download  19
errors  801–804
examples  795–797
game data tab  789–794
information tab  783–784
Inject Onyx lip-sync  799
requirements  768. See 

also Xbox 360: play cus-
tom songs: copy custom 
song to jump drive

export MIDI from REAPER  
769–770

format jump drives  811
normalize audio

LUFS  773–774
W1 limiter  775–776

render dry-vox  777–778
render song audio  771–772
title update 4  812
title update 5  812

settings  781–782
song ID  798

measures  142
MIDI

note length and BPM  318
MIDI editor

copy and paste notes  130
customize note colors  121–124
dock  119
drag notes between difficul-

ties  131
draw notes  127
resize elements  111–112
select notes  128
un-dock  120

MIDI editor grid  163–174
32nd note grid  165–166
color menu: pitch  175
color menu: velocity  176
grid size  164
grid type  164
note size  164
quintuplet notes  164
straight grid  167
swing grid  171–174
triplet grid  169

MIDI tracks
view multiple tracks

Unison. See Unison phrase: 
MIDI tracks: stack

vocals. See vocals: MIDI 
tracks: stack

Miniconda  275–276
download  20

[MUSIC_END] text event  638
[MUSIC_START] text event  638

N
Nautilus

add custom song to jump 
drive  813

download  19
.NET Framework  21

download  20
note consistency

guitar, bass, and keys  385
note lengths  143–144
note pitch  175

note velocity  176

O
Onyx

create lip-sync file for Magma  
583–584

download  20
Overdrive  595–608

authoring
rules  597–598

drum fills  597
drum solos  597
frequency  599–600

calculate  601
keys and Pro keys  604
overview  595–596
tips and tricks  603–604
Unison phrase (ratio)  605–

606
workflow  590

example  602

P
play cursor  109

position  115
play-testing  814–822

animation  818
Big Rock Endings (BRE)  818
drums  819–820
guitar and bass  817–818
non-instrument review  

815–816
overview  814
solos  818
vocals  821–822

plugins  289–296
bassmanager  289
Center/Canceler  292
MIDI Tool II  294
ReaEQ  291
ReaPitch  290
ReaSynth  293–294

enable and disable  295
W1 limiter  296

practice mode
timekeeping notes  641

practice sections. See EVENTS 

track: practice sections
preserve motion

guitar, bass, and keys  386
Pro keys  485–503

animation (left and right-
hand)  503

authoring  486
C3 template  485
character animation  501–502
Easy  500
Expert  497
glissando lanes  495
Hard  498
lane shift notes and ranges  

487–488
lane shift rules  489–490
Medium  499
Overdrive, Unison, and solo 

markers  496
overlapping gems  492
trill markers  493–494
wrapping notes  491

Python 2.7
download  19

Python 3  42

Q
quantized MIDI notes  388
quintuplet notes  164

R
range shift indicators (YARG)  

435–442
RBN preview  287–288
RBN Tools

download  19
REAPER

dependencies  21–22
Java Runtime Environment  

22
.NET Framework 4  21
Visual C++ 2010  22

download  19
media controls  114
MIDI editor  107–108
Modern REAPER install  41–44
navigation  117–118
new project tabs  134
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normalize song audio: LUFS 
(modern REAPER)  
773–774

play cursor  109
resize elements  111–112
track control panel  113
undo (Ctrl + Z)  134
User Interface  103–104
view modes  132

REAPER configuration  53–70
automate backup  61–62
audio device  53–54
default template  59–60
load C3 Template  56
new versions  55
project settings  63
project timebase  64
ReaScript  91–92
render dry-vox  69–70
render song audio  67–68
replace missing file  57–58
scrub settings  65–66

Rhythm Gaming World  13
RhythmVerse  13
Rocksmith  302–306. See 

also count-in: fix long or 
short count in

conversion  303–304
conversion review  305–306
organize MIDI tracks  311–312

S
scrub audio  65–66, 110, 195–196
software  18
software install  23–40

custom tools  24
C3 Automation Tools (CAT)  

33–34
Custom Tools  35–36
Magma  37–38
Nautilus  31–32
Python 2.7  29–30
RBN Tools  27–28
REAPER 4.22  25–26
W1 Limiter  39–40
venuegen  701–702

software (other)
cPlayer  45
Onyx  45

INDEX

Tux Guitar  45
solos

authoring  609
spleeter

dependencies  275–276
sustained notes

guitar and bass  395–396
song tempo  395–396

T
tempo mapping  181–222. See 

also advanced tempo 
mapping

audio sample (reposition)  
207–208

change time signature  
219–220

count in  201–202
count in & first measure BPM  

203–204
flams  199
import audio  191–192
import separated audio  213
limits  187–188
measures one to three  

203–204
overview  185–186
render song audio  209–212
scrub audio  195–196
separated audio  182
set BPM and position audio  

193–194
solo the drum track  215–216
steps  189–190
tab to transient method  200
tab to transient vs wave-

form vs peaks vs scrub  
197–198

methods  183–184
scroll tempo mapping  

221–222
timeline method  223–224

tempo map the rest of the 
song  217–218

transients  182
text events  125–126

text event lists  126
time signatures

3/4 and 6/8  151

4/4  141
7/4  154
7/8  153
12/8  152

title update 4  810, 812
title update 5  810, 812
transport bar  114

BPM, time signature, & rate  
116

play cursor position  115
tremolo notes  156
trills  155
triplets  149

eighth note triplets  150
TuxGuitar  313–314

download  20

U
Unison phrase  595–608

drum fills  598
frequency  599–600

calculate  601
keys and Pro keys  604
MIDI tracks

stack  607–608
Overdrive (ratio)  605–606
overview  595–596
tips and tricks  603–604
workflow  590

example  602
Universal Vocal Remover  

265–272
audio separation  268–270
download  20
install  265–266
user interface  267
workflows  271–272

V
venue  660–745

authoring tips  713
auto-generated themes  661

built-in presets  665
open themes  662
structure  663–664

automatic lighting calls  
679–682

autostrobe  709–710

Big Rock Ending (BRE)  699
camera cuts  704

random  708
camera shots

examples  715–716
priority  714

generic to specific  717–718
stacked  714

custom themes  666
blueprint  667–668

directed cuts  683–698
blending  707
crowd shot  692
examples  685–690
full band  691–692
individual character

cam shots  695
close up shots  697
crowd interaction  697
hits  693
not playing  694
pointing (drummer)  697
vocalist stagedive / crowd-

surf  696
overview  683–684
priority

generic to specific  
719–720

example venue  725–730
camera cuts  727–728
directed cuts and blending  

729–730
overview  725–726

lighting  705
lighting calls

blending  707
manual lighting calls  677–678

keyframe triggers  706
post processing calls

blending  707
post processing effects

basic  669–672
special  673–676

pyrotechnics  699
screenshots  733–745
sing-alongs  711
spotlights  712
text events to venugen note 

names  721–724
VENUE track  660

venuegen  700–703
import

venue  731–732
install  701–702
interface  703
overview  700

Visual C++ 2010  22
download  20

vocals  539–584. See also har-
mony vocals

authoring  540, 541–542
vocal tubes and separated 

audio  543–544
C3 template  539
character animation  567
dry-vox  579–580
dry-vox (record)  581–582
grid size  540
hyphenator tool (link)  551
import lyrics  561–562
lead vocals  545–546
lip-sync animation  579–580. 

See also Onyx: create lip-
sync file for Magma

lyric formatting  551–552
MIDI

auto-generate  573–574
example  575–576

MIDI tracks
stack  577–578

non-pitched vocals  549–550
Overdrive  559
Overdrive deploy  558
percussion  565–566

animation  568
example  569–570

phrase markers  557–558
phrase markers (create with 

CAT)  563–564
pitched vocals  547–548
separated vocals (clean-up)  

571–572
Tutorial video (link)  540
vocal ranges (static HUD)  560
vocal stems  540

W
W1 limiter  18

download  19

normalize audio  775–776
overview  296

wrapping notes
guitar and bass

Easy  434
Hard  421
Medium  427–428

guitar, bass, and keys  389–
390

keys
Hard  519
Medium  524

X
Xbox 360

play custom songs
copy custom song to jump 

drive  813
requirements  810

Y
YARG range shift indicators  

435–442
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Terms used by the custom creators community.

AUTHORING TERMS 

2x Kick: A drum chart authored 
for a kit with two kick drums.

4/4: A time signature with four 
quarter note beats per measure. 

Author: A person who creates a 
custom song.

Authoring / Charting: The 
process of creating a custom.

BPM: The tempo of a song, 
measured in beats per minute.

BRE: Big Rock Ending.

C3: The community for Rock 
Band 3 custom creators.

C3 Custom RB3 Template: A 
REAPER project template for 
authoring customs songs.

CARV: C3 Automated Rules 
Validator. Use this tool to check 
for errors in your REAPER 
project. CARV can also display  
Overdriveand song lyrics.

CAT: C3 Automation Tools. Use 
these tools to automate tasks 
in REAPER. 

INDEX

Chart: The MIDI notes for a 
particular Rock Band  
instrument or event track.

Chords: Two or three notes 
played at the same time.

CON File: A custom file that is 
ready to play on the Xbox. See 
also Magma.

Custom: An unofficial Rock 
Band song. C3 does not allow 
customs of any Harmonix Rock 
Band content. 

Count-in: An audio cue that 
establishes the starting tempo 
of a song.

Color map: A graphics file used 
to customize the colors of MIDI 
notes in REAPER for Rock Band.

Combo: Short for combination. 
A combo is a set actions 
completed in sequence (usually 
with strict timing). For example, 
if part of a song is difficult to 
combo, this means it is difficult 
to execute perfectly. 

Demucs: A music separation 
model for drums, bass, vocals, 
and other instruments.

Free form lanes: Lanes used in-
game for trills, fast (odd rhythm) 
tremolo, fast drum rolls, and  
cymbal swells.

HOPO: Guitar / bass gems that 
do not need to be strummed.

Key map: A text file used to 
customize templates and fields 
in REAPER for Rock Band. 

Magma: Software used to 
compile custom songs from 
audio and MIDI into CON files. 
See also CON File. 

Measure: A small section 
of music. The duration of a 
measure is determined by the 
time signature and tempo.

MIDI notes: Notes placed into 
MIDI tracks in REAPER. The 
notes chart the rhythm and 
pitch of instruments, and other 
game related events. 

Mogg: The audio format output 
by Magma for custom songs.

Nautilus: A collection of 
software tools that help you 
manage your customs. See also 
CON File.

Overdrive (OD): Energy that is 
deployed for score multipliers. 

Project Marker: A vertical red 
line placed on the MIDI grid. 
Markers are numbered in the 
order that they are placed. They 
are used for advanced tempo 
mapping.

RBN Tools: Software used to 
customize REAPER. The tools 
include a preview window for 
visualizing charts. See also 
keymaps, and color maps.

RB3: An abbreviation of Rock 
Band 3. 

rb3con file: An abbreviation of 
Rock Band 3 CON File (typically 
referred to as a CON file).

REAPER: A digital audio 
workstation, or DAW. It is the 
primary software used to create 
and chart custom songs. 

Reduction: A chart that is 
reduced in difficulty for Hard, 
Medium, and Easy instruments.

RGW: An abbreviation of Rhythm 
Gaming World. RGW is an online 
community for rhythm games.

RV: An abbreviation of 
RhythmVerse. RV is a free web 
app for finding content for 
rhythm games. 

Tempo Mapping: A process that 
aligns a MIDI grid to the rhythm 
of a song. This is an essential 
process in creating a playable 
custom song.

Tempo Marker. A marker placed 
during tempo mapping. Tempo 
markers align the MIDI grid to 
beats and downbeats in the 
music. They are are used to set 
the time signature and current 
song BPM.

Tremolo: Rapid alternate picking 
of notes on guitar or bass. 

Trill: Rapid alternation between 
two notes.

https://rhythmverse.co/
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A list of useful keyboard shortcuts for authoring 
in REAPER.

GENERAL
Select All   Ctrl + A

Show / hide mixer   Ctrl + M

Open Action List   ?

Item Properties   F2

Preferences   Ctrl + P

Project Settings   Alt + Enter

MIDI EDITOR
Cut    Ctrl + X

Copy    Ctrl + C

Paste    Ctrl + V

View Piano Roll   Alt + 1

View Note Names   Alt + 2

View Track Events LIst  Alt + 3

Clear Selection   Esc

Start / Stop Playback  Space

Show / Hide note names  Alt + 0

TRACK HEIGHT
Expand selected tracks  !

Minimize track height  @

KEYBOARD  
SHORTCUTS 

AUTHORING
Open CAT   F9

Open Venuegen   F10

Scroll Tempo Map   Alt + Q

Tempo Map Measure  Q

New Time Signature  T

Advanced Tempo Map  Shift + Q

Advance Play Head   Tab

Unison Phrase   U

Import Lyrics   Ctrl + L

Align Lyrics & notes  Shift + A

Toggle Snap to Grid  Alt + S

Quantize notes   Q

Open Region Manager  Ctrl + Shift +  
    Alt + R


